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General information on VideoCAD 8 Professional
VideoCAD is a multifunctional tool for professional video surveillance system design,
modeling parameters of video image and video equipment.
VideoCAD allows even the beginners to use the new opportunities appearing to be hard to
obtain without it due to the complexity of calculations and therefore not being used even by
the skilled engineers of CCTV.
VideoCAD practically boosts the quality of CCTV design to a new level which appears to be
beyond any competition with those lacking the program.
Four VideoCAD versions are offered:
VideoCAD 8 Professional - the most powerful, professional version with many unique tools.
VideoCAD 8 Lite 31 - basic version offers the most useful and easy-to-master tools for CCTV
design;
VideoCAD 7 Starter 45 - easiest, low cost version;
VideoCAD 7 Starter II Kit 45 - is lik e the Starter version but with several valuable features 45 in
addition. Starter II version is offered only in a k it with IP Camera CCTV Calculator and VideoCAD
Plugin for Sk etchUp;
VideoCAD 8 Professional is registered with USB dongle. All other VideoCAD versions are registered
only by personal registration code. This code doesn't depend on computer hardware or a dongle. This
code is valid on any computer.
VideoCAD Starter, VideoCAD Starter II Kit and VideoCAD Lite can be upgraded to VideoCAD 8
Professional at discount price.
Licenses of VideoCAD 8 Professional and VideoCAD 8 Lite allows free use of the demo versions
for educational purposes, for research, theses, writing articles, etc. non-profit activities.
Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

The main features of VideoCAD 8 Professional:
Calculations
Calculating geometric parameters 251 of camera view area in any camera position.

Calculating size of the active area of the image sensor in dependence of the aspect ratio of the
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image sensor and the aspect ratio of the output image of the camera.

Calculating horizontal projection sizes of person detection, identification and license plate reading
areas.

Calculating Depth of Field of each camera of the project.
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Calculating the image size on display of any object in camera view area in percentage of display
size, pixels and millimetres (inches in case of Imperial format).

Calculate length 388 and electric parameters of cables 342 .
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Calculate light power and illumination produced by illuminators.

Working with 2D projections
Use 2D Graphics window with CAD interface 158 . Use a lot of 2D/3D constructions and CAD tools,
line types, font types, snaps 194 , horizontal and vertical projections, up to 10 layouts in each
project, unlimited number of layers.
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Display on the 2D layout results of calculations 3 : view area projections, person detection and
identification areas, depth of field limits, test object, cables and luminaries.
Display by separate colors and hatch styles different regions of spatial resolution 170 and field-ofview size. There are prepared spatial resolution patterns according to the following criteria: Home
Office Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.
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Construct the horizontal projection of camera control areas including shadows 172 from obstacles
on the scene.

Choose the best positions and calculate control areas of PTZ cameras 384 , Dome cameras and 360
degree cameras.
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Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras 409 (fisheye, 360°/180°).

Modeling camera rotation 255 around the main optical axis.
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Modeling lens distortion 429 . Modeling influence of the lens distortion on view area shape, on view
area projection shape and spatial resolution distribution.Correct modeling wide-angle lenses with
strong distortion.

3D modeling layout and camera view areas
VideoCAD has special 3D World window with standard tools for 3D navigation (Orbit, Move,
ZOOM, Walk, Look around, Zoom frame). With the help of the window you can observe the
layout in 3D representation. You can work on the project in usual 2D projections and watch it in 3D.
You can "walk" on the floors of 3D models of buildings and study every detail.
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3D visualization of the camera view area surface taking into account spatial resolution, shadows,
lens distortion.

3D visualization of the active camera coverage on the environment taking into account spatial
resolution, shadows, lens distortion.
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3D visualization of control areas of PTZ cameras 384 , Dome cameras and 360 degree cameras.

Visualization of camera coverage area and spatial resolution distribution on the surrounding objects
of panoramic cameras 409 (fisheye, 360°/180°).
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Free cutting 3D layout by six planes to provide access to any point of complex 3D buildings.

Working with multilevel 398 3D layouts and terrains with complicated vertical structure.
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Possibility of loading prepared 3D models 229 (a person, a car, etc., ). You can add your own 3D
models from 3ds max and Sketchup 397 .

Possibility of using 3D models-territories 398 , to place inside them cameras, constructions and
other 3D models.

Modeling images from cameras based on camera parameters and scene
conditions
Modeling observed scene parameters (illumination, visibility limitations).
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com
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Model luminaires considering spectrum of radiation and spectral sensitivity of image sensors,
including discharge lamps with complex spectrum and infrared LED illuminators.

Model camera parameters (spectral response, number of pixels, resolution, minimum illumination
at known signal/noise ratio, IRE and aperture, maximum signal/noise ratio, electronic shutter,
AGC, BLC, gamma, day/night cameras,frame rate, interlace scan, global shutter and rolling shutter
).
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Model lens parameters (focal length, aperture, auto iris DC and Video Drive, resolution).

Visually control modeled resolution with the help of the Test chart
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Model images from megapixel cameras 378 with number of pixels exceeds Windows screen
number of pixels (Up to 100 megapixel and more!) with PiP (Picture in Picture) and without PiP.

See examples: 5 megapixels,10 megapixels, 25 megapixels.
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Calculate and model depth of field of each camera in project.

Model brightness, contrast, compression, horizontal and vertical sharpness.
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Model moving objects 166 , camera frame rate 379 , create animated images with moving 3D models.

Model blur and distortion 385 of moving 3D models depending on camera parameters (exposure
time, interlacing, rolling shutter).
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Modeling images taking into account lens distortion 429 (barrel and pincushion). Correct modeling
wide-angle lenses with strong distortion.

Simulation of image resolution and view area limits of panoramic cameras 269 (fisheye,
360°/180°).

Obtain Image Model 284 for each camera in the project based on models of scene and equipment.

Design operator interface
Design operator interface using the Monitor window 294 .
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Modeling size and resolution 297 of monitors.
Create animated monitor models 380 as html files with moving 3D models and different frame rates
of each camera. See an example of animated monitor (file size about 4 Mb).

Import from other CAD programs
Locate cameras and cables on the prepared layouts 204 in *.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf. AutoCAD *.dxf *.dwg formats.
For backgrounds in AutoCAD *.dxf *.dwg formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.
Import constructions 199 from a 2D background in AutoCAD formats to 3D VideoCAD constructions
automatically. Use of this tool allows to reduce efforts of outlining background to convert it to 3D
constructions.
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Import 3D models of objects and 3D models of territory 399 using VideoCAD plugin for SketchUP 397
.

Import raster images 191 to display them in 3D.
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Import camera model parameters to the Table of camera models via copying and pasting 313
from Excel.

Export
Export 202 the 2D drawing into any of the following formats:*.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf (raster and vector), AutoCAD *.dxf, AutoCAD *.dwg, PLT (HPGL/2), CGM (Computer
Graphic Metafile), SWF (Adobe Flash).
Advanced export to AutoCAD formats. At exporting to AutoCAD DWG and DXF formats, cameras
and illuminators are exported as blocks. The most important parameters of cameras and
illuminators are recorded to the block attributes. VideoCAD layers, fonts and line types are
exported.
When you export a drawing with a background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers 329 or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing 204 in AutoCAD format as a background;
2. Import 199 AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
4. Export 202 the obtained drawing to AutoCAD format to work with it in AutoCAD.
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Export to DXF file 3D view areas and camera coverage taking into account lens distortion, spatial
resolution, and shading.
This feature allows the convenient scheme of work with combination of 3D BIM Software
(SketchUP) + VideoCAD.
1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with
the original layout in 3D.

Export images from the 3D World window to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
png. Size in pixels of the exported file can exceed the Windows screen size.
Export 3D images 286 from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.png.
Size in pixels of the exported file can exceed 378 the Windows screen size.
Export animated image models 286 with moving 3D models to animated gif. See an example of
animated monitor (file size about 4 Mb).
Export images from monitors 298 to *.bmp, *.jpg,*.gif,*.tif,*.png.
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Export images from monitors to animated monitor models 380 as html files, with moving 3D models,
taking into account frame rate of each camera.
Obtain the text report 200 with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
Get a report in PDF format 200 , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See example of PDF report.
Obtain the cable report 240 .
Copy the Camera list with most important parameters 336 to MS Excel, MS Word and other
software.

Get detailed adjustable table of all initial and calculated parameters of cameras in project. Print the
table or export it to *.txt, *.csv,*.rtf, *.xls, *.htm formats.
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Printing
Printing 207 the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
Printing image models from cameras 286 and monitors 298 .
Printing 3D images from the 3D World window.
Printing the Table of cameras and the Table of camera models 314 as a whole or by selected
fragments.

Database of camera models
Maintain database of camera models 304 , assign different models to cameras in project, compare
models with each other.
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VideoCAD will help you: spare the means and win tenders due to optimization of cameras' quantity in
projects and increase of their efficiency, reduce time expended and boost design quality, cut down
the amount of controversial situations with customers and accelerate their solution.
VideoCAD can be used for the prompt, but exact calculations of view area projections to draw on a
location plan when performing a graphical part of CCTV project. It can be also used to perform
scrupulous analysis complicated cases to choose the most suitable camera location and lens
parameters.
VideoCAD is employed by security firms, army, police, universities and security department of many
companies worldwide.
VideoCAD is effective for CCTV designer training 424 .
It is more than you need? See:
VideoCAD Lite 31 , Differences between VideoCAD 8 Professional and VideoCAD 8 Lite 53
VideoCAD Starter II 45 , Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II 74
VideoCAD Starter 49 , Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter 85
Differences between versions of VideoCAD
What is new in VideoCAD

89
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General information on VideoCAD 8 Lite
VideoCAD Lite is a basic version offers the most useful and easy-to-master tools for CCTV design.
If VideoCAD Professional 3 version seems too complicated or slow, try the Lite version! It does not
contain complex tools. At the same time VideoCAD Lite is a powerful tool, not a very restricted
version.
VideoCAD Lite is less demanding of computer resources because of absence of resource-intensive
tools. However, these tools when they are not needed, can be disabled 427 in version Professional
too.
VideoCAD 8 Lite is registered only by personal registration code. This code doesn't depend on
computer hardware (HID) or a dongle. This code is valid on any computer.
VideoCAD Lite purchased separately can be upgraded to more powerful Professional version.
VideoCAD Starter, VideoCAD Starter II Kit can be upgraded to VideoCAD Lite at discount price.
One license of VideoCAD 8 Lite purchased separately allows to use the program on two workplaces
nonsimultaneously (work and home computers) if both workplaces belong to one person.
VideoCAD 8 Lite demo allows to change lens focal length of cameras. Licenses of VideoCAD 8
Professional and VideoCAD 8 Lite allows free use of the demo versions for educational
purposes, for research, theses, writing articles, etc. non-profit activities.
Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

The main features of VideoCAD 8 Lite:
Calculations
Calculating geometric parameters 251 of camera view area in any camera position.

More accurate modeling cameras taking into account the size of active area of the image sensor in
dependence of the aspect ratio of the image sensor and the aspect ratio of the output image of the
camera.
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Calculate length 388 and electric parameters of cables 342 .

Working with 2D projections
Use 2D Graphics window with CAD interface 158 . Use a lot of 2D/3D constructions and CAD tools,
line types, font types, snaps 194 , horizontal and vertical projections, up to 10 layouts in each
project.
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Display on the 2D layout results of calculations of view area projections.
Display by separate colors and hatch styles different regions of spatial resolution 170 and field-ofview size. There are prepared spatial resolution patterns according to the following criteria: Home
Office Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

33

34

VideoCAD Lite

Construct the horizontal projection of camera control areas including shadows 172 from obstacles
on the scene. In VideoCAD Lite obstacles can be constructions only. In VideoCAD Professional
3 3D models also can be obstacles.

Choose the best positions and calculate control areas of PTZ cameras 384 , Dome cameras and 360
degree cameras.
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Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras 409 (fisheye, 360°/180°).

3D modeling layout and camera view areas
3D visualization of the location plan and camera view areas in the 3D Video 284 window by other
cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view areas from
the side.
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Possibility of loading prepared 3D models 229 (a person, a car, etc., ). You can add your own 3D
models from 3ds max and Sketchup 397 .

In special 3D models 291 window you can create 3D model projections with specified resolution.
You can load 3D models from files, save 3D models to files, create copies of 3D models
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Modeling images from cameras based on camera parameters and scene
conditions
Model camera parameters: number of pixels and compression.

Simulation of image resolution and view area limits of panoramic cameras 269 (fisheye, 360°/180°).
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Obtain Image Model 284 for each camera in the project based on models of scene and equipment.

Design operator interface
Design operator interface using the Monitor window 294 .

Modeling size and resolution 297 of monitors.
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Import from other CAD programs
Locate cameras and cables on the prepared layouts 204 in *.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf. AutoCAD *.dxf *.dwg formats.
For backgrounds in AutoCAD *.dxf *.dwg formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.

Import 3D models of objects and 3D models of territory 399 using VideoCAD plugin for SketchUP 397
.
Import raster images 191 to display them in 3D.

Import camera model parameters to the Table of camera models via copying and pasting 313
from Excel.
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Export
Export 202 the 2D drawing into any of the following formats:*.bmp, *.jpg, *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf (raster), AutoCAD *.dxf.
Export 3D images 286 from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.png.
Export images from monitors 298 to *.bmp, *.jpg,*.gif,*.tif,*.png.
Obtain the text report 200 with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
Get a report in PDF format 200 , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See example of PDF report.
Obtain the cable report 240 .
Copy the Camera list with most important parameters 336 to MS Excel, MS Word and other
software.

Printing
Printing 207 the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
Printing image models from cameras 286 and monitors 298 .
Printing the Table of camera models 314 as a whole or by selected fragments.

Database of camera models
Maintain database of camera models 304 with the most important parameters (22 fields for each
camera model). You can add your models, assign different models to cameras in project, compare
models with each other.
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Download VideoCAD 8_Lite demo version
Need more? See: VideoCAD Professional
and VideoCAD 8 Lite 53

3

, Differences between VideoCAD 8 Professional

It is more than you need? See:
VideoCAD Starter II 45 , Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II
74

VideoCAD Starter

49

, Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter

Differences between versions of VideoCAD
What is new in VideoCAD

89

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

53

85

Part

III
General information on
VideoCAD 7 Starter II

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

General information on VideoCAD 7 Starter II

3

45

General information on VideoCAD 7 Starter II
VideoCAD Starter II - advanced version of VideoCAD Starter

49

.

VideoCAD Starter II differs from the Starter version by presence of additional features
available in the Lite and Professional versions only.

45

formerly

VideoCAD Starter II is registered only by personal registration code. This code doesn't depend on
computer hardware (HID) or a dongle. This code is valid on any computer.
VideoCAD Starter II is offered only in a kit of three programs - VideoCAD Starter II Kit. This Kit
includes:
VideoCAD Starter II;
IP Camera CCTV Calculator;
VideoCAD Plugin for SketchUp.
VideoCAD Starter II can be upgraded to more powerful Lite 31 and Professional 3 versions. You
can also upgrade from version VideoCAD Starter 49 to VideoCAD Starter II Kit. To get this upgrade
you should purchase VideoCAD Plugin for SketchUp and IP Camera CCTV Calculator if you have not
purchased them yet.

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

With VideoCAD 7 Starter II you can:
Choose the most suitable lenses, heights and locations for camera installation to provide the
required parameters of view areas.
Calculate the horizontal projection sizes of view areas to draw them on the location plan.
Display by separate colors different regions of spatial resolution 170 and field-of-view size.
Choose visually a relative location of cameras using the graphics window 158 with CAD interface.
Locate cameras on the prepared layouts 204 in *.bmp, *.jpg, AutoCAD *.dxf *.dwg formats.
Obtain a drawing 202 containing horizontal projection of site layout with the camera images,
calculated view areas, and with coordinate grid to be used in graphical path of the project.
Export 202 the obtained drawing into any of the following formats: *.bmp, *.jpg. Saving the drawing
202 in the Graphics windows with resolution exceeding Windows screen resolution.
Copy the Camera list with most important parameters 336 to MS Excel, MS Word and other
software.
Construct three dimensional models 284 of real scenes.
Use many 3D models 190 (people, cars, bus, furniture, turnstile, tree, grass). You can add other 3D
models from 3ds max and Sketchup 397 .
Spare the means and win tenders due to the reduction of cameras' quantity in projects
and increase of their efficiency.
Reduce time expended and boost design quality.
Cut down the amount of controversial situations with customers and accelerate their
solution.
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Download VideoCAD Starter II demo version
Need more? See:
VideoCAD Lite 31 , Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II 74
VideoCAD Professional 3 , Differences between VideoCAD 8 Professional and VideoCAD 8
Lite 53
It is more than you need? See: VideoCAD Starter
II and VideoCAD 7 Starter 85
Differences between versions of VideoCAD
What is new in VideoCAD

49

, Differences between VideoCAD 7 Starter

53

89
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General information on VideoCAD 7 Starter
VideoCAD Starter - the easiest, low cost version of VideoCAD.
VideoCAD Starter is less demanding of computer resources because of absence of resourceintensive tools.
VideoCAD Starter is registered only by personal registration code. This code doesn't depend on
computer hardware or a dongle. This code is valid on any computer.
VideoCAD Starter can be upgraded to more powerful Lite 31 and Professional 3 versions. You can
also upgrade from version VideoCAD Starter to VideoCAD Starter II Kit 45 To get this upgrade you
should purchase VideoCAD Plugin for SketchUp and IP Camera CCTV Calculator if you have not
purchased them yet.

Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

With VideoCAD 7 Starter you can:
Choose the most suitable lenses, heights and locations for camera installation to provide the
required parameters of view areas.
Calculate the horizontal projection sizes of view areas to draw them on the location plan.
Display by separate colors different regions of spatial resolution 170 and field-of-view size.
Choose visually a relative location of cameras using the graphics window 158 with CAD interface.
Locate cameras on the prepared layouts 204 in *.bmp, *.jpg formats.
Obtain a drawing 202 containing horizontal projection of site layout with the camera images,
calculated view areas, and with coordinate grid to be used in graphical path of the project.
Export 202 the obtained drawing into any of the following formats: *.bmp, *.jpg.
Copy the Camera list with most important parameters 336 to MS Excel, MS Word and other
software.
Construct three dimensional models 284 of real scenes with the possibility of loading prepared 3D
models 229 (a person, a car).
Spare the means and win tenders due to the reduction of cameras' quantity in projects
and increase of their efficiency.
Reduce time expended and boost design quality.
Cut down the amount of controversial situations with customers and accelerate their
solution.
Download VideoCAD7 Starter demo version
Need more? See:
VideoCAD Starter II

45

, Differences between VideoCAD 7 Starter II and VideoCAD 7 Starter

85

VideoCAD Lite 31 , Differences between VideoCAD 8 Lite and VideoCAD 7 Starter II 74
VideoCAD Professional 3 , Differences between VideoCAD 8 Professional and VideoCAD 8
Lite 53

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

50

VideoCAD Lite

Differences between versions of VideoCAD
What is new in VideoCAD

89

What is new in VideoCAD

89
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Differences between versions of VideoCAD
Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site

Differences between VideoCAD 8 Professional

3

and VideoCAD 8 Lite

31

Calculations
Calculating horizontal projection sizes of person detection, identification and license plate reading
areas.

Calculating Depth of Field of each camera of the project.

Calculating the image size on display of any object in camera view area in percentage of display
size, pixels and millimetres (inches in case of Imperial format).
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Calculate light power and illumination produced by illuminators.

Working with 2D projections
Graphical editing state of the Active camera 162 . In this case the objects in the horizontal
projection rotate so that the direction of the camera lens main optical axis becomes parallel to a
screen plane, and the bounds of active camera view area are marked with lines of double
thickness. The graphical editing state enables a detailed analysis of view area using the test
object, in the vertical projection it becomes possible graphical calculation of depth of field,
spatial resolution analysis and field-of-view sizing 166 at any point of view area. In the graphical
editing state the Test object is visible in the 3D Video 284 .
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Ability to display horizontal projection of the view area as two sections 169 by planes on the
minimum and maximum heights of the view area (Camera 23). One of the sections is drawn by a
transparent filling, the other in the form of hatching. In many camera positions such representation
is more informative than standard volume projection (Camera 22).
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Constructions, 3D models and cameras can be distributed by layers. Each layer can have its own
Base height. All constructions belong to the layer will be shifted in 3D by the Base height. This
feature is useful in work with multilevel 3D constructions. In addition to the Base height, each layer
has the following parameters: Active, Enabled, Visible, Hidden, Snap, Shadows, 3D Visible, Color.

Display on the 2D layout results of calculations 3 : person detection and identification areas, depth
of field limits, test object, cables and luminaries.
Construct the horizontal projection of camera control areas including shadows 172 from obstacles
on the scene. In VideoCAD Lite obstacles can be constructions only. In VideoCAD Professional
3 3D models also can be obstacles.
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Modeling camera rotation 255 around the main optical axis.

Modeling lens distortion 429 . Modeling influence of the lens distortion on view area shape, on view
area projection shape and spatial resolution distribution.Correct modeling wide-angle lenses with
strong distortion.

An option for drawing regions of spatial resolution in the Graphics windows in ascending
resolution - High resolution on top 199 . With this option enabled all cameras remain visible despite
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the shading of projections of different cameras. While regions with higher spatial resolution are
drawn on the top.

Usual drawing

High resolution on top

3D modeling layout and camera view areas
VideoCAD Professional has special 3D World window with standard tools for 3D navigation (Orbit,
Move, ZOOM, Walk, Look around, Zoom frame). With the help of the window you can observe
the layout in 3D representation. You can work on the project in usual 2D projections and watch it in
3D. You can "walk" on the floors of 3D models of buildings and study every detail.
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3D visualization of the camera view area surface taking into account spatial resolution, shadows,
lens distortion.

3D visualization of the active camera coverage on the environment taking into account spatial
resolution, shadows, lens distortion.
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3D visualization of control areas of PTZ cameras 384 , Dome cameras and 360 degree cameras.

Visualization of camera coverage area and spatial resolution distribution on the surrounding objects
of panoramic cameras 409 (fisheye, 360°/180°).
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Free cutting 3D layout by six planes to provide access to any point of complex 3D buildings.

Working with multilevel 398 3D layouts and terrains with complicated vertical structure.
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Possibility of using 3D models-territories 398 , to place inside them cameras, constructions and
other 3D models.

The Base height 255 in the camera geometry parameters. All heights related to a camera (height of
installation, heights of the lower and upper bounds of view area, heights of person detection,
identification, license plate reading areas) counted from the base height. The Base height together
with layers is used in work with multilevel 3D constructions.

More capabilities of the 3D models 291 window. In the window you can create 3D model
projections with specified brightness, create projection in the form of faces, points and lines.
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Ability to make projections in the form of sections of 3D models at the specified range of heights.
These projections of 3D models of buildings can be used as background for placing cameras in
the Graphics window.
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Ability to create 3D model projections with exceeding Windows screen resolution.
Possibility to create a projection of individual area of 3D model with even higher resolution using
PiP (Picture in Picture) tool.
To use the 3D models as territories, and their projections as a background, a new ability to block
the projection of certain 3D models from selection by mouse click was added.
Ability to consider a 3D model as obstacle in the calculation of shadows.
In the 3D Models window you can also 292 earn 3D models using 3D interface similar to the 3D
World window.
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Modeling images from cameras based on camera parameters and scene
conditions
Modeling observed scene parameters (illumination, visibility limitations).

Model luminaires considering spectrum of radiation and spectral sensitivity of image sensors,
including discharge lamps with complex spectrum and infrared LED illuminators.
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Model camera parameters (spectral response, number of pixels, resolution, minimum illumination
at known signal/noise ratio, IRE and aperture, maximum signal/noise ratio, electronic shutter,
AGC, BLC, gamma, day/night cameras,frame rate, interlace scan, global shutter and rolling shutter
).
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Model lens parameters (aperture, auto iris DC and Video Drive, resolution).

Visually control modeled resolution with the help of the Test chart
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Model images from megapixel cameras 378 with number of pixels exceeds Windows screen
number of pixels (Up to 100 megapixel and more!) with PiP (Picture in Picture) and without PiP.

See examples: 5 megapixels,10 megapixels, 25 megapixels.
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Calculate and model depth of field of each camera in project.

Model brightness, contrast, horizontal and vertical sharpness.
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Model moving objects 166 , camera frame rate 379 , create animated images with moving 3D models.

Model blur and distortion 385 of moving 3D models depending on camera parameters (exposure
time, interlacing, rolling shutter).
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Modeling images taking into account lens distortion 429 (barrel and pincushion). Correct modeling
wide-angle lenses with strong distortion.

Design operator interface
Create animated monitor models 380 as html files with moving 3D models and different frame rates
of each camera. See an example of animated monitor (file size about 4 Mb).

Import from other CAD programs
Import constructions 199 from a 2D background in AutoCAD formats to 3D VideoCAD constructions
automatically. Use of this tool allows to reduce efforts of outlining background to convert it to 3D
constructions.

Export
Export 202 the 2D drawing into any of the following formats: *.pdf (vector), AutoCAD *.dwg, PLT
(HPGL/2), CGM (Computer Graphic Metafile), SWF (Adobe Flash).
Advanced export to AutoCAD formats. At exporting to AutoCAD DWG and DXF formats, cameras
and illuminators are exported as blocks. The most important parameters of cameras and
illuminators are recorded to the block attributes. VideoCAD layers, fonts and line types are
exported.
When you export a drawing with a background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers 329 or the background can be
added as an external links to the file of the background. In both cases the structure of the
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background is saved.
Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing 204 in AutoCAD format as a background;
2. Import 199 AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
4. Export 202 the obtained drawing to AutoCAD format to work with it in AutoCAD.

Export to DXF file 3D view areas and camera coverage taking into account lens distortion, spatial
resolution, and shading.
This feature allows the convenient scheme of work with combination of 3D BIM Software
(SketchUP) + VideoCAD.
1. Export layout as a 3D model-territory through SketchUP and loading it into VideoCAD.
2. Adding cameras with 3D view areas in VideoCAD.
3. Export 3D view areas in DXF format, loading them into 3D BIM Software and combining with
the original layout in 3D.

Export images from the 3D World window to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
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png. Size in pixels of the exported file can exceed the Windows screen size.
During export 3D images 286 from cameras to any of the following formats: *.bmp, *.jpg,*.gif,*.tif,*.
png, size in pixels of the exported file can exceed 378 the Windows screen size.
Export animated image models 286 with moving 3D models to animated gif. See an example of
animated monitor (file size about 4 Mb).
Export images from monitors to animated monitor models 380 as html files, with moving 3D models,
taking into account frame rate of each camera.
Get detailed adjustable table of all initial and calculated parameters of cameras in project. Print the
table or export it to *.txt, *.csv,*.rtf, *.xls, *.htm formats.

Printing
Printing 3D images from the 3D World window.
Printing the Table of cameras as a whole or by selected fragments.

Database of camera models
Maintain database of camera models 304 with extended parameters (up to 117 camera parameters),
assign different models to cameras in project, compare models with each other.
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Registration
VideoCAD 8 Professional is registered with USB dongle. All other VideoCAD versions are
registered only by personal registration code. This code doesn't depend on computer hardware or a
dongle. This code is valid on any computer.
You can install VideoCAD 8.2 Professional on many computers, but launch on one computer with
dongle connected. One license of VideoCAD 8 Lite, purchased separately, allows to use the
program on two workplaces nonsimultaneously (work and home computers) if both workplaces
belong to one person - owner of the license.

Demo version
You can't change lens focal length, lens aperture, image sensor format, aspect ratio and light
sensitivity in the demo-version of VideoCAD Professional. You may install the demo-version of
VideoCAD Professional to test and evaluate it for 30 days; after this time you must either buy the
license to use the VideoCAD Professional permanently or delete the demo version from your hard
drive.
In the demo version of VideoCAD 8 Lite changing lens focal length and image sensor is allowed.
Instead of this, saving working project to a file is prohibited and there is a limit on the maximum
number of cameras (5) in one project.

Differences between VideoCAD 8 Lite

31

and VideoCAD Starter II

45

Calculations
More accurate modeling cameras taking into account size of active area of the image sensor in
dependence of the aspect ratio of the image sensor and the aspect ratio of the output image of the
camera. Model cameras with non standard image sensor size 267 and aspect ratio.
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Calculate length 388 and electric parameters of cables 342 .

Working with 2D projections
Use more than 30 additional constructions and CAD tools (Point, Horizontal line, Vertical line,
Line segment, Angle, Double line, Arc, Mask, Filling, Text, 3D image, Inclined rectangle, Change
installation height, Change view area upper bound, Change view area lower bound, Copy with base
point, Cut with base point, Scale, Mirror, Change line type, Hide camera names, Cameras over
constructions, Bring to front, Send to back, Hide, Align, Combine in block, Destroy block, Find
text, Hidden state of objects, Numerate cameras, Length calculation of line segments,Merge
contour, High resolution on top).

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

76

VideoCAD Lite

Work with vertical projection 176 of the site plan.
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More convenience in editing on the layout 3D models, Rectangle, Wall, Aperture in wall, Stairs,
Mask, Filling, 3D Image. You can scale them and rotate around its axis using the square grips and
pink circle.

Use Titles 216 and texts 189 on the drawing. Different fonts 322 are supported.
Use up to 10 layouts 242 in each project.
Use up to 30 spatial resolution patterns 272 in each project. Each pattern can contain up to 10
regions. Adjust object height 276 in the patterns, height of measuring spatial resolution 275 ,
direction (horizontal or vertical) of measuring spatial resolution. The Spatial resolution box contains
models of field-of-view images 277 for each region in current pattern.
There are prepared spatial resolution patterns according to the following criteria: Home Office
Scientific Development Branch; Home Office Guidelines for identification; P 78.36.008-99,
Australian Standard AS4806: Closed Circuit Television, European Standard EN50132-7, ISO/IEC
19794 Biometric data interchange formats.

Use gradient color and hatching for visualization of spatial resolution.
Show view area projections by different colors and hatch styles, using different line types.
Use different camera icons ( fixed, PTZ, outdoor..).
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

78

VideoCAD Lite

Construct the horizontal projection of camera control areas including shadows 172 from obstacles
on the scene. In VideoCAD Lite obstacles can be constructions only. In VideoCAD Professional
3 3D models also can be obstacles.

Choose the best positions and calculate control areas of PTZ cameras 384 , Dome cameras and 360
degree cameras.
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Simulation of the horizontal projection of the view area and visualization of the spatial resolution
distribution of panoramic cameras 409 (fisheye, 360°/180°).

Adjust keyboard shortcuts 324 for each item in the Main menu.
Adjust visibility 332 of buttons on the Toolbar.

3D modeling layout and camera view areas
3D visualization of the location plan and camera view areas in the 3D Video 284 window by other
cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view areas from
the side.
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In special 3D models 291 window you can create 3D model projections with specified resolution.
You can load 3D models from files, save 3D models to files, create copies of 3D models

Support of 3D models with textures, transparent texture and opacity of materials. New version of
VideoCAD Plugin for SketchUP with possibilities of export textures, transparent textures,
opacity of materials and scaling.
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Modeling images from cameras based on camera parameters and scene
conditions
Simulation of image resolution and view area limits of panoramic cameras 269 (fisheye, 360°/180°).

Obtain Image Model 284 for each camera in the project based on models of scene and equipment.

Design operator interface
Design operator interface using the Monitor window 294 .
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Modeling size and resolution 297 of monitors.

Import from other CAD programs
Locate cameras and cables on the prepared layouts 204 in formats *.emf, *.wmf, *.png, *.gif, *.
tif, *.pdf. Upgraded AutoCAD import modules can read much more CAD files.
For backgrounds in AutoCAD *.dxf *.dwg formats you can choose Layout in the background,
control visibility of layers, hide texts. For backgrounds in PDF format you can choose page and
resolution of the background.
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Import raster images 191 to display them in 3D.

Import camera model parameters to the Table of camera models via copying and pasting 313
from Excel.

Export
Export 202 the 2D drawing into any of the following formats: *.emf, *.wmf, *.png, *.gif, *.tif, *.pdf
(raster), AutoCAD *.dxf.
Export images from monitors 298 to *.bmp, *.jpg,*.gif,*.tif,*.png.
Obtain the text report 200 with full description of all cameras in the project, view areas and cables to
be pasted into a project explanatory note or used as instruction for installation.
Get a report in PDF format 200 , with full description of all cameras in the project, view areas and
cables. The PDF Report can include images from the cameras, fragments of layouts with camera
placed, a cover with logo. Report parameters and the structure of information in the report is
configurable. See example of PDF report.
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Obtain the cable report 240 .

Printing
Printing 207 the obtained 2D drawing in raster or vector mode on one or several pages for pasting
together. You can use prepared frames with standard title-block and logo. Sizes, colors styles of
fonts and lines, weights of lines can be adjusted.
Printing image models from cameras 286 and monitors 298 .
Printing the Table of camera models 314 as a whole or by selected fragments.

Database of camera models
Maintain database of camera models 304 with the most important parameters (22 fields 22 fields for
each camera model). You can add your models, assign different models to cameras in project,
compare models with each other.

Registration
One license of VideoCAD Starter II allows to use VideoCAD Starter II on one computer. One
license of VideoCAD 8 Lite, purchased separately, allows to use the program on two workplaces
nonsimultaneously (work and home computers) if both workplaces belong to one person - owner of
the license.

Package contents
VideoCAD Starter II is offered only in a kit of three programs - VideoCAD Starter II Kit. This Kit
includes:
VideoCAD Starter II;
IP Camera CCTV Calculator;
VideoCAD Plugin for SketchUp.
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Demo version
In the demo version of VideoCAD 8 Lite there is a limit on the maximum number of cameras (5) in
one project.
License of VideoCAD 8 Lite allows free use of the demo version for educational purposes, for
research, theses, writing articles, etc. non-profit activities.

Differences between VideoCAD 7 Starter II

45

and VideoCAD 7 Starter

49

Possibility of using 3D models 190 from version Lite (people, trees, cars etc.).
Possibility of import 3D models and scenes from SketchUp and Autodesk 3ds MAX; VideoCAD
Plugin for Sk etchUp is included in the VideoCAD Starter II Kit.
Loading background 204 in AutoCAD *.dxf and *.dwg formats.
Saving the drawing 202 in the Graphics windows with resolution exceeding Windows screen
resolution.
Additional constructions and CAD tools: Rotakin 192 (without modeling rotation), Copy 180 and
Paste 180 constructions and cameras.
Modeling number of pixels 287 and JPEG compression 286 in the 3D window.
Displaying examples of images 278 in the Spatial resolution box (resolution only).
Modeling cameras with any image sensor sizes and aspect ratio.
Modeling images from cameras turned by 90 degrees 257 .
VideoCAD Starter II is offered only in a k it of three programs - VideoCAD Starter II Kit. This Kit
includes:
VideoCAD Starter II;
IP Camera CCTV Calculator;
VideoCAD Plugin for Sk etchUp.

Download VideoCAD 8 Professional demo version
Download VideoCAD 8_Lite demo version
Download VideoCAD 7 Starter II demo version
Download VideoCAD 7 Starter demo version
What is new in VideoCAD

89
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What is new in VideoCAD
Information in the Help file can be outdated. Please see actual information on the cctvcad.
com web site
What is new in VideoCAD 8.2 Lite

89

(April 2016)

What is new in VideoCAD 8.1 101 (18 May 2015)
What is new in VideoCAD 8.0 103 (September 2014)
What is new in VideoCAD 7.0 123 (March 2011)
What is new in VideoCAD 6.1 132 (October 2008)
What is new in VideoCAD 6.0 133 (October 2007)
What is new in VideoCAD 5.0 138 (April 2006)
What is new in VideoCAD 4.0 140 (April 2005)
What is new in VideoCAD 3.0 142 (June 2004)

8.L. What is new in VideoCAD 8.2 Lite
New features of VideoCAD 8 Lite have been chosen from features, available in VideoCAD 8
Professional. In addition: The registration rules 100 have been simplified, Functional and license
restrictions of the demo version 100 have been reduced, Upgrade 100 from VideoCAD Starter 49
and VideoCAD Starter II Kit 45 to VideoCAD Lite 31 and VideoCAD Professional 3 has been
allowed.

MORE PRECISE MODELING IMAGE SENSOR SIZES AND ASPECT RATIO OF MODERN
CAMERAS
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8L.1 The following parameters have been separated:
image sensor size and size of active area of the image sensor;
aspect ratio of image sensor and aspect ratio of output image of the camera.
8L.2 The Image sensor format box has been renamed to the Image sensor size 255 .
8L.3 New abilities to specify the size of image sensor 267 through arbitrary sensor format (type) in
inches or through the length of diagonal in millimeters, or through width and height in millimeters.
8L.4 New ability to set aspect ratio of image sensor separately from the aspect ratio of output
image for a given format in inches or length of diagonal of the image sensor.
8L.5 New ability to set the Crop factor 420 to model image sensors with active area does not
touch the edges of the image sensor.
8L.6 Detailed guide 415 of specifying the active area size of image sensors of modern cameras
has been added.
8L.7 The Sensor and Distortion box has been renamed to Sensor and Lens 267 . Its interface
has been changed.
8L.8 The Image sensor calculator 349 was added.
IMPROVING USABILITY OF WORKING WITH 3D MODELS AND CONSTRUCTIONS IN
EDITING STATE
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8L.9 Switching 3D models 190 from the selected state 161 to the editing state 161 by double
clicking on its projections was added (previously it was possible to switch a 3D model to the
editing state only from the normal state 160 ).
8L.10 In the editing state 161 , 3D models 190 are displayed with square grips and pink circle.
You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.

8L.11 In the 3D Video 284 views of 3D models in editing state and in the selected state differ.

8L.12 New possibility to rotate around its axis in editing state Rectangle, Wall, Aperture in wall,
Stairs, Mask, Filling, 3D Image.
MODELING VIEW AREA AND CAMERA POSITION
8L.13 The Style of line type 320 assigned to a
camera determines not only style of lines, but
hatching style of view area projection.
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8L.14 The Maximum distance 265 of drawing view area is added to the camera geometry
parameters. This distance limits view area in 2D and 3D drawings. It is convenient in case of
infinite view areas.
8L.15 The ground is no longer the lowest possible height limiting view area. Height of installation,
heights of the lower and upper bounds of view area can be negative. A camera can see from under
the ground and under the ground.

8L.16 Constructing the horizontal projection of camera control areas including shadows 172 from
obstacles on the scene. In VideoCAD Lite obstacles can be constructions only. In VideoCAD
Professional 3 3D models also can be obstacles.

8L.17 Choosing the best positions and calculate control areas of PTZ cameras 384 , Dome
cameras and 360 degree cameras.
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MODELING PANORAMIC CAMERAS (FISHEYE, 360°/180°)
8L.18 Simulation of image resolution and view area limits of panoramic cameras 409 in the 3D
Video.

8L.19 Model spatial resolution of panoramic cameras in the 3D Video window.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

93

94

VideoCAD Lite

8L.20 Simulation of the horizontal projection of the view area and visualization of the spatial
resolution distribution of panoramic cameras 269 in the Graphics window.

8L.21 New icons 336 for panoramic cameras were added
8L.22 In the Sensor and Lens 267 box a new
Panoramic panel was added. On the panel the
Pan and Tilt angles of panoramic camera
installation can be specified.

and

.

8L.23 To the list of camera model parameters 315 : Type>Fixed, PTZ,Dome, Mini a new panoramic
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item was added,
8L.24 To the list of camera model parameters: Lens>Type a new fisheye item was added,
8L.25 Lens focal length boxes in the Graphics window and the Camera geometry box are colored

in Aqua when the active camera is panoramic.
.
8L.26 In reports 345 panoramic cameras have fisheye word instead of lens focal length value;
WORK WITH 3D MODELS
8L.27 Support of 3D models with textures, transparent texture and opacity of materials.
8L.28 New version of VideoCAD Plugin for
SketchUP was released with possibilities of
export textures, transparent textures, opacity
of materials and scaling.

8L.29 Import of new 3D models was simplified. The special 3D models 291 window was added for
creation of 3D model projections. In the window , you can create 3D model projections with
specified resolution. In the 3D Models window you can also 292 : save 3D model to a file, make
copy of the 3D model.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

96

VideoCAD Lite

8L.30 Tools related to 3D models were moved to special branch 229 of the main menu.
8L.31 Ability to distribute 293 3D models by folders in the menu.
8L.32 Loading 231 files of 3D models via a dialog box.
8L.33 3D model file name can contain spaces.
8L.34 During placing or editing 3D models, on the Current construction parameter panel 248 the
3D Models button
appears to quick open the 3D Models window 291 .
3D VIDEO WINDOW
8L.35 A window, which shows models of camera images, named 3D Window in the past, was
renamed to the 3D Video 284 window.
8L.36 3D visualization of the location plan and camera view areas in the 3D Video 284 window by
other cameras. Visualization of the spatial resolution. Flexible adjustment of displaying view
areas from the side.
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8L.37 In the main menu of the 3D Video window, in View submenu, a new 3D view areas 288 item
was added. It allows to enable visualization of view areas of other cameras.
8L.38 In the main menu of the 3D Video window, in View submenu, a duplicating Ground 288
item was added for quick hiding the ground surface in the 3D Video window.
8L.39 In the main menu of the 3D Video window, in Image submenu, a new Copy to clipboard 286
item was added.
8L.40 In the PTZH mode a camera is panned and tilted by moving mouse cursor on the image
with left mouse button pressed..
8L.41 Background representation in the 3D Video window was improved.
8L.42 Ability to switch 326 image generation thread: in separated thread or in the main thread.
SPATIAL RESOLUTION
8L.43 Ability to specify spatial resolution in
spatial resolution patterns not only vertically
but also horizontally. To do this, a new switch
275 to the Spatial resolution box was added.
8L.44 Numbers of pixels horizontally and vertically can be specified.
8L.45 Additional Spatial resolution patterns 274 were added based on the Standards:
Australian Standard AS4806: Closed Circuit Television;
European Standard EN50132-7;
ISO/IEC 19794 Biometric data interchange formats.
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8L.46 As a result of right-click on the Pattern 274 combo box a pop up menu will appear.
Selecting the Default patterns item, you can erase all changes in the patterns and return to the
patterns set by default.
8L.47 To the Spatial resolution box 278 new
test images were added.

IMPORT AND EXPORT TO AUTOCAD
8L.48 Import module was upgraded. Up to AutoCAD DWG 2015 formats are supported.
8L.49 The dialog box Scale background was renamed to the Adjust background 205 . For
backgrounds in DWG or DXF formats, abilities to choose Layout in the background, control
visibility of layers, hide texts were added. For backgrounds in PDF format you can choose page
and resolution of the background.
8L.50 Export module 329 was updated.
IMPORT AND EXPORT TO OTHER FORMATS
8L.51 Supporting PDF files to use as background 204 including multi-page PDF files.
8L.52 Export 202 to PDF (raster).
8L.53 Export 329 tab in the Options box is divided into two sub-tabs: "DXF" and "BMP,WMF,
EMF,GIF,TIFF,PNG,JPG,rPDF".
8L.54 To the options of export to BMP, JPG, EMF, WMF, GIF, TIFF, PNG, rPDF possibility to
set hatch step factor 330 was added.
8L.55 In the 3D Image 191 you can load images in BMP, JPG, PNG, GIF TIF (early BMP and
JPG). Transparency of PNG files is supported.
8L.56 New PDF report 200 was added. Unlike the Text report 200 , the PDF Report can include
images from the cameras, fragments of layouts with camera placed, a cover with logo. Report
parameters and the structure of information in the report is configurable. See example of PDF
report.
PRINTING
8L.57 New mode Use buffer 334 was added. Using this mode, you can get the correct results and
print transparent gradient fills, projections of 3D models even on printers do not support these
tools, including most of free virtual printer to print to PDF.
8L.58 New mode Scale Hatching 333 was added. Using this mode, you can get the correct
hatching even on printers do not support scaling hatching.
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8L.59 Menu item Print setup 207 remains enabled even VideoCAD can not get access to the
current printer.
DATABASE OF CAMERA MODELS
8L.60 Maintain database of camera models 304 with the most important parameters (22 fields for
each camera model). You can add your models, assign different models to cameras in project,
compare models with each other.

MISCELLANEOUS
8L.61 Ability to change the minimum and maximum heights of several objects at once through
changing their line type. If during changing the line type of selected objects by the Change line
type 237 tool, to press and hold Ctrl, then the selected objects will also change their minimum
and maximum height according to the chosen line type . If Ctrl is not pressed, the heights remain
unchanged.
8L.62 Autosaving 334 the project in specified intervals during running the program in a chain of
files (up to 100 copies of the project are saved and rewritten in the regular intervals around the
ring).
8L.63 Image update with lots of rotated projections of the 3D models was accelerated.
8L.64 New construction - Stairs 226 .
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8L.65 Added a possibility to draw legends 276
of Spatial resolution patterns on the layouts.

8L.66 New tool Merge contour 237 was added.
8L.67 New possibility to adjust transparence of filling view area projections 169 in the Graphics
window.
8L.68 A mode to improve visibility of thin lines 334 at scaling background in BMP, JPG, PDF
formats.
8L.69 The cursor coordinates in the lower left corner of the Graphics window are displayed
rounded to the second decimal place .
8L.70 The Export to Text 200 menu item was renamed to Text report.
8L.71 In the Text report 200 for each camera additional lines were added: layer, the base height ,
angle of rotation around its axis, number of pixels.
8L.72 Child windows "sticks" to the screen edges.
8L.73 An option of changing registration code 241 via the Main menu was added.
8L.74 Titles of the 3D video window includes camera resolution in pixels.
8L.75 Detected bugs were fixed.
8L.76 The Help system was updated.
8L.77 Examples of work with VideoCAD 353 in the Help were updated according to the new
features. Several new examples were added.
8L.78 Project format of VideoCAD7 - *.vc7 is supported. There are possibilities of export 199 and
import 199 of the previous project format *.vmp, supported by versions from 4 to 6.
8L.79 The program was tested under Windows 8 and Windows 10.
SIMPLIFYING REGISTRATION RULE
8L.80 VideoCAD 8 Lite is registered only by personal registration code as well as
VideoCAD Starter. This code doesn't depend on computer hardware or a dongle. This code
is valid on any computer.
8L.81 One license of VideoCAD 8 Lite, purchased separately, allows the use of the program on
two workplaces nonsimultaneously: work and home computers if both workplaces belong to one
person.
CHANGING DEMO VERSION RESTRICTIONS
8L.82 In the demo version of VideoCAD 8 Lite changing lens focal length and image sensor is
now allowed. Instead of this, saving working project to a file is prohibited and a limit on the
maximum number of cameras (5) in one project is added.
8L.83 Licenses of VideoCAD 8 Professional and VideoCAD 8 Lite allows free use of the
demo versions for educational purposes, for research, theses, writing articles, etc. non-profit
activities.
RULES OF UPGRADE
8L.84 The Rules of upgrade from previous VideoCAD versions to VideoCAD 8 Lite:
For the customers who have purchased VideoCAD Lite (or upgraded to VideoCAD Lite) after 01
January 2016 upgrade to VideoCAD 8 Lite is free.
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For the customers who have purchased VideoCAD Lite (or upgraded to VideoCAD Lite)
before 01 January 2016 updating cost makes half of the VideoCAD 8 Lite cost.
For the customers who has VideoCAD3..VideoCAD6 and didn't upgrade to VideoCAD 7 Lite,
updating cost makes 3/4 of VideoCAD 8 Lite cost.
For the customers, whose original valuable suggestions have found application in VideoCAD
8.0, the additional discount for upgrade is given.
Upgrade of VideoCAD plugin for SketchUP is free with upgrade to VideoCAD 8 Lite.

8.1. What is new in VideoCAD 8.1
MODELING IMAGE SENSOR SIZES AND ASPECT RATIO OF MODERN CAMERAS
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8.1.1 The following parameters have been separated:
image sensor size and size of active area of the image sensor;
aspect ratio of image sensor and aspect ratio of output image of the camera.
8.1.2 The Image sensor format box has been renamed to the Image sensor size 255 .
8.1.3 New abilities to specify the size of image sensor 267 through arbitrary sensor format (type)
in inches or through the length of diagonal in millimeters, or through width and height in
millimeters.
8.1.4 New ability to set aspect ratio of image sensor separately from the aspect ratio of output
image for a given format in inches or length of diagonal of the image sensor.
8.1.5 New ability to set the Crop factor 420 to model image sensors with active area does not
touch the edges of the image sensor.
8.1.6 Detailed guide 415 of specifying the active area size of image sensors of modern cameras
has been added.
8.1.7 The Sensor and Distortion box has been renamed to Sensor and Lens 267 . Its interface
has been changed.
8.1.8 The Image sensor calculator 349 was added.
IMPROVING USABILITY OF WORKING WITH 3D MODELS AND CONSTRUCTIONS IN
EDITING STATE
8.1.9 Switching 3D models 190 from the selected state 161 to the editing state 161 by double
clicking on its projections was added (previously it was possible to switch a 3D model to the
editing state only from the normal state 160 ).
8.1.10 In the editing state 161 , 3D models 190 are displayed with square grips and pink circle.
You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.
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8.1.11 In the 3D World and 3D Video 284 views of 3D models in editing state and in the selected
state differ.

8.1.12 New possibility to rotate around its axis in editing state Rectangle, Wall, Aperture in wall,
Stairs, Mask, Filling, 3D Image.
OTHER
8.1.13 Import and export modules of AutoCAD were upgraded. Some improvements were added.
8.1.14 An inaccuracy of snap 194 operation during construction of walls and aperture in wall has
been fixed.
8.1.15 New tool Merge contour 237 .
8.1.16 Printing on some virtual PDF printers has been improved.
RULES OF UPGRADE
8.1.17 Upgrade from VideoCAD 8.0 is offered free-of-charge. Upgrade from earlier versions is
performed according to rules 89 of upgrade up to VideoCAD 8.0

8. What is new in VideoCAD 8.0
MODELING VIEW AREA AND CAMERA POSITION
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8.1 Ability to display horizontal projection of
the view area as two sections 169 by planes on
the minimum and maximum heights of the view
area (Camera 23). One of the sections is
drawn by a transparent filling, the other in the
form of hatching. In many camera positions
such representation is more informative than
standard volume projection (Camera 22).

8.2 When the projection of the view area is displayed as two sections 173 by horizontal planes
located at height of lower 259 and upper 258 bounds, the shading from obstacles appears as
shadows from objects on these planes.
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8.3 When visualizing spatial resolution with two
levels, lower section is not at the view area
lower bound but at the height of measuring
spatial resolution 275 , determined in the spatial
resolution pattern 274 assigned to the camera.
Spatial resolution is rendered on this level.
8.4 If the height 275 of measuring spatial
resolution is set to AUTO, then:
if the view area projection bounds 168 is set
to 2 Levels, the height of measuring spatial
resolution is set at the view area lower bound
259 ;
if the view area projection bounds is set
to Projection, the height of measuring
spatial resolution is set at the halfway
between the lower and upper 258 bounds of
the view area ( as in previous versions ).
8.5 Simulation of camera rotation 255 around the main optical axis. Even a slight turn significantly
changes the view area projection.

8.6 The Style of line type 320 assigned to a
camera determines not only style of lines, but
hatching style of view area projection.
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8.7 The Maximum distance 265 of drawing view area is added to the camera geometry
parameters. This distance limits view area in 2D and 3D drawings. It is convenient in case of
infinite view areas.

8.8 The ground is no longer the lowest possible height limiting view area. Height of installation,
heights of the lower and upper bounds of view area can be negative. A camera can see from under
the ground and under the ground.

8.9 The Base height 255 is added to the camera geometry parameters. All heights related to a
camera (height of installation, heights of the lower and upper bounds of view area, heights of
person detection, identification, license plate reading areas) counted from the base height. The
Base height together with layers is used in work with multilevel 3D constructions.

MODELING LENS DISTORTION
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8.10 Simulating lens distortion 429 . Distortion is especially pronounced in the short-focus lenses
and may lead to significant deviation of form of view area of real cameras from regular pyramid.
8.11 Modeling the influence of lens distortion on a 3D image model (pincushion and barrel
distortion), the shape of the view area and its projections, on the distribution of spatial resolution.

8.12 Correct modeling wide-angle lenses with strong distortion.
8.13 The Special sensor size box was renamed to the Sensor and Distortion 267 .
8.14 The order of calculation in the Sensor and distortion box was changed. You can enter any
image sensor size, then from it the calculated view angles and the aspect ratio are calculated.
8.15 To the Sensor and distortion box a box with a calculated diagonal angle was added..
8.16 To the the Sensors and distortion box
new Distortion 267 panel was added. On the
panel you can specify Real view angles from
the camera and lens specifications. Distortion
is calculated from the ratio between the
calculated and real angles.

8.17 In the PTZH 287 mode, FOV frame is
drawn taking into account lens distortion.

8.18 The following camera model parameters were added: Distortion>ON 316 , horizontal,
vertical, diagonal real angles 316 .
8.19 Using PiP and Real frame size 286 for simulating real camera number of pixels with
distortion.
3D WORLD WINDOW
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8.20 New 3D World window with 3D navigation. There are the main tools for 3D navigation (Orbit,
Move, ZOOM, Walk, Look around, Zoom frame). In the window you can observe the layout in
3D representation. You can work on the project in usual 2D projections and watch it in 3D. You
can "walk" on the floors of 3D models of buildings and study every detail.
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8.21 3D visualization of the camera view
area surface taking into account spatial
resolution, shadows, lens distortion.

8.22 3D visualization of the active
camera coverage on the environment
taking into account spatial resolution,
shadows, lens distortion.

8.23 3D visualization of control areas of
PTZ cameras 384 , Dome cameras and
360 degree cameras.

8.24 Free cutting 3D layout by six planes to provide access to any point of complicated 3D
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buildings.

8.25 Export images from the 3D World window to any of the following formats: *.bmp, *.jpg,*.gif,*.
tif,*.png. Size in pixels of the exported file can exceed the Windows screen size.
8.26 3D camera view area and camera coverage constructed in the 3D World taking into account
distortion, spatial resolution and shading can be exported to a DXF file for insertion into a 3D
project processed in another 3D program. This important feature makes possible to use
VideoCAD to build 3D models of the view areas for designers working with any 3D design
software that support import DXF files, including SketchUP 400 .

MODELING PANORAMIC CAMERAS (FISHEYE, 360°/180°)
8.27 Simulation of image resolution and view area limits of panoramic cameras 409 in the 3D
Video.
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8.28 Simulation of the horizontal projection of the view area and visualization of the spatial
resolution distribution of panoramic cameras 269 in the Graphics window.

8.28 Visualization of camera coverage area and spatial resolution distribution of panoramic
cameras 409 on the surrounding objects in the 3D World window.
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8.30 New icons 336 for panoramic cameras were added
8.31 In the Sensor and Distortion 267 box a
new Panoramic panel was added. On the panel
the Pan and Tilt angles of panoramic camera
installation can be specified.

and

.

8.32To the list of camera model parameters 315 : Type>Fixed, PTZ,Dome, Mini a new panoramic
item was added,
8.33 To the list of camera model parameters: Lens>Type a new fisheye item was added,
8.34 Lens focal length boxes in the Graphics window and the Camera geometry box are colored

in Aqua when the active camera is panoramic.
.
8.35 In reports 345 panoramic cameras have fisheye word instead of lens focal length value;
LAYERS
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8.36 Constructions, 3D models and cameras
can be distributed by layers.
8.37 Each layer can have its own Base height.
All constructions belong to the layer will be
shifted in 3D by the Base height. This feature
is useful in work with multilevel 3D
constructions.
8.38 In addition to the Base height, each layer
has the following parameters: Active, Enabled,
Visible, Hidden, Snap, Shadows, 3D Visible,
Color.
8.39 To the main and pop-up menus of the
Graphics window the Move to Active layer 199
item was added to move constructions and
cameras between layers.

WORK WITH 3D MODELS
8.40 Possibility of using 3D models-territories
398 , to place inside them cameras,
constructions and other 3D models.
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8.41 Support of 3D models with textures,
transparent texture and opacity of materials.

8.42 New version of VideoCAD Plugin for
SketchUP was released with possibilities of
export textures, transparent textures, opacity
of materials and scaling.

8.43 Import of new 3D models was simplified. The special 3D models 291 window was added for
creation of 3D model projections. In the window , you can create 3D model projections with
specified resolution, brightness, create projection in the form of faces, points and lines.
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8.44 Ability to make projections in the form of sections of 3D models at the specified range of
heights. These projections of 3D models of buildings can be used as background for placing
cameras in the Graphics window.
8.45 Ability to create 3D model projections with exceeding Windows screen resolution.
8.46 Possibility to create a projection of individual area of 3D model with even higher resolution
using PiP (Picture in Picture) tool.
8.47 To use the 3D models as territories, and their projections as a background, a new ability to
block the projection of certain 3D models from selection by mouse click was added.
8.48 Ability to consider a 3D model as obstacle in the calculation of shadows.
8.49 In the 3D Models window you can also 292 : save 3D model to a file, make copy of a 3D
model, earn 3D models using 3D interface similar to the 3D World window.
8.50 Tools related to 3D models were moved
to special branch 229 of the main menu.
8.51 Ability to distribute 293 3D models by
folders in the menu.
8.52 Loading 231 files of 3D models via a dialog
box.
8.53 3D model file name can contain spaces.
8.54 During placing or editing 3D models, on
the Current construction parameter panel 248
the 3D Models button
appears to quick
open the 3D Models window 291 .
MODELING RESOLUTION OF CAMERAS AND LENSES
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8.55 Ability to obtain full-size 286 image models of cameras with number of pixel exceeding
Windows screen size, without using PiP. See examples of exported files: 5 megapixels,10
megapixels, 25 megapixels.
This feature can be useful to model real resolution model of images with distortion 429 .

8.56 Resolution modeling algorithms were reworked.
8.57 As an unit of measuring resolution instead of actually ambiguous TVL (TV lines), the Lines
per Picture Height (LPH) is used. For analog cameras the LPH is the same as "actual" TV
lines, ie the number of vertical lines fit within the part of picture width equals to the picture height.
8.58 Accuracy of modeling resolution in LPH was increased. When you set the image resolution
in LPH, you can also set the drop of contrast in %.
8.59 In modeling the camera resolution in LPH, it is possible to model as only horizontally
resolution (for analog cameras) as the resolution in both directions (for IP cameras).
8.60 The Test chart EIA1956 is tied to the frame height and saves equal aspect ratio regardless of
the aspect ratio of the simulated images that allows you to watch resolution of the simulated
images in LPH (lines per picture height) in any aspect ratios of the frame.
8.61 Size in pixels of the Test chart EIA1956 is increased twice.
8.62 Ability to display the Test chart EIA1956 in reduced-size (up to 64 times), what extends the
range of estimates resolution using the test chart up to 100 000 LPH.
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8.63 Simulating lens resolution in line pair
per millimeter at specified contrast drop by
MTF (10%, 20%, 30%, 50%).

8.64 The following camera model parameters were added: Rolling shutter>Up (scan direction)
316 ; Resolution>LPH 316 (lines per picture height); Resolution>Contrast % 316 ;
Resolution>Horizontal only 316 ; Lens>Resolution>lp/mm 316 (line pair per mm);
Lens>Resolution>Contrast % 316 .
3D VIDEO WINDOW
8.65 A window, which shows models of camera images, named 3D Window in the past, was
renamed to the 3D Video 284 window.
8.66 In the main menu of the 3D Video window, in Image submenu, a new Real frame size 286
item was added. If it is checked, then saving the image in the 3D video window will be with the
number of pixels of the camera, which can exceed the screen size in Windows. This item is also
used to simulate resolution of image with lens distortion 429 .
8.67 In the main menu of the 3D Video window, in View submenu, a duplicating Ground 288 item
was added for quick hiding the ground surface in the 3D Video window.
8.68 In the main menu of the 3D Video window, in Image submenu, a new Copy to clipboard 286
item was added.
8.69 View area faces of cameras are invisible in the 3D Video window, they are visible in the 3D
World window.
8.70 In the PTZH mode a camera is panned and tilted by moving mouse cursor on the image with
left mouse button pressed..
8.71 Background representation in the 3D Video window was improved.
8.72 Ability to switch 326 image generation thread: in separated thread or in the main thread.
8.73 Ability to model Rolling Shutter with line scan order from up to down was added.
8.74 Accuracy of positioning PiP and accuracy of working PiP together with Rolling Shutter was
increased.
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SPATIAL RESOLUTION
8.75 Ability to specify spatial resolution in
spatial resolution patterns not only vertically
but also horizontally. To do this, a new switch
275 to the Spatial resolution box was added.
8.76 To the Option box an option of switching 333 direction of the spatial resolution calculation in
dependence of the camera rotation around its optical axis was added.
8.77 Additional Spatial resolution patterns 274 were added based on the Standards:
Australian Standard AS4806: Closed Circuit Television;
European Standard EN50132-7;
ISO/IEC 19794 Biometric data interchange formats.
8.78 As a result of right-click on the Pattern 274 combo box a pop up menu will appear. Selecting
the Default patterns item, you can erase all changes in the patterns and return to the patterns
set by default.
8.79 The Vertical resolution of camera 277 field in the Spatial resolution box was renamed to the
Vert. (Horiz) number of pixels 277 .
8.80To the Spatial resolution box 278 new test
images were added.

8.81 Spatial resolution visualization on the view
area faces and on the active camera coverage
in the 3D World window.
8.82 Spatial resolution visualization taking into
account lens distortion 429 .
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8.83 A new option for drawing regions of spatial resolution in the Graphics windows in ascending
resolution - High resolution on top 199 was added. With this option enabled all cameras remain
visible despite the shading of projections of different cameras. While regions with higher spatial
resolution are drawn on the top.

Usual drawing

High resolution on top

IMPORT AND EXPORT TO AUTOCAD
8.84 Import module was upgraded. Up to AutoCAD DWG 2015 formats are supported.
8.85 The dialog box Scale background was renamed to the Adjust background 205 . For
backgrounds in DWG or DXF formats, abilities to choose Layout in the background, control
visibility of layers, hide texts were added. For backgrounds in PDF format you can choose page
and resolution of the background.
8.86 Export module 329 was updated and reworked. Export to AutoCAD was improved. Export
accuracy was increased.
8.87 Cameras with view areas are exported as AutoCAD blocks, view area bounds are exported
as polylines. In attributes of the block the most important parameters of the camera are recorded:
Name, Model, Lens focal length, Height of installation, Base height, Heights of view area lower
and upper bounds, View angles, Number of pixels, Spatial resolution pattern, Quality level.
8.88 Illuminators are exported as AutoCAD blocks. In attributes of the block the most important
parameters of the illuminator are recorded: Lamp type, Number and power of lamps, Height of
installation.
8.89 Distribution by layers, set in VideoCAD is saved.
8.90 Hatching and filling of shadows 172 are saved.
8.91 Styles and weights of lines 320 set in VideoCAD are saved.
8.92 Point of origin is saved.
8.93 Grid is exported as AutoCAD block with attributes.
8.94 In the exported file the references to raster insertions are saved: background and 3D model
projections. Raster images are exported along with DXF or DWG file into a separate directory.
8.95 In addition to the DXF format, export to the following vector formats was added: DWG, vector
PDF, PLT (HPGL/2), CGM (Computer Graphic Metafile), SWF (Adobe Flash).
8.96 When you export a drawing with the background in AutoCAD DWG/DXF format, VideoCAD
constructions can be added to the background on separate layers 329 or the background can be
added as an external links to the file of the background. In both cases the structure of the
background is saved.
8.97 Possible scheme of the combining AutoCAD + VideoCAD:
1. Load drawing 204 in AutoCAD format as a background;
2. Import 199 AutoCAD lines to VideoCAD 3D constructions automatically;
3. Adding cameras and constructions on special layers.
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4. Export 202 the obtained drawing to AutoCAD format to work with it in AutoCAD.

8.99 Export to DXF file 3D view areas and
camera coverage taking into account lens
distortion, spatial resolution, and shading.
This feature allows the convenient scheme of
work with combination of 3D BIM Software
(SketchUP) + VideoCAD.
1. Export layout as a 3D model-territory
through SketchUP and loading it into
VideoCAD.
2. Adding cameras with 3D view areas in
VideoCAD.
3. Export 3D view areas in DXF format,
loading them into 3D BIM Software and
combining with the original layout in 3D.

8.99 Import constructions 199 from a 2D background in AutoCAD formats to 3D VideoCAD
constructions automatically. Use of this tool allows to reduce efforts of outlining background to
convert it to 3D constructions.
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IMPORT AND EXPORT TO OTHER FORMATS
8.100 Supporting PDF files to use as background 204 including multi-page PDF files.
8.101 Export 202 to PDF (raster and vector), AutoCAD DWG, PLT (HPGL/2), CGM (Computer
Graphic Metafile), SWF (Adobe Flash).
8.102 Because of the increased number of export options, Export 329 tab in the Options box is
divided into two sub-tabs: "DXF,DWG,PLT,CGM,SWF,vPDF" and "BMP,WMF,EMF,GIF,TIFF,
PNG,JPG,rPDF".
8.103 To the options of export to BMP, JPG, EMF, WMF, GIF, TIFF, PNG, rPDF possibility to
set hatch step factor 330 was added.
8.104 In the 3D Image 191 you can load images
in BMP, JPG, PNG, GIF TIF (early BMP and
JPG). Transparency of PNG files is supported.
8.105 New PDF report 200 was added. Unlike the Text report 200 , the PDF Report can include
images from the cameras, fragments of layouts with camera placed, a cover with logo. Report
parameters and the structure of information in the report is configurable. See example of PDF
report.
PRINTING
8.106 New mode Use buffer 334 was added. Using this mode, you can get the correct results and
print transparent gradient fills, projections of 3D models even on printers do not support these
tools, including most of free virtual printer to print to PDF.
8.107 New mode Scale Hatching 333 was added. Using this mode, you can get the correct
hatching even on printers do not support scaling hatching.
8.108 Menu item Print setup 207 remains enabled even VideoCAD can not get access to the
current printer.
MISCELLANEOUS
8.109 Ability to change the minimum and maximum heights of several objects at once through
changing their line type. If during changing the line type of selected objects by the Change line
type 237 tool, to press and hold Ctrl, then the selected objects will also change their minimum
and maximum height according to the chosen line type . If Ctrl is not pressed, the heights remain
unchanged.
8.110 Autosaving 334 the project in specified intervals during running the program in a chain of files
(up to 100 copies of the project are saved and rewritten in the regular intervals around the ring).
8.111 Image update with lots of rotated projections of the 3D models was accelerated.
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8.112 New construction - Stairs 226 .

8.113 Added a possibility to draw legends 276
of Spatial resolution patterns on the layouts.

8.114 New possibility to adjust transparence of filling view area projections 169 in the Graphics
window.
8.115 A mode to improve visibility of thin lines 334 at scaling background in BMP, JPG, PDF
formats.
8.116 In the Test object box at calculation of the part of frame occupied by the test object, tvl
(TB- lines ) and p ( pixels) are not used.
8.117 The Quality level combo box with a list of quality level was removed from the Camera
geometry box. You can assign a quality level to the active camera in the Quality levels box.
8.118 The item Assign to active camera was removed from the pop up menu of the Quality
levels table. A quality level is assigned when you select a line with the quality level name. To save
your selection, click Save. To cancel - click Cancel.
8.119 In the graphical editing state 159 of the active camera, selection and rotation of the active
camera is blocked to prevent displacement of the background, constructions and cameras relative
to each other on other layouts.
8.120 The cursor coordinates in the lower left corner of the Graphics window are displayed
rounded to the second decimal place .
8.121 The Export to Text 200 menu item was renamed to Text report.
8.122 In the Text report 200 for each camera additional lines were added: layer, the base height ,
angle of rotation around its axis, number of pixels.
8.123 When lens distortion 267 is modeled, the exported text file 200 contains real angles taking
into account the distortion and in parentheses calculated angles.
8.124 Child windows "sticks" to the screen edges.
8.125 Maximum number of lamp in a illuminator was increased up to 250 for modeling LED
illuminators.
8.126 An option of changing registration code 241 via the Main menu was added.
8.127 An option of typing sensor size 255 in millimeters was described in the Help system.
Checking invalid sensor sizes was added.
8.128 Detected bugs were fixed.
8.129 The Help system was updated.
8.130 Examples of work with VideoCAD 353 in the Help were updated according to the new
features. Several new examples were added.
8.131 Project format of VideoCAD7 - *.vc7 is supported. There are possibilities of export 199 and
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import 199 of the previous project format *.vmp, supported by versions from 4 to 6.
8.132 The program was tested under Windows 8.
RULES OF UPGRADE
8.133 The Rules of upgrade from previous VideoCAD versions to VideoCAD8:
For the customers who have purchased VideoCAD7 (or upgraded to VideoCAD7) after 01 July
2014 upgrade cost makes a difference between cost of VideoCAD8 and VideoCAD7.
For the customers who have purchased VideoCAD7 (or upgraded to VideoCAD7) before 01
July 2014 updating cost makes half of the VideoCAD8 cost.
For the customers who has VideoCAD3..VideoCAD6 and didn't upgrade to VideoCAD7,
updating cost makes 3/4 of VideoCAD8 cost.
Upgrade Lite version to Professional is paid in addition.
For the customers, whose original valuable suggestions have found application in VideoCAD
8.0, the additional discount for upgrade is given.
Upgrade of VideoCAD plugin for SketchUP is free with upgrade to VideoCAD 8.
VideoCAD 8 Professional can work only with USB Senselock dongle. HID registration with
the Professional version is not applied. Senselock dongles from VideoCAD 6.XX and VideoCAD
7.XX are supported. In case of absence of USB Senselock dongle it is necessary to purchase
it. Guardant dongles are not supported by VideoCAD 8.0.
VideoCAD 8 Lite
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can work with USB Senselock dongle and with the HID registration.

VideoCAD 8 Starter 49 and VideoCAD 8 Starter II 45 are registered only by personal
registration code, without dongle, without hardware locking.

7. What is new in VideoCAD 7.0
NEW PROJECT FORMAT
7.1 New project file format *.vc7. There are possibilities of export 199 and import 199 of the previous
project format *.vmp, supported by versions from 4 to 6.
7.2 Unlimited quantity of cameras in one project. In the previous versions each project could
contain no more than 100 cameras.
7.3 Unlimited quantity of constructions on each layout. In the previous versions each layout could
contain no more than 5000 constructions.
7.4 Quantity of line types 320 is increased to 2000.
SPEED OPTIMIZATION
7.5 Resource-intensive operations are allocated in separate threads. This allows working in the
graphics window without delays and also get considerable gain in efficiency on modern multicore
processors.
7.6 3D image 284 generation is allocated in a separate thread. This allows working in the graphics
window with opened 3D window without delays for redrawing 3D images. The priority of the 3D
window thread can be switched 326 . During image generation in the 3D window on the 3D window
button 176 blinking red frame appears.
7.7 New items were added to the 3D window's main menu: Speed>Disable image processing 286
and Update image only by clicking 286 . These items duplicate the same items in the Options box.
When image processing is disabled the 3D image redraw speed considerably increases.
7.8 Possibility of two-stage image generation 326 in the 3D window. At the first stage the image
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without processing is quickly generated and displayed. Then resource-intensive per-pixel
processing is carried out and the processed image is shown.
7.9 In the PTZH frame 287 mode image processing is disabled to increase speed of image
redrawing. Titles are disabled too.
7.10 The algorithm of modeling sensitivity of megapixel cameras is accelerated.
7.11 Image redrawing in the Graphic window was accelerated too. Bottlenecks were optimized.
CALCULATING SHADOWS IN THE VIEW AREA
7.12 Constructing horizontal projection of
camera control area taking into account
shadows 172 , arisen from obstacles on the
scene environment. In three dimensions,
shadows from any constructions (including 3D
models) can be automatically calculated and
displayed.
7.13 New definitions are introduced: Camera
control area and Control area projection.
Camera control area forms by subtracting
shadows of environment objects (uncontrolled
areas) from camera view area 147 .
7.14 Constructing the Camera control areas of
PTZ 384 (dome) cameras taking into account
shadows, created by obstacles on the scene
environment. The tool is also useful for
choosing the best location for fixed cameras to
make reachable required areas.
7.15 In the Line type properties there is new
item: Shadow 320 . If the item is checked then
all constructions made by this line type are
considered as obstacles at calculating
shadows.
7.16 On the Current construction parameter
panel when a 3D model is editing, there is
additional checkbox- Shadow 248 . If the
checkbox is checked, then the 3D model is
considered as an obstacle at calculating
shadows.
Shadows - a new powerful yet easy-to-use
tool of VideoCAD 7. Shadows are calculated
for all positions of cameras, shading objects
can be located at any point of space. You
should only enable calculation of shadows.
COLORS, FILLING AND HATCHING OF VIEW AREA PROJECTIONS
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7.17 View area projection of different cameras
can have different color 169 according to
parameters of line type of these cameras (in
case of disabled spatial resolution 170
visualization).
7.18 View area projection can be
semitransparent. The Fill projection 169 button
and corresponding item of the main menu have
a drop-down list in which it is possible to
choose blend filling or hatching view area
projection.

VISUALIZATION OF SPATIAL RESOLUTION AND FIELD OF VIEW SIZE
7.19 Camera view area can be divided into regions 170 filled by different color and (or) type of
hatching. Regions can differ depending on the following criteria:
spatial resolution (pixels/meters, pixels/foot);
vertical field of view size (meter, foot);
vertical number of pixels covered by an object of the specified height (meter, foot);
the part of the frame (%) covered by an object of the specified height (meter, foot).
7.20 The spatial resolution is measured at the specified height and can be displayed in the
Horizontal projection in all modes. In the Vertical projection the spatial resolution is displayed in
the loaded (active) camera editing mode only.
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7.21 The new Spatial resolution box 272 was
added in which it is possible to create and edit
patterns of spatial resolution and field of view
size visualization. In the box there are prepared
spatial resolution patterns according to the
following criteria: Home Office Scientific
Development Branch, Home Office Guidelines
for identification, P 78.36.008-99. Also in the
box there are examples of images of group of
people are automatically displayed for each
region of spatial resolution. Different patterns
can be assigned to different cameras.
7.22 View area projections can have gradient
colors 170 . In this case key colors of the
gradient correspond to the colors in the
assigned pattern from the Spatial resolution
box.

MODELING RESOLUTION OF MEGAPIXEL CAMERAS
7.23 On the Image parameter panel a new tab
PiP (Picture in Picture) was added. The PiP
mode allows to model in the 3D window images
with resolution exceeding the 3D window
resolution and even the resolution of the
Windows screen.
7.24 Digital ZOOM in the PiP mode allows to
additionally magnifying specified area on the 3D
window for detailed analysis.
7.25 If the image resolution differs from the 3D
window size and artificial decrease of resolution
is performed or the PiP is displayed, in the
Titles 284 of the 3D window in separated lines
the image resolution and the screen resolution
are displayed.
7.26 New values of resolution in the drop-down lists. Lists of resolution are stored in files H_res.txt
and V_res.txt in the VideoCAD installation directory. To add new resolution it is possible to edit
these files. As well as in the previous versions you can type any resolutions by the keyboard.
MODELING MOVEMENT
7.27 You can specify speed and direction of movement for 3D models 166 in a velocity vector form
and in a numerical form.
7.28 On the Current construction parameter panel when choosing 3D models there is an additional
Speed 248 box.
7.29 Frame rate was added to the camera parameters.
7.30 It is possible to model movement of 3D models and rotation of the Rotakin 192 object.
7.31 Visual estimation 379 in the Graphics window how many times moving object will get into the
frame, depending on speed and direction of movement of the object, location and frame rate of the
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camera and the view area form.

7.32 Exposure time and Row time of Rolling shutter were added to camera parameters.
7.33 It is possible to model blur of moving 3D models (motion blur) and rotating Rotakin depending
on the speed, direction of movement and exposure time of camera.
7.34 When modeling exposure time in the 3D window Titles current exposure time value is
displayed.
7.35 Modeling distortions 385 of moving 3D models and rotating Rotakin from Rolling shutter and
Global shutter.
7.36 Modeling interlace distortions 385 of moving 3D models and rotating Rotakin.

CREATION OF ANIMATED IMAGES
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7.37 Possibility of creation of animated images
with moving 3D models.
7.38 On the Image parameter panel, View tab
the Number of frames box was added.
7.39 When the Number of frames is more than
one, in the 3D window's titles 284 the Frame
rate value is displayed and in the 3D window
animated image with specified Frame rate is
generated.
7.40 Animated images can be saved 286 as
animated GIF files and displayed on the
Monitor window.

See an example of animated monitor
(file size about 4 Mb).
NEW IN THE MONITOR WINDOW
7.41 Scaling the Monitor window in Windows 7 was improved.
7.42 New sizes 296 of monitors were added.
7.43 Possibility of setting resolution 297 of digital monitors.
7.44 During loading monitors it is possible to interrupt the long operation, having pressed ESC.
7.45 It is possible to set correcting factor 334 for exact modeling physical sizes of monitors.
7.46 Displaying on the monitors animated 295 images with moving 3D models.
7.47 Saving 298 image of the monitors in formats *.gif, *.tif, *.png.
7.48 Exporting images on the monitors to the *.html 298 file with static or animated images.
Camera’s images are saved in the camera's original resolutions in the form of separate files PNG
or animated GIF.

See an example of animated monitor (file size about 4 Mb).
NEW OBJECTS AND TOOLS
7.49 New object - Rotakin 192 - an animated rotating test target for visual estimation of spatial
resolution and motion distortions on the 3D images. In the Options box it is possible to change
rotation speed of the Rotakin.
7.50 New object - Wall 186 . It allows drawing walls with different thickness.
7.51 New object - Aperture in Wall 187 . It allows making in 3D walls any apertures, for example for
windows and doors.
7.52 New object - Polyline 183 . It allows drawing line segments continuously.
7.53 New tool - Scale 181 . It allows scaling selected constructions relative to a base point.
7.54 New tool - Mirror 181 . It allows getting mirror copies of selected constructions relative to a
horizontal or vertical line.
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7.55 Existing Copy and Cut tools are renamed to Copy with base point 234 and to Cut with base
point 234 .
7.56 New Copy 180 and Cut 179 tools were added. In the new tools the base point is set
automatically at the center of copied objects.
7.57 Several new 3D models 190 were added to the library.
CABLE REPORT
7.58 Possibility of using in the project a lot of brands of cables. Line types 320 can be considered
as cables.
7.59 Possibility of drawing main cables, which is not associated with cameras.
7.60 Possibility of getting the Cable report 388 . The report contains lengths of all cables separated
by brands and cameras, including the main cables.
7.61 Continuous drawing cables 238 . The end of each segment is the start of the following one. To
stop drawing cable press ESC.
DEPTH OF FIELD IN THE HORIZONTAL PROJECTION
7.62 The Height parameter was added to the depth of field parameter list. At the set Height the
analysis of depth of field is performed do display the depth of field bounds in the Horizontal
projection. The height can be different for different cameras.
7.63 When the Depth of field box is opened, all cameras in the horizontal projection have displayed
borders of the sharpness area, hyperfocal distance, focus distance measured at the set height. In
the vertical projection the borders of the sharpness area, hyperfocal distance, focus distance are
displayed in the loaded (active) camera editing mode.
7.64 It is possible to specify focus distance by clicking on the view area horizontal projection of the
loaded (active) camera. The Specify focus plane button is always accessible.
7.65 When the Specify focus plane button is pressed, during cursor movement over the view area
horizontal projection of loaded (active) camera, on the Status bar 243 the resolution under the
cursor limited by the depth of field is displayed.
7.66 In the Depth of field box the new Default button was added. As a result of clicking this button,
default values will be assigned to input parameters in the Depth of field box: the boundary
resolution = 0.7*horizontal pixel count, focus distance = hyperfocal distance, height = AUTO
(middle height of the camera's view area).
NEW IN TABLE OF CAMERAS AND TABLE OF CAMERA MODELS
7.67 A new menu for switching visibility 308 of separate columns was added.
7.68 Several new possibilities of filtering 308 data in the tables.
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7.69 Several new parameters of camera model were added: Exposure time at measuring sensitivity
316 , Maximal frame rate 316 , Row time 316 (parameter of the Rolling Shutter).
7.70 To the Table of cameras these three new parameters of model were added and in addition:
Current frame rate, Name of the assigned Spatial resolution pattern 272 , Signal cable brand 341 and
Power cable brand 342 .
INTERFACE IMPROVEMENTS
7.71 Possibility to adjust 332 visibility of buttons on the Tool bar.
7.72 When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow
keys and to change scale using plus and minus keys irrespective of the input focus.
7.73 In the PTZH frame mode of the 3D window you can pan and tilt the camera by moving the
image in the 3D window with left mouse button pressed like moving drawing in the Graphics
window.
7.74 In the Options box the Default 319 button was added. Using this button you can assign default
values to all parameters on the opened tab.
7.75 Sign of the Scaling factor when turning the mouse wheel 333 in the Option box determines the
reaction for direction of rotation the mouse wheel in the Graphics window.
7.76 Manual scaling 3D window in Windows 7 was improved.
7.77 On the Processing tab of the Image parameter panel and in the Sensitivity and resolution box
between combo boxes with horizontal and vertical numbers of pixels, new buttons with a cross
were added. These buttons are intended for fast calculation of vertical number of pixels from the
specified horizontal number of pixels and on the contrary. Calculation is carried out using the
Aspect Ratio 257 .
7.78 On the View tab of the Image parameter panel near to a box with the horizontal number of
pixels, the calculated value of vertical number of pixels and the Aspect ratio are displayed.
7.79 At the left top corner of the Tool bar the Save project 166 button was added for convenient
regular saving the current project to a file.
7.80 Links to the last 10 used project files are accessible in the Main menu>Project 199 .
7.81 Accuracy of 3D model selection in the Graphics window was improved.
7.82 In the Main menu>Help 240 new items with links to our web site and VideoCAD user forum in
the Internet were added.
UNDO
7.83 Buffer of last operations (UNDO) stores now all parameters of cameras.
7.84 Depth of the undo buffer can be adjusted on the Miscellaneous 334 tab of the Options box.
This depth can be up to last 50 operations.
7.85 The REDO 196 button was added for moving in the UNDO buffer in the opposite direction.
NEW FORMATS OF IMPORT AND EXPORT
7.86 Support of import as background 204 and export 202 drawing in the following formats: EMF +,
GIF, TIFF, PNG. Blend color and gradient color are supported.
7.87 Support of export drawing to JPG format (Import of the JPG format is present in the previous
versions).
7.88 Possibility of saving 286 image from the 3D window in formats: GIF, animated GIF, TIF and
PNG.
7.89 Possibility of saving 298 image from the Monitor window in formats: GIF, TIF, PNG, HTML with
PNG, HTML with animated GIF.
CHANGES
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7.90 When editing by points a rectangle 184 , an inclined rectangle 184 or 3D image 191 , the
rectangle remains rectangular by default. By pressing Ctrl it is possible to edit separate points and
to change distance between lines. In the previous versions it was on the contrary.
7.91 Double line 185 rotates as a whole, with keeping distance between lines that is more
convenient at construction of walls.
7.92 When editing by points a double line, it rotates as a whole by default. Keeping Ctrl it is
possible to edit separate points and to change distance between lines. In the previous versions it
was on the contrary.
7.93 The Post in the 3D window is hidden by default. It is possible to show post on the View tab of
the Image parameter panel.
7.94 Setting of export to raster formats on the Export 329 tab of the Options box by default
correspond to an exact copy of the screen.
7.95 At the moment of closing the Image parameter panel the According to camera parameters
box on the Processing tab becomes marked automatically and all parameters on this tab get
values from the loaded (active) camera. This is to avoid mess with displaying resolution of loaded
(active) and inactive cameras.
7.96 Name of the loaded (active) camera is not red colored when exporting and printing.
7.97 When modeling interlaced fields, the vertical resolution of video sensor (if it is set) decreases
twice. In the previous versions the vertical resolution of the whole image in the 3D window was
decreased.
7.98 From the Camera tab of the Image parameter panel duplicating controls are removed to clear
a place for new tools. The controls remain on the Sensitivity and resolution box.
RENAMINGS
7.99 The Loaded camera term is changed to the Active camera.
7.100 Menu item Project> Export is renamed to Project> Export to Text 200 .
7.101 Button Actual view area projections and the corresponding Main menu item are renamed
to Fill projections 169 .
7.102 The Interface tab in the Options box is renamed to Miscellaneous 333 .
7.103 Coaxial cable is renamed to the Signal cable (the Russian version).
UTILITIES
7.104 Utilities for measuring camera and image parameters were separated out from VideoCAD in
the separate product - CCTVCAD Lab Toolkit.
7.105 Utilities in the CCTVCAD Lab Toolkit become more stable in Windows 7.
7.106 The Video analyzer has a possibility of automatic measuring signal/noise ratio of static
image or live video on the computer screen, in a window of any third party program.
7.107 In the Image analyzer, showing separate image lines as a oscilloscope can be separated by
color.
7.108 In the Spectrum analyzer, a possibility of calculating spectral efficiency of infra-red LEDs of
different wavelength for different image sensors was added.
7.109 In the Spectrum analyzer, spectral sensitivity curves of modern CMOS and CCD megapixel
image sensors (SONY, Cypress, Micron) were added.
7.110 The technique of measuring sensitivity 367 of cameras was refined on the base of practice of
measuring the sensitivity of IP cameras. A new method of measuring the sensitivity using the
Video analyzer was added.
7.111 Procedures for measuring camera exposure time 391 and the row time of rolling shutter 394 of
IP cameras were developed.
MISCELLANEOUS
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7.112 Possibility to make camera and luminaries icons scalable together with the other
constructions on the drawing. In this case the size of icons is specified in meters (foots). This
possibility allows setting the exact sizes and positions of icons and names of cameras for
exporting and printing.
7.113 Possibility of assigning scalable fonts 322 to the camera names and specifying displacement
of camera names in meters (foots) for scalable icons and in pixels for no scalable icons
separately.
7.114 Displaying background in the 3D window was improved.
7.115 A new possibility of adjusting resolution 326 of a vector background (in AutoCAD format) in
the 3D window.
7.116 In the Options box on the 3D tab a slider was added which allows adjusting realism of
modeling 325 depth of field, exposure time and rolling shutter.
7.117 In the Sensitivity and resolution box a new camera parameter Exposure time at measuring
sensitivity was added.
7.118 In the exporting text file 200 for each camera the following information was added: Horizontal
angle of camera, Coordinate X, Coordinate Y, Model, Producer and Cost.
7.119 In the Camera list 336 box new parameters were added: lens focal length and vertical
number of pixel. Now you can copy the camera list to the Windows clipboard to paste in MS
Excel, MS Word and other software.
7.120 Help system was considerable improved; a lot of pictures were added.
7.121 Examples of work with VideoCAD 353 in the Help were updated according to the new
features. Several new examples were added.
7.122 Program was adapted for modern wide-screen monitors with high resolution.
7.123 Program was tested under Windows 7. Detected incompatibilities are eliminated.
RULES OF UPGRADE
7.124 The Rules of upgrade from previous VideoCAD versions to VideoCAD7:
For the customers who have purchased VideoCAD6 (or upgraded to VideoCAD6) after 01
January 2011 upgrade cost makes a difference between cost of VideoCAD7 and VideoCAD6.
For the customers who have purchased VideoCAD6 (or upgraded to VideoCAD6) before 01
January 2011 updating cost makes half of the VideoCAD7 cost.
For the customers who has VideoCAD3..VideoCAD5 and didn't upgrade to VideoCAD6, updating
cost makes 3/4 of VideoCAD7 cost.
Upgrade Lite version to Professional is paid in addition.
For the customers, whose original valuable suggestions have found application in VideoCAD 7.0,
the additional discount for upgrade is given.
VideoCAD 7 Professional can work only with USB Senselock dongle. HID registration with
the Professional version is not applied. Senselock dongles from VideoCAD 6.XX are supported.
In case of absence of USB Senselock dongle it is necessary to purchase it. Guardant dongles
are not supported by VideoCAD 7.0.
VideoCAD 7 Lite

31

can work with USB Senselock dongle and with the HID registration.

VideoCAD 7 Starter 49 and VideoCAD Starter II 45 are registered only by personal
registration code, without dongle, without hardware locking.

6.1 What is new in VideoCAD 6.1
6.1.1 VideoCAD_Lite 31 is released. VideoCAD_Lite is an inexpensive version of VideoCAD with
limited features. VideoCAD_Lite offers only the most useful and easy-to-master tools for CCTV
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design.
6.1.2 A new possibility to assign any model to all selected cameras 174 simultaneously
6.1.3 A possibility to change the following parameters of all selected cameras 251 simultaneously:
lens focal length, Image sensor size, installation height, parameters of view area, quality level.
6.1.4 Exposure time range is expanded up to 1 sec. for convenience in modeling modern IP
cameras with increased exposure time.
6.1.5 Line color in the 3D window 321 is displayed on the Line type panel 245 .
6.1.6 Changing Number 316 and Model Name 316 is disabled on the Used models tab in the Table
of camera models 304 . Earlier such changes resulted in loss of the model from the model list.
6.1.7 If size of video sensor is standard, at closing the Special sensor size 267 box, the standard
designation of the sensor size is kept.
6.1.8 The Help system is updated.
6.1.9 VideoCAD installer is updated.
6.1.10 Found bugs are fixed: running under a user account, error at starting VideoCAD by double
clicking on a project file, an erroneous message ' Your graphics card does not support this tool ',
directory path of jpg images saving is not kept, error at editing text on the drawing.
6.1.11 Updating from VideoCAD 6.0 is offered free-of-charge. Updating from earlier versions is
performed according to rules 138 of updating up to VideoCAD 6.0.

6. What is new in VideoCAD 6.0
IllUMINATION AND LUMINARIES
6.1 Modeling background scene illuminantion, considering type and direction of light source,
separately for day and nighttime.
6.2 Luminaries 166 modeling considering lamp type and light efficiency, including discharge lamps
with complex spectrum of radiation.
6.3 Different wavelength Infrared LED illuminators modeling.
6.4 Illuminator calculation box for creating luminaire models and calculating their parameters.
CAMERA, LENS AND DVR PARAMETERS
6.5 Camera parameters modeling (spectral response; number of pixels; resolution; minimum
scene illumination at known signal-to-noise ratio, IRE and aperture; maximum signal-to-noise ratio;
electronic shutter; AGC; Back Light Compensation; gamma correction).
6.6 Lens parameters modeling (focal length; aperture; Auto Iris DC and Video Drive). Calculating
and modeling Depth of field based on calculated aperture.
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6.7 Modeling cameras, switching into black and white mode in case of low illuminance: day/night
with removable IR filter and easy day/night with permanent IR filter.
6.8 Enhanced modeling of DVR parameters (vertical and horizontal digitization, brightness,
contrast, compression, vertical and horizontal sharpness).
6.9 Modeling specific distortions which are arisen as a result of mismatching output image size
and number of pixels on camera's video sensor.
6.10 Modeling images based on scene, lens, camera and DVR models. Calculating and modeling
signal-to-noise ratio and contrast.
6.11 Image models at different illumination levels are tested 367 against real video cameras. Very
high level of coincidence has been achieved.
UTILITIES
6.12 Image analyzer tool allows measuring signal-to-noise ratio, brightness and brightness
amplitude of an image, size and contrast of an object relative to background, building histogram,
calculating image size at different compression levels, analyzing certain lines of an image similarly
to oscilloscope, as well as modifying certain image parameters. By analyzing saved images using
this tool it's possible to calculate sensitivity and resolution of a real camera for precise modeling in
VideoCAD.
6.13 Live video analyzer tool allows measuring brightness, average brightness and noise in certain
point, as well as screen frame rate in window containing live video created by any program.
6.14 Lamp spectrum analyzer tool allows to determine the spectral efficiency of any light source
for various camera types based on spectral power distribution curve. Determined value of spectral
efficiency is used in VideoCAD for precise modeling various types of light sources.
CAMERAS
6.15 Table of camera models 304 support (over 100 parameters for each model), ability of assigning
models for project cameras. It's possible to adjust a view of model table by hiding unnecessary
columns. Table of models supports sorting and filtering. Automatic calculation of sums of power
consumption and prices. Ability of printing tables and their parts, importing and exporting into
Excel, Word, *.txt, *.csv, *.htm.
6.16 Modern IP cameras support (16:9 Aspect Ratio 267 , different image sensor sizes and
aspect ratio, high image resolution).
6.17 Criteria in Quality levels concerned with limiting image resolution (maximum vertical field of
view size, minimal parts of screen occupied by a license plate and a face) are related to the
number of pixels for modeling and comparing digital cameras with different resolution. These
criteria are now known as: Minimal vertical resolution (pixel/meter), Minimal vertical size of face
image (pixels) and Minimal vertical size of license plate image (pixels).
6.18 Varifocal and ZOOM lens support. Adjusting 256 lens focal length by moving view area
bound on a layout within set limits using a mouse.
6.19 Icons for internal, outdoor and PTZ cameras may be different 166 .
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6.20 For each camera icon by various line types 166 can be set. Thus, the camera icons can vary
in color and line thickness.
6.21 Lens focal length 256 range has been widened to 1000mm.
IMPORT AND EXPORT
6.22 A background 204 in *.dwg AutoCAD™ 2007 format support, AutoCAD™ PROXY records
support, loading speed of complex *.dxf files is improved. Bug fixed. All ANSI code pages support,
and other improvements concerned with *.dxf and *.dwg files import.
6.23 Export 329 to*.dxf file is improved. It's possible to set camera icons and illuminator size in
AutoCAD™ units. Ability of exporting large background files.
3D MODELS AND 3D WINDOW
6.24 Several new 3D models 190 were added, including dark-skinned person for testing the ability
of detecting dark-skinned people at low illumination.
6.25 3D models now can be scaled 248 in any direction.
6.26 3D models can be placed in vertical projection 190 . Models placed in vertical projection will not
be visible in 3D window.
6.27 Convenient 3D model 164 selection from the tool bar.
6.28 Raster images 191 in the 3D window. Usual photos and pictures in *.bmp or *.jpg format can
be placed in 3D space. Raster images can be transparent, and can replace difficult-to-make 3D
models. Raster images can be scaled, placed at any angle, used for modeling variety of objects,
from banknotes and plates to a complex background.
6.29 Background can be visible in the 3D window.
6.30 Redraw 3D image only by clicking 326 mode is convenient in case of complex scenes and\or
slow computers, when image repainting in 3D window takes much time.
6.31 Fixed fuzzy drawing PTZH frame and titles in the 3D window when using certain video cards.
6.32 Image parameter panel with View, Scene, Camera, Processing tabs. Panel can be activated
by right-click or double-click on the 3D window.
6.33 Setting visibility of different objects in the 3D window on View panel.
6.34 View, scene and equipment parameters are set individually for each camera. Quality levels
no longer include 3D image parameters.
WINDOWS
6.35 Quality level box contains corresponding quality level criteria..
6.36 Sensitivity and resolution box with camera and lens parameters.
6.37 Camera parameter box has been renamed to Camera geometry 251 . Inherited from older
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versions unnecessary interface elements have been removed. Additionally, this box allows to
change aspect ratio 257 , image sensor sizes 267 and view angles.
6.38 Modeling 16:9 297 format monitors. Switching day/night 295 illumination modes on the Monitor
window.
6.39 Tab quantity in the Options box 319 has been increased.
6.40 Model column has been added to the table in the Camera list 336 box. Column width can be
adjusted by the mouse. Icon box and Table of camera models button have been added to the
Cameras list box.
6.41 Appropriate camera is loaded by double-clicking on the Camera list 336 box. To rename
camera use appropriate pop-up menu item.
6.42 Camera type box has been added to the New camera 166 box. When creating new camera,
line type can be chosen for it's icon on the Line type panel 245 .
REPORTS AS A TABLE
6.43 Interactive adjustable table reports including any camera parameter sets. Various types of
tables can be formed by hiding unnecessary columns. Tables support sorting and filtering.
Automatic calculation of sums of power consumption, cable lengths and prices. Ability of printing
tables and their parts, importing and exporting into Excel, Word, *.txt, *.csv, *.htm. Convenient
editing parameters by double-clicking on any cell.
TOOLS
6.44 A New Tool for automatic name generation 338 and camera serial numeration on layouts.
Various numeration templates and rules.
6.45 A New Tool for counting length sum 343 of line segments of specified line type. Thus any line
type can be used as a cable.
6.46 A New tools for switching draw order of constructions and cameras:Cameras over
constructions 216 , Bring to front 236 , Send to back 236 . These tools simplify work with complex 3D
models of buildings, grass, etc., where another 3D models can be placed above (or inside) them.
6.47 Show all 219 tool considers not only cameras, but the background and constructions as well.
6.48 Change line type 237 tool can change icon line type of selected cameras.
6.49 In order to model windows and transparent objects, inclined rectangle 184 in the 3D window
can be transparent by 70%.
6.50 Edit 247 button will appear on the Current construction parameters panel when drawing
construction is complete. Click this button to edit last drawn construction.
INTERFACE
6.51 Assigning and editing keyboard Shortcuts 324 for items in Graphics window main menu.
6.52 Rotating cameras 159 in both planes by moving view area bound on the layout using the
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mouse.
6.53 Adjusting lens focal length 163 by moving view area bound on the layout using the mouse.
6.54 Loading and saving directories are stored. When recalling same operation stored directory is
opened.
6.55 Horizontal and vertical scroll bars and scaling by + - keys to simplify work on portable
computers.
6.56 Tabs 242 in the Graphics window for fast switching, creating and deleting layouts. Layouts
button has been removed from the Tool bar.
6.57 A combo box 167 on the Tool bar for fast loading of any camera. Using pop-up menu of the
combo box it is possible to search the camera on the layout.
6.58 A combo box 174 on the Tool bar for fast assigning a model to the loaded camera.
6.59 Enhanced selecting and loading cameras on the layout using the mouse. Cursor snaps to a
camera icon with higher priority, and it's highlighted with red rectangle.
6.60 Priority of mouse selection 177 of close objects is presetted: 1. Cameras; 2. Constructions; 3.
Text; 4. 3D models.
6.61 A New algorithm of selecting constructions 177 , located over each other. In order to select
another construction it is necessary to click the same point again.
6.62 Snap sensitivity 333 can be adjusted for convenient work with different screen resolutions and
mouse accuracy. The snap to a camera has a priority.
6.63 Following info is displayed at the bottom of the Graphic window on the Status bar 243 when
moving cursor close to a camera icon: name, model name and basic parameters of the camera.
6.64 Field of view size 166 on the Status bar in loaded camera edit mode now is displayed when
moving the cursor over view area in vertical projection, not only when clicking.
6.65 Move 180 mode is set after creating new camera 166 . It's convenient to place new camera on
the layout instantly.
6.66 ESC key stops current operation. If an operation is not performed, Select/edit 177 mode is
switched on.
6.67 Current line type 320 is stored before placing 3D models, cameras and illuminators, and is
restored after placing.
6.68 In case of editing height 247 values on the Current construction parameter panel during
drawing, new height value will be kept when drawing is complete. Other parameters of construction
located on the Current construction parameters panel are kept as well.
6.69 Loaded camera icon's color is changed to red.
6.70 View>All camera cables 216 and View>Loaded camera cables 216 menu item states are not
stored individually for each camera; they are stored in common project settings.
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INHERITED ELEMENTS
6.71 Fast scaling mode by rotating pressed mouse-wheel is disabled due to inconvenience of work
with certain mouse types.
6.72 Title button has been removed from the Tool bar. It is possible to show/hide titles 216 using
the main menu item.
6.73 Saving Resolution and Edit Image menu items have been removed from the Main menu.
Resolution can be changed in the Options box on Export 329 tab.
6.74 Measurement format by default box has been removed from the Options box 319 . When
creating new project, measurement format concurs with measurement format in the current
project.
6.75 Layout combo box has been removed from the New camera 166 box. The layout of creating
camera always concurs with the current layout.
6.76 Camera>Save as item has been removed from the Main menu.
OTHER
6.77 VideoCAD Help system is now in Html Help format for compatibility with Windows Vista.
6.78 Help system has been redesigned taking into account user's suggestions and new program
features. Examples 353 have been renovated.
6.79 Many functions are improved, detected errors are corrected.
6.80 VideoCAD 6.0 can read projects, created in VideoCAD 4.xx and VideoCAD 5.XX.
6.81 VideoCAD 6.0 has been tested on Windows Vista. All incompatibilities found have been
eliminated.
6.82 The regulations of upgrading 439 previous VideoCAD versions to VideoCAD 6:
The cost of upgrading amounts the difference between the costs of previous VideoCAD versions
(VideoCAD 3.02, VideoCAD 4.0 or VideoCAD 5.0) and VideoCAD 6.0.
Considerable discounts are offered to the users, whose valuable suggestions have found
application in VideoCAD 6.0.
At upgrading it is necessary to exchange USB dongle.

5. What is new in VideoCAD 5.0
5.1 Monitor window 294 has been added. Monitor window logically finishes the information transfer
process in video surveillance system "from a real object to an operator" and thus, allows to model
the video surveillance system as a hole.
5.2 The new tool in 3D window - PTZH frame 287 allows operating a camera in 3D window similarly
to PTZ one and additionally to change camera's installation height. Together with the Monitor
window this tool offers a new method 363 of 3D CCTV design.
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5.3 There is a new opportunity to carry out Depth-of-field 286 3D modeling.
5.4 There is a new opportunity to carry out 3D modeling visibility 286 limited by rain, snow, fog
according to the Meteorological Visibility.
5.5 Current construction parameters panel 247 allows creating and editing constructions by input of
parameters.
5.6 The Load camera box is essentially modified and renamed to the Camera list box 167 . The
following options are added: 3D image show, search, sorting.
5.7 Snap panel 229 allows fast switching of snaps during drawing.
5.8 An option to set heights in 3D window 181 separately for each construction, irrespective to a
line type.
5.9 The new tool - Inclined rectangle 184 allows modeling 3D inclined objects.
5.10 The new tool - Filling 189 allows creating fillings and hatchings.
5.11 Print preview box 207 is updated. There is a new option to save exact position of the drawing
and adjustment for reprinting. The print area displacement caused by Line type panel and Font
type panel is eliminated.
5.12 The new 3D models 229 : a boy and a truck.
5.13 The new tools: Combine to block 237 and Destroy block 237 .
5.14 VideoCAD 5.0 can use files of the following CAD formats as a background 204 :
*.dxf AutoDesk DXF Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006.
*.dwg AutoDesk DWG Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006.
5.15 DWG and DXF reference images, SHX fonts, DXF Autocad Table, Hatch gradients,
Unicode fonts (important especially for languages based on hieroglyphs - Chinese, Korean,
Japanese etc.) are supported in CAD background 204 .
5.16 Visibility of Camera view area 174 in 3D window can be switched independently of View area
visibility 167 in Graphics window.
5.17 Displaying cameras' names 216 and titles can be switched separately..
5.18 Option to switch on/off the display of view area 167 and view area projections for all selected
cameras simultaneously.
5.19 Selected camera changes the color together with it's view area.
5.20 Construction of person detection area is carried out more precisely, considering additional
inflection of bound.
5.21 Option to move constructions and cameras in Select/Edit 177 mode, without switching to
Move mode.
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5.22 While working only with cameras we have a new option to lock constructions 229 .
5.23 The tool Find loaded camera is updated and renamed to Show loaded camera 166 .
5.24 Number of redrawings in 3D window is reduced for increasing program's speed. For forced
redrawing, click the image in 3D window.
5.25 Exact position of the drawing is stored at finishing the work with the program and restored at
restart.
5.26 Reloading speed of cameras is increased.
5.27 The range of drawing scaling is expanded.
5.28 The range of focal lengths of lens is expanded.
5.29 Many functions are improved, detected errors are corrected.
5.30 VideoCAD 5.0 can read projects, created in VideoCAD 4.xx.
5.31 The regulations of updating previous VideoCAD versions to VideoCAD 5.0:
The cost of updating amounts the difference between the costs of previous VideoCAD
versions (VideoCAD 3.02 or VideoCAD 4.0) and VideoCAD 5.0.
For users, whose valuable suggestions have found application in VideoCAD 5.0, updating is free
of charge.

4. What is new in VideoCAD 4.0
4.1 There is a possibility of full value 3D designing 284 of a video surveillance object with loading
prepared 3D models 229 (a man, car and other) and getting images from cameras in the project.
4.2 It has become possible to model the 3D image quality from each camera through the image
quality parameters, based on the real videosignal distortions.
4.3 Line type parameters 320 include minimum, maximum height and color in the 3D window.
The number of line types has increased to 100.
4.4 There are new system fonts 322 and line types 320 :
title font in the 3D window;
sharpness area line;
focus plane line;
hyperfocal distance line;
3D model line.
4.5 Test object became 3D parallelepiped. Test object can be seen in the 3D window.
4.6 There is the depth-of-field and hyperfocal distance calculation.
4.7 There is a support for all *.dwg file formats as a background 204 : *.dwg AutoDesk Release
12, 13, 14 , 2000, 2002, 2004.
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4.8 It has become possible to export 202 obtained drawing to the file of *.dxf format on several
layers. It is convenient to process the obtained file in AutoCAD.
4.9 It has become possible to change the scale factor 325 of nonscalable elements when
exporting.
4.10 There is a new function of saving drawing - Save as background 199 .
4.11 It has become possible to print
Blocks.

207 and

export together with the prepared frames with Title-

4.12 The scaling range and grid step is expanded. Now maximum grid step is 500 m, and
maximum area displaying on the screen is 15x20 km (more than 200 square kilometers).
4.13 It has become possible to change the scale factor 325 when clicking the button Zoom in,
Zoom out and by turning the mouse wheel.
4.14 There are new means of navigation Show all 219 , Find text 219 and Zoom window

159 .

4.15 Image refreshing is realized without blinking 325 due to the using the graphics buffer.
4.16 The speed of image repainting with a big number of video cameras is increased.
4.17 The text 189 scaling accuracy has become higher. Now Title Blocks and other tables can be
filled without a risk of strings getting out of the frames.
4.18 It has become possible to select one or more constructions located 177 one over another.
4.19 The Main window is renamed to The camera parameters box 251 . When launching
VideoCAD first Graphics window loads. For showing the camera parameters box the button Show
Camera parameters box 176 is used.
4.20 Real view area 169 filling now is not solid, but as hatching. Due to this it doesn't shade other
objects.
4.21 Graphics background files 204 themselves, not the references to their loading, are included in
the project file.
4.22 All information on program settings (line types, fonts, etc.) is included in the project.
4.23 The current project is saved now in the VideoCAD database and at the next program
launching the last project, on which you worked, will be available and exactly in the place, on
which you broke the work.
4.24 There is a context help not only for the menu items, but also for the tools on the tool bars.
To get the context help for the button click it by the right mouse button and then by the appeared
Item "What's this?".
The context help is still available for the menu items and other interface elements. To get the
context help for the menu item or the interface element select it and press F1.
4.25 Now the recommended operating system is Windows XP. When working in other operating
systems big graphics file displaying errors are possible.
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4.26 From the tool bar 164 and the main menu 197 of the graphics window unnecessary buttons and
items are deleted.
4.27 Default parameters of quality levels are changed.
4.28 Examples are remade taking into account new possibilities of the program. The example of
the person identification criteria determination according to the real image 362 is included.
4.29 Many functions are improved, detected errors are corrected.
4.30 Multilingual version of VideoCAD 4.0 has the possibility of registration with the dongle 439 .
4.31 VideoCAD MAP is released. VideoCAD MAP is a graphical interface for security systems on
the basis of VideoCAD technology. VideoCAD MAP includes all possibilities of VideoCAD and
many other additional functions, is partly compatible with VideoCAD by the projects and integrated
in the Russian Integrated security system "Intellect".
4.32 The regulations of updating previous VideoCAD versions to VideoCAD 4.0:
For buyers of VideoCAD 1.0, i.e. for our first buyers, the updating is free-of-charge.
For the others the cost of updating amounts the difference between the costs of VideoCAD
3.02 and VideoCAD 4.0.
For those, who have bought more than one VideoCAD licenses at once, the updating is
chargeable only for one license. Other licenses can be freely updated.

3. What is new in VideoCAD 3.0
3.1 The opportunity of loading 204 the prepared layouts as a background in *.bmp, *.jpg, *.emf,
*.wmf, *.dwg, *.dxf formats was introduced. To display *.dwg and *.dxf files the CAD Import
module by CAD Soft Tools http://www.cadsofttools.com was used.
3.2 The obtained drawing can be saved 202 in *.bmp, *.wmf, *.emf formats or copied 204 to
clipboard in *.bmp, *.emf formats.
3.3 The opportunity of quality printing 207 , including the one on several pages to glue them was
introduced.
3.4 The opportunity of using texts 227 was introduced.
3.5 The opportunity of using various fonts 322 and line types 320 was introduced.
3.6 New object is a Mask 227 . The masks allow to cover any part of a drawing. It is possible to
draw new constructions over masks.
3.7 New objects is a Circle 225 , an Arc 188 , a Double line 185 .
3.8 New operations are Align 236 , Move loaded camera name 202 .
3.9 The opportunity to undo 196 the last four operations was introduced.
3.10 The opportunity of using a constant coordinate system 218 , that is not dependent on the
loaded camera, was introduced.
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3.11 The speed of redrawing the drawing containing many constructions and cameras was
increased.
3.12 The size of a project file was reduced.
3.13 The maximal quantity of objects on each plan was increased up to 5000 and the maximal
quantity of cable segments of each camera was increased up to 500.
3.14 The opportunity of precise scaling using Ctrl 249 was introduced.
3.15 The opportunity of quick navigation using the mouse wheel was introduced.
3.16 The opportunity of operating with inches and feet was introduced.
3.17 The opportunity of changing 177 the size of a rectangle without distorting its shape was
introduced.
3.18 The displaying view area edges 167 , view area projection bounds 168 and view area actual
projections 169 can be switched on/off separately.
3.19 The opportunity of copying and pasting 180 constructions, cables and texts between projects
was introduced.
3.20 Many existing functions have been improved, discovered errors have been corrected.
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Definitions
Camera view area
A dimensional figure in shape of a nearpyramid with vertex abutting the camera lens
and bisector, coinciding with the main optical
axis of the camera lens.
Any object within the view area will be
displayed on the screen, if it is not shaded by
other objects on the scene.
View area has the form of a regular pyramid
only if lens distortion 429 is negligible. The lens
distortion complicates the form of the view
area.

View area projections
In VideoCAD Lite and VideoCAD Starter horizontal projection of the view area can be displayed as
a volume projection (Projection) only. Type of displaying for the active camera 162 is selected in
the pop up menu of the
View area projection bounds 168 button.
In the case of the volume projection
(Projection):
It is displayed as projection to horizontal plane of
a view area part, which is residing between the
view area upper 258 and lower bounds 259
specified in parameters 253 in the Camera
Geometry box 251 .
View area horizontal projection is calculated
according to the rule:
A point on the horizontal projection is considered
visible if a vertical segment, formed by this point
in the range of heights from the view area lower
bound height 259 to the view area upper bound
height 258 , is visible wholly.

Camera control area
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A complex dimensional figure inside view area.
Camera control area forms by subtracting shadows
of environment objects (uncontrolled areas) from
the camera view area.
Any object within the control area will be displayed
on the screen.
In the Graphics window 158 VideoCAD
calculates Horizontal projection 148 of the control
area.

Control area horizontal projection
In VideoCAD Lite and VideoCAD Starter h
orizontal projection of the control area can be
displayed as a volume projection (Within
projection) only. Type of displaying for the
active camera 162 is selected in the pop up
menu of the
Shadow 172 button.
In the case of the volume projection (Within
projection):
Projection to horizontal plane of a control area 147
part, which is residing between the view area
upper 258 and lower bounds 259 specified in
parameters 253 in the Camera Geometry box 251 .
Control area horizontal projection is calculated
according to the rule:
A point on the horizontal projection is considered
visible if a vertical segment, formed by this point
in the range of heights from the view area lower
bound height 259 to the view area upper bound
height 258 , is visible wholly.

Camera Field of View
A flat figure limited by view area bounds and residing in a
plane, perpendicular to the main optical axis of camera
lens.
The field of view has rectangular form only if lens
distortion 429 is negligible. The lens distortion complicates
the form of the field of view.

Image sensor size and size of active area of the image sensor
The Image sensor size in VideoCAD implies the size of the entire light sensitive area of the
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image sensor, which can form an image with the maximum number of pixels horizontally and
vertically.
Active area of the image sensor in VideoCAD implies an area of image sensor on which in a
given mode of the camera the image is formed. The sizes of the active area may be less than or
equal to the image sensor size. Active area can differ in different modes of operation of the same
camera.
Exactly the active area size and lens focal length 256 determines the angles of view, and
through them influences on the results of camera modeling. Accuracy of specifying the active
area size greatly affects the accuracy of modeling the camera.
Aspect ratio of the active area of image sensor is identical with the aspect ratio of the
output image of the camera, but can differ from the aspect ratio of the image sensor.
On the figure on the right you can see the image
sensor size and the active area of the image
sensor in case of the image sensor has aspect
ratio of 4:3, but the output image from the camera
has aspect ratio of 16:9.

See also: Specifying active area size of the image sensor 415

Camera tilt angle
Camera tilt angle is a calculated parameter and can not be edited directly. The camera tilt angle
is an angle between the main optical axis of camera lens and a horizontal.
Camera inclination is defined not by the tilt angle
but by the three parameters:
Height of installation 257 ;
View area upper bound distance 260
View area upper bound height 258

Background
It is a prepared horizontal site plan in any of the following formats:
*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.pdf - cross-platform electronic document format from Adobe Systems;
*.jpg, *.png, *.gif, *.tif - the compressed image (e.g., a digital picture of the plan, scanned
image);
*.wmf, *.emf, *.emf+ - Windows Metafile (export to *.wmf is supported by the majority of the
Windows graphics applications).
Over the background, cameras, constructions and 3D models can be drawn.
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

150

VideoCAD Lite

Compatiability with AutoCAD versions
VideoCAD 8.0 can use files of the following CAD formats as a background:
*.dxf AutoDesk DXF Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006, 2007, 2008, 2009, 2010,
2011, 2012, 2013, 2014, 2015.
*.dwg AutoDesk DWG Release 12, 13, 14 , 2000, 2002, 2004, 2005, 2006, 2007, 2008, 2009,
2010, 2011, 2012, 2013, 2014, 2015.

Software registration by personal registration code (applied for all versions
except VideoCAD Professional)
After installing the program you must enter personal pair of the name and the registration code,
which is valid on any computer. USB dongle is not required.
If the license provides limited number of workplaces, attempt to run the program on more
computers may produce error.

Software registration on USB Dongle basis (applied for VideoCAD
Professional)
The program is operable on any computers to which port the dongle is connected. So you can
carry the program from computer to computer, modernize computer, etc.
In the past USB dongle was used for VideoCAD6, VideoCAD 7 Lite, VideoCAD 7 Professional.
Now it is used for VideoCAD 8 Professional only.
When you purchase a new license of VideoCAD 8 Professional Kit, one license of VideoCAD 8
Lite 31 can be supplemented free of charge. This minimizes the inconvenience of having to use
the USB dongle with VideoCAD Professional.
The dongle should be connected to the USB port of you computer.

Software protection on HID identifiers basis (not used for new licenses)
In the past HID protection was used for VideoCAD1..VideoCAD6, VideoCAD 7 Lite. Now it is not
used for new licenses.
The registration is realized with the tie to your computer parameters. After computer change, hard
disk formatting or other serious upgrade you will need a reserve registration.
Although the number of reserve registrations is limited to two, the registration counter cleaning is
regularly realized. So you won't lose the purchased program in any case. If you spend all reserve
registrations before the registration counter cleaning, you will have to wait for the next registration
counter cleaning to continue using the program.
You may exchange the variant on the HID protection to the variant with the dongle protection,
paying in addition for the cost of the dongle and delivery.
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Getting started
These illustrated teaching articles with step by step instructions will help you to get started with
VideoCAD quickly:
These articles describe work ing with the Professional version.
The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
The principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification
area, license plate reading area. Spatial resolution.""(*.pdf)
The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
The principles of CCTV design in VideoCAD. Part 4. Illumination and camera sensitivity in CCTV"(*.
pdf)
The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving objects."(*.pdf)
The principles of CCTV design in VideoCAD. Part 6. Lens distortion in CCTV design."(*.pdf)
See also: Examples of work with VideoCAD 353 , CCTVCAD Software on Youtube
VideoCAD employs a context-sensitive help system. This means that the program tries to direct
you to the portion of the help system that is most likely to answer your question, based on what you
are viewing or doing.
To get detailed information about any component, box or menu item, move the input focus (mouse
cursor) to the component and press F1.
To get detailed information about any button on the Tool bar, right click on it then choose What's

this? pop-up item.
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Interface
The VideoCAD Lite interface consists of the Graphics window 158 and the additional
windows and boxes:
Camera Geometry 251
Sensor and Lens 267
Spatial resolution 272
3D Video 284
3D Models 291
Monitor window 294
Table of Camera Models 304
Options box 319
Camera list 336
Serial numeration of cameras 338
Layouts 340
Signal cable length calculation box 341
Power cable electrical parameters and length calculation box 342
Length calculation of line segments 343
Image sensor calculator 349
You can open any window or box from the Graphics window.
VideoCAD employs a context-sensitive help system. This means that the program tries to direct
you to the portion of the help system that is most likely to answer your question, based on what you
are viewing or doing.
To get detailed information about any component or menu item, move the input focus (mouse cursor)
to the component and press F1.
To get detailed information about any button on the Tool bar, right click on it then choose What's
this? pop-up item.
Mouse:
Any Wheel Mouse is particularly convenient when changing parameters and moving along layouts in
the graphics window.
In all the windows except for the Graphics window the use of mouse is almost the same as when
using it with other Windows programs. The use of mouse in the graphics window is reviewed in the
correspondent HELP section 159 .
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Graphics window

It is the main window of the program.
The window is designed for the visual cameras' view area representation and analysis, visual choice
of lens parameters and camera locations, calculation of cable parameters and a 2D drawing
preparation to be pasted into graphical path of the project.
During 3D modeling 284 , all work of placing and editing 3D models is carried out in the Graphics
window too.
The graphics window contains:
Graphics area 159
Main menu 197
Tool bar 164
Status bar 243
Line type panel 245
Font type panel 246
Current construction parameters panel 247
Layout tabs 242
Horizontal and vertical scroll bars
Snap panel 229
Keyboard shortcuts 249
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Graphics area
See Graphics area location 158 .
The graphics area contains two projections of the current layout 340 .
A thick black line designating the ground in vertical (upper) projection parts these two projections.
You can hide any projection using the tools Hide horizontal projection 176
projection 176
or using the corresponding items of the Main menu 197 .

and Hide vertical

Main work is carried out as a rule in the horizontal projection. Vertical projection is used only in
some cases.
Navigation 159
Coordinate systems 160
Types of objects 160
Possible states of objects 160
Normal state 160
Selected state 161
Editing state ( active state of cameras ) 161
Hidden state 163

Navigation
Wheel Mouse is particularly convenient when working in the graphics window. Using the Wheel
mouse you can change drawing scale with the simultaneous zooming in the drawing sections
pointed by the cursor.
If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation.
If Ctrl is pressed, the scale changes with the less step which is convenient for the precise drawing
positioning before printing 207 or saving 202 .
The Step and direction of scaling can be changed in wide range via Scale factor 333 in the Options
box.
You can move the drawing by pressing and holding down the mouse wheel (or the middle
button). If Ctrl is not pressed, the entire drawing is dragged, if Ctrl is pressed, the horizontal
projection is dragged only.
You can move drawing using horizontal and vertical scroll bars.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
To increase any screen area press in the corner of the
area and hold the right mouse button then move the
mouse with the right button pressed. At the same
time you will see zoom window. After releasing the
button, the area inside the zoom window will be shown
on the full screen.
There is an opportunity of quick navigation with the help of text markers 219 .
Since all the constructions in VideoCAD are made by two clicks, but not by pressing and release
the mouse button (as in most CAD programs), so it is very convenient to combine constructions

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

160

VideoCAD Lite

with quick navigation.
To show all cameras and constructions, use item of the Main menu or Pop-up menu: Scale>
Show all 219 .

Coordinate systems
The graphics area allows to use 2 coordinate systems 218 :
Fixed coordinate system
Float coordinate system attached to the Active camera

162

In case of Fixed coordinate system, the origin of coordinates does not vary when changing the
active camera. The origin of coordinates is displayed by two icons
in horizontal and vertical
projections. You can change a point of origin after choosing the menu item View > Set origin 218 .
In case of the coordinate system attached to the active camera, the origin always coincides
with the active camera location. It is convenient when studying its view area.
A grid 176 is fixed to the origin of coordinates, and the counting of the cursor current
coordinates in the status bar 243 starts from the origin.

Types of objects
The graphics area may contain the following objects:
Cameras
Constructions 181
3D objects 229
Backgrounds 204
Cables 238
Texts 189
Titles 216

Possible states of objects
All the objects except for the backgrounds and titles can take one of the following states:
Normal 160 ;
Selected 161 ;
Editing 161 (active state of camera);
Hidden 163 ;
You can change object's state with the help of the Select/Edit 177
To hide objects use the Hide 236 Main menu item.

tool.

Normal state
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An object is displayed in its usual color. Editing
and moving is not possible.

Selected state
An object is displayed in pink color. It is
possible to delete, drag, move, rotate,
change draw order, scale, mirror and copy
the object.
Several objects can be selected at a time.
You can select objects by clicking or by
capturing by the selection window in the
Select/Edit 177
mode.
See Select/Edit 177 for details.

Editing state ( active state of cameras )
Object's base points are marked with pink
grips, camera name and icon are marked
with red color, texts are displayed in pop-up
frame.

In the editing state, 3D models 190 are
displayed with square grips and pink circle.
The editing state can be taken only by one of
the objects and one camera at a time.
One of the cameras is always Active.
Switching an object to the editing state is
performed by double clicking the object in the
Select/Edit 177
mode.
To switch circle 225 into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
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To switch arc 226 into the editing state you need to double-click on its center or on either of its
two ends.
How to edit objects

You can change the shape and geometrical sizes of the objects and edit the texts. The line
types 245 of the objects and the fonts 246 of the texts can be changed, too.
To edit an object click beside a base point with a grip and move the cursor. After clicking for
the second time, the changed object will be saved.
When on one side of a construction a circle appears, the construction can be rotated around
its axis by gripping the circle by the mouse.
When editing a rectangle 184 or a mask 189 , then several points will move at a time, the
rectangle or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
When editing the Double line 185 or Wall 186 , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved.
When clicking the text 189 twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.
You can rotate the 3D model by the mouse using the circle, scale 3D model on X and Y axis
using the square grips. You can move the 3D model by pressing the left mouse button on the
3D model, as well as in the selected state.. Sizes of 3D models can be edited with the help of
the Current construction parameter 247 panel or by changing line type 245 .
It is possible to change object's parameters in editing state on the current construction
parameters panel 247 which automatically appears in the bottom of graphics window.
You can edit the object by changing parameters on the panel.

Active camera
Pay attention that the icon of one of cameras is highlighted in red, and icons of other
cameras are colorless. One of cameras is always active.
The active camera parameters are
displayed in the Camera Geometry box 251
, Spatial resolution 272 .
The active camera itself is displayed on
the foreground in the Graphics window.

In the 3D Video 284 there is an image from the active camera.
To switch camera to active state double-click on the center of its
lens.
You can fast activate any camera in the project using the Active
camera 167 combo box on the Tool bar. To activate a camera,
just choose its name in the list.
To find the active camera on the layout, right click on the combo
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box then choose Find camera item.
The active camera parameters can be changed both using the boxes and graphically with the
tools of the Active camera group 195 . With the help of the View 167 button group you can
change the appearance of view area projections of the active camera.
For tilting and panning the active camera on the layout in Select /edit 177 mode:
Move the cursor to the pink grip in the middle of the view area
bound. Thereupon, the point will be outlined by red square;
Click on it by mouse;
Move the cursor;
To stop tilting or panning click once again on a point where the
middle of the view area bound is to be located.
To change lens focal length 256 of the active camera on the layout in Select /edit 177
mode:
Move the cursor to any orange grip on the ends of view area
bound. Thereupon, the point will be outlined by red square;
Click on it by mouse;
Move the cursor;
To stop changing focal length click once again on a point where
the end of view area bound is to be located.

Hidden state
An object is displayed on the background in light
grey color. 3D objects are displayed as grey
frames. The rest characteristics are similar to those
of normal state.
The hidden state is used to conceal the
temporarily interfering objects.
Constructions in the hidden state is not exported
to AutoCAD formats 202 .
The snap Extension 229 is disabled for hidden
objects.
Several objects can be hidden at a time.
To hide an object use Select/Edit 177 and Hide 236
tools.
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Tool bar

See Tool bar location 158 .
Visibility of buttons on the Tool bar can be adjusted on the Toolbar 332 tab of the Options box.
'Project' button group 166

"Edit" button group 177

Save project 166

Stop operation 177
Erase 177
Select/Edit 177
Cut 179
Copy 180
Paste 180
Move 180
Rotate 180
Scale 181
Mirror 181

"Camera" button group 166
New 166
Save to project 167
Camera list 167
Combo box Active camera
167

"View" button group 167
View area edges 167
View area projection
bounds 168
Fill projections 169
Spatial resolution 170
Shadow 172
3D view area 174
Combo box Model of active
camera 174
Table of camera models

"Construction" button
group 181
Point 182
Horizontal line 182
Vertical line 182
Line segment 183
Polyline 183
Angle 183
Rectangle 184
Inclined rectangle

175

Combo box Lens focal
length 175
Camera Geometry 176
Spatial resolution 176
3D Video 176
Monitor window 176
Hide vertical projection

184

Double line 185
Wall 186
Aperture in Wall 187
Circle 187
Arc 188

Text 189
Mask 189
Filling 189
3D model 190
3D image 191
Rotakin 192
Signal cable 193
Power cable 193
Global snaps 194
"Active camera" control
element group 195
Change installation
height 195
Change view area
upper bound 195
Change view area
lower bound 195
"Scale" button group 195
Move drawing 195
Zoom in/zoom
out 195
'Undo' button group 196
Undo 196
Redo 196

176

Hide horizontal
projection 176
"Grid" control element
group 176
Grid selected step box
176

ON/OFF mode of
automatic grid step
selection 177
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Tools

See Tool bar location 158 .
Visibility of buttons on the Tool bar can be adjusted on the Toolbar 332 tab of the Options box.

'Project' button group
Save project
Save working project to a file.

"Camera" button group
New
Create new camera with default parameters.
In the dialog box appeared you can change
camera number, name, type of the camera
which determines the kind of icon by which it
will be displayed. If necessary, you can enter
additional information on the created camera
(for example: purpose, a place and features of
installation).

Later it is possible to change name, number, type of the camera and the additional information in
the Camera list 336 box.
Cameras can be numerated sequentially with the help of the Numerate cameras 201 tool.
Cameras are displayed by different icons only if the Display camera type box in the Options box
319 is mark ed.
On the Line type panel 245 it is possible to choose line type 320 by which the icon of the camera
and View area projection bounds 168 will be drawn. When displaying spatial resolution 170 is
disabled, projection will be filled 169 (hatched) by the color of assigned line type. Later it is possible
to change line type using Change line type 237 tool.
Hatch style 169 is determined by style of a line type 320 , assigned to the camera (solid, dash, dot,
dash dot etc.).
After entering all necessary data click OK, to cancel the operation click Cancel.
If there is already a camera with chosen number in the current project, VideoCAD will ask to
specify, whether you would like to rewrite it.
After camera creation specify by clicking a place for the new camera on the layout.
Just after camera creation the moving mode will be switched on. When placing will be completed,
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Select/Edit 177 button or press ESC.

It is convenient to create new cameras with already set parameters by copying 180 and pasting 180
existing ones.

Save to project
All the specified and calculated parameters of the Active camera 162 and layout are saved to
the current project.
Saving is performed automatically at many operations.

Camera list
Clicking this button opens Camera list box, in which camera list of current project is displayed.
Active camera 162 is highlighted by red frame. Any camera can be activated, removed, renamed,
found on layouts, it is possible to show 3D image from any camera. It is also possible to sort
cameras in the list. For carrying out any manipulations with the camera first select its name in the
list by single clicking.
See more: Camera list 336

Active camera combo box
Using the combo box, you can fast activate any camera in the project. To activate a camera, just
choose its name in the list.
To find the active camera on the layout, right click on the combo box then choose Find camera
item.

"View" button group
View area edges
Show the Active camera view area edges, calculated according to parameters 253 in the Camera
Geometry box.
Line type can be changed in the options box 320 .
When View area projection bounds 168 is
disabled, but Shadows 172 is enabled, the View
area edges 168 is shown simplified in the form
of two rays.
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If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box, then for this camera the line
type of View area edges is taken from the
Options box>Lines>System line types>Bounds
320 . This line type is assigned to new cameras
by default (Camera 32 on the figure).
Default line type for cameras is Line 21.
If another line type was assigned to the
camera, the View area edges of this camera is
drawn by this line type assigned to the camera,
as well as the View area projection bounds 169
and camera icon. (Camera 33...38).
Thus you can draw different cameras and their
view areas by different colors, thickness and
line style.
In VideoCAD Lite the View area edges are
visible in the 3D Video 284 window as lines
when 3D view areas 174 is enabled and the 3D
view areas 288 menu item is marked.
A button state at the moment of camera saving determines whether the view area edges of the
given camera will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the active camera, this button changes
view
and operates the visibility of View area edges of all selected cameras simultaneously.

View area projection bounds
Show the bounds of the Active camera view area projections calculated according to parameters
253 in the Camera Geometry box.
Submenu of the button:
1.
Projection - show View area projection
bounds of the active camera.
Projection is calculated according to a
simple rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of
heights from the view area lower bound
height 259 to the view area upper bound
height 258 , is visible wholly.

Difference between the View area projection bounds and Shadows 172 buttons is that the View
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

169

area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
2. Off. - don't show.
When View area projection bounds is disabled, but Shadows 172 is enabled, the View area
edges 168 is shown simplified in the form of two rays.
If the line type of camera 166 coincides with default line type for camera icons, specified in the
Options box 327 , then for this camera the line type of View area projection bounds is tak en
from the Options box>Lines>System line types>Bounds 320 . This line type is assigned to new
cameras by default.
If another line type was assigned to the camera, the View area projection bounds of this
camera is drawn by this line type assigned to the camera, as well as the View area edges 168 and
camera icon.
A button state at the moment of camera saving determines whether the bounds of the given
camera view area projections will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the active camera, this button changes
view
and operates the visibility of View area projection bounds of all selected cameras
simultaneously.

Fill projections
Hatch or fill by blend color view area projections of active camera 162 ( if these projections exist)
calculated according to parameters in the Camera Geometry 253 box.
If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box 327 , then hatching (filling)
projections of this camera is performed by grey
color by default (Camera 30 on the figure).
If another line type was assigned to the
camera, then hatching (filling) projections of
this camera is performed by a color of this line
type assigned to the camera. (Camera 41,42).
If the Spatial resolution 170 is enabled, then
colors of hatching (filling) projections is
determined by Spatial resolution parameters
(Camera 43).

Drop-down menu:
1.

H a tc hing - hatch projections.

2.

Filling - fill projections by blend semitransparent color.
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If the Hatching item is chosen, but in the dropdown menu of the Spatial resolution 170 button
the Gradient item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.
Transparence of filling in the Graphics window
and the 3D Video 288 can be adjusted in the
Options box.
3. Off - don't hatch and fill view area projections.
If Off is chosen in the Fill projections and
Shadows 172 , then filling view area faces in the
3D Video 288 is not shown.
If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box, then for this camera Filling is
performed by Gray color and Hatching by
DiagCross style. (Camera 32)
Default line type for cameras is Line 21.
If another line type was assigned to the
camera, then for this camera filling is
performed by a color determined by color of
the line type and hatch style is determined by
style of the line type (Camera 33...38).
Thus you can fill and hatch projections of
different cameras by different colors and hatch
styles.
A button state at the moment of camera saving determines whether the filling or hatching of the
view area projections of the camera will be displayed when this camera is inactive.
If selected cameras exist on the layout, except the active camera, this button changes view
and operates the visibility of filling (hatching) projections of all selected cameras simultaneously.

Spatial resolution
Fill in different colors regions on the view area projections of the active camera, depending on
the spatial resolution within these regions.
Colors of the regions and the boundary values of the spatial resolution are determined by the
spatial resolution pattern assigned to the camera.
In the Spatial resolution box 272 you can edit the patterns and assign them to cameras.
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Drop-down menu:
1.
D is c re te c o lo rs - fill the regions in discrete colors in accordance with a spatial resolution
at the far bounds of the regions.
2.
Gradient - fill the view area projection in gradient color according to the spatial resolution at
each point on the projection.
In case of gradient color is chosen, the colors at the far region bounds equal to the colors of the
spatial resolution pattern, but between the bounds color changes smoothly, as well as real
spatial resolution.
Gradient reflects the spatial resolution more accurately and look s impressive, but discrete colors
are more intuitive and easy to use..
If the Gradient item is chosen, but in the
drop-down menu of the Fill projections 169
button the Hatching item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.

Calculation of gradient demands a lot of resources and increases redraw time.
3. Off. - don't display spatial resolution

In the Dome 172 mode the Spatial resolution is calculated without tak ing into account pan and tilt
angles of camera. It is assumed that the camera can pan and tilt freely, and spatial resolution is
calculated at the center of the field of view.
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The Spatial resolution button controls
displaying spatial resolution on 3D View areas
174 in the 3D Video 288 .

A button state at the moment of camera saving determines whether the spatial resolution of the
camera will be displayed when this camera is inactive.
If selected cameras exist on the layout, except the Active camera 162 , this button changes view
( ) and operates the visibility of spatial resolution of all selected cameras simultaneously.
See also: Spatial resolution box 272 , Visualization of the camera control area projections and
spatial resolution within them 381 .

Shadow
Display horizontal projection of the view area of
the active camera taking into account
shading from constructions 181 .

Shadows - a powerful yet easy-to-use tool of VideoCAD. Shadows are calculated for all
positions of cameras, shading objects can be located at any point of space. You should only
enable calculation of shadows with the help of this button.
Shading takes into account the camera installation height and all 3 coordinate of constructions
(including heights).
Drop-down menu:
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Within projection - display view area
projection taking into account shadows.
Shading is calculated according to a rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height 259
to the view area upper bound height 258 , is
visible wholly.
By the same rule the horizontal projections 168
of view area are calculated. Changing the height
of the lower and upper bounds of view area
could change conditions of calculation of
shading.

2.
Dome - display projection of the territory
controlled by the camera in 360 degrees,
without view area borders, but only taking into
account the shadowing.
When the Dome item is chosen, actually the
control area of a dome (PTZ) camera is
displayed.
The Dome mode is also useful for choosing the
best installation place for fixed cameras to
make required areas reachable for the cameras.
In the Dome mode all shaded areas from the
specified camera position become visible.
In the Dome mode the Spatial resolution 170 is
calculated without taking into account pan and
tilt angles of camera. It is assumed that the
camera can pan and tilt freely, and spatial
resolution is calculated at the center of the field
of view
.

In the Graphics window calculation of shadows
in the Dome mode is performed lik e in the
Within projection 173 mode, ie according to the
rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height 259
to the view area upper bound height 258 , is
visible wholly.
3. Off - disable shadow calculation and displaying.
Difference between the Shadows and View area projection bounds 168 buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
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considering obstacles. Both buttons can be used simultaneously in various combinations.
The Shadow button work s in conjunction with the Spatial resolution 170
and the Fill
169
projections
buttons. Depending on the state of these buttons, shadows can be
displayed in different ways: as filling, as shading, as a border lines, with mapping spatial resolution
or not.
The calculation of shading - resource-intensive operation. During the shadow calculation on
the Shadow button red frame flashes .
Automatic shadow calculation is performed only for the active 163 camera. To recalculate shading
for a particular camera - activate this camera. To recalculate shading for all selected cameras,
click Main Menu>View>Recalculate shadows 215 .
To temporarily disable the automatic calculation of shading (k eeping already calculated shadows
visible) clear the item Main menu>View>Calculate shadows for active camera 215 .
Whether or not a specific construction takes into account in the calculation of shading determines
by the Shadow 320 checkbox of the line type used for the construction.
.

A button state at the moment of camera saving determines whether the shadows of the camera will
be displayed when this camera is inactive.
If selected cameras exist on the layout, except the Active camera 162 , this button changes view
(
and operates the visibility of shadows of all selected cameras simultaneously.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Options box>Miscellaneous>Shadow
333 , Choosing the best place for PTZ (dome) camera 384 , Visualization of the camera control area
projections and spatial resolution within them 381

3D view area
Show 3D transparent view area in the 3D Video
window.
The 3D Video>Main menu>View>3D View
areas menu item must be mark ed.
See details: 3D Video>Main menu>View>3D
View areas 288

Button state at the moment of camera saving determines whether the 3D view area of the given
camera will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the Active camera 162 , this button changes
view
and operates the visibility of 3D view areas of all selected cameras simultaneously.

Model of active camera
Using this combo box, you can choose a model for the Active camera 162 .
The list consists of two parts:
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Under =Used models = header there are camera models listed which are already used in the
project . All parameters of these models can be seen on Used models tab in the Table of camera
models 304 .
Under =All models = header there are all camera models listed which are available in the
database of models. Parameters of these models can be seen and edited on All models tab in the
Table of camera models.
To assign a model, just choose its name in the list.
As a result of model assignment to the active camera, model parameter values will be assigned to
parameters of the active camera. After that changing some parameters will be locked.
There is =Unassigned = string in the bottom of the list. Choose this string if it is necessary to
remove model assignment from the active camera. As a result of removing model assignment all
parameters of the active camera will be unlocked and can be changed.
You can change model of all selected cameras simultaneously. For this purpose:
Select 177 necessary cameras on the layout
Right click on this combo box, then click on the Assign to selected cameras pop up item.
See more: Table of camera models 304

Table of camera models
Show Table of camera models. In this table it is possible to adjust parameters of camera models
and assign any model to the Active camera 162 . The table can be exported to *.txt, *.csv, *.htm, *.
rtf, *.xls formats.
See more: Table of camera models 304

Lens focal length combo box
The box duplicates a corresponding box 256 in the Camera Geometry box to enhance the
convenience when using the graphics window.
When moving the cursor to the box with a lens focal length the information on the lens view
angles appears.
If a model 304 is assigned to the camera, and the model has fixed 316 focal length lens, then you
can not change the focal length.
If a model is assigned to the camera, and the model has a lens with limited 317 variable focal
length, then you can change focal length within the limits only. When approach to the limit values,
the box will become crimson.
You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned
model or the assigned model have not specified limits of the lens focal length.
If the active camera is panoramic 269 then the lens focal length box is colored by aqua-green.

You can change lens focal length of all selected cameras simultaneously. For this purpose:
Select 177 necessary cameras on the layout
Right click on this combo box, then click on the Assign to selected cameras pop up item.
See more: Lens focal length 256
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Camera geometry
Clicking this button will open Camera Geometry box 251 . This box includes geometric parameters of
the camera, lens and installation parameters of the camera.
See more: Camera geometry box 251

Spatial resolution
Show or hide the Spatial resolution box 272 . In this box it is possible to create and edit patterns of
spatial resolution and field of view size visualization. In the box there are prepared spatial resolution
patterns according to the following criteria: Home Office Scientific Development Branch, Home
Office Guidelines for identification, P 78.36.008-99, Australian Standard AS4806: Closed Circuit
Television, European Standard EN 50132-7, ISO/IEC 19794 Biometric data interchange formats.
Also in the box there are examples of images are automatically displayed for each region of spatial
resolution.
See more. Spatial resolution box 272 , Spatial resolution button 170 .

3D Video
Show or hide the 3D Video window. The 3D Video displays the image from the Active camera 162 .
During the image generation in the 3D Video window on the 3D Video button red frame flashes
.
See more: 3D Video 284 .

Monitor window
Show or hide Monitor window. In the Monitor window images from any quantity of cameras are
displayed simultaneously. Monitor window allows modeling monitors of video surveillance system.
See more: Monitor window 294 .

Hide vertical projection
If this button is pressed, the horizontal projection is only present in the graphics area.
To display a vertical projection click this button again.

Hide horizontal projection
If this button is pressed, the vertical projection is only present in the graphics area. To display
a horizontal projection click this button again.

"Grid" control element group
The graphics area 159 includes 2 grids with the coinciding horizontal coordinates: a grid in the
vertical projection and a grid in the horizontal projection. The grid origin coincides with the
chosen origin of coordinates 218 .

Grid selected step box
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To change a grid step click the box and choose the required step from the pop-up list.
If the automatic step selection mode is active when changing the step value in the box this mode
is deactivated.
See also: "Grid" control element group 176

ON/OFF the automatic grid step selection mode
Switch on/off the mode of automatic grid step selection according to a drawing scale.
See also: "Grid" control element group 176

ON/OFF displaying grid
Switch on/off displaying grid.
Choosing NO in the grid step selection box can also deactivate grid displaying.
See also: "Grid" control element group 176

"Edit" button group
Buttons of this group are used for the editing constructions 181 , 3D objects 229 , cables 193 , texts
189 and cameras. In this case the status bar 243 in the bottom of the Graphics window displays
hints.
When editing an object the projections should be tak en into account. Different projections are
different views, though connected ones. Moving objects correctly between projections has no
sense and is impossible to perform.
To start the editing select 177 the desired objects. An object can be inaccessible for selection if it
belongs to a not enabled layer
Choosing the items from the pop-up menu that appears when click ing the graphics area 159 by the
right mouse button performs the commands of this group as well.

Stop operation
Stop the current operation. Use also Esc.

Erase
Erase the selected objects 161 . To select objects use the button Select/Edit 177 .
If there are no selected objects this button is disabled.
Use also Del.
You can not erase the Active camera 162 .

Select/Edit
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With this button chosen the first corner of
selection window appears when clicking any
empty place of graphics area 159 once. Clicking
it again completes the designation of selection
window.
All the objects, which hit in the selection
window and reside on the projection
coinciding with one being clicked for the first
time, will be selected 161 . However, the earlier
selected objects not hitting in the selection
window will revert to normal state 160 .

If Ctrl is pressed at click ing, the objects within the selection window are inverted, on the
contrary, state of those not hitting in the selection window remains the same.
It is possible to select objects by one by clicking their image once, thus enabling the earlier
selected objects to revert to normal state.
If Ctrl is pressed at click ing, the objects are inverted, and the state of the rest remains the same.
During construction 3D scenes 284 it is often necessary to place some constructions one over
another at a different height, made by means of different line types 320 .
To select one or more construction, located one over another, made by means of different
line types:
make the line type panel 245 visible, for example by double clicking any construction;
choose on the panel the line type of construction you want to select;
select the construction by clicking.
Just repeat clicking at the same place without moving the cursor. Thus objects under the cursor
will be selected sequentially.
To move objects on the foreground or background use menu items: Bring to front 236 , Send to back
236 .
Selected objects can be moved. To move the selected objects, bring the cursor to the selected
one, press the left mouse button and move the selected objects. After finishing the moving, release
left mouse button.
To cancel selection click this button again.
To select all objects on the current layout use Ctrl+A shortcut.
For switching to Select / Edit mode from any mode use also Esc button.
See also: Selected state 161
Editing state of objects
To translate an object into editing state 161 double-click its
image. After that pink grips appear on the object base points.
When moving the cursor over this point its image changes.

To edit an object click beside a base point with a grip and move the cursor. After clicking for the
second time, the changed object is set up.
If on one side of a construction a circle is displayed, the construction can be rotated around its
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axis by gripping the circle by mouse.
To switch the circle 225 into the editing state you need to double-click on its center or on the
point on its radius that appears during the process of construction.
To switch the arc 226 into the editing state you need to double-click on its center or on either of
its two ends.
When editing a rectangle 184 or a mask 189 , then several points will move at a time, the rectangle
or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
When editing a Double line 185 or Wall 186 , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved.
When clicking the text 189 twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.
In the editing state, 3D models 190 are displayed with square
grips and pink circle.
You can rotate the 3D model by the mouse using the circle,
scale 3D model on X and Y axis using the square grips. You can
move the 3D model by pressing the left mouse button on the 3D
model, as well as in the selected state.
It is possible to change object's parameters in editing state on the current construction
parameters panel 247 which automatically appears in the bottom of graphics window.
See also: Editing state 161

Activate cameras
When double-clicking the camera lens the following actions are performed:
the Active camera 162 is saved.
the camera being double-clicked will become active.
It is convenient to pan and tilt the active camera by moving the grip in the middle of the view area
upper bound.
In a similar way by moving grips on the ends of the view area upper bound it is possible to
change lens focal length 256 of the camera.
If a model 304 is assigned to the camera, the focal length changing is possible only in the limits
specified in model parameters 317 .
See also: Active camera 162

See also: "Edit" button group 177

Cut
Cut the selected objects 161 into the VideoCAD internal clipboard.
It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions 181 , 3D objects 229 , cameras
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Copy
Copy the selected objects 161 into the VideoCAD internal clipboard.
It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions 181 , 3D objects 229 , texts 189 and cables.
See also: Copy with base point 234 .

Paste
Paste the objects from the VideoCAD internal clipboard.
After clicking this button specify the base point of paste in the projection being clicked when
cutting or copying.
It is possible to paste into different layouts 340 , paste cables of one camera while another camera
is active (in this case the pasted cables belong to a camera which is active during paste), and to
paste any quantity of constructions 181 , 3D objects 229 , cameras, texts 189 and cables at a time.
It is available to copy and paste constructions, cables and texts between the projects. To this
effect make a copy in one project, then open another project or create a new one and paste what
you have copied.
Be careful when copying and pasting cables. You can copy only cables of Active camera 162 ,
and when pasting, these cables will belong to the camera which is active during pasting.
If a camera is being pasted a new camera with parameters of the pasted camera is created
automatically. This is an alternative way to create new cameras.
Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but pasted
camera doesn't become active. Therefore the view area of the pasted camera is displayed without
shadows. To calculate shadows - activate 162 the camera after pasting.

Move
Move the selected objects 161 .
After clicking this button the first click in a graphics area 159 designates the starting moving point,
the second click - the final one.
When moving tak e into account the projection to which the objects are attached. A simultaneous
moving objects in different projections vertically is lock ed as being incorrect.
Selected 161 objects or cameras can be moved in Select / edit 177 mode. In order to move place
the cursor above the selected object, press left mouse button, move, after moving is finished
release the left mouse button.
Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but moved
camera can be not active. If the camera is not active, the view area of the moved camera is
displayed with old shadows. To recalculate shadows - activate 162 the camera after moving.

Rotate
Rotate the selected objects 161 .
After clicking this button the first click in a graphics area 159 designates the rotation center, the
second click specifies the initial rotating point, and the third click specifies the final rotating point.
When rotating tak e into account the projection to which the objects are attached. The selected
objects, attached to the projection with a rotation center designated, can rotate only.
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The scalable 322 fonts can rotate only. If a font is not scalable then its initial point rotates only,
the text remaining horizontal.
The Active camera 162 can be rotated in Select / edit 177 mode by moving the grip in the middle of
the view area upper bound.
Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but rotated
camera can be not active. If the camera is not active, the view area of the rotated camera is
displayed with old shadows. To recalculate shadows - activate 162 the camera after rotating.

Scale
Change scale of selected 161 constructions relative to the center of scaling.
After clicking on this button, the first click on the graphics area 159 specifies the center of scaling
.
Then moving the cursor up increases sizes of selected constructions, moving the cursor down
decreases sizes of selected constructions.
In the Status bar 243 the current scale factor is displayed.
When required sizes will be achieved, click for the second time to complete scaling operation. To
cancel the scaling press ESC.
This tool does not scale 3D models 190 . 3D models can be scaled in editing state 161 with the help
of the Current construction parameter panel 248 .

Mirror
Mirror the selected 161 constructions relative to the horizontal or vertical line passing through the
specified point.
After clicking on this button, the first click on the graphics area 159 specifies the point through
which a mirror line must be passed.
Then moving the cursor changes position of the mirror line.
When required position of the mirroring objects will be achieved, click for the second time to
complete mirroring operation. To cancel mirroring press ESC.

"Constructions" button group
Buttons of this group are used to perform measurements and constructions. The status bar 243
in the bottom of the Graphics window and the Current construction parameter panel 247 display the
results of measurements. The constructions can be used for 3D modeling the video surveillance
object, for specifying the required view areas, objects, obstacles, etc.
Each construction is attached to the projection containing its initial point. The constructions can
be moved, deleted, rotated, edited, copied, mirrored , scaled, changed draw order, hidden
using the buttons of Edit 177 group.
Constructions made in the horizontal projection are also displayed in the 3D Video 284 . At this, the
line corresponds to a vertical rectangle, the point - to a vertical segment, the rectangle - to a
parallelepiped, circle - to a cylinder, etc.
Constructions are stretched throughout the height and become 3D objects.
Minimal and maximal height of each object is determined by parameters of line type 320 , by which
the construction is made. The heights can be set separately for each object, during constructing
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and editing by means of current construction parameters panel 247 . Heights of constructions are
calculated relative to base height of a layer to which the construction belongs.
Color of constructions is determined only by line type 320 , which is used at constructing.
To enhance speed and convenience of drawing, VideoCAD uses global and local snaps 229 .
The construction coordinates are displayed relatively to the chosen origin of coordinates 218 . The
coordinates of constructions belonging to one camera only (focal plane 166 , optical axis 166 ,
field-of-view size 166 , test object 166 ,change view area upper bound 195 ) are always displayed
relatively to the Active camera 162 .
When choosing a button of this group a line type panel 245 or a font type panel 246 appear, allowing
to change the line 320 or font 322 types.
When double-click ing the panels the options box 319 appears.
Above these panels the current construction parameters panel
possible to create construction, by setting its parameters.

247 appears,

by means of which it is

Point
When this button is pressed, clicking on the graphics area places a point.
The status bar 243 displays the coordinates of this point relatively to the origin of coordinates 218 .
In the 3D Video 284 the vertical segment will be displayed in the points place.
Default minimal and maximal heights of the segment are determined by the line type 320 , which
constructs the point. The heights can be set separately for each point by means of the current
construction parameters panel 247 , on which it is also possible to set coordinates of the point in
numeric values.
See also: "Constructions" button group 181

Horizontal line
When this button is pressed, clicking on the graphics area 159 specifies a point through which a
horizontal line is passes.
The status bar 243 displays the line height or its shift from the origin of coordinates 218 according
to the projection being clicked.
In the 3D Video 284 at the place of the horizontal line 2 horizontal lines will be displayed.
Default minimal and maximal heights of the lines are determined by the line type 320 , which
constructs the horizontal line. The heights can be set separately for each horizontal line by means
of current construction parameters panel 247 , on which it is also possible to set coordinates of the
horizontal line in numeric values.
See also: "Constructions" button group 181

Vertical line
When this button is pressed, clicking on the graphics area 159 specifies a point through which a
vertical line is passes.
The status bar 243 displays the distance from the origin of coordinates 218 .
In the 3D Video 284 at the place of the vertical line 2 horizontal lines will be displayed.
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Default minimal and maximal heights of the lines are determined by the line type 320 , which
constructs the vertical line. The heights can be set separately for each vertical line by means of
the current construction parameters panel 247 , on which it is also possible to set coordinates of the
vertical line in numeric values.
See also: "Constructions" button group 181

Line segment
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
line segment. Second clicking specifies the end point of the line segment.
The status bar 243 displays the segments length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point in it.
In the 3D Video 284 a vertical rectangle will be
displayed at the segment place.
Default minimal and maximal heights of the
rectangle are determined by the line type 320 ,
which constructs the line segment. The heights
can be set separately for each line segment by
means of current construction parameters panel
247 , on which it is also possible to set
coordinates of the line segment in numeric
values.
Color of the rectangle is determined only by line
type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
segment: coordinates of the first and second points, length, angle.
A segment can be also used to measure distances on layouts without click ing for the second
time in this case.
Line segments can be used for modeling cables with subsequent cable length calculation. Use
separate line types to draw each cable type. For length calculation use the Length calculation of
line segments 343 tool.
See also: "Constructions" button group 181

Polyline
This tool allows to draw line segments continuously. The end of each segment is the start of the
next one. To stop drawing lines, press ESC.
In other respects this tool equals to the Line segment 183 (see. above).
See also: "Constructions" button group" 181

Angle
When this button is pressed, the first clicking on the graphics area 159 specifies the vertex of an
angle. Second and third clicking specify its arms.
The status bar 243 displays the angle value in degrees.
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If the angle vertex and arms are constructed in different projections, when changing drawing
the angle is attached to the projection with its vertex.
In the 3D Video 284 2 vertical rectangles will be
displayed at the angle place.
Default minimal and maximal heights of the
rectangles are determined by the line type 320 ,
which constructs the Angle. The heights can be
set separately for each Angle by means of
current construction parameters panel 247 , on
which it is also possible to set coordinates of
the line segment in numeric values.
Color of the rectangles is determined only by
line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
angle: coordinates of the first, second, third points, length, angle value in degree.
The angle tool is also used to measure angles on layouts.
See also: "Constructions" button group 181

Rectangle
When this button is pressed, the first clicking on the graphics area 159 specifies the first corner of
a rectangle. Second clicking completes the rectangle construction.
The status bar 243 displays the information on the rectangle sizes and location.
In the 3D Video 284 a parallelepiped will be
displayed at the rectangle place.
Default minimal and maximal heights of the
parallelepiped are determined by the line type
320 , which constructs the rectangle. The
heights can be set separately for each
rectangle by means of current construction
parameters panel 247 , on which it is also
possible to set coordinates of the rectangle in
numeric values.
Color of the parallelepiped is determined only
by line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
rectangle: coordinates of the first points, height, width.
Rectangles are also used for creating rectangular horizontal planes in the 3D Video, for example
a ceiling or floor.
See also: "Constructions" button group 181

Inclined rectangle
When this button is pressed, clicking on the graphics area 159 specifies first corner of an inclined
rectangle.
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Inclined rectangle is similar to a rectangle 184
and differs from it that in 3D Video 284 it is
displayed in the form of inclined rectangle.
The minimal height of rectangle
corresponds to the lower side of this
rectangle, and the maximal height - to the
upper one.
In the Graphics window the upper side of
inclined rectangle is displayed by thick line.
For modeling complex objects it is possible to edit 177 inclined rectangle by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
Inclined rectangle can be made transparent by 70 %. For this purpose it is necessary to mark the
Transparence checkbox on the Current construction parameter panel 247 .
Inclined rectangle is very universal tool. Using the inclined rectangles it is possible to model any
3D objects.
It can be useful to combine inclined rectangles
in pairs thus to get triangles with independent
vertexes in the 3D space. Meanwhile two
vertices of each inclined rectangle must
coincide. The rest two vertices of first inclined
rectangle must coincide with the other two
vertices of second inclined rectangle.

Using obtained triangles you can theoretically
build any 3D surfaces, although it can be not
simple in practice.
For example, all 3D models in VideoCAD
consist of triangular mesh only.

See also: "Constructions" button group 181

Double line
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
double line. Second clicking specifies the end point of the double line.
The length and the width of the double line appear in the status bar 243 .
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the distance between lines of the double line.
Two buttons allow switching the orientation of the second line relatively to the first one
.
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You can also switch the orientation quickly by pressing the Space bar.
In the 3D Video 284 2 vertical rectangles will be
displayed at the double line place.
Default minimal and maximal heights of the
rectangles are determined by the line type 320 ,
which constructs the double line. The heights
can be set separately for each double line by
means of current construction parameters
panel 247 , on which it is also possible to set
coordinates of the double line in numeric
values.
Color of the rectangles is determined only by
line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
double line: coordinates of the first, second points, length, angle.
See also: "Constructions" button group 181

Wall
The Wall tool is intended for drawing walls with specified thickness and height. In these walls you
can make apertures 187 of any shape, for example for doors and windows..
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
Wall. Second clicking specifies the end point of the Wall.
The length and the width of the wall appear in the status bar 243 .
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the wall.
Two buttons allow switching the orientation of the second wall side relatively to the first one
.
You can also switch the orientation quickly by pressing the Space bar.
In the 3D Video 284 a parallelepiped will be
displayed at the wall place.
Default minimal and maximal heights of the wall
are determined by the line type 320 , which
constructs the wall. The heights can be set
separately for each wall by means of the current
construction parameters panel 247 , on which it
is also possible to set coordinates of the wall in
numeric values.
Color of the parallelepiped is determined only
by line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
wall: coordinates of the first, second points, length, angle.
In walls it is possible to mak e apertures for doors and windows using the Aperture in Wall 187 tool.
See also: "Constructions" button group 181
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Aperture in Wall
The Aperture in Wall tool designed to easily
create apertures (openings) of various shapes
in the walls, built by the Wall 186 tool.

In order to an aperture will appear in the 3D
space, it must intersect the horizontal
projection of the wall.

The Aperture in Wall tool is similar to the Inclined rectangle 184 tool. But the Inclined rectangle
creates a flat rectangle in 3D space, but the Aperture in Wall placed inside the Wall, cuts an
aperture in the wall. This aperture equals to the projection of the same flat rectangle on the plane
of the wall.
The minimal height of aperture corresponds to the lower side of this rectangle, and the
maximal height - to the upper one.
In the Graphics window the upper side of aperture is displayed by thick line.
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the aperture.
The Thickness of the wall affects only the shape of aperture projection in the Graphics window. In
the 3D Video the apertures always cut through a wall at its full thickness.
Two buttons allow switching the orientation of the second aperture side relatively to the first one
.
You can also switch the orientation quickly by pressing the Space bar.
For modeling complex apertures it is possible to edit 177 the Apertures by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
You can create complex apertures using several intersecting apertures.
See also: Wall 186 , "Constructions" button group" 181

Circle
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

188

VideoCAD Lite

When this button is pressed, the first clicking on the graphics area 159 specifies the center of a
circle. Second clicking completes the circle construction.
The status bar 243 displays the information on the sizes and location of the circle.
To switch the circle into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
In the 3D Video 284 a cylinder will be displayed
in the circle place.
Default minimal and maximal heights of the
cylinder are determined by the line type 320 ,
which constructs the circle. The heights can be
set separately for each circle by means of
current construction parameters panel 247 , on
which it is also possible to set coordinates of
the circle in numeric values.
Color of the cylinder is determined only by line
type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
circle: coordinates of the center and second point, radius, angle.
See also: "Constructions" button group 181

Arc
When this button is pressed, the first clicking on the graphics area 159 specifies the center of an
arc. Second and third clicking specify its ends..
To switch the arc into the editing state you need to double-click on its center or on either of its
two ends.
In the 3D Video 284 the arc stretches, creating
a cylindrical surface.
Default minimal and maximal heights of the
cylindrical surface are determined by the line
type 320 , which constructs the arc. The heights
can be set separately for each arc by means
of current construction parameters panel 247 , on
which it is also possible to set coordinates of
the arc in numeric values.
Color of the arc is determined only by line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
arc: coordinates of the center, first and second points, radius, angle.
See also: "Constructions" button group 181

Stairs
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Stairs is similar to the Inclined rectangle 184
and differs from it that in the 3D Video and 284
3D World windows it is shown in the form of
stairs
On the current construction parameters
panel the minimum height corresponds to the
pedestal of the stairs, maximum height
corresponds to the top of the stairs.
In the Graphics window the upper side of
stairs is displayed by thick line.
The number of steps is calculated
automatically from the height of one step
equals to 15 cm.
See also: "Constructions" button group 181

Text
When this button is pressed, clicking on the graphics area 159 specifies the place for a text string.
At this point a pop-up frame with cursor will appear.
The necessary text is to be entered within a frame. To separate the lines use Enter.
The font type panel 246 appears below in the graphics area allowing to change the font type 322 . A
pop-up menu is available within a frame, appearing at clicking the right mouse button.
The entered text is a text marker and can be quickly found using the Find text 219 tool. This is a
very convenient and quick means for navigation on big layouts.
See also: "Constructions" button group 181 , Find text 219

Mask
When this button is pressed, the first clicking on the graphics area 159 specifies the first vertex of
rectangular mask. Second clicking completes the mask construction.
The status bar 243 displays the information on the mask sizes and location.
Using masks allows to cover any image parts. Constructions 181 and texts 189 can be drawn over
masks.
To cover separate construction fragments you can also use line of white color.
In the 3D Video 284 masks are not shown.
See also: "Constructions" button group 181

Filling
Filling is similar to a mask 189 , but can be of any color, and also in the form of different hatch
type. Color of filling is defined by the color of line type, by which the filling is made, and type of
hatching or its absence - by style of this line type.
Fillings, as well as other objects, could be edited 177 by moving separate vertexes, and thus could
be stretched on various objects.
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In the 3D Video 284 fillings are not shown.
See also: "Constructions" button group 181

3D model
The button opens submenu, in which there are 3D models which are present in the program
library.
When any item in the submenu is chosen, clicking in the graphics area 159 specifies the place for
a 3D model.
3D models placement is possible in the
horizontal and vertical projections, however only
3D models placed in the horizontal projection
will be visible in the 3D Video 284 .

In the horizontal projection the 3D models are displayed in the top view, in the vertical projection
- in the side view, and in the 3D Video 284 models are as 3D objects.
Horizontal and vertical projections 292 for displaying in the Graphics window can be created in
the 3D Models 291 window.
3D models can be moved, rotated, copied, changed draw order 236 as other VideoCAD
objects.
The default height of the 3D models above the ground is determined by the maximal height of
the line type 320 which was chosen when the 3D model was being placed. The height can be set
separately for each 3D model using the current construction parameters panel 247 .
To change 3D model height above the ground, select 232 the 3D model, then change line type
237 or switch the 3D model to editing state by double clicking on it and change value in the 3D H
box on the Current construction parameters panel.
By default the 3D models are on the ground and constructed by the line type with the number,
specified on the Lines 320 tab of the Options box 319 . This line type has the maximum height
equal to 0.
Heights can also tak e on negative values, in this case 3D model plunges under ground.
For example, to place a 3D model on a surface: construct the surface by the rectangle 184 tool
using line type with the required maximum height, place the 3D model on it, and then change 3D
model line type to the line type of the surface.
In the Editing state 161 using the Current construction parameters panel you can resize 3D
models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the
box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken. 3D model height above the ground is displayed and can be changed in 3D H box.
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In the editing state 161 , 3D models are
displayed with square grips and pink circle.
You can rotate the 3D model by the mouse
using the circle, scale 3D model on X and Y
axis using the square grips. You can move the
3D model by pressing the left mouse button on
the 3D model, as well as in the selected state.

License plate of cars
Let's consider 3D models - cars with license plates. License plate type, the same for all
car models, is determined by the file number.bmp file in the directory \Models\, and the
plate size - by the corresponding settings in the Options box on the 3D modeling 325 tab.
This opportunity allows using the same models in different countries with different license
plates.
To make cars appear in the 3D Video with the license plate of your country:
create a *.bmp file with the image of you license plate;
!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....
replace the file number.bmp by your file;
specify the sizes of your license plate in the Options box.

Adding new 3D models, manage 3D models
You can add new 3D models to the library using Add 3D Model 231 menu item.
You can add, delete, duplicate 3D models, distribute 3D models by directories in menu, get
projections of 3D models for the Graphics window using the 3D Models 291 window.
Files of 3D models in *.vcm format can be exported from SketchUP and 3ds max using
plugins. Custom 3D models for VideoCAD can be created in SketchUP and 3ds max.
See more: Importing 3D models from SketchUp and Autodeck 3ds Max

397

See also: 3D Video 284 , 3D Models 291 , Options box>Lines 320 , Options box>3D modeling 325 .

3D image
This tool is similar to Inclined rectangle 184 . As well as the inclined rectangle it allows to place a
rectangle in three-dimensional space at any angle.
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But this rectangle can be "covered" by any
raster image in *.bmp , *.jpg, *.gif, *.tiff, *.png
formats. The image can be a photo or a figure.
In *.bmp and *.jpg files, pixels of the image
can be transparent if they have a color
coincided with the color of the left bottom
pixel. Thus the image border can take any
form.
In *.png files transparent pixels will be
displayed transparent.
In many cases raster images can replace 3D
models 190 which are difficult to make. They
can be used for modeling many objects from
banknotes and plates up to a complex
background.

After choosing this button the Loading 3D image dialog box appears. After choosing a file in *.
bmp,*.jpg,*.jpeg,*.png,*.gif,*.tif or *.tiff format place 3D image in the same way as Inclined
rectangle.
On the Current construction parameter panel 247 the minimal height corresponds to the bottom
bound of this rectangle and the maximal height - to the top bound.
In the Graphics window the top of 3D images is displayed by thick line.
Later 3D image can be edited 177 by moving its grips. It is possible to change 3D image sizes on
the Current construction parameter panel, delete and change the image file using buttons
and
. on the Current construction parameter panel.
To make transparent pixels with color coincided with color of left bottom pixel (or transparent
pixels of *.png file), check Transparence checkbox on the Current construction parameter
panel.
To get the transparence of *.bmp or *.jpg file, the image file has to be specially prepared by
means of any graphic editor, for example Paint. Pixels that should become transparent have to
be filled by color that coincides with the color of left bottom pixel.
See also: "Constructions" button group 181

Rotakin
Rotakin - an animated rotating test target for
visual estimation of spatial resolution and
motion distortions on the 3D images.
\

In the horizontal plane the Rotakin
automatically turns towards the Active camera
162 .
In the vertical plane the Rotakin rotates with a
specified speed about an axis passing through
its center (in Professional version only).
.
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To place the Rotakin specify a place for the Rotakin by clicking.
On the current construction parameters panel it is possible to set minimal and maximal
heights of the Rotakin.
Rotating test target named Rotakin is used in field testing of video surveillance systems by the
techniques developed by the Home Office Scientific Development Branch 'Performance Testing
of CCTV Perimeter Surveillance Systems (Using the Rotakin Standard Test Target) ". The
Rotak in model meets the requirements of the document.
See also: "Constructions" button group 181

Signal cable
When this button pressed, you can draw the signal cable of the Active camera 162 by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop
drawing cable, press ESC.
The status bar 243 displays the segment length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the
segment is attached to the projection with its initial point.
A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately.
When copying 180 the cable segments between cameras and layouts 340 a process of cable
drawing is accelerated considerably even in complex CCTV systems.
When drawing a cable the menu item Cable laying 239 might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
The type and parameters of line designating the Signal cable can be changed in the options
box 320 .
VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Signal cable again.
A dialog box of the same name appears after that.
The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report 200 and Cable report 240 .
In multi-layer drawings, cables belong to the same layer as a camera to which the cables belong.
It is possible to use Line segments 183 for cable modeling with subsequent cable length
calculation. Use separate line types 320 for drawing a cable of each type. For length calculation
use the Length calculation of line segments 343 tool and the Cable report 240 .
See also: "Constructions" button group 181 , View>Active camera cables 216 , View>All camera
cables 216 , Cable laying 239 , Length calculation of line segments 343 , Cable report 240 .

Power cable
When this button pressed, you can draw the power cable of the Active camera 162 by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop
drawing cable, press ESC.
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The status bar 243 displays the segment length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point.
A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately.
When copying 180 the cable segments between cameras and layouts 340 a process of cable
drawing is accelerated considerably even in complex CCTV systems.
When drawing a cable the menu item Cable laying 239 might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
The type and parameters of line designating the power cable can be changed in the options
box 320 .
VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Power cable again.
A dialog box of the same name appears after that enabling to choose a cross-section area of
power cable to fit the requirements of camera voltage supply. It is assumed that the conductor
material is copper and the conductor temperature is + 50° C
The results of the cables' calculation on each individual camera, each individual section area and
on the project as a whole are included into the text file obtained by Text report 200 and Cable report
240 .
In multi-layer drawings, cables belong to the same layer as a camera to which the cables belong.
It is possible to use Line segments 183 for cable modeling with subsequent cable length
calculation. Use separate line types 320 for drawing a cable of each type. For length calculation
use the Length calculation of line segments 343 tool, Cable report 240 .
See also: "Constructions" button group 181 , View>Active camera cables 216 , View>All camera
cables 216 , Cable laying 239 , Length calculation of line segments 343 , Cable report 240 .

Global snaps
This button is used to promptly switch global snaps 229 on/off.
Snaps enhance the convenience in drawing. As a result of the snaps' functioning the cursor
"sticks" to the certain points, lines or directions.
Points - the cursor sticks to base object points.
Lines - the cursor sticks to objects lines.
Angular snap functions at construction of line segments, angles, cables, and at moving and
rotating as well. After that the subsequent construction points are leveled from the previous
points horizontally and vertically.
Extension - the cursor sticks to the virtual horizontal and vertical lines passing through base
objects points.
The snap Extension is disabled for hidden 236 objects and in the Select/Edit 177 mode.
At grid - the cursor sticks to grid nodes.
In the pop-up menu you can choose permanent opened snap panel, with the help of which it is
convenient fast switch the snaps during drawings.
In the Options box 333 you can change snap sensitivity.
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You can disable snaps for any layer using parameter of layers - Snap.

"Active camera" control element group
Change installation height
When this button is pressed, clicking in a vertical projection specifies a new height of the
Active camera 162 installation.
The value of camera installation height 257 in the Camera Geometry box 253 changes according to
the clicked point height.

Change view area upper bound
When this button is pressed clicking in a vertical projection specifies a new height of the view
area upper bound 258 and new distance up to the view area upper bound 260 .
Clicking in the horizontal projection specifies a distance up to the view area upper bound
only. The values of correspondent parameters in the Camera Geometry box 251 change to clicked
point coordinates.
You can change view area upper bound in the Select / Edit 177 mode, by moving the grip in the
middle of the view area upper bound.

Change view area lower bound
When this button is pressed clicking in a vertical projection specifies a new height of the view
area lower bound. The values of view area lower bound height 259 in the Camera Geometry box
251 change according to a clicked point height.

"Scale" button group
Move drawing
When this button is pressed you can move a drawing within the graphics area 159 using the
mouse.
To do that press and hold down the left mouse button at any spot of drawing and then move the
mouse holding the button down. To stop moving the drawing release the mouse button.
If your mouse is an Intellimouse or other Wheel mouse you can move the drawing at any time
by pressing and holding the middle button down.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.

Zoom IN/Zoom OUT
Clicking these buttons increases or reduces a drawing scale correspondingly.
Using the Intellimouse or other Wheel mouse you can change the drawing scale with the
simultaneous zooming in the drawing sections pointed by the cursor.
If Ctrl is not pressed at changing the scale, then the scale changes roughly which is
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convenient at navigation. If Ctrl is pressed, the scale changes with the less step which is
convenient for the precise drawing positioning before printing, saving or exporting.
If input focus is on the graphics area, scale can be changed by + and - buttons on the keyboard.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.

"Undo" button group
UNDO
Undo the last operation.
VideoCAD stores several last operations including Undo operation. When clicking this button
successively VideoCAD retraces to the last states and a state before the button Undo was
clicked for the first time.
The quantity of the stored operations can be adjusted in the Options box>Miscellaneous>UNDO
depth 334 .

REDO
Redo the last operation undone by the UNDO 196 tool.
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Main menu

See Main menu location 158 .
Menu items substantially duplicate the buttons of the tool bar 164 ; however, there are certain
advanced tools.
Keyboard shortcuts 324 . 250 can be assigned to each menu item.

Project
New 199
Open 199
Save 199
Save as 199
Import from
VideoCAD3..6
199

Export to
VideoCAD3..6
199

Text report 200
PDF Report 200
Exit 200

Camera
New 200
Save to project
201

Camera list 201
Numerate
cameras 201
Table of camera
models 202
Change
installation
height 202
Change view
area upper
bound 202
Change view
area lower bound
202

Move active
camera name 202

Drawing

View
View area edges
209

View area
projections
bounds 210
Fill projections
210

Spatial resolution
212

Shadow 213
Calculate
shadows for
active camera 215
Recalculate
Shadows 215
3D view area 216
Titles 216
Camera names
216

Active camera
cables 216
All cameras'
cables 216
Cameras over
constructions 216
High resolution
on top 199
Camera
Geometry 217
Spatial resolution
217

3D Video 217
Monitor window
217

Hide vertical
projection 217
Hide horizontal
projection 217
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Constructions
Point 220
Horizontal line
220

Vertical line 220
Line segment 220
Polyline 221
Angle 221
Rectangle 222
Inclined
rectangle 222
Double line 223
Wall 224
Aperture in Wall
224

Circle 225
Arc 226
Stairs 226
Text 227
Mask 227
Filling 227
3D image 227
Rotakin 228
Global snaps 229
Lock
constractions 229

3D Models
3D model 229
3D Models
window 231
Add 3D model
231

Edit
Select all 232
Select/Edit 232

Edit
Bring to front 236
Send to back 236
Hide 236
Align 236
Change Line
type 237
Combine to
block 237
Merge contour
237

Destroy 237
Undo 237
Redo 237
Erase 238
Erase all 238

Cables
Signal cable 238
Power cable 239
Cable laying 239
Length
calculation of line
segments 239
Cable report 240

Help
About VideoCAD
240

Help Contents 240
Language 240
Homepage 241
Order 241
User forum 241
Contact us 241
Change
registration code
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Save as 202
Copy to
clipboard 204
Load background
204

Adjust
background 205
Move
background 206
Hide background
206

Delete
background 206
Background only

Grid 217
Origin 218
Set origin 218
Black-and-white
218

Options 218

Scale
Zoom in 218
Zoom out 219
Move drawing 199
Show all 219
Find text 219

Cut 234
Copy 234
Cut with base
point 234
Copy with base
point 234
Paste 234
Move 235
Rotate 235
Scale 235
Mirror 236

241

207

Layouts 207
Printer setup 207
Print 207
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Menu items

See Main menu location 158 .
Menu items substantially duplicate the buttons of the tool bar 164 ; however, there are certain
advanced tools.
Keyboard shortcuts 324 . 250 can be assigned to each menu item.

Project > New
Create new project.
A project may contain unlimited number of cameras and up to 10 layouts 207 .
In the New project dialog box type the new project name.
You can change the format of measurements in new project when necessary: Metric (meters,
millimetres) or Imperial (feet, inches).

Project > Open
Open earlier saved project.
Choose a project file. If the current project was not saved, VideoCAD offers to save it.

Project > Save
Save project to a file.
If a project is saved for the first time, the dialog box Save as appears enabling to change a project
filename and a saving directory when needed.

Project > Save as
Save project to a file under another name or in another directory.
In the appearing dialog box choose a filename and a directory to save it.
The project includes all information on the program settings (line types, fonts, etc.).

Project > Import from VideoCAD3..6
Import of the previous project format *.vmp, supported by VideoCAD versions from 3 to 6.. In the
appearing dialog box choose a filename with *.vmp extension.
If after importing project seems incorrectly, - restart VideoCAD.

Project > Export to VideoCAD3..6
Export current project to the previous project format *.vmp, supported by VideoCAD versions from
3 to 6.. In the appearing dialog box choose a filename with *.vmp extension.
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*.vmp file can contain no more than 100 cameras and no more than 5000 constructions on each
layout. All that exceeds these limits, will be lost. Also new tools which appeared in VideoCAD7
and VideoCAD8 will not be saved.

Project > Text report
Export the data on most of the specified and calculated parameters of cameras and cables
included into the current project to a text file.
Enter a filename. A default filename coincides with the project name.
When clicking OK, the text document obtained is automatically loaded into a text editor for
viewing and editing.
You can copy and paste the text obtained into a project explanatory note.
You can get a report in PDF format 200 .
See also: PDF report 200 , Cable report 240

Project > PDF report
Export the data on most of the specified and calculated parameters of cameras and cables
included into the current project to a PDF file.
Unlike the Text report 200 , the PDF Report can include images from the cameras, fragments of
layouts with camera placed, a cover with logo. Report parameters and the structure of information in
the report is configurable.
After choosing this menu item, a dialog box for configuring the report parameters will appear. After the
setting, click OK in the dialog.
See more details about PDF report configuration: PDF Report 345
Generating a report in PDF format can take a lot of time, while generating the image in the Graphics
window may vary, the 3D Video 284 window can appear. Be patient, do not touch the mouse and
keyboard.
See also: PDF Report 345 , Text report 200 , Cable report 240

Project > Exit
Exit the program.

Camera > New
Create new camera with default parameters.
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In the dialog box appeared you can change
camera number, name, type of the camera
which determines the kind of icon by which it
will be displayed. If necessary, you can enter
additional information on the created camera
(for example: purpose, a place and features of
installation).

Later it is possible to change name, number, type of the camera and the additional information in
the Camera list 336 box.
Cameras can be numerated sequentially with the help of the Numerate cameras 201 tool.
Cameras are displayed by different icons only if the Display camera type box in the Options box 319
is mark ed.
On the Line type panel 245 it is possible to choose line type 320 by which the icon of the camera
and View area projection bounds 168 will be drawn. When displaying spatial resolution 170 is
disabled, projection will be filled 169 (hatched) by the color of assigned line type. Later it is possible
to change line type using Change line type 237 tool.
Hatch style 169 is determined by style of a line type 320 , assigned to the camera (solid, dash, dot,
dash dot etc.).
After entering all necessary data click OK, to cancel the operation click Cancel.
If there is already a camera with chosen number in the current project, VideoCAD will ask to
specify, whether you would like to rewrite it.
After camera creation specify by clicking a place for the new camera on the layout.
Just after camera creation the moving mode will be switched on. When placing will be completed,
click
Select/Edit 177 button or press ESC.
It is convenient to create new cameras with already set parameters by copying 180 and pasting 180
existing ones.

Camera > Save to project
All the specified and calculated parameters of the active camera and layout are saved to the
current project.
Saving is performed automatically at many operations.

Camera > Camera list
Clicking this button opens Camera list box, in which camera list of current project is displayed.
Active camera is highlighted by red frame. Any camera can be activated, removed, renamed,
found on layouts, it is possible to show 3D image from any camera. It is also possible to sort
cameras in the list. For carrying out any manipulations with the camera first select its name in the
list by single clicking.
See more: Camera list 336

Camera > Numerate cameras
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Open the Numerate cameras 338 tool. This tool allows renaming and serial numeration any quantity
of cameras simultaneously.
See more: Numerate cameras 338

Camera > Table of camera models
Show Table of camera models. In the table it is possible to set parameters to models and
assign any model to the active camera. The table can be exported to *.txt, *.csv, *.htm, *.rtf, *.xls
formats.
See more: Table of camera models 304

Camera > Change installation height
When this button is pressed clicking in a vertical projection specifies a new height of the
Active camera 162 installation.
The values of camera installation height 257 in the Camera Geometry box 253 change according to a
clicked point height.

Camera > Change view area upper bound
When this button is pressed clicking in a vertical projection specifies a new height of the view
area upper bound 258 and new distance up to the view area upper bound 260 .
Clicking in a horizontal projection specifies a distance up to the view area upper bound. The
values of correspondent parameters in the Camera Geometry box 251 change to clicked point
coordinates.
You can change view area upper bound in Select / Edit 177 mode, by moving the the grip in the
middle of the view area upper bound.

Camera > Change view area lower bound
When this button is pressed clicking in a vertical projection specifies a new height of the view
area lower bound. The values of view area lower bound height 259 in the Camera Geometry box
251 change according to a clicked point height.

Camera > Move active camera name
When this item chosen, clicking in the graphics area 159 specifies new location of the active
camera name relatively to its icon in the projection which you clicked.
If the Options box>Camera icon>Camera Icon>Scalable 327 is not checked, then the size of the
camera icon is not scalable so the distance up to the name also cannot be scalable. The distance
is saved in pixels.
If the Scalable is checked, then the size of the camera icon is scalable so the distance up to the
name is scalable too. The distance is saved in meters(foot).
Scalable and unscalable positions are stored separately, so switching the Scalable box will not
lead to losing of the saved positions of the camera name.

Drawing > Save as
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The item opens a submenu in which a format of saving drawing file can be chosen. You may
save the drawing in any of the following formats: *.dxf, *.wmf, *.emf, *.emf+, *.gif, *.tif, *.png, *.
pdf (raster), *.bmp, *.jpg.
To the *.png, *.pdf (raster), *.bmp, *.emf+ (vector) formats, a copy of the image in the Graphics
window is exported practically without artefacts. The default export is performed with the same
resolution as on the screen. You can increase the resolution of the drawing on the Export 330 tab in
the Options box. Therein you can also configure other export parameters.

In VideoCAD Lite export to DXF is performed by simplified way as well as in previous versions
VideoCAD4-VideoCAD7.
All cameras and constructions splits into separate lines, parts of cameras are not combined into
blocks, the structure of the background is broken. Filling of the view areas is not saved, it can be
saved as hatching. When the shadows 213 is enabled, view areas with shadows are not saved.
Simplified export is possible to DXF format only. Resolution is limited by the value in the
Resolution 330 combo box.
While simplified export, the export file will be multi-layers. In obtained *.dxf file there will be the
following layers:
Background;
Constructions;
Cameras;
Additional (grid, titles, horizontal);
Frame for printing (if it is enabled).
Raster objects (projections of 3D models 229 ) are saved in the form of rectangles.
More about export options to AutoCAD: Options box>Export>DXF 329

*. wmf format is very outdated, it does not support images of 3D models, semitransparent (blend)
and gradient filling projections. *. emf format does not support gradient and blend filling.
An alternative way to export to *.pdf is to print 199 to a virtual printer, which produces printing result
as a PDF file. In this method, the weight and color of lines 320 , fonts 322 will match the values
specified for printing.
While saving to *.gif, color distortions are possible, while saving to *.jpg compression artefacts can
be visible .
While saving to other formats, mentioned above and other distortions are possible.
Clicking a sub-item with extension name will open the Export 329 tab in the Options box 319 . It is
possible on the tab to adjust export parameters: exporting drawing scale, camera icon and
illuminator icon sizes, size of nonscalable fonts, step of dash line and step of hatches.
After closing the Options box the dialog box Save drawing as appears enabling to choose a
filename and a saving directory.
The file name coincides with the layout name by default.
You can save the drawing with a frame and tittle-block . To do this chose Print 207 , chose frame
with a tittle-block then save the drawing.
If export module of VideoCAD can not export drawing with a complex background in AutoCAD
format, try the following:
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1. Hide the background;
2. Export;
3. Combine the obtained dxf file with the original background in AutoCAD or any other program that
can do it.
Shift and rotation between background and drawing are possible when exporting drawing with a
background in AutoCAD format with the active User Coordinate System (UCS). The shift can be
corrected in AutoCAD. To prevent the shift do not use as a background files with the active User
Coordinate System. Use the files in the World Coordinate System (WCS). Before loading a file
with UCS as a background, open it in AutoCAD and use the PLAN command.
See also: Work with back ground in AutoCAD format 413 ,Options box>Export 329 , PDF Report 200

Drawing > Copy to clipboard
Copy drawing to Windows clipboard.
Choosing this item opens a submenu allowing to choose the format in which the drawing will be
copied to the clipboard.
After that the drawing can be pasted into any document, e.g. into a project explanatory note.
A drawing is copied in a displayed size.

Drawing > Load background
This item opens a submenu allowing to choose a projection to load a background.
After choosing item a dialog box for choosing background file appears. Graphic files of the
following formats can be used as a background: *.bmp, *.jpg, AutoCAD *.dxf, *.dwg, *.wmf, *.
emf, *.emf+, *.gif, *.tif, *.png,*.pdf.
Choose the necessary file in the dialog box and click OK.
The background will appear in the chosen projection along with the dialog box Adjust background
205 . Using its tools is necessary to bring an image scale on the background in correspondence
with the general VideoCAD scale.
Click the
Ruler button
Specify by clicking 2 points on the
background image, the distance between
which is known to you (e.g., the length of a
building, a wall, etc.). In the Distance box
the measured distance at the current scale
will appear.
Enter the known distance into the Real
distance box and click OK.
The background will be automatically scaled
so that the distance specified by you will be
equal to the entered value of real distance.
If the loaded background is in PDF format, the Adjust background dialog includes fields for
selecting page in the PDF document and to set resolution of the PDF document. If the loaded
background is in DXF or DWG format, the dialog includes tools to select a layout and to control
visibility of layers of the background, as well as a checkbox to hide texts.
If the back ground is already loaded, and you load a back ground without removing 206 the previous
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one, then the size, scale and location of a new back ground will remain the same as of a previous
one. In this case, the proportion between the sides of a new back ground might be distorted.
If you remove an old background beforehand, then the new one will be automatically placed
according to the size of a file and the current scale on the screen.
The project includes background files themselves, therefore when moving the project file don't worry
about the background files moving.
If VideoCAD can not read a file in AutoCAD format or reads it incorrectly, proceed as follows:
1. Open your file in AutoCAD, check the scale, check the presence of remote from the main
construction details, check for other abnormal details. If necessary, correct the detected errors.
2. Create a new blank file in AutoCAD
3. Copy from your file only those constructions that are necessary to accommodate the cameras.
4. Save the file as dxf version no later than 2015.
5. Load this file in VideoCAD as a back ground.
See also: Adjust back ground 205 , Move back ground 206 , Hide back ground 206 ,Delete back ground
206 , Thin lines of raster back ground 334 .

Drawing > Adjust background
This item opens a submenu allowing to choose a projection to adjust background.
After choosing item the dialog box Adjust Background appears. Using its tools is necessary to
bring an image scale on the background in correspondence with the general VideoCAD scale
.
Sequence of actions:
Click the
Ruler button
Specify by clicking 2 points on the
background image, the distance between
which is known to you (e.g., the length of a
building, a wall, etc.). In the Distance box
the measured distance at the current scale
will appear.
Enter the known distance into the Real
distance box and click OK.
The background will be automatically scaled
so that the distance specified by you will be
equal to the entered value of real distance.
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If the loaded background is in PDF format, the
Adjust background dialog includes fields for
selecting page in the PDF document and to
set resolution of the PDF document.

If the loaded background is in DXF or DWG
format, the dialog includes tools to select a
layout and to control visibility of layers of the
background, as well as a checkbox to hide
texts.
To enable/disable layers: choose layers name
in the Layers list, then mark or clear the
Visible checkbox.
See also: Work with back ground in AutoCAD
format 413 , Import DXF/DWG back ground 199

Drawing > Move background
This item opens a submenu allowing to choose a projection to move background.
After choosing item clicking in the graphics area 159 specifies new location of the background
in the corresponding projection.

Drawing > Hide background
This item opens a submenu allowing to choose a projection to hide background.
The hidden background and all its parameters are stored in memory, but the background is not
displayed. It is convenient for increasing speed on weak computer or in some other cases.
If export module of VideoCAD can not export drawing with a complex background in AutoCAD
format, try the following:
1. Hide the background;
2. Export;
3. Combine the obtained dxf file with the original background in AutoCAD or any other program that
can do it.

Drawing > Delete background
This item opens a submenu allowing to choose a projection to remove background.
Choosing item from the submenu removes background and all its parameters from the project.
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If the back ground is already loaded, and you load 204 a back ground without removing the
previous one, then the size, scale and location of a new back ground will remain the same as of a
previous one. In this case, the proportion between the sides of a new back ground might be
distorted.
If you remove an old background beforehand, then the new one will be automatically placed
according to the size of a file and the current scale on the screen.

Drawing > Background only
After choosing this item the background only will be displayed in the graphics area 159 .
VideoCAD turns to a handy program for graphic files viewing and printing.
For all the rest to be displayed choose this item again.

Drawing > Layouts
Choosing this item opens a box with the list of current project layouts.
The project may contain up to 10 layouts. Originally one layout is created into project.
See more. Layout box 340
To switch between layouts, create, delete, rename layouts in the Graphics window it is convenient
to use the Layouts tabs 242 in the lower left corner and the pop-up menu of these tabs.

Drawing > Printer setup
Choosing this item opens a standard dialog box of current printer setup in Windows.

Drawing > Print
After choosing this item the borders of pages for printing and the Preview box appear in the
graphics area.
In the box you can choose the number of pages horizontally
and vertically to print out current drawing. The obtained pages can
be glued together forming a drawing of a larger format.
Using the mouse, position and scale the drawing as needed.
If Ctrl is not pressed at changing the scale, then the scale changes
roughly which is convenient at navigation. If Ctrl is pressed, the
scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.
To exclude the certain areas of a drawing at printing, use the Mask
button that duplicates the same button 189 on the Tool bar.
To change settings of the current printer click the Printer
Setup

button.

After the drawing preparation is completed click the button Print
.
In case if any problem with printing try to choose printing options in
the Options box 334 .
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Frames and Tittle blocks
To get the standard drawing sheet with the frame and the Title-Block choose the required
frame in the Frame combo box. The frame should be created beforehand.
Frames are a files of AutoCAD *.dxf format. They can be created or edited using the
AutoCAD or other program exporting to *.dxf. VideoCAD can be used too. Frame files are
saved in the \Frames\ directory in the VideoCAD installation directory.
You may use the prepared frames with the filled Title Blocks, or you may fill the Title Block
before printing.
To fill the Title Block:
Click the Fill Title-Block
button. As a result the frame becomes fixed to other
constructions and at navigation is moved and scaled together with them. Current drawing
location and scale are memorized;
With the help of the mouse enlarge the Title-Block area and fill the fields with the text 227 ;
Click the button Title-Block again. The drawing and frame will return to the memorized
position.

Store positions of drawing
In the lower part of the panel there is the Positions area. By means of tools in this area it is
possible to store the adjustments and positions of the drawing, and then quickly return to the
stored positions. This option is useful in case of repeated printing the same view after editing is
carried out.
After adjustment of the drawing's position and frame, before print, click the Add button and
enter any name of the position.
At printing the same view for returning to the stored position it is enough to select only the
position's name in the combo box.
To return to position in the combo box after displacement click Show button.
To store new position under the name selected from the positions' list click Save button.
To delete the selected position click Del button.

Printing on a virtual printer
An alternative way to export to PDF is printing on a virtual printer, which produces printing
result as a PDF file. In this method, the thickness and color of lines 320 , fonts 322 will match
the values specified for printing.
However, not all virtual and hardware printers support printing transparent, gradient fills,
hatches , transparent images . When printing on these printers , you can use an option
Printing>Use buffer 334 in the Options box .
When using a raster buffer, initial printing is carried out on the buffer, and then raster buffer is
sent to the printer.
Without using the buffer, an image is sent to the printer in vector form, as a set of drawing
commands and if the printer does not support all commands, errors are possible on the printed
image.
However not all printers can work with the Use buffer mode in all cases. In case of issues
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clear the Use buffer 334 checkbox. Try also to decrease printer DPI resolution, hide raster
background. Try another virtual printer.

View > View area edges
Show the Active camera view area edges, calculated according to parameters 253 in the Camera
Geometry box.
Line type can be changed in the options box 320 .
When View area projection bounds 168 is
disabled, but Shadows 172 is enabled, the View
area edges 168 is shown simplified in the form of
two rays.

If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box, then for this camera the line
type of View area edges is taken from the
Options box>Lines>System line types>Bounds
320 . This line type is assigned to new cameras
by default (Camera 32 on the figure).
Default line type for cameras is Line 21.
If another line type was assigned to the
camera, the View area edges of this camera is
drawn by this line type assigned to the camera,
as well as the View area projection bounds 169
and camera icon. (Camera 33...38).
Thus you can draw different cameras and their
view areas by different colors, thickness and
line style.
In VideoCAD Lite the View area edges are
visible in the 3D Video 284 window as lines
when 3D view areas 174 is enabled and the 3D
view areas 288 menu item is marked.
A button state at the moment of camera saving determines whether the view area edges of the
given camera will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the active camera, this button changes
view
and operates the visibility of View area edges of all selected cameras simultaneously.
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View > View area projection bounds
Show the bounds of the Active camera view area projections calculated according to parameters
253 in the Camera Geometry box.
Submenu of the button:
1.
Projection - show View area projection
bounds of the active camera.
Projection is calculated according to a
simple rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of
heights from the view area lower bound
height 259 to the view area upper bound
height 258 , is visible wholly.

Difference between the View area projection bounds and Shadows 172 buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
considering obstacles. Both buttons can be used simultaneously in various combinations.
2. Off. - don't show.
When View area projection bounds is disabled, but Shadows 172 is enabled, the View area
edges 168 is shown simplified in the form of two rays.
If the line type of camera 166 coincides with default line type for camera icons, specified in the
Options box 327 , then for this camera the line type of View area projection bounds is tak en from
the Options box>Lines>System line types>Bounds 320 . This line type is assigned to new cameras
by default.
If another line type was assigned to the camera, the View area projection bounds of this
camera is drawn by this line type assigned to the camera, as well as the View area edges 168 and
camera icon.
A button state at the moment of camera saving determines whether the bounds of the given
camera view area projections will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the active camera, this button changes
view
and operates the visibility of View area projection bounds of all selected cameras
simultaneously.

View > Fill projections
Hatch or fill by blend color view area projections of active camera 162 ( if these projections exist)
calculated according to parameters in the Camera Geometry 253 box.
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If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box 327 , then hatching (filling)
projections of this camera is performed by grey
color by default (Camera 30 on the figure).
If another line type was assigned to the
camera, then hatching (filling) projections of
this camera is performed by a color of this line
type assigned to the camera. (Camera 41,42).
If the Spatial resolution 170 is enabled, then
colors of hatching (filling) projections is
determined by Spatial resolution parameters
(Camera 43).

Drop-down menu:
1.

H a tc hing - hatch projections.

2.

Filling - fill projections by blend semitransparent color.

If the Hatching item is chosen, but in the dropdown menu of the Spatial resolution 170 button
the Gradient item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.
Transparence of filling in the Graphics window
and the 3D Video 288 can be adjusted in the
Options box.
3. Off - don't hatch and fill view area projections.
If Off is chosen in the Fill projections and
Shadows 172 , then filling view area faces in the
3D Video 288 is not shown.
If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box, then for this camera Filling is
performed by Gray color and Hatching by
DiagCross style. (Camera 32)
Default line type for cameras is Line 21.
If another line type was assigned to the
camera, then for this camera filling is
performed by a color determined by color of
the line type and hatch style is determined by
style of the line type (Camera 33...38).
Thus you can fill and hatch projections of
different cameras by different colors and hatch
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styles.
A button state at the moment of camera saving determines whether the filling or hatching of the
view area projections of the camera will be displayed when this camera is inactive.
If selected cameras exist on the layout, except the active camera, this button changes view
and operates the visibility of filling (hatching) projections of all selected cameras simultaneously.

View > Spatial resolution
Fill in different colors regions on the view area projections of the active camera, depending on
the spatial resolution within these regions.
Colors of the regions and the boundary values of the spatial resolution are determined by the
spatial resolution pattern assigned to the camera.
In the Spatial resolution box 272 you can edit the patterns and assign them to cameras.

Drop-down menu:
1.
D is c re te c o lo rs - fill the regions in discrete colors in accordance with a spatial resolution
at the far bounds of the regions.
2.
Gradient - fill the view area projection in gradient color according to the spatial resolution at
each point on the projection.
In case of gradient color is chosen, the colors at the far region bounds equal to the colors of the
spatial resolution pattern, but between the bounds color changes smoothly, as well as real
spatial resolution.
Gradient reflects the spatial resolution more accurately and look s impressive, but discrete colors
are more intuitive and easy to use..
If the Gradient item is chosen, but in the dropdown menu of the Fill projections 169 button
the Hatching item is chosen, then the
projections will be hatched by a bold style of
hatch without gradient.
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Calculation of gradient demands a lot of resources and increases redraw time.
3. Off. - don't display spatial resolution

In the Dome 172 mode the Spatial resolution is calculated without tak ing into account pan and tilt
angles of camera. It is assumed that the camera can pan and tilt freely, and spatial resolution is
calculated at the center of the field of view.
The Spatial resolution button controls
displaying spatial resolution on 3D View areas
174 in the 3D Video 288 .

A button state at the moment of camera saving determines whether the spatial resolution of the
camera will be displayed when this camera is inactive.
If selected cameras exist on the layout, except the Active camera 162 , this button changes view
( ) and operates the visibility of spatial resolution of all selected cameras simultaneously.
See also: Spatial resolution box 272 , Visualization of the camera control area projections and
spatial resolution within them 381 .

View > Shadow
Display horizontal projection of the view area of
the active camera taking into account shading
from constructions 181 .

Shadows - a powerful yet easy-to-use tool of VideoCAD. Shadows are calculated for all
positions of cameras, shading objects can be located at any point of space. You should only enable
calculation of shadows with the help of this button.
Shading takes into account the camera installation height and all 3 coordinate of constructions
(including heights).
Drop-down menu:
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1.
Within projection - display view area
projection taking into account shadows.
Shading is calculated according to a rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height 259
to the view area upper bound height 258 , is
visible wholly.
By the same rule the horizontal projections 168
of view area are calculated. Changing the height
of the lower and upper bounds of view area
could change conditions of calculation of
shading.

2.
Dome - display projection of the territory
controlled by the camera in 360 degrees,
without view area borders, but only taking into
account the shadowing.
When the Dome item is chosen, actually the
control area of a dome (PTZ) camera is
displayed.
The Dome mode is also useful for choosing the
best installation place for fixed cameras to
make required areas reachable for the cameras.
In the Dome mode all shaded areas from the
specified camera position become visible.
In the Dome mode the Spatial resolution 170 is
calculated without taking into account pan and
tilt angles of camera. It is assumed that the
camera can pan and tilt freely, and spatial
resolution is calculated at the center of the field
of view
.

In the Graphics window calculation of shadows
in the Dome mode is performed lik e in the
Within projection 173 mode, ie according to the
rule:
A point on the horizontal projection is
considered visible if a vertical segment,
formed by this point in the range of heights
from the view area lower bound height 259
to the view area upper bound height 258 , is
visible wholly.
3. Off - disable shadow calculation and displaying.
Difference between the Shadows and View area projection bounds 168 buttons is that the View
area projection bounds are built without obstacles on the scene but the Shadows are built
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considering obstacles. Both buttons can be used simultaneously in various combinations.
The Shadow button work s in conjunction with the Spatial resolution 170
and the Fill
169
projections
buttons. Depending on the state of these buttons, shadows can be
displayed in different ways: as filling, as shading, as a border lines, with mapping spatial resolution
or not.
The calculation of shading - resource-intensive operation. During the shadow calculation on the
Shadow button red frame flashes .
Automatic shadow calculation is performed only for the active 163 camera. To recalculate shading
for a particular camera - activate this camera. To recalculate shading for all selected cameras,
click Main Menu>View>Recalculate shadows 215 .
To temporarily disable the automatic calculation of shading (k eeping already calculated shadows
visible) clear the item Main menu>View>Calculate shadows for active camera 215 .
Whether or not a specific construction takes into account in the calculation of shading determines
by the Shadow 320 checkbox of the line type used for the construction.
.

A button state at the moment of camera saving determines whether the shadows of the camera will
be displayed when this camera is inactive.
If selected cameras exist on the layout, except the Active camera 162 , this button changes view
(
and operates the visibility of shadows of all selected cameras simultaneously.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Options box>Miscellaneous>Shadow
333 , Choosing the best place for PTZ (dome) camera 384 , Visualization of the camera control area
projections and spatial resolution within them 381

View > Calculate shadows for active camera
Enable/ disable calculating shadows.
Automatic calculating shadows is performed for the active camera 161 only.
To temporary disable automatic calculating shadows (with k eeping already calculated shadows)
clear this menu item.
This item controls shadow calculation in the Graphics window only, it doesn't affect shadows in
the 3D World.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Layers>Shadow, Options
box>Miscellaneous>Shadow 333 , Options box>Calculate shadows from 3D models 333 , Current
construction parameter panel>3D model>Shadows 248 , 3D Models window>Shadows, Choosing the
best place for PTZ (dome) camera 384 , Visualization of the camera control area projections and
spatial resolution within them 381

View > Recalculate shadows
Recalculate shadows for all selected 161 cameras
Calculating shadows is a resource-intensive operation. Automatic calculating shadows is
performed for the active camera 161 only. To recalculate shadows for all selected 161 cameras,
click this item.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Layers>Shadow, Options
box>Miscellaneous>Shadow 333 , Options box>Calculate shadows from 3D models 333 , Current
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construction parameter panel>3D model>Shadows 248 , 3D Models window>Shadows, Choosing the
best place for PTZ (dome) camera 384 , Visualization of the camera control area projections and
spatial resolution within them 381

View > 3D view area
Show 3D transparent view area in the 3D Video
window.
The 3D Video>Main menu>View>3D View
areas menu item must be mark ed.
See details: 3D Video>Main menu>View>3D
View areas 288

Button state at the moment of camera saving determines whether the 3D view area of the given
camera will be displayed when this camera is inactive.
If selected cameras exist on the current layout, except the Active camera 162 , this button changes
view
and operates the visibility of 3D view areas of all selected cameras simultaneously.

View > Titles
Show on the top left corner: names of project and layout and the grid step on the drawing.
Font type can be changed in the Options box 322 .

View > Camera names
Switch on/off the displaying cameras' names near their icons in the Graphics window and in the 3D
Video.
Font type can be changed in the Options box 322 .

View > Active camera cables
Show/Hide cables 238 of the active camera.

View > All cameras' cables
Show/Hide the cables 238 of all the cameras.
Only cables of the active camera can be edited.

View > Cameras over constructions
When this item is checked, cameras icons and view areas are displayed over constructions, i.e.
the constructions do not cover the cameras. This mode is convenient at operation with complex 3D
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models of rooms.
When the item is not checked, the constructions are displayed over cameras (by default).
See also: High resolution on top 199 .

View > Camera geometry
Clicking this item will open Camera Geometry box 251 . This box includes geometric parameters of
the camera, lens and installation parameters of the camera.
See more: Camera geometry box 251

View > Spatial resolution
Show or hide the Spatial resolution box 272 . In this box it is possible to create and edit patterns of
spatial resolution and field of view size visualization. In the box there are prepared spatial resolution
patterns according to the following criteria: Home Office Scientific Development Branch, Home
Office Guidelines for identification, P 78.36.008-99, Australian Standard AS4806: Closed Circuit
Television, European Standard EN 50132-7, ISO/IEC 19794 Biometric data interchange formats..
Also in the box there are examples of images of group of people are automatically displayed for
each region of spatial resolution.
See more. Spatial resolution box 272 , Spatial resolution button 170 .

View > 3D Video
Show or hide the 3D Video window. The 3D Video displays the image from the active camera.
See more: 3D Video 284

View > Monitor window
Show or hide the Monitor window. In the Monitor window images from any quantity of cameras
are displayed simultaneously. Monitor window allows modeling monitors of video surveillance
system.
See more: Monitor window 294

View > Hide vertical projection
With this item chosen a horizontal projection is only present in the graphics area 159 .
To display a vertical projection click this item again.

View > Hide horizontal projection
With this item chosen a vertical projection is only present in the graphics area 159 .
To display a horizontal projection click this item again.

View > Grid
Choosing this item opens a submenu of grid displaying control. The submenu enables to set a
certain grid step up, switch a mode of automatic grid step selection on/off and switch the grid
displaying off.
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See also: "Grid" control element group 176

View > Origin
This item opens the submenu of origin selection.
The graphics area 159 allows to use 2 coordinate systems:
Fixed coordinate system
Float coordinate system attached to the active camera
In case of the fixed coordinate system, the origin of coordinates does not vary when changing
the active camera. The origin is displayed as two icons
in horizontal and vertical projections. It
is possible to change a point of origin after choosing the menu item View > Set origin 218 .
In case of the coordinate system attached to the active camera, the origin of coordinates
always coincides with the active camera location. It is convenient when studying its view area.
A grid 176 is fixed to the origin of coordinates, and the counting of the cursor current coordinates
in the status bar 243 starts from the origin.

View > Set Origin
After choosing this item clicking on the horizontal projection sets up a new origin
Fixed coordinate system 160 .

of the

In the vertical projection horizontally the Origin coincides with the one set in the horizontal
projection, and vertically it coincides with the ground.

View > Black-and-white
Switch black-and-white drawing mode on/off.
This mode is useful when printing a drawing out on black -and-white printer.

View > Options
Choosing this item opens a dialog box of the program options 319 .
See more: Options box 319

Scale > Zoom in
Clicking this item increases a drawing scale.
Using the Intellimouse you can change the drawing scale with the simultaneous zooming in the
image sections pointed by the cursor.
If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation. If Ctrl is pressed, the scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.
If input focus is on the graphics area, scale can be changed by + and - buttons on the keyboard.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
Choosing an item of the pop-up menu appearing when click ing the graphics area 159 with the right
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mouse button performs the command as well.

Scale > Zoom out
Clicking this item reduces a drawing scale.
Using the Intellimouse you can change the drawing scale with the simultaneous zooming in the
image sections pointed by the cursor.
If Ctrl is not pressed at changing the scale, then the scale changes roughly which is convenient
at navigation. If Ctrl is pressed, the scale changes with the less step which is convenient for the
precise drawing positioning before printing or saving.
If input focus is on the graphics area, scale can be changed by + and - buttons on the keyboard.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.
Choosing an item of the pop-up menu appearing when click ing the graphics area 159 with the right
mouse button performs the command as well.

Scale > Move drawing
With this item chosen you can move a drawing within the graphics area 159 using the mouse.
To do that press and hold down the left mouse button at any spot of drawing and then move the
mouse holding the button down. To stop moving the drawing release the mouse button.
If your mouse is an Intellimouse or other Wheel mouse you can move the drawing at any time
by pressing and holding the middle button down.
When Alt is pressed 249 , it is possible to move drawing in the Graphics window using arrow keys
and change scale using plus and minus keys irrespective of the input focus.

Scale > Show all
Show all cameras and other constructions on the current layout. At this the scale and view are
chosen automatically.

Scale > Find text
After choosing this item the Find text box will appear. In the box any text can be entered.
After clicking the button OK, all cameras and text markers 227 on the current layout, in which
designation the entered text is included, will become visible and selected 161 . At this the scale
and view are chosen automatically.
Even only one letter can be entered, and at this all cameras and text mark ers on the current
layout, in which designation the entered letter is included will become visible.
It is convenient to mark the upper left and the lower right corner of the required areas with text
markers. After that as the result of searching the marked area will be displayed on the full screen.
When clicking the button Save the entered text string will be saved, and it will be enough later on
just to choose it from the list to find the corresponding objects.
Text strings are saved in the project in separate lists for each layout, i.e. are saved between
computer rebooting and project moves.
When clicking the button Delete the displayed text string will be deleted from the project.
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Constructions > Point
When this button is pressed, clicking on the graphics area places a point.
The status bar 243 displays the coordinates of this point relatively to the origin of coordinates 218 .
In the 3D Video 284 the vertical segment will be displayed in the points place.
Default minimal and maximal heights of the segment are determined by the line type 320 , which
constructs the point. The heights can be set separately for each point by means of the current
construction parameters panel 247 , on which it is also possible to set coordinates of the point in
numeric values.
See also: "Constructions" button group 181

Constructions > Horizontal line
When this button is pressed, clicking on the graphics area 159 specifies a point through which a
horizontal line is passes.
The status bar 243 displays the line height or its shift from the origin of coordinates 218 according
to the projection being clicked.
In the 3D Video 284 at the place of the horizontal line 2 horizontal lines will be displayed.
Default minimal and maximal heights of the lines are determined by the line type 320 , which
constructs the horizontal line. The heights can be set separately for each horizontal line by means
of current construction parameters panel 247 , on which it is also possible to set coordinates of the
horizontal line in numeric values.
See also: "Constructions" button group 181

Constructions > Vertical line
When this button is pressed, clicking on the graphics area 159 specifies a point through which a
vertical line is passes.
The status bar 243 displays the distance from the origin of coordinates 218 .
In the 3D Video 284 at the place of the vertical line 2 horizontal lines will be displayed.
Default minimal and maximal heights of the lines are determined by the line type 320 , which
constructs the vertical line. The heights can be set separately for each vertical line by means of
the current construction parameters panel 247 , on which it is also possible to set coordinates of the
vertical line in numeric values.
See also: "Constructions" button group 181

Constructions > Line segment
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
line segment. Second clicking specifies the end point of the line segment.
The status bar 243 displays the segments length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point.
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In the 3D Video 284 a vertical rectangle will be
displayed at the segment place.
Default minimal and maximal heights of the
rectangle are determined by the line type 320 ,
which constructs the line segment. The heights
can be set separately for each line segment by
means of current construction parameters panel
247 , on which it is also possible to set
coordinates of the line segment in numeric
values.
Color of the rectangle is determined only by line
type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
segment: coordinates of the first and second points, length, angle.
A segment can be also used to measure distances on layouts without click ing for the second time
in this case.
Line segments can be used for modeling cables with subsequent cable length calculation. Use
separate line types to draw each cable type. For length calculation use the Length calculation of
line segments 343 tool.
See also: "Constructions" button group 181

Constructions > Polyline
This tool allows to draw line segments continuously. The end of each segment is the start of the
next one. To stop drawing lines, press ESC.
In other respects this tool equals to the Line segment 183 (see. above).
See also: "Constructions" button group" 181

Constructions > Angle
When this button is pressed, the first clicking on the graphics area 159 specifies the vertex of an
angle. Second and third clicking specify its arms.
The status bar 243 displays the angle value in degrees.
If the angle vertex and arms are constructed in different projections, when changing drawing the
angle is attached to the projection with its vertex.
In the 3D Video 284 2 vertical rectangles will be
displayed at the angle place.
Default minimal and maximal heights of the
rectangles are determined by the line type 320 ,
which constructs the Angle. The heights can be
set separately for each Angle by means of
current construction parameters panel 247 , on
which it is also possible to set coordinates of
the line segment in numeric values.
Color of the rectangles is determined only by
line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
angle: coordinates of the first, second, third points, length, angle value in degree.
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The angle tool is also used to measure angles on layouts.
See also: "Constructions" button group 181

Constructions > Rectangle
When this button is pressed, the first clicking on the graphics area 159 specifies the first corner of a
rectangle. Second clicking completes the rectangle construction.
The status bar 243 displays the information on the rectangle sizes and location.
In the 3D Video 284 a parallelepiped will be
displayed at the rectangle place.
Default minimal and maximal heights of the
parallelepiped are determined by the line type
320 , which constructs the rectangle. The
heights can be set separately for each
rectangle by means of current construction
parameters panel 247 , on which it is also
possible to set coordinates of the rectangle in
numeric values.
Color of the parallelepiped is determined only
by line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
rectangle: coordinates of the first points, height, width.
Rectangles are also used for creating rectangular horizontal planes in the 3D Video, for example
a ceiling or floor.
See also: "Constructions" button group 181

Constructions > Inclined rectangle
When this button is pressed, clicking on the graphics area 159 specifies first corner of an inclined
rectangle.
Inclined rectangle is similar to a rectangle 184
and differs from it that in 3D Video 284 it is
displayed in the form of inclined rectangle.
The minimal height of rectangle corresponds
to the lower side of this rectangle, and the
maximal height - to the upper one.
In the Graphics window the upper side of
inclined rectangle is displayed by thick line.
For modeling complex objects it is possible to edit 177 inclined rectangle by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
Inclined rectangle can be made transparent by 70 %. For this purpose it is necessary to mark the
Transparence checkbox on the Current construction parameter panel 247 .
Inclined rectangle is very universal tool. Using the inclined rectangles it is possible to model any
3D objects.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

223

It can be useful to combine inclined rectangles
in pairs thus to get triangles with independent
vertexes in the 3D space. Meanwhile two
vertices of each inclined rectangle must
coincide. The rest two vertices of first inclined
rectangle must coincide with the other two
vertices of second inclined rectangle.

Using obtained triangles you can theoretically
build any 3D surfaces, although it can be not
simple in practice.
For example, all 3D models in VideoCAD
consist of triangular mesh only.

See also: "Constructions" button group 181

Constructions > Double line
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
double line. Second clicking specifies the end point of the double line.
The length and the width of the double line appear in the status bar 243 .
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the distance between lines of the double line.
Two buttons allow switching the orientation of the second line relatively to the first one
.
You can also switch the orientation quickly by pressing the Space bar.
In the 3D Video 284 2 vertical rectangles will be
displayed at the double line place.
Default minimal and maximal heights of the
rectangles are determined by the line type 320 ,
which constructs the double line. The heights
can be set separately for each double line by
means of current construction parameters panel
247 , on which it is also possible to set
coordinates of the double line in numeric
values.
Color of the rectangles is determined only by
line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
double line: coordinates of the first, second points, length, angle.
See also: "Constructions" button group 181
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Constructions > Wall
The Wall tool is intended for drawing walls with specified thickness and height. In these walls you
can make apertures 187 of any shape, for example for doors and windows.
When this button is pressed, the first clicking on the graphics area 159 specifies the start point of a
Wall. Second clicking specifies the end point of the Wall.
The length and the width of the wall appear in the status bar 243 .
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the wall.
Two buttons allow switching the orientation of the second wall side relatively to the first one
.
You can also switch the orientation quickly by pressing the Space bar.
In the 3D Video 284 a parallelepiped will be
displayed at the wall place.
Default minimal and maximal heights of the wall
are determined by the line type 320 , which
constructs the wall. The heights can be set
separately for each wall by means of the current
construction parameters panel 247 , on which it
is also possible to set coordinates of the wall in
numeric values.
Color of the parallelepiped is determined only
by line type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
wall: coordinates of the first, second points, length, angle.
In walls it is possible to mak e apertures for doors and windows using the Aperture in Wall 187 tool.
See also: "Constructions" button group 181

Constructions > Aperture in Wall
The Aperture in Wall tool designed to easily
create apertures (openings) of various shapes in
the walls, built by the Wall 186 tool.
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In order to an aperture will appear in the 3D
space, it must intersect the horizontal
projection of the wall.

The Aperture in Wall tool is similar to the Inclined rectangle 184 tool. But the Inclined rectangle
creates a flat rectangle in 3D space, but the Aperture in Wall placed inside the Wall, cuts an
aperture in the wall. This aperture equals to the projection of the same flat rectangle on the plane
of the wall.
The minimal height of aperture corresponds to the lower side of this rectangle, and the
maximal height - to the upper one.
In the Graphics window the upper side of aperture is displayed by thick line.
In line type panel 245 that appeared below graphics area there is a box in which it is possible to
choose from the list or enter from keyboard the thickness of the aperture.
The Thickness of the wall affects only the shape of aperture projection in the Graphics window. In
the 3D Video the apertures always cut through a wall at its full thickness.
Two buttons allow switching the orientation of the second aperture side relatively to the first one
.
You can also switch the orientation quickly by pressing the Space bar.
For modeling complex apertures it is possible to edit 177 the Apertures by points, moving its
vertexes.
When moving separate vertexes press Ctrl.
You can create complex apertures using several intersecting apertures.
See also: Wall 186 , "Constructions" button group" 181

Constructions > Circle
When this button is pressed, the first clicking on the graphics area 159 specifies the center of a
circle. Second clicking completes the circle construction.
The status bar 243 displays the information on the sizes and location of the circle.
To switch the circle into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
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In the 3D Video 284 a cylinder will be displayed
in the circle place.
Default minimal and maximal heights of the
cylinder are determined by the line type 320 ,
which constructs the circle. The heights can be
set separately for each circle by means of
current construction parameters panel 247 , on
which it is also possible to set coordinates of
the circle in numeric values.
Color of the cylinder is determined only by line
type 320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
circle: coordinates of the center and second point, radius, angle.
See also: "Constructions" button group 181

Constructions > Arc
When this button is pressed, the first clicking on the graphics area 159 specifies the center of an
arc. Second and third clicking specify its ends..
To switch the arc into the editing state you need to double-click on its center or on either of its
two ends.
In the 3D Video 284 the arc stretches, creating a
cylindrical surface.
Default minimal and maximal heights of the
cylindrical surface are determined by the line
type 320 , which constructs the arc. The heights
can be set separately for each arc by means of
current construction parameters panel 247 , on
which it is also possible to set coordinates of
the arc in numeric values.
Color of the arc is determined only by line type
320 , which is used at constructing.
On the current construction parameters panel it is possible to set and fix parameters of the
arc: coordinates of the center, first and second points, radius, angle.
See also: "Constructions" button group 181

Constructions > Stairs
Stairs is similar to the Inclined rectangle 184
and differs from it that in the 3D Video and 284
3D World windows it is shown in the form of
stairs
On the current construction parameters
panel the minimum height corresponds to the
pedestal of the stairs, maximum height
corresponds to the top of the stairs.
In the Graphics window the upper side of
stairs is displayed by thick line.
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The number of steps is calculated
automatically from the height of one step
equals to 15 cm.
See also: "Constructions" button group 181

Constructions > Text
When this button is pressed, clicking on the graphics area 159 specifies the place for a text string.
At this point a pop-up frame with cursor will appear.
The necessary text is to be entered within a frame. To separate the lines use Enter.
The font type panel 246 appears below in the graphics area allowing to change the font type 322 . A
pop-up menu is available within a frame, appearing at clicking the right mouse button.
The entered text is a text marker and can be quickly found using the Find text 219 tool. This is a
very convenient and quick means for navigation on big layouts.
In the 3D Video 284 Texts are not displayed.
See also: "Constructions" button group 181 , Find text 219

Constructions > Mask
When this button is pressed, the first clicking on the graphics area 159 specifies the first vertex of
rectangular mask. Second clicking completes the mask construction.
The status bar 243 displays the information on the mask sizes and location.
Using masks allows to cover any image parts. Constructions 181 and texts 189 can be drawn over
masks.
To cover separate construction fragments you can also use line of white color.
In the 3D Video masks are not shown.
In the 3D Video 284 the Mask is not displayed.
See also: "Constructions" button group 181

Constructions > Filling
Filling is similar to a mask 189 , but can be of any color, and also in the form of different hatch
type. Color of filling is defined by the color of line type, by which the filling is made, and type of
hatching or its absence - by style of this line type.
Fillings, as well as other objects, could be edited 177 by moving separate vertexes, and thus could
be stretched on various objects.
In the 3D Video 284 fillings are not shown.
See also: "Constructions" button group 181

Constructions > 3D image
This tool is similar to Inclined rectangle 184 . As well as the inclined rectangle it allows to place a
rectangle in three-dimensional space at any angle.
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But this rectangle can be "covered" by any
raster image in *.bmp , *.jpg, *.gif, *.tiff, *.png
formats. The image can be a photo or a figure.
In *.bmp and *.jpg files, pixels of the image can
be transparent if they have a color coincided
with the color of the left bottom pixel. Thus
the image border can take any form.
In *.png files transparent pixels will be
displayed transparent.
In many cases raster images can replace 3D
models 190 which are difficult to make. They can
be used for modeling many objects from
banknotes and plates up to a complex
background.

After choosing this button the Loading 3D image dialog box appears. After choosing a file in *.
bmp,*.jpg,*.jpeg,*.png,*.gif,*.tif or *.tiff format place 3D image in the same way as Inclined
rectangle.
On the Current construction parameter panel 247 the minimal height corresponds to the bottom
bound of this rectangle and the maximal height - to the top bound.
In the Graphics window the top of 3D images is displayed by thick line.
Later 3D image can be edited 177 by moving its grips. It is possible to change 3D image sizes on
the Current construction parameter panel, delete and change the image file using buttons
and
. on the Current construction parameter panel.
To make transparent pixels with color coincided with color of left bottom pixel (or transparent
pixels of *.png file), check Transparence checkbox on the Current construction parameter
panel.
To get the transparence of *.bmp or *.jpg file, the image file has to be specially prepared by means
of any graphic editor, for example Paint. Pixels that should become transparent have to be filled
by color that coincides with the color of left bottom pixel.
See also: "Constructions" button group 181

Constructions > Rotakin
Rotakin - an animated rotating test target for
visual estimation of spatial resolution and
motion distortions on the 3D images.
\

In the horizontal plane the Rotakin
automatically turns towards the active camera.
In the vertical plane the Rotakin rotates with a
specified speed about an axis passing through
its center (in Professional version only).
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To place the Rotakin specify a place for the Rotakin by clicking.
On the current construction parameters panel it is possible to set minimal and maximal
heights of the Rotakin.
Rotating test target named Rotakin is used in field testing of video surveillance systems by the
techniques developed by the Home Office Scientific Development Branch 'Performance Testing
of CCTV Perimeter Surveillance Systems (Using the Rotakin Standard Test Target) ". The
Rotak in model meets the requirements of the document.
See also: "Constructions" button group 181

Constructions > Global snaps
Choosing this item opens a submenu enabling to switch global snaps on/off and display the snap
panel, with the help of which it is convenient switch the snaps fast when drawing.
Snaps enhance the convenience in drawing. As a result of the snaps' functioning the cursor
"sticks" to the certain points, lines or directions.
Points - the cursor sticks to base object points.
Lines - the cursor sticks to objects lines.
Angular snap functions at construction of line segments, angles, cables, and at moving and
rotating as well. After that the subsequent construction points are leveled from the previous
points horizontally and vertically.
Extension - the cursor sticks to the virtual horizontal and vertical lines passing through base
objects points.
The snap Extension is disabled for hidden 236 objects and in the Select/Edit 177 mode.
At grid - the cursor sticks to grid nodes.
In the Options box 333 you can change snap sensitivity.
Show panel - display the snap panel, with the help of which it is convenient switch the snaps
fast while drawing.
The pop-up menu appearing when clicking the graphics area 159 with the right button of the mouse
contains an item Local snap. The local snaps have the same function as the global ones though
working during one operation.

Constructions > Lock constructions
After modeling the environment the cameras' placement stage begins. At this stage displacement
of constructions is not required any more, and their casual selection can cause inconveniences. If
this item is marked, the selection of constructions is locked. To release the locking, click this item
once again.

3D models > 3D Model
The item opens submenu, in which there are 3D models which are present in the program library.
When any item in the submenu is chosen, clicking in the graphics area 159 specifies the place for
a 3D model.
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3D models placement is possible in the
horizontal and vertical projections, however only
3D models placed in the horizontal projection
will be visible in the 3D Video 284 .

In the horizontal projection the 3D models are displayed in the top view, in the vertical projection in the side view, and in the 3D Video 284 models are as 3D objects.
Horizontal and vertical projections 292 for displaying in the Graphics window can be created in
the 3D Models 291 window.
3D models can be moved, rotated, copied, changed draw order 236 as other VideoCAD objects.
The default height of the 3D models above the ground is determined by the maximal height of
the line type 320 which was chosen when the 3D model was being placed. The height can be set
separately for each 3D model using the current construction parameters panel 247 .
To change 3D model height above the ground, select 232 the 3D model, then change line type 237
or switch the 3D model to editing state by double clicking on it and change value in the 3D H box
on the Current construction parameters panel.
By default the 3D models are on the ground and constructed by the line type with the number,
specified on the Lines 320 tab of the Options box 319 . This line type has the maximum height
equal to 0.
Heights can also tak e on negative values, in this case 3D model plunges under ground.
For example, to place a 3D model on a surface: construct the surface by the rectangle 184 tool
using line type with the required maximum height, place the 3D model on it, and then change 3D
model line type to the line type of the surface.
In the Editing state 161 using the Current construction parameters panel you can resize 3D
models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the
box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken. 3D model height above the ground is displayed and can be changed in 3D H box.
In the editing state 161 , 3D models are displayed
with square grips and pink circle.
You can rotate the 3D model by the mouse
using the circle, scale 3D model on X and Y
axis using the square grips. You can move the
3D model by pressing the left mouse button on
the 3D model, as well as in the selected state.

License plate of cars
Let's consider 3D models - cars with license plates. License plate type, the same for all car
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models, is determined by the file number.bmp file in the directory \Models\, and the plate
size - by the corresponding settings in the Options box on the 3D modeling 325 tab. This
opportunity allows using the same models in different countries with different license plates.
To make cars appear in the 3D Video with the license plate of your country:
create a *.bmp file with the image of you license plate;
!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....
replace the file number.bmp by your file;
specify the sizes of your license plate in the Options box.

Adding new 3D models, manage 3D models
You can add new 3D models to the library using Add 3D Model 231 menu item.
You can add, delete, duplicate 3D models, distribute 3D models by directories in menu, get
projections of 3D models for the Graphics window using the 3D Models 291 window.
Files of 3D models in *.vcm format can be exported from SketchUP and 3ds max using plugins.
Custom 3D models for VideoCAD can be created in SketchUP and 3ds max.
See more: Importing 3D models from SketchUp and Autodeck 3ds Max

397

See also: 3D Video 284 , 3D Models 291 , Options box>Lines 320 , Options box>3D modeling 325 .

3D models > 3D Models window
Open the 3D Models window. This window is intended for working with 3D models 190 , add, delete,
duplicate, make projections etc.
See more: 3D Models window 291

3D models > Add 3D model
Add a 3D model to the program library. In the dialog box, select a file of 3D model *. vcm format
and click Open.
Files in *. vcm format can be obtained by exporting from SketchUP and 3ds max using plugins.
For details, see IImport of 3D models from SketchUp and Autodesk 3dsMax 397
If VideoCAD library already has a 3D model with the same name or ID, you will be prompted to add
the model under a different name or ID.
Then you will see the 3D Models window 291 , in which you can create the projection 292 of the 3D
model to display it in the Graphics window 158 and menus 190 . To do this click the Save
projection button and close the 3D Models window. After this, icons of the 3D model will appear
in menus and the 3D model can be placed in the graphics area.
For other features of the 3D Models window, see 3D Models window 291
If your 3D model has textures, in the same directory where the *.vcm file is opened from, a folder
with textures must be. The folder should be named <model name> _textures. VideoCAD plugin
for SketchUP automatically creates the folder with the textures in the directory of saving exported
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model.

Edit > Select All
Select all constructions, models, cameras, cables and illuminators on the current layout.

Edit > Select/Edit
With this button chosen the first corner of
selection window appears when clicking any
empty place of graphics area 159 once. Clicking
it again completes the designation of selection
window.
All the objects, which hit in the selection
window and reside on the projection
coinciding with one being clicked for the first
time, will be selected 161 . However, the earlier
selected objects not hitting in the selection
window will revert to normal state 160 .

If Ctrl is pressed at click ing, the objects within the selection window are inverted, on the contrary,
state of those not hitting in the selection window remains the same.
It is possible to select objects by one by clicking their image once, thus enabling the earlier
selected objects to revert to normal state.
If Ctrl is pressed at click ing, the objects are inverted, and the state of the rest remains the same.
During construction 3D scenes 284 it is often necessary to place some constructions one over
another at a different height, made by means of different line types 320 .
To select one or more construction, located one over another, made by means of different
line types:
make the line type panel 245 visible, for example by double clicking any construction;
choose on the panel the line type of construction you want to select;
select the construction by clicking.
Just repeat clicking at the same place without moving the cursor. Thus objects under the cursor will
be selected sequentially.
To move objects on the foreground or background use menu items: Bring to front 236 , Send to back
236 .
Selected objects can be moved. To move the selected objects, bring the cursor to the selected
one, press the left mouse button and move the selected objects. After finishing the moving, release
left mouse button.
To cancel selection click this button again.
To select all objects on the current layout use Ctrl+A shortcut.
For switching to Select / Edit mode from any mode use also Esc button.
See also: Selected state 161
Editing state of objects
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To translate an object into editing state 161 double-click its image.
After that pink grips appear on the object base points.
When moving the cursor over this point its image changes.

To edit an object click beside a base point with a grip and move the cursor. After clicking for the
second time, the changed object is set up.
If on one side of a construction a circle is displayed, the construction can be rotated around its
axis by catching the circle by mouse.
To switch the circle 225 into the editing state you need to double-click on its center or on the point
on its radius that appears during the process of construction.
To switch the arc 226 into the editing state you need to double-click on its center or on either of
its two ends.
When editing a rectangle 184 or a mask 189 , then several points will move at a time, the rectangle
or the mask remaining square.
If Ctrl is pressed when editing a rectangle or a mask, then one point will move only.
When editing a Double line 185 or Wall 186 , the whole Double line or Wall will be moved.
If Ctrl is pressed when editing the double line or wall, only one line will be moved.
When clicking the text 189 twice the pop-up frame appears allowing to edit text in it. When
clicking the right mouse button the pop-up menu of text editing appears in the frame.
In the editing state, 3D models 190 are displayed with square grips
and pink circle.
You can rotate the 3D model by the mouse using the circle, scale
3D model on X and Y axis using the square grips. You can move
the 3D model by pressing the left mouse button on the 3D model,
as well as in the selected state.
It is possible to change object's parameters in editing state on the current construction
parameters panel 247 which automatically appears in the bottom of graphics window.
See also: Editing state 161

Activate cameras
When double-clicking the camera lens the following actions are performed:
the Active camera 162 is saved.
the camera being double-clicked will become active.
It is convenient to pan and tilt the active camera by moving the grip in the middle of the view area
upper bound.
In a similar way by moving grips on the ends of the view area upper bound it is possible to
change lens focal length 256 of the camera.
If a model 304 is assigned to the camera, the focal length changing is possible only in the limits
specified in model parameters 317 .
See also: Active camera 162
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See also: "Edit" button group 177

Edit > Cut
Cut the selected objects 161 into the VideoCAD internal clipboard.
It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions 181 , 3D objects 229 , cameras

Edit > Copy
Copy the selected objects 161 into the VideoCAD internal clipboard.
It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions 181 , 3D objects 229 , texts 189 and cables.
See also: Copy with base point 234 .

Edit > Cut with base point
Cut the selected objects 161 into the VideoCAD internal clipboard relative to a base point.
After clicking this button specify the base point of cutting.
It is possible to cut objects of different projections at a time, and to cut any quantity of
constructions 181 , 3D objects 229 , texts 189 , cameras and cables as well.
When cutting the active camera it is copied.
See also: Cut 234 .

Edit > Copy with base point
Copy the selected objects 161 into the VideoCAD internal clipboard relative to a base point.
After clicking this button specify the base point of copying.
It is possible to copy objects of different projections at a time, and to copy any quantity of
constructions 181 , 3D objects 229 , texts 189 , cameras and cables as well.
See also: Copy 234 .

Edit > Paste
Paste the objects from the VideoCAD internal clipboard.
After clicking this button specify the base point of paste in the projection being clicked when
cutting or copying.
It is possible to paste into different layouts 340 , paste cables of one camera while another camera
is active (in this case the pasted cables belong to a camera which is active during paste), and to
paste any quantity of constructions 181 , 3D objects 229 , cameras, texts 189 and cables at a time.
It is available to copy and paste constructions, cables and texts between the projects. To this
effect make a copy in one project, then open another project or create a new one and paste what
you have copied.
Be careful when copying and pasting cables. You can copy only cables of Active camera 162 ,
and when pasting, these cables will belong to the camera which is active during pasting.
If a camera is being pasted a new camera with parameters of the pasted camera is created
automatically. This is an alternative way to create new cameras.
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Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but pasted
camera doesn't become active. Therefore the view area of the pasted camera is displayed without
shadows. To calculate shadows - activate 162 the camera after pasting.

Edit > Move
Move the selected objects 161 .
After clicking this button the first click in a graphics area 159 designates the starting moving point,
the second click - the final one.
When moving tak e into account the projection to which the objects are attached. A simultaneous
moving objects in different projections vertically is lock ed as being incorrect.
Selected 161 objects or cameras can be moved in Select / edit 177 mode. In order to move place
the cursor above the selected object, press left mouse button, move, after moving is finished
release the left mouse button.
Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but moved
camera can be not active. If the camera is not active, the view area of the moved camera is
displayed with old shadows. To recalculate shadows - activate 162 the camera after moving.

Edit > Rotate
Rotate the selected objects 161 .
After clicking this button the first click in a graphics area 159 designates the rotation center, the
second click specifies the initial rotating point, and the third click specifies the final rotating point.
When rotating tak e into account the projection to which the objects are attached. The selected
objects, attached to the projection with a rotation center designated, can rotate only.
The scalable 322 fonts can rotate only. If a font is not scalable then its initial point rotates only,
the text remaining horizontal.
The active camera can be rotated in Select / edit 177 mode by moving the grip in the middle of the
view area upper bound.
Shadows 172 in the Graphics window 158 are calculated for the active camera 162 , but rotated
camera can be not active. If the camera is not active, the view area of the rotated camera is
displayed with old shadows. To recalculate shadows - activate 162 the camera after rotating.

Edit > Scale
Change scale of selected 161 constructions relative to the center of scaling.
After clicking on this button, the first click on the graphics area 159 specifies the center of scaling
.
Then moving the cursor up increases sizes of selected constructions, moving the cursor down
decreases sizes of selected constructions.
In the Status bar 243 the current scale factor is displayed.
When required sizes will be achieved, click for the second time to complete scaling operation. To
cancel the scaling press ESC.
This tool does not scale 3D models 190 . 3D models can be scaled in editing state 161 with the help
of the Current construction parameter panel 248 .
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Edit > Mirror
Mirror the selected 161 constructions relative to the horizontal or vertical line passing through the
specified point.
After clicking on this button, the first click on the graphics area 159 specifies the point through
which a mirror line must be passed.
Then moving the cursor changes position of the mirror line.
When required position of the mirroring objects will be achieved, click for the second time to
complete mirroring operation. To cancel mirroring press ESC.

Edit > Bring to Front
Move selected objects 161 on the foreground, then other objects will not shadow them.
To move cameras over constructions use the Cameras over constructions 216 item.
Changing the objects' draw order can be required at operation with large 3D models 229 of rooms,
and also at operation with constructions placed one over another.

Edit > Send to Back
Move selected objects on the background, then selected objects will be covered by other objects.
To move cameras over constructions use the Cameras over constructions 216 item.
Changing the objects' draw order can be required at operation with large 3D models 229 of rooms,
and also at operation with constructions placed one over another.

Edit > Hide
Hide the selected objects 161 .
With this item chosen the selected objects proceed into hidden state 163 . In the hidden state the
objects in the Graphics window are displayed on the background in light grey color. The rest
characteristics are similar to those of normal state 160 .
In the 3D Video 284 window the hidden objects are not displayed. Hidden objects are not exported
to AutoCAD formats 202 , therefore to exclude some objects from export - hide them.
The hidden state is used to conceal the temporarily interfering objects.
To return to normal state select 232 the hidden objects.
The snap Extension 229 is disabled for hidden objects.
When working with a separate object it is convenient to select all the objects in layout 207 using
the shortcut Ctrl+A and hide them. After that select the objects needed.

Edit > Align
Align the selected objects 161 .
Because limited accuracy of computer calculations, sometimes after a rotation objects' form is
being distorted a little.
The effect of choosing this item is alignment of the form of selected objects.
Efficiency of alignment depends on a scale. Vast scale provides the minimum of efficiency, small
scale - the maximum. At high degree of efficiency small objects can be distorted.
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Edit > Change Line type
After choosing this item at the bottom of the graphics area 159 appears the line type panel 245 .
In the line type panel you can choose line type 320 for the selected 161 constructions 181 and
cameras.
If during changing the line type of selected objects by the Change line type tool, to press and
hold Ctrl, then the selected objects will also change their minimum and maximum height according
to the chosen line type . If Ctrl is not pressed, the heights remains unchanged.
For changing line type with returning heights to values set in the new line type parameters 321 , use
the Line type panel 245 in editing state 161 of one construction.

Edit > Combine to block
Combine to a block all selected 161 constructions. The block will behave as one object. Combining is
convenient at modeling complex objects and their subsequent moving, rotating and copying.
To destroy the block use the Destroy 237 tool.

Edit > Merge contour
Merge contours of selected 161 constructions. This tool works with walls 224 and rectangles 222 .
Merging improves appearance of drawing of buildings. To destroy merged contours use the Destroy
237 tool.

Line type 320 of the contour is determined by line type of the first construction of the contour. You
can create multiple contours of different constructions with different line types.

Edit > Destroy
Divide selected blocks 237 or contours 237 to separate objects.

Edit > Undo
Undo the last operation.
VideoCAD stores several last operations including Undo operation. When clicking this button
successively VideoCAD retraces to the last states and a state before the button Undo was clicked
for the first time.
The quantity of the stored operations can be adjusted in the Options box>Miscellaneous>UNDO
depth 334 .

Edit > Redo
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Redo the last operation undone by the UNDO 196 tool.

Edit > Erase
Erase the selected objects 161 .
If there are no selected objects this item is disabled.
Use also Del.
You can not erase the active camera.

Edit > Erase all
Erase all constructions 181 .
If there are no constructions this item is disabled.

Cables > Signal cable
When this button pressed, you can draw the signal cable of the active camera by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop drawing
cable, press ESC.
The status bar 243 displays the segment length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the
segment is attached to the projection with its initial point.
A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately.
When copying 180 the cable segments between cameras and layouts 340 a process of cable
drawing is accelerated considerably even in complex CCTV systems.
When drawing a cable the menu item Cable laying 239 might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
The type and parameters of line designating the Signal cable can be changed in the options
box 320 .
VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Signal cable again.
A dialog box of the same name appears after that.
You can open this box by choosing Calculate item near Signal cable item.
The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report 200 and Cable report 240 .
In multi-layer drawings, cables belong to the same layer as a camera to which the cables belong.
It is possible to use Line segments 183 for cable modeling with subsequent cable length
calculation. Use separate line types 320 for drawing a cable of each type. For length calculation use
the Length calculation of line segments 343 tool and the Cable report 240 .
See also: "Constructions" button group 181 , View>Active camera cables 216 , View>All camera
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cables 216 , Cable laying 239 , Length calculation of line segments 343 , Cable report 240 .

Cables > Power cable
When this button pressed, you can draw the power cable of the active camera by successive
clicks in the graphics area. The end of each segment is the start of the next one. To stop drawing
cable, press ESC.
The status bar 243 displays the segment length and its projection to distance and height.
Both clicks are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing a drawing the segment
is attached to the projection with its initial point.
A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately.
When copying 180 the cable segments between cameras and layouts 340 a process of cable
drawing is accelerated considerably even in complex CCTV systems.
When drawing a cable the menu item Cable laying 239 might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
The type and parameters of line designating the power cable can be changed in the options
box 320 .
VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates
the total length of cable. To change the default parameters and obtain the calculation results
double-click the image of any cable segment or click Power cable again.
A dialog box of the same name appears after that enabling to choose a cross-section area of
power cable to fit the requirements of camera voltage supply. It is assumed that the conductor
material is copper and the conductor temperature is + 50° C
You can open this box by choosing Calculate item near Power cable item.
The results of the cables' calculation on each individual camera, each individual section area and
on the project as a whole are included into the text file obtained by Text report 200 and Cable report
240 .
In multi-layer drawings, cables belong to the same layer as a camera to which the cables belong.
It is possible to use Line segments 183 for cable modeling with subsequent cable length
calculation. Use separate line types 320 for drawing a cable of each type. For length calculation
use the Length calculation of line segments 343 tool, Cable report 240 .
See also: "Constructions" button group 181 , View>Active camera cables 216 , View>All camera
cables 216 , Cable laying 239 , Length calculation of line segments 343 , Cable report 240 .

Cables > Cable laying
With this item chosen a float panel of the same name appears enabling to choose a shift of
segment ends for a level parallel cable drawing along the walls, columns etc.
See also: View>Active camera cables 216 , View>All camera cables 216

Cables > Length calculation of line segments
Clicking this item will open a box allowing calculate total length of any line segments 220 . This
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tool allows using line segments for modeling cables.
See more: Length calculation of line segments 343 , See also: Cables 238

Cables > Cable report
Choosing this item opens a box with a text report of all line segments 183 and cables 193 made by
line types with marked Cable 320 box in the parameters of the line type.
These line types are considered as cable brands. These line types can be assigned to the
Signal cable 341 and the Power cable 342 of any camera.
You can simply draw cables as line segments on layouts using these line types. In this case, the
cables are considered as main cables which are not attached to any camera.
The Cable report includes the cables attached to cameras and the main cables as well. Cable
lengths is calculated for each brand (line type) separately.
See also: Length calculation of line segments 343 , Calculation lenght of cables and getting the
Cable report 388 , Signal cable length calculation box 341 , Power cable electrical parameters and
length calculation box 342 , Cables summary 347 .

Help > About VideoCAD
Open the About box with the general information of VideoCAD version and the Authors.

Help > Help contents
Open the contents of this Help file.

Help > Language
Choose the language.
All the text resources of the program are stored in *.lng files in the VideoCAD installation directory.
We are interested in translating the program to other languages.
If you can do it, could you please contact us.support@cctvcad.com
We offer big discounts for the translations.
How to add a new interface language
There is English.lng file in a directory of VideoCAD (or VideoCADdemo) installation. All text
elements of the interface are loaded from this file.
For creation of new interface language it is necessary:
1. Copy English.lng (Russian.lng) file under a new name <YourLanguage>.lng
2. Accurately translate each line in the file. Don't change positions of the lines, don't delete or
create new lines! Each position corresponds to some interface element. Don't translate lines
which begin from '///' - they are labels. It is necessary to keep all blanks between lines.
3. Copy the obtained new file to the directory of VideoCAD(VideoCADdemo) installation and
start VideoCAD (or VideoCADdemo).
4. Choose Main menu> Help> Language><YourLanguage>
5. Check up new interface. Correct the <YourLanguage>.lng file if necessary.
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Don't hesitate to contact us in case of any troubles.

Help > Home page
Visit CCTVCAD Software home page in the Internet.

Help > Order
Visit CCTVCAD Software Order page in the Internet.

Help > User forum
Visit CCTVCAD Software User forum in the Internet.

Help > Contact us
Send us an email message.

Help > Change registration code
Open the Enter key box to change the registration code.
Ability to change the registration code might be usefull for users with multiple licenses with USB
dongles. Each USB dongle corresponds its own registration code. Message "The Dongle does not
fit the License." means that the USB dongle does not match registration code, which registered
the program. You need to change or a USB dongle, or enter the code corresponding to the dongle
connected.
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Layout tabs

See location of the Layouts tabs 158
There are Layouts tabs in the bottom-left corner of the Graphics area 159 . Each tab corresponds to
the separate layout created in the project.
The layouts are separate sections of monitored object (building, room, territory and storey). A layout
contains the horizontal and vertical projections locating backgrounds, cameras, cables 238 and
constructions 181 . Each camera can be displayed in one layout only, but camera cables may pass
through several layouts.
The project may contain up to 10 layouts. Originally one layout is created into project.
To show any layout, click the tab with its name.
Using the pop-up menu, which appears by right clicking on the tab, you can create, delete, and
rename layouts or show the current layout completely.
The original layout and any layout with the cameras present in it can not be deleted.
See also: Layouts box 340
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Status bar

See: location of the Status bar 158
Graphics window 158 status bar is situated in the bottom of the graphics window and consists of
two parts.
The left part is constantly displaying the current coordinate of the cursor relatively to the origin of
coordinates 218 .
If the origin coinciding with the active camera is set up, then the coordinates have the following
values:
.If the cursor is in the vertical projection, then it is the distance to the camera location and
its height above the ground. If the cursor is in the horizontal projection, then it is the
distance to the active camera location in horizontal and vertical.
If there is no active camera in the layout displayed, then the values of coordinates have no sense.
The right part is displaying the measurement results and the hints.
The construction coordinates are displayed relatively to the chosen origin of coordinates 218 . The
coordinates of constructions belonging to one camera only (change view area upper bound 195 )
are always displayed relatively to the active camera.
At moving the cursor nearer to the camera icon the name, model name and basic camera
parameters are displayed.
During scaling 181 , in the right part of the Status bar the current scale factor is displayed.
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Pop-up panels
See location of the Pop-up panels 158
Pop-up panels appear automatically in the bottom of the Graphics window during creating or editing
constructions and texts.
Line type panel 245
Font type panel 246
Current construction parameter panel 247
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Line type panel

The panel is designed for choosing line types 320 and displaying parameters of the current line type
.
The panel appears automatically in the bottom of the graphics area 159 when clicking the
construction buttons 181 , when choosing the correspondent menu items or when editing 177
constructions.
The panel hides automatically in other modes. You can hide the panel by choosing the Hide panel
item in the pop-up menu appearing when right clicking the panel.
The panel contains the following items:
Line type number box
Line type name box
Choosing values in these boxes changes the current line type.
As a result of changing line type of a construction using this tool, the minimum and maximum
heights 247 will be returned to values set in parameters 321 of the new line type.
For changing a line type without changing heights, use Change line type 237 tool.
When drawing a Double line 223 Wall 186 or Aperture in Wall 187 , in the right part of line type panel
appear additional elements:
Box in which it is possible to choose or enter from the keyboard the width of the double line
(wall or aperture).
Two buttons
allow switching the orientation of the second line relatively to the first one.
You can also switch the orientation quick ly with the help of the Space bar.
Other items display parameters of the chosen line type. The parameters can be changed in the
options box 320 launched by double-clicking the line type panel or by choosing the item Edit line
type in the pop-up menu which appears when right clicking the panel.
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Font type panel

The panel is designed for choosing font types and displaying parameters of the current font type.
The panel appears automatically in the bottom of the graphics area 159 when clicking the button Text
189 , when choosing the correspondent menu items or when editing 177 text.
The panel hides automatically in other modes. You can hide the panel by choosing the item Hide
panel in the pop-up menu appearing when right clicking the panel.
The panel contains the following items:
Font type number box
Font type name box
Choosing values in these boxes changes the current font type.
Other items display parameters of the chosen font type. The parameters can be changed in the
options box 322 launched by double-clicking the font type panel or by choosing the Edit font type
item in the pop-up menu which appears when right clicking the panel.
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Current construction parameter panel

The Panel is intended to set and edit parameters of constructions, 3D models. The Panel appears
automatically at the bottom of the Graphics area 158 when drawing or editing constructions.
The set of the parameters for each kind of construction (point, line, rectangle, etc.) differs.
For example:
for a point it is coordinates of the point, and its heights in the 3D Video;
for a line segment it is coordinates of the segment's ends, length, angle and its heights in the 3D
Video;
for a rectangle it is coordinates of corners, height, width and its heights in the 3D Video, etc.
Options of the panel in Construction and Editing 161 modes differ.

In the Construction mode:
It is possible to draw constructions, having set the parameters sufficient for complete definition of
this construction.
For example, for a line segment it is enough to set coordinates of the first and second point, or
coordinates of the first point, an angle and length.
It is possible to fix some parameters of construction, having marked check boxes nearby these
parameters
. At moving the cursor, the construction will be drawn in such a
manner that the fixed parameter will remain constant.
For example, for a line segment it is possible to fix length or angle, for a rectangle - width or height,
etc.
After a construction has been drawn, in the right end of the panel Edit
Clicking this button allows editing just created construction.

button appears.

In the Editing mode:
It is possible to edit any parameters of construction from keyboard, thus the result of changing will
be visible at once.
In both modes it is possible to change the minimal and maximal heights of the construction in the
3D Video irrespective of parameters of line type 320 , by which the construction is drawn.
3D model, 3D image, Inclined rectangle, transparency
During placing or editing 3D models 190 , special parameter set on the Current construction parameter
panel is displayed.
See details: 3D models 248 .
During drawing or editing 3D images 191 using the Current construction parameter panel it is
possible:
Load raster image by Load image
button;
Delete image by Delete image
.button;
Mark Transparence box to make pixels transparent, which color coincides with the color of the
left-bottom pixel.
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During Inclined rectangle 184 drawing or editing it is possible to make it transparent by 70 %. To do
this mark Transparence box.
Transparence of 3D images and transparence of Inclined rectangle have different purport.
Inclined rectangle becomes completely transparent by 70 %, what mak es possible modeling glass.
On 3D image, if its raster image is not *.png, pixels become completely transparent, which color
coincides with color of the left- bottom pixel. Other pixels remain opaque.
If its raster image is *.png, then transparent pixels of png file will be transparent in VideoCAD ( *.png
format supports transparency).
Thus, you can model objects of irregular shape using 3D images.

9.1.6.3.1 3D models

Current construction parameter panel
3D models
You can resize 3D models separately on axes.
To do this, enter new values into X, Y, Z boxes during 3D model editing. If the
box is marked,
change of any size leads to proportional change of other sizes, thus model proportions are not
broken.
3D model height above the ground is displayed and can be changed in the 3D H box.
The button

allows to open the 3D Models 291 window with edited 3D model loaded in it.
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Keyboard shortcuts
Keyboard shortcuts allow fast activation of various commands, by pressing shortcuts on the
keyboard.
VideoCAD has:
Predefined shortcuts 249 which cannot be changed;
Customizable shortcuts 250 which can be adjusted according to users' preferences.

Predefined shortcuts
F1 Call Help information of interface element, box or window, which has the input focus.
Ctrl+A Select all objects 160 in the current layout 340 .
Ctrl+TAB Switch to the next layout in turn.
Ctrl+Space bar Save the active camera and activate the next camera in turn in the current layout.
If there is no active camera in the current layout, then a camera with the minimal number will be
activated.
ESC Stop the current operation, if an operation is executed. If no operation is executed, switching
to the Select/Edit 177 mode.
DEL Delete selected 177 objects.
Spacebar Pressing Spacebar when constructing a double line 185 , wall 186 , aperture in wall 187
enables to switch the orientation of the second line (side) relatively to the first one quickly.

+ (plus on the digital keypad) Zoom in, if the input focus is on the Graphics area 159 .
- (minus on the digital keypad) Zoom out if the input focus is on the Graphics area.
When Alt is pressed, it is possible to move drawing in the Graphics window using arrow keys and
change scale using + plus and

-

minus keys irrespective of the input focus.

Ctrl has several purposes:
Changes the selection logic 177
Allows moving the horizontal projection vertically apart from the vertical one using the middle
mouse button or the button Move drawing 195 .
If Ctrl is not pressed, then the whole drawing moves, if Ctrl is pressed, the horizontal
projection moves only.
If Ctrl is pressed and held down when editing rectangle 184 , mask 189 , inclined rectangle 184 ,
filling 189 or 3D image 191 by moving pink grips, then one point move only. If Ctrl is not pressed
when editing these objects, then several points will move at a time, the editing object remain
square.
If Ctrl is pressed when editing a double line 185 , wall 186 , aperture in wall 187 then only one line
will be moved. If Ctrl was not pressed when editing these objects, the whole double line (wall,
aperture) will be moved.
If Ctrl is not pressed at changing the common scale, then the scale changes roughly which is
convenient at navigation. If Ctrl is pressed, the scale changes with the less step which is
convenient for the precise drawing positioning before printing or saving. The effect of reducing
zoom step presents in the Graphics window 158 .
If during changing the line type of selected objects by the Change line type 237 tool, to press and
hold Ctrl, then the selected objects will also change their minimum and maximum height
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according to the chosen line type . If Ctrl is not pressed, the heights remain unchanged.

Customizable shortcuts
Customizable shortcuts are seen in the Main menu 197 of the Graphics window during the
program operation. These shortcuts can be changed on the Keyboard 324 tab in the Options box.
Shortcuts can be assigned to any item of the Main menu of the Graphics window.
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Camera Geometry
Camera Geometry box includes geometric
parameters of active camera 162 , lens and
installation parameters of the camera.

In the Camera Geometry box, geometric parameters of the active camera view area in the
horizontal and vertical planes are displayed.
The image in the Camera Geometry box represents two projections of view area, parted by the
horizontal black line corresponds to the ground in the vertical (upper) projection.
The red lines mark the sizes, the green dash lines specify auxiliary constructions, the dark blue
lines designate the camera tilt angle, and the turquoise ones mark the space bounds of camera view
area.
The actual projection of view area as a result of calculations is filled by grey color.
The camera location and calculated parameters are displayed in the text boxes next to the camera
icon and the red dimension lines. The parameters in the white boxes can be changed, by choosing
them from list or by typing. When any of the parameter is changed, the values of the rest parameters
are recalculated.
You can change any parameters of all selected cameras simultaneously. For this purpose:
Select 177 necessary cameras on the layout
Right click on the combo box, then click on the Assign to selected cameras pop up item.
The parameters in the grey text boxes are results of calculation and can be changed only through
changing the parameters in the white boxes.
The linear parameters are entered and outputted in meters or feet according to the measurement
system 199 set in the project, if not specified otherwise on the image. The angular parameters are
inputted and outputted in degrees.
When an incorrect value is entered the box turns red. When an incorrect value ratio is ensued from
the input, all boxes with the values of mutually incorrect ratio turn red. If calculation with incorrect
values is still possible and has sense, the program nevertheless performs it. In this case check the
results carefully. You can see the source of mistake in the graphics window 158 .
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If the image of view area changes radically with new values, the image in the Camera Geometry
box changes correspondingly, thus the arrangement of parameter boxes are changed too. Watch
carefully the image changed, since with the image alteration the parameter boxes might interchange
their positions.
See also: Parameters in the Camera Geometry box 255
External link : "The principles of CCTV design in VideoCAD. Part I. Camera view area"(*.pdf) .
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Parameter list

Camera parameters
Image sensor size 255
Lens focal length 256
Aspect Ratio (of output
image) 257
Sensor and Lens 257
Camera installation
parameters
Height of installation 257
Camera tilt angle 258
View area limitations
View area upper bound height
258

View area lower bound height
259

View area upper bound
distance 259
View area lower bound
distance 261
View area length 263
Width of view area upper
bound 264
Width of view area lower
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bound 265
Maximum distance of
drawing view area 265
Projection 265
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Parameters

Image sensor size
In the box, you can specify the size of the Image sensor or the size of Active area of the Image
sensor 255 .
See more: Image sensor and Active area of image sensor
The Image sensor size can be specified by any of the following ways:
Choosing a standard format (type) from the list
1/10",1/8",1/6",1/5",1/4.5",1/4",1/3.6",1/3.2",'1/3",'1/2.7",'1/2.5",1/2.3",1/2",1/1.8",1/1.7",1/1.6",2/
3",1/1.2",1",4/3",1.5";
This traditional way of setting Image sensor size can be unaccurate for modern cameras 415 .
Entering a custom format in inches, in the form of X/Y". For example: 1/7.31";
If you enter a format which does not exist in the list, the box turns yellow, and the Image sensor
size will be calculated by VideoCAD.
Entering diagonal size of the image sensor in millimeters, in the form of dX.Y. For example:
d6.0.
See more: Specifying image sensor size through its diagonal and aspect ratio 418
Entering sensor side sizes in millimeters horizontally and vertically separated by hash, in the
form of W#H. For example: 4.8#3.6;
See more: Direct specifying image sensor side sizes 418
After format or length of diagonal, separated by space character, you can specify the aspect
ratio of the image sensor in the form of W:H. For example: 1/3" 16:9 or d6 16:9. If the aspect
ratio of the image sensor is not specified, it is assumed equal to 4:3.
See more: Direct specifying active area size of the image sensor 417
Active area side sizes of the image sensor can be specified in millimeters horizontally and
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vertically separated by asterisk, in the form of W*H. For example: 4.8*3.6;
See more: Direct specifying active area side sizes of the image sensor 417
See also: Sensor and Lens>Image sensor 267 , Specifying active area size of the image sensor/ 415
When moving the cursor to the image sensor box the information on horizontal and vertical view
angles of lens appears.

Lens focal length
The values can be chosen from the list or typed by keyboard, e.g. when using the varifocal
lenses.
Choose a value given in the lens specification in this box.
It is assumed that the lens format equal to or larger than the camera Image sensor format is
used.
The lens focal length influences all the calculated parameters.
When moving the cursor to the lens focal length box the information on calculated view angles
appears.
If in lens' specification there are view angles which are different from the calculated ones, then
probably the lens has distortion. For precise modeling such lens you should enable and adjust
simulating distortion 267 . Distortion simulation is possible in VideoCAD Professional
Focal length can be chosen from the list or typed into this box or duplicate boxes on the Tool bar
175 of the Graphics window and on the 3D Video 287 .
It is convenient to change lens focal length of active
camera on layout in the Select/Edit 177 mode, by
moving grips at the corners of view area projection.

If a model 304 is assigned to the camera, and the model has fixed 316 focal length lens, then you
can not change the focal length.
If a model is assigned to the camera, and the model has a lens with limited 317 variable focal
length, then you can change focal length within the limits only. When approach to the limit values,
the box will become crimson.
You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned
model or the assigned model have not specified limits of the lens focal length.
If the active camera is panoramic 269 then the lens focal length box is colored by aqua-green.

You can change lens focal length of all selected cameras simultaneously. For this purpose:
Select 177 necessary cameras on the layout
Right click on this combo box, then click on the Assign to selected cameras pop up item.
See also: Sensor and Lens>Lens 269
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Aspect ratio (of output image)
Aspect ratio of the output image of the camera: 4:3,16:9, 16:10 etc.
The Aspect ratio of the output image equals to the Aspect ratio of the active area of the
image sensor and may be different from the Aspect ratio of the image sensor.
The Aspect ratio of the image sensor can be specified in the Image sensor size 255 box.
See more: Specifying the Aspect ratio of output image 420
You can enter custom values from keyboard in the form of <width> :<height>, for example 11:4.
By specifying formats 3:4 or 9:16, you can specify the so-called corridor format in which the
height of the frame is larger than its width.
For correct simulation resolution in the corridor format you must also swap the number of pixels
horizontally and vertically in the camera parameters 277 .
Separated by space character after the Aspect ratio you can set the crop factor - the ratio of
cropping active area size of the image sensor when the active area does not touch the edges of
the image sensor. The Crop factor can be set as a vulgar fraction (separated by slash) or a real
number. For example 4:3 0.67 or 16:9 720/1080. If the Crop factor is not specified, it is taken to be
unity.

See more: Specifying the crop factor 420
If the camera has directly assigned active area sizes, then this box shows 'custom' and it
becomes unavailable. To make it available, set the size of image sensor by any way except of
direct specifying its active area size.
See also: Sensor and Lens>Image sensor's active area 268 , Specifying active area size of the
image sensor 415

Sensor and Lens
Clicking this button will open Sensor and Lens box. In the box it is possible to specify any image
sensor size 267 , active area size 268 and adjust modeling active camera as a panoramic camera 269
.
See more: Sensor and Lens 267 , Specifying active area size of the image sensor 415

Height of installation
Height of installation can be chosen from the list or typed. The height of installation influences
all calculated parameters.
Height of installation can be negative.
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Camera tilt angle
Camera tilt angle is a calculated parameter and can not be edited directly. The camera tilt angle
is an angle between the main optical axis of camera lens and a horizontal.
Camera inclination is defined not by the tilt angle but by the three parameters:
Height of installation 257 ;
View area upper bound distance 260
View area upper bound height 258

View area upper bound height
The height of view area upper bound can be chosen from the list or typed. In the horizontal
projection of the calculated view area the space above the upper bound height is not taken into
consideration.
Together with view area upper bound distance 260 it completely determines a camera tilt angle and
all calculated parameters through it.
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Height of view area upper bound can be negative.
Height of calculating Spatial resolution and Shadows
Heights of the upper and lower bounds of view area are taken into account when
calculating shadows 172 . If in the menu of the Shadow 172 tool Within projection is chosen,
then a point in the horizontal projection is considered as shaded if at least partially shaded the
vertical segment, formed by this point in the altitude range from the view area lower bound
height to the view area upper bound height.
If in the Height 275 box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds 168 and Shadow 172 buttons the Within projection is chosen, then
calculation of spatial resolution in the horizontal projection is carried out at the middle height
between the heights of the view area lower bound and the view area upper bound.

View area lower bound height
The height of view area lower bound can be chosen from the list or typed. In the horizontal
projection of the calculated view area the space below the lower bound height is not taken into
consideration.
The height of view area lower bound influences the following calculated parameters:
View area lower bound distance 261
View area lower bound width 265
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Height of view area lower bound can be negative.
Height of calculating Spatial resolution and Shadows
Heights of the upper and lower bounds of view area are taken into account when
calculating shadows 172 . If in the menu of the Shadow 172 tool Within projection is chosen,
then a point in the horizontal projection is considered as shaded if at least partially shaded the
vertical segment, formed by this point in the altitude range from the view area lower bound
height to the view area upper bound height.
If in the Height 275 box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds 168 and Shadow 172 buttons the Within projection is chosen, then
calculation of spatial resolution in the horizontal projection is carried out at the middle height
between the heights of the view area lower bound and the view area upper bound.

View area upper bound distance
Together with the height of view area upper bound 253 ,
the view area upper bound distance completely
determines the camera tilt angle and all the calculated
parameters via it.
When the camera is located above the view area upper bound 253 , a view area upper bound
distance is the maximal distance of surveillance. The view area upper bound distance is
chosen from the list or typed. The view area is calculated up to this distance.
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When the camera is located below the view area upper bound 253 , the view area upper bound
distance can become the minimal distance of surveillance.

When a camera is located above the view area upper bound, a view area upper bound
distance is the maximal distance of surveillance. The view area upper bound distance is
chosen from the list or typed. The view areas are calculated up to this distance. Together with the
height of view area upper bound 258 , the view area upper bound distance completely determines
the camera tilt angle and all the calculated parameters through it.

View area lower bound distance
The view area lower bound distance is a calculated parameter and can not be edited.
When the camera is located above the view area upper bound 253 , the view area lower bound
distance is the minimal distance of surveillance (dead zone of surveillance).
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When the camera is located below the view area upper bound 253 , in some positions the view
area lower bound distance is the minimal distance of surveillance too.

In some positions the view area lower bound distance can be the maximal distance of
surveillance.
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The view area lower bound distance can be negative.

This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle 255 is multiple of 90 degrees;
Lens distortion 267 is not considered.
In other cases, the projection of view area has a more complicated form.

View area projection length
The view area projection length is a calculated parameter and can not be edited.
When there is an actual view area projection, the view area projection length displays the
absolute value of difference between the upper and the lower bound distances of view area
projection.
When there is no actual view area projection, the parameter doesn't have any sense and is not
displayed. The parameter displaying enhances the convenience in use when it is required to obtain
the length of view area projection.
This parameter reflects the correct value only if:
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Camera is not rotated around its axis or the rotation angle 255 is multiple of 90 degrees;
Lens distortion 267 is not considered.
In other cases, the projection of view area has a more complicated form.

Width of view area projection upper bound
The width of view area projection upper bound is a calculated parameter and can not be
edited.
According to the "Projection 265 " switcher state the width of view area projection upper bound
displays the camera view area width at the point of intersection between the camera view area
bound and the view area projection upper bound, or the view area projection edge width between
the lower bound and the upper one.
This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle 255 is multiple of 90 degrees;
Lens distortion 267 is not considered.
In other cases, the projection of view area has a more complicated form.
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Width of view area projection lower bound
The width of view area projection lower bound is a calculated parameter and can not be
edited.
According to the "Projection 265 " switcher state the width of view area projection lower bound
displays the camera view area width at the intersection point between the camera view area bound
and the view area projection lower bound, or the view area projection edge width between the lower
bound and the upper one.
This parameter reflects the correct value only if:
Camera is not rotated around its axis or the rotation angle 255 is multiple of 90 degrees;
Lens distortion 267 is not considered.
In other cases, the projection of view area has a more complicated form.

Projection
A "Projection" is a switcher determining a way of calculation:
The view area lower bound distance 261 and the view area lower bound width 265 when the view
area is narrowing upwards on the view area lower bound distance;
The view area upper bound distance 260 and the view area upper bound width 264 when the view
area is narrowing downwards on the view area upper bound distance;
When the switcher is checked, the view area bound distance and width are calculated according to
narrower level of the view area opposite bound. In this case all the points of the calculated view area
horizontal projection from the lower bound up to the upper one hit in the camera view area.
When the switcher is not checked, the distance up to the camera view area bound intersection with
the upper or lower bounds and the width of this bound are calculated.
When the view area is not narrowing towards the opposite bound, the switcher doesn't have any
sense and is not displayed.

Maximum distance of drawing view area
Value in this combo box limits the distance from the camera beyond which the view area is not
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drawn in the Graphics window 158 and in the 3D Video 284 .
If the value in this box is less than the maximum of the view area upper bound distance 255 and the
view area lower bound distance 255 , the box is colored in pink color.

External link : "The principles of CCTV design in VideoCAD. Part I. Camera view area"(*.pdf).
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Sensor and Lens
The Sensor and Lens box can be invoked by
clicking the Plus button in the Camera Geometry
251 box.

In the box it is possible to specify any image
sensor size 267 , active area size 268 and adjust
modeling active camera as a panoramic camera
269 .

Image sensor
See before: Image Sensor and Active area of image sensor
On the Image sensor panel you can set the size and aspect ratio of the image sensor or size of
active area of the image sensor.
Size and Aspect ratio boxes duplicate the Image sensor size 255 box on the Camera geometry
window, but allow you to enter the size and aspect ratio in different boxes.
In the Size box you can specify the image sensor size by any of the following ways:
Choosing a standard format (type) from the list
1/10",1/8",1/6",1/5",1/4.5",1/4",1/3.6",1/3.2",'1/3",'1/2.7",'1/2.5",1/2.3",1/2",1/1.8",1/1.7",1/1.6",2/3"
,1/1.2",1",4/3",1.5";
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This traditional way of setting the image sensor size can be unaccurate for modern cameras 415 .
Entering a custom format in inches, in the form of X/Y". For example: 1/7.31";
If you enter a format which does not exist in the list, the box turns yellow, and the Image sensor size
will be calculated by VideoCAD.
Entering diagonal size of the image sensor in millimeters, in the form of dX.Y. For example: d6.0.
See more: Specifying image sensor size through its diagonal and aspect ratio 418
Entering sensor side sizes in millimeters horizontally and vertically separated by hash, in the form
of W#H. For example: 4.8#3.6;
See more: Direct specifying image sensor side sizes 418
In the Format box you can specify the active area side sizes of the image sensor in millimeters
horizontally and vertically separated by asterisk, in the form of W*H. For example: 4.8*3.6;
See more: Direct specifying active area side sizes of the image sensor 417
In the Aspect ratio box you can specify the aspect ratio of the image sensor in the form of W:H.
For example: 16:9 or 4:3.
To save changes click Save.
To cancel changes click Cancel.
See also: Specifying active area size of the image sensor/ 415

Image sensor's active area
See before: Image Sensor and Active area of image sensor
On the Image sensor's active area panel you can specify parameters of active area of the image
sensor.
In the Aspect ratio box displays the aspect ratio of the active area of the image sensor. It is
identical with the Aspect ratio of the output image 257 of the camera.
See more: Specifying the Aspect ratio of output image 420
In the Crop box you can set the crop factor - the ratio of cropping active area size of the image
sensor when the active area does not touch the edges of the image sensor. In other cases Crop=1.
The Crop factor can be set as a vulgar fraction (separated by slash) or a real number. For example
4:3 0.67 or 16:9 720/1080. If the crop factor is not specified, it is taken to be unity.

See more: Specifying the crop factor 420
The Calculator icon
invokes the Image sensor calculator 349 box for convenient calculation of
image sensor's aspect ratio, active area aspect ratio and the crop factor.
The Horiz., Vert. and Diag. boxes display sizes of the active area of the Image sensor, which are
used in modeling the camera.
These sizes are calculated based on the size and aspect ratio of the image sensor, as well as the
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aspect ratio of the output image.
In the boxes, you can directly type any sizes of the active area of the image sensor in millimeters.
In this case, the aspect ratio of the active area will be defined by the ratio of its sizes. The Aspect
ratio 257 box will show Custom.
By this method, you can specify an arbitrary aspect ratio of the image and camera angles. To set
arbitrary camera angles choose the sizes of the active area of the image sensor.
Below you can see the dynamic image showing the position and relative sizes of the active area on
the image sensor (aqua color) subject to the selected aspect ratios and crop factor.
Examples of images of image sensor of real cameras:
Aspect ratio of
Image sensor
Aspect ratio of
Active area of
Image sensor

4:3

16:9

4:3

16:9

16:10

16:10

4:3

16:9

16:9

4:3

16:9

4:3

1

1

1

1

1

1

Crop

16:9
(1920*1
080)
16:9
(1280*7
20)
720/10
80=0.6
7

Image

To save changes click Save.
To cancel changes click Cancel.
See also: Specifying active area size of the image sensor/ 415

Lens
On the Lens panel you can see:
Lens focal length - the box duplicates the similar box 256 in the Camera geometry.
Calculated view angles are calculated from the sizes of active area of image sensor and the
lens focal length.
Via changing sensor sizes when the lens focal length 256 is fixed, you can set separately arbitrary
horizontal and vertical view angles.
To save changes click Save.
To cancel changes click Cancel.

Panoramic
The panel is designed to control simulation of cameras with a view area in the form of a hemisphere
(fisheye, panoramic, 360°/180° cameras).
To enable the simulation of the active camera as a panoramic camera, check the Panoramic box.
In the Pan angle and Tilt angle combo boxes the angles of rotation of camera main optical axis in
horizontal and vertical planes are specified.
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Thus, if the camera is mounted on a vertical wall, the Tilt angle should be zero, and Pan angle
determines angle of the wall. If the camera is mounted on a ceiling, the Tilt angle must be set to 90
degrees, and the Pan angle does not matter. If the camera is mounted on the floor, the Tilt angle
should be 90 degrees.
Pan, tilt and rotation of the camera around its own axis, made in the usual way does not affect the
position of the panoramic camera. By rotation the camera in the usual way, you can view images
from the panoramic camera in different directions in the 3D Video 284 . In this case, the view area will
be limited at 180 degrees from the main optical axis of the lens. Beyond this limit the image is cut

Image resolution of a panoramic camera is determined by the Number of pixels of sensor 277
Lens focal length 256 has no affect on the image resolution of a panoramic camera.
You can change the Lens focal length, thereby changing the field of view size, but the image
resolution in the 3D Video will be always limited by the calculated resolution of the panoramic
camera.
If the calculated resolution is worse, the resolution of the 3D Video will be artificially reduced.
The Image line in the Titles 287 displays a virtual number of pixels for correct simulation of the
resolution.
To enable modeling resolution in the 3D Video mark the item 3D Video>Main menu>
Processing>Resolution 287 .
Distortion of a panoramic camera images in the 3D Video is not modeled.
The simulated resolution is exact only at the center of the frame. Towards the edges of the frame
the actual resolution is worse than simulated. The smaller the view angle, the more accuracy of
simulating resolution on the edges of the frame.
For a more realistic model of the image, turn on modeling compression 286 .
In the Graphics window 158 the horizontal projection of the view area and the distribution of spatial
resolution 272 are visualized. The projection is constructed in accordance with the Within projection
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rule.

Pattern criterion 275 of spatial resolution for panoramic cameras must be based on spatial resolution
(Pixel per meter (Pixel per foot), Pixel for object), but not on field of view size. Criterion Fieldof-view height, % of Field-of-view for object are not suitable to panoramic cameras, because of
panoramic cameras don't have a stable field of view.
To draw a camera using the special icons
or
in the Graphics window, you need to choose
thus icon during new camera creation 200 or later on the Camera list 336 panel. Selecting the icon
works regardless of the state of the Panoramic checkbox .
To make a camera model 304 a panoramic camera it is necessary:
Assign fisheye to the parameter Lens>Type 317 to model the camera as panoramic.
Assign panoramic to the parameter Type>Fixed, PTZ,Dome, Mini 316 to draw the camera using the
special icons

or

in the Graphics window.

The lens focal length boxes in the Graphics window and the Camera Geometry box for panoramic

cameras are colored by aqua-green.
In reports for panoramic cameras instead of the lens focal length value the 'fisheye' word is
displayed. .
See also: Modeling panoramic cameras (Fisheye, 360°/180°) 409
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Spatial resolution
Graphics window
Tool bar
Spatial resolution

View area of cameras can be divided into
regions based on the following criteria:
vertical or horizontal spatial resolution (pixels/
meters, pixels/foot);
vertical or horizontal field of view size (meter,
foot);
vertical or horizontal number of pixels covered
by an object of the specified height(width)
(meter, foot);
the part of the frame height(width) covered by
an object of the specified height(width)
(meter, foot).

These Criteria relates to the spatial resolution or the field of view size. For short, in the definitions,
it is mentioned the spatial resolution only (the Spatial resolution box, the Spatial resolution pattern,
the Spatial resolution criterion ...), except of special cases.
In the Graphics window, projection of different regions of view area can be filled 170 by different
color and (or) type of hatching.

Spatial resolution pattern
- contains information about the regions and how they are filled and (or) hatched.
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VideoCAD project can contain up to 30 spatial resolution patterns. Each pattern can include up to 10
regions. You can assign different patterns to different cameras.

Spatial resolution box
- is designed for creating and editing the patterns of spatial resolution and field of view size
visualization.
In the box there are prepared spatial resolution patterns according to the following criteria:
Home Office Scientific Development Branch;
Home Office Guidelines for identification;
P 78.36.008-99;
Australian Standard AS4806: Closed Circuit Television;
European Standard EN 50132-7;
ISO/IEC 19794 Biometric data interchange formats.
Individual patterns can be customized according to any other criteria related to the spatial resolution
or the field of view size.
Also in the box there are examples of images of group of people are automatically displayed for each
region of spatial resolution.
It is convenient to keep the Spatial resolution box opened during the analysis of spatial resolution in
the Graphics window. Comparing color of regions on the layout with color in table in the spatial
resolution box, on the images in the Resolution 278 and Field of view 278 columns you can
immediately see the expected resolution and field of view size at every point of view area of each
camera.
See further : Tools in the Spatial resolution box 274 , Work with the Spatial resolution box 281 .
See also: Spatial resolution 170 , Fill projection 169 , Visualization of cameras' control area projections
and spatial resolution inside them 381 .
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Tools
Pattern 274
Active camera 274
Edit/Save 274
Vert./Hor. 275
Pattern criterion 275
Height 275
Object height (width) 276
Draw Legend 276
Blend/Hatch 276
Assign 277
To selected cameras 277
Number of pixels 277
Table of regions 277
Resolution 278
Field of view 278
Type of hatching combo box 278
Colors of regions button 278
How to add your own images to the Table of
regions 279

Pattern

In this combo box the name of the chosen pattern of spatial resolution is shown.
You can choose any pattern from 30 patterns of spatial resolution. Parameters of the chosen
pattern are displayed and can be edited in the Spatial resolution box.
The name of the pattern can be edited in this box, when the Edit 274 button is pressed.
As a result of right-click on the combo box a pop up menu will appear. Selecting the Default
patterns item, you can erase all changes in the patterns and return to the patterns set by default.
The box is inaccessible when the Active camera 274 box is check ed.

Active camera
If the checkbox is checked, a pattern assigned to the active camera is automatically displayed in
the spatial resolution box. The Pattern 274 combo box will become inaccessible for editing.

Edit/Save
Edit the chosen pattern. Clicking on the Edit button makes parameters of the chosen pattern
accessible for editing. The button caption is changed to Save - stop editing and save the modified
pattern.
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

275

Vert./Hor. switch

The switch allows to choose direction (horizontal or vertical) to which the pattern criterion 275
must be applied.
If Vert. is checked then the Pixel per meter is the number of pixel per meter along the
vertical, the Field-of-view height is the height of the Field-of-View, the Pixel for object is the
number of pixel covered by the object along the vertical, the % of Field-of-view for object is a
part (%) of the Field-of-View covered by the object along the vertical;
If Hor. is checked then the Pixel per meter is the number of pixel per meter along the
horizontal, the Field-of-view width is the width of the Field-of-View, the Pixel for object is
the number of pixel covered by the object along the horizontal, the % of Field-of-view for
object is a part (%) of the Field-of-View covered by the object along the horizontal.
The switch is accessible for editing in the Editing 274 mode.

Pattern criterion

In the box you can choose a criterion according to which regions in the pattern will differ.
You can choose one from 4 criteria:
Pixel per meter (Pixel per foot) - vertical (horizontal 275 ) spatial resolution (pixels/meters,
pixels/foot);.
Field-of-view height (width) - vertical (horizontal) 275 field of view size (meter, foot);
Pixel for object - vertical (horizontal) 275 number of pixels covered by an object of the height
(width) specified in the Object height(width) 276 box (meter, foot); .
% of Field-of-view for object - the part of the frame height (width 275 ) covered by an object of
the height (width) specified in the Object height(width 276 box (meter, foot).
Direction of the criterion (vertical/height or horizontal/width) can be specified by the Vert.//Hor 275 .
switch
Meters or feet as a unit of height are selected automatically depending on the format of
measurements 199 in the project.
For the criteria Pixel per meter (Pixel per foot), Pixel for object the spatial resolution depends
on the number of pixels specified in the Number of pixels 277 boxes.
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels (or horizontal
768 pixels), what corresponds to analog camera.
Pattern criterion of spatial resolution for panoramic 269 cameras must be based on the spatial
resolution (Pixel per meter (Pixel per foot), Pixel for object), but not on the field of view size.
Criterion Field-of-view height, % of Field-of-view for object are not suitable to panoramic
cameras, because of panoramic cameras have not a stable field of view.
The box is accessible for editing in the Editing 274 mode.

Height
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Height of measuring the spatial resolution in the
horizontal projection (height of the horizontal red
line on the picture).
If the main optical axis of the camera is not
parallel to the horizon, the spatial resolution in the
horizontal projection depends on the height above
the ground.
If in the Height box AUTO is chosen and in
the View area projection bounds 168 and
Shadow 172 buttons the Within projection is
chosen, then calculation of spatial resolution in
the horizontal projection is carried out at the
middle height between the view area lower
bound height 259 and the view area upper
bound height 258 .
The box is accessible for editing in the Editing 274 mode.

Object height (width)
Height (width 275 ) of the object for the criteria associated with an object: Pixel for object and % of
Field-of-view for object.
The caption is changed according to the Vert./Hor. 275 switch.
The box is accessible for editing in the Editing 274 mode.

Draw Legend

Draw legend of the current Spatial resolution pattern on the Graphics area. After choosing this
button specify place of the legend on the Graphics area of the Graphics window.
You can select font type 322 on the font type panel 246 before placing or after double clicking near
to the left top corner of the legend.
By means of font type you can change size and color of the legend. You can also make the
legend scalable 322 or nonscalable.
Legend is tied with his Spatial resolution pattern 272 . If parameters of the pattern is changed then
the legend will be changed too. You can place several legends of different patterns on the same
layout.

Blend/Hatch
Show the regions in the Spatial resolution box hatched or filled by blend translucent colors.
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This box affects displaying regions in the Spatial resolution box only. Hatch or fill regions in the
Graphics window can be determined separately for each camera using the Fill projections 169
button.

Assign

Assign chosen pattern to the Active camera. If the To selected cameras box is checked, then
the chosen pattern is assigned to all selected cameras.

Number of pixels

Attention! The purpose of these combo box differs in Starter, Lite and Professional
versions!
In VideoCAD Lite these boxes represent number of pixels of the image of the active camera 162 .
The number of pixels affect visualization of the regions in the Graphics window. If the item
Processing>Resolutions 287 in the main menu of the 3D Video is checked, then the number of
pixels of the image in the 3D Video will be limited by the value in these boxes.
If number of pixels is not set (N/A), calculation is performed for vertical 576 pixels and horizontal
768 pixels, that corresponds to analog camera.
These boxes affect numbers of pixels for modeling images 278 on the far bounds of regions in the
Resolution 278 and the Field of view 278 columns in the Spatial resolution box.
Images on the bounds of regions depend not only on the criterion value 275 , but also on the number
of pixels.
Thus, for criteria related to the number of pixels which covers a specified height (width) (
Pixel per meter, Pixel for object) value of the criterion determines the spatial resolution, ie
how detailed the scene is photographed. In this case, the Number of pixels determines the size
of the field of view.
Conversely, for criteria related to the height (width) of the field of view (Field-of-view height
(width),% of Field-of-view for object) criterion value determines the size of the field of view. In
this case, the Number of pixels determines the spatial resolution, ie how detailed the scene is
photographed.

Table of regions
In rows of this table you can see and edit 281 parameters of regions of the chosen spatial
resolution pattern.
The bottom row of the table corresponds the nearest to the camera region.
On the first column of the table, on the background rectangles filled by a color assigned to the
region, the Name of the region and the Criterion value 275 at the far bound of region are
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displayed.

Resolution column
The Resolution column contains fragments of images with people at the far bounds of each
region. These are fragments of images, not whole images. Field of view of the
fragments is less than the real field of view, but the resolution of people corresponds the
real images exactly.
On the images in the Resolution column, you can see with which resolution people at the far
bound of each region will be visible.

Field of view column
The Field of view column contains whole reduced images of people with the field of
view at the far bounds of each region. Resolution of these images is less than resolution of
the real image, but the field of view corresponds the real images exactly.
On the images in the Field of view column, you can see which part of the field of view
people at the far bound of each region will cover.
Images in Resolution and Field of view columns are automatically generated according to the
criterion value of each region and the Number of pixels 277 value.
The images visualize the boundary values of the criterion.
The height of "men in blue shirt" is 2 meters (about 6.5 feet).
Right click on any
image in the Table of
regions. Pop up
menu will appear.
With the help of this
menu you can change
image in the Table of
regions.

In the Editing 274 mode the Names of regions and the Criterion values become accessible for
editing. In addition the Type of hatching combo boxes
buttons

and Colors of regions

appear.
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you can choose type of hatching for each

Hatching will be visible in the Spatial resolution box when the Blend/Hatch 276 box is not
checked. In the Graphics window, hatching of the chosen type will be shown for cameras, which
have chosen Hatching in the menu of the Fill projections 169 button.
Color of region is the same for filling and for hatching.

How to add your own images to the Table of regions
Table of regions can display any images in *. jpg format, for example: photos of objects,
etc. Adding your own images you can see how your objects will look at the far bounds of
regions.
To add your own images to the Table of regions:
1. Take any *.jpg file, digital photo image etc.
Simulated spatial resolution can not exceed the spatial resolution of the object on the used
picture, so the spatial resolution of the object on the picture should be sufficient. The object
should tak e the greatest possible part of the picture and the picture resolution should be
sufficient.
2. Name your file by the following composite name: <anyname>,<W>,<H>,<CX>,<CY>.
jpg
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Thus the name is a string composed of
the comma separated values:
<anyname> - any string without
spaces and special characters;
<W> - image width, in meters;
<H> - image height, in meters;
<CX> - X coordinate of a spot on the
image, at which the camera should be
pointed (in meters);
<CY> -Y coordinate of a spot on the
image, at which the camera should be
pointed (in meters);
Origin of coordinates is on the top left
corner of the image.

Example of file name:
sample1,2.67,2,1.335,0.177.jpg

3. Put your file in the VideoCAD installation directory, /Resolution samples/ folder.
You can place several files to this folder.
4. Launch VideoCAD. Open the Spatial resolution box. Right click on any image in the
Table of regions. Pop up menu will appear. With the help of this menu you can change
image in the Table of regions.
If your file is missing in the menu, then you probably made a mistak e in the filename. If the
file is displayed not correctly, you probably typed wrong values of sizes in the filename.

See further : Work with the Spatial resolution box 281 .
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Work with the Spatial resolution box
Editing the Spatial resolution pattern 281
Assigning the pattern to cameras 282

Editing the Spatial resolution pattern
1. Clear the Active camera 274 box.
2. Choose a pattern for editing in the Pattern 274 combo box.

3. Click the Edit 274 button.
Caption on this button will be changed to Save. Parameters
of the chosen pattern will become accessible for editing.
4. If necessary, edit the Name of the pattern in the Pattern 274 box by the keyboard.
5. Choose direction 275 (horizontal or vertical) and criterion in the Pattern criterion 275 combo box.

6. Specify Height 275 at which the criterion values should be calculated.
If in the Height box AUTO is chosen and in the View area projection bounds 168 and Shadow 172
buttons the Within projection is chosen, then calculation of spatial resolution in the horizontal
projection is carried out at the middle height between the view area lower bound height 259 and
the view area upper bound height 258 .
If in the Height 275 box of the Spatial resolution box, AUTO is chosen and in the View area
projection bounds 168 and Shadow 172 buttons the 2 levels is chosen, then calculation of spatial
resolution in the horizontal projection is carried out at the view area lower bound height 259
7. In case of chosen criteria is related to an object (Pixel for object, % of Field-of-view for
object), choose the object height(width) in the Object height (width) 276 box.

8. If the type of hatching is needed to show, clear the Blend/Hatch 276 box.
9. Specify values of the criterion 275 at far bound of each region in the Table of regions 277 .
When editing the values of criteria, you must comply with the following
rules:
9.1 The bottom row of the table should correspond to the closest to the camera region, and
thus must have:
maximum spatial resolution (the maximum value of the criterion Pixel per meter);
any object must cover the maximum number of pixels (the maximum value of the criterion
Pixel for object);
minimum size of the field of view (the minimum criterion Field-of-view height (width));
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any object must cover maximum part of the field of view (the maximum value of the criterion
% of Field-of-view for object).
9.2 The values of the criteria should be edited consistently from region to region, starting from
the closest to camera region (bottom row). For example, if the criterion is Pixel per meter, then
in the bottom row should be the maximum spatial resolution, and in each subsequent row
criterion value must be less than the row below.
If this rule is violated then the boxes with wrong values would be red highlighted.
9.3 In the editing mode 274 , the table unfolds and shows the maximum number of region in
the pattern (10). If you need a smaller number of regions, the "extra" regions must have equal
values of the criterion. "Unnecessary" regions should be placed one after another at the top of
the table.

10. You can edit the Name of each region in the Name box, choose a color that will be used for
displaying the region in the Graphics window by clicking on the Color button 278
hatch style in the Hatch style 278 .

, choose

combo box.

Hatching will be visible in the Spatial resolution box when the Blend/Hatch 276 box is not
check ed.
In the Graphics window, hatching of the chosen type will be shown for cameras, which have
chosen Hatching in the menu of the Fill projections 169 button.
11. On the images in the Resolution 278 column, you can see with which resolution people at the
far bound of each region will be visible.
On the images in the Field of view 278 column, you can see which part of the field of view people
at the far bound of each region will cover.
Sample images are correct for the cameras with vertical number of pixels specified in the Number
of pixels 277 combo boxes .

12. When editing pattern will be finished, click the Edit/Save 274 button once again.

Assigning the pattern to cameras
To assign a pattern, displayed in the Spatial resolution box to a camera:
1. Activate 162 the camera.
2. Click on the Assign 277 button.
If the To selected cameras 277 box is checked, then the chosen pattern is assigned to all selected
cameras.
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See also: Spatial resolution 170 , Fill projection 169 , Visualization of cameras' control area projections
and spatial resolution inside them 381 .
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3D Video
Graphics window
Main menu
View
3D Video

The 3D Video window is designed for 3D modeling images from the active camera.

3D Video can display:
Ground surface. The ground color is set on the tab 3D modeling 325 in the Options Box.
Grid. The presence, step and location of the grid are determined by the similar grid parameters
176 in the graphics window.
Background 204 . The Background is not visible by default. You can make the background visible
in the Main menu of 3D Video.
3D constructions; represent stretched throughout the height 2D constructions 181 in the graphics
window.
3D models. These are prepared 3D models of people, cars and other objects. See more: 3D
model 190
3D images. Usual raster images can be placed in the 3D space. See more: 3D image 191
Cameras. Cameras are represented as 3D models.
3D view areas. View areas in VideoCAD Lite are shown in the 3D Video in the form of semitransparent pyramids. See more: 3D view areas 288
Titles 287 . At the left top corner the main image parameters are displayed.
Visibility of some objects can be switched in the Main menu 286 of the 3D Video.
Location and editing these objects are carried out in the horizontal projection of the graphics
area 159 . In the 3D Video the result of these actions can be observed.

3D Video allows to:
disclose the view area distortions, arising from obstacles;
save 286 obtained images in the static files;
see at the design stage that, for what the video surveillance system is made - images from
video cameras.
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If image in the 3D Video is distorted, redrawing the image is too long or there are other artifacts,
see Errors in rendering 3D images 290 .
See also: 3D Video main menu 286 , 3D model 190 , 3D image 191 , Errors in rendering 3D images 290 ,
3D Models 291
External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
.
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Main menu

Image
Save as *.bmp ( *.jpg, *.gif, *.tif, *.png) 286
Copy to clipboard 286
Printer setup 286
Print 286
Processing
Compression 286
Resolution 287
View
Title 287
PTZH frame 287
Background 288
Ground surface 288
3D view areas 288
Help

Image > Save as *.bmp ( *.jpg, *.gif, *.tif, *.png)
Save the static image in the 3D Video in any format from the following: *.bmp, *.jpg, *.gif, *.tif, *.png.

Image > Printer setup
Choosing this item opens a standard dialog box of current printer setup in Windows.

Image > Print
Print image in the 3D Video.

Processing > Compression
The item opens a submenu, in which the image compression level can be chosen.
Compression levels may differ from the compression levels in the settings of different DVR or IP
cameras. To determine a correspondence use the visual image comparison.
Obtained image compress by the JPEG algorithm for approximating the image in the 3D Video to the
real image from video cameras to exactly estimation the possibilities of detection, identification and
reading
Using in your DVR algorithms different from JPEG is not generally an obstacle for compression
modeling with the help of JPEG algorithm. Although other algorithm artifacts differ from JPEG artifacts,
the general amount of information correspondence that can be determined by the careful visual image
comparison is enough for modeling.
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Processing > Resolution
If this item is checked, then the resolution in the 3D Video will be limited by value in the Number of
pixels 277 boxes, set for the active camera in the Spatial resolution box
The resolution will be limited in case of the size of the image in the 3D Video is more than value in
the Number of pixels 277 boxes.
This item must be checked for modeling resolution of panoramic (fish-eye) cameras 269 . Distortion
of a panoramic camera images in the 3D Video is not modeled.
The simulated resolution is exact only at the center of the frame. Towards the edges of the frame
the actual resolution is worse than simulated. The smaller the view angle, the more accuracy of
simulating resolution on the edges of the frame.

View > Title
Place the following information in the left upper corner of the image:
Name of the layout 340 on which the active camera is placed.
Active camera name.
Current image sizes in pixels.
Current image resolution in pixels (Image) and 3D Video size (Screen) separately, when the image
resolution 277 differs from the 3D Video size. The Resolution 287 menu item must be checked;
The grid 176 step, if the grid is displayed.

View > PTZH frame
PTZH frame (Pan-Tilt-Zoom-Height) allows operating camera similarly to PTZ one and additionally
change camera's installation height.
After clicking this item the camera's field of view
extends, and the objects being off view area, for
increasing the convenience of camera's
adjustment, become visible. Real field of view is
limited by orange frame.

Above the frame the buttons, which changes view area upper bound distance 260
area upper bound height 258
shown under the buttons.

and view

., are located. Current distance and height values are digitally

It is recommended to set view area upper bound height, which is equal to maximal height of
observed objects, and do not change it further. Further adjust camera's inclination by changing only
the view area upper bound distance.
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On the right and to the left of the frame there are camera rotation buttons

.

Under the frame there are buttons, which change the height of camera installation 257

. Current

value of height is digitally shown above the buttons. Near by them the lens focal length 256
combo box is located. Value in the box can be selected from the list or entered from the keyboard.
Using these tools it is possible to rotate the camera in both planes, change lens focal length and
height of installation.
To change the position on one step click corresponding button. For continuous moving bring the
cursor to the button, then press it and do not release the left mouse button. For precise position
adjustment do the same, but with pressed Ctrl.
In the PTZH frame mode you can pan and tilt the camera by moving the image like moving drawing in
the Graphics window. Press left mouse button, move cursor with the button pressed then release the
mouse button. Camera tilt angle is changed through changing view area upper bound distance. But
when Ctrl is pressed, the tilt angle is changed through changing view area upper bound height.
You can pan camera using arrow keys.
Together with Monitor window 294 this tool offers a new method 363 of 3D CCTV design.
If a model 304 is assigned to the camera, and the model has fixed 316 focal length lens, then you can
not change the focal length.
If a model is assigned to the camera, and the model has a lens with limited 317 variable focal length,
then you can change focal length within the limits only. When approach to the limit values, the box will
become crimson.
You can change focal length in wide range of 0.5-1000mm of cameras, which have not assigned model
or the assigned model have not specified limits of the lens focal length.

View > Background
Show or hide a background in the 3D image.
In case of vector back ground you can adjust
back ground resolution 326 in the 3D Video.

See more: Back ground 204

View > Ground surface
Show or hide ground surface. Ground color can be set on the 3D modeling 333 tab on the Options
box.

View > 3D view areas
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Enable in the 3D Video visualization of view
areas of cameras with 3D view area 174
enabled. View areas are shown in the form of
pyramids.
If the line type of camera 166 coincides with
default line type for camera icons, specified in
the Options box>Camera icon>Camera
icon>Line type 327 , then sides of the view area
are filled by different colors by default
(Camera 7 on the figure).
If another line type was assigned to the
camera, then filling view area of this camera is
performed by a color (3D>Color) of this line
type assigned to the camera. (Camera 5,9).
If the Spatial resolution 170
is enabled,
then colors of filling projections is determined
by Spatial resolution parameters (Camera 1,8).
View of 3D view area of the active camera can
be adjusted by buttons on the Toolbar
View area edges 167 ,
Fill projections 169
,
Spatial resolution 170 .
Transparency of the 3D view areas can be
changed with transparency of view area
projections in the Graphics window, in the
Transparency 327 box in the Camera icon tab in
the Options box.
The 3D view areas can be limited by the
maximum distance from the camera by using
the Camera geometry> Maximum distance of
drawing view area 265 .
To display the 3D view areas in VideoCAD
Professional there is a special window - 3D
World, it offers much more powerful tools for
view area visualization.

Help
Open the Help system topic with the information about 3D Video.
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Errors in rendering 3D images
The quality of 3D images in the 3D Video 284 and 3D Models 291 windows and the speed of its
refreshing depends much on your graphics card capabilities. To get maximum realism set the
maximum quality of Open GL images.
On some outdated graphic cards visible pixelization, errors and the lack of image are possible. This
is not a program fault. Some new graphic cards need an additional setting to get the maximum
realistic quality.
The speed of image updating also depends on the quantity of the displayed 3D models.
If errors are visible on the image in the 3D Video or the computer buzzes at the 3D Video/3D World
displaying, first of all update the graphics card driver to the latest version accessible on the
manufacturer website. The drivers which are used in Windows by default as a rule do not support
hardware acceleration.
Then try to change Hardware acceleration in the Display Properties box.
Then try to reduce Model space on the 3D modeling 325 tab in the Options box.
If failures or distortions remain, - a more high-end graphics card is necessary for 3D modeling.
For the best quality it is necessary to use a graphics card with OpenGL hardware support.
Redraw speed of the image depends also on number and complexity of displayed 3D
models and the size of opened 3D Video.

If the image is redrawn too slowly and that hinder operation in the Graphics window, try to adjust
VideoCAD for the most comfortable working on your equipment and your projects:
Mark the Redraw 3D image only by clicking 326 box on the 3D modeling 325 tab in the Options box
319 . After that the image in 3D Video will be redrawn automatically only at activation of cameras. To
force redrawing click on the image.
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3D Models
Graphics window
Main menu
View
3D Models

The 3D Models window is intended to manage 3D models 190 in the program library.
The 3D Models window can be opened in several ways:
Via the Main menu > 3D models> 3D Models window 231 ;
By clicking the button
on the Current construction parameter panel 248 during placement or
editing 3D models. In the 3D Models window the placed or edited 3D model will be loaded.
Adding a new model via Main menu >3D Models> Add 3D model 231 . The 3D Models window will
appeared automatically after opening a 3D model file, the new 3D model will be loaded into the 3D
Models window.
The 3D Models window consists of display area and panels with tools.
On the top of panels there is a button of choosing 3D models. Clicking on the button opens a menu
where you can select a 3D model from 3D model available in the library of 3D models.
In VideoCAD Lite there is only one tab - Model 292 . In VideoCAD Professional there are more tabs
View and Navigation.
Changes in the 3D Models window will be applied to all instances of the 3D model already placed in
the project. If you need several variants of the same 3D model with different properties, create a copy
293 of the 3D model.
You can resize the 3D Models window by dragging its borders by mouse. Via resizing the window,
you can change resolution of the 3D model's projection for displaying in the Graphics window
159 .
The 3D model's projection is updated at the moment of clicking the Save projection 292 button.
See further:Model tab 292
See also: 3D Video 284
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Model
On the Model tab you can:
Load new 3D models from *.vcm files.
3D model files in *.vcm format can be
obtained from SketchUP or 3ds max with the
help of special plugins. See more: Import of
3D models from Sk etchUp and Autodesk
3dsMax 397 .
Delete 3D models from the library;
Build projections of 3D models to display in
the Graphics window 158 and in menus 190 ;
Save 3D models to *.vcm files;
Duplicate 3D models;
Distribute 3D models by hierarchy
directories for convenient access from
menus.

Projection panel
The panel is intended to create projections of the 3D model to display in the Graphics window
159 and the menu 190 . Without the created projections, in the menus and Graphics window
instead of the 3D models gray rectangles will be displayed.
These projections can be repeatedly re-created for new or already placed 3D models.
The order of creation projection:
1. By the Horiz. <> Vert. switch, choose which projection should be created. Firstly you should
create the horizontal projection. The vertical projection is used rarely only to display 3D
model in Vertical projection of the Graphics area 159 .
2. Then adjust resolution of the projection visually, via changing window size by mouse.
For 3D-models of objects in order to improve performance you should chose minimally sufficient
resolution.
3D-models-territories require high resolution, for its increase special tools on the View tab are
offered.
3. After adjusting resolution, click the Save projection button. As a result in menus and in the
Graphics area 159 the 3D model will be displayed in the form of created projection.

Model panel
Load - Add new 3D model to the program library. In the appeared dialog choose a file in *.vcm
format and click Open.
3D model files in *.vcm format can be obtained from SketchUP or 3ds max with the help of
special plugins. See more: Import of 3D models from Sk etchUp and Autodesk 3dsMax 397 .
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If VideoCAD library already has a 3D model with the same name or ID, you will be prompted to
add the model under a different name or ID.
Then you will see the 3D Models window 291 , in which you can create the projection 292 of the 3D
model to display it in the Graphics window 158 and menus 190 . To do this click the Save
projection button and close the 3D Models window. After this, icons of the 3D model will appear
in menus and the 3D model can be placed in the graphics area.
If your 3D model has textures, in the same directory where the *.vcm file is opened from, a folder
with textures must be. The folder should be named <model name> _textures. VideoCAD plugin
for SketchUP automatically creates the folder with the textures in the directory of saving exported
model.
Save - save to *.vcm file the current 3D model. If your 3D model has textures, in the directory of
saving *.vcm file, a folder with textures named <model name> _textures will be created.
Dupl - make a copy of the current 3D model. Copies can be useful, for example, while working
with multi-storey buildings. You can create multiple copies of the 3D model of the building for
each floor. For each copy make a projection at different levels 292 and put them on different layers.
Delete - delete the current 3D model from the library. When you delete placed 3D model, all
instances of this 3D model will be also deleted from the project.

Directories panel
The panel is intended for distribution 3D models by hierarchy directories for convenient access
from menus.
List of directories - The list with full paths starting from the root directory. In the list you can
choose a directory for deleting or to put in it the current 3D model.
Add - Add new directory. The name of the directory should be entered with all directories of higher
levels. For example:
"cars" - new directory cars in the root directory of menus.
"cars\trucks" - new directory trucks in directory cars. If the cars directory does not exist, it will be
created.
Empty directories are not visible in menus, only directories with 3D models are visible in menus.
Delete - Delete the directory, chosen in the List of directories. Only empty directory can be
deleted.
Insert model - Put the current 3D model to the directory, displayed in the List of directories.
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Monitor window
Graphics window
Main menu
View
Monitor window

Monitor window is intended to model monitors of video surveillance system. However the field of
application of this tool is much wider.
Together with 3D Video 284 the Monitor window allows to project video surveillance system, working
directly with images. Thus all necessary changes on the drawing are carried out automatically.
Monitor window logically finishes the information transfer process in video surveillance system "from
a real object to an operator" and thus, allows to model the video surveillance system as a hole.
In Monitor window there can be up to 10 monitors. On each monitor up to 100 images from cameras
could be displayed simultaneously or with the dividing into screens.
Using Monitor window in order to achieve the best result it is possible to compare various variants of
cameras' placement.
Monitor window is useful at designing an operator's workplace. It is possible to estimate the detail of
images from cameras in split screen, an option to display images from different cameras in various
sizes, choose optimal quantity and sizes of monitors as well as optimal distance of watching these
monitors, taking into account features of projected video surveillance system.
Together with PTZH frame 287 this tool offers a new method 363 of 3D CCTV design.
See also: Work with Monitors 302 , Monitor window Tool bar 295 , Monitor window Main menu 298 ,
Monitor window Pop-up menu 300 .
External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

9.8.1

295

Tool bar

Monitor list 295
Update 295
Previous screen 295 , Next screen 295
Previous cell 296 , Next cell 296
Edit 296
Monitor dimension 296
Monitor diagonal 296
Screen Acpect Ratio 297
Stretch another aspect ratio images 297
Analog monitor 297
Monitor resolution 297

Monitor list
In the combo box there is a name of displayed monitor. It is possible to choose other monitor. In
VideoCAD there are 10 monitors, in which the set of cameras and the parameters are adjusted
independently.
To rename the displayed monitor use item Main menu Monitor>Rename 299 .

Update
Update all images on the displayed monitor.
Monitor window itself does not generate 3D images, but uses the ready images which are created
in 3D Video 284 and are stored in the memory that allows to work simultaneously with a big
quantity of 3D images without decreasing program's speed.
As a result of clicking this button, for some time 3D Video will appear, in which the images from
all cameras will be modeled according to saved parameters of the cameras.
.
To update the image in one cell click it by the right mouse button and choose in the pop-up
menu Update 300 .

Previous screen, Next screen
Each monitor consists of 100 cells, but it is also possible to display a smaller quantity of cells
simultaneously. The quantity of simultaneously displayed cells is chosen in the Monitor
dimension 296 combo box.
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Clicking the buttons Previous screen and Next screen shift the displayed cells on the quantity
of simultaneously displayed cells.
For example, if the monitor's dimension is 2x2, 4 cells are simultaneously displayed. If cells
5,6,7,8 are displayed, as a result of click ing the Previous screen button - cells 1,2,3,4 will be
displayed, and by click ing the Next screen button - cells 9,10,11,12 will be displayed.
Thus, each monitor can have several screens.

Previous cell, Next cell
Each monitor consists of 100 cells, but it is also possible to display a smaller quantity of cells
simultaneously. The quantity of simultaneously displayed cells is chosen in the Monitor
dimension 296 combo box.
Clicking the buttons Previous cell and Next cell shift displayed cells on one cell.
For example, if monitor's dimension is 2x2, 4 cells are simultaneously displayed. If cells 5,6,7,8
are displayed, as a result of click ing the Previous cell button - cells 4,5,6,7 will be displayed,
and by click ing the Next cell button - cells 6,7,8,9 will be displayed.

Edit
If this button is pressed, the monitor editing tools become available:
Monitor dimension 296
Monitor diagonal 296
Screen Acpect Ratio 297
Stretch another aspect ratio images 297
Analog monitor 297
Monitor resolution 297
Monitor>Clear 299
Monitor>Rename 299
Clear cell 300
Opportunity of cameras connection to the monitor 302
Opportunity of moving and copying cells 303
If this button is not pressed, monitor's editing is locked for protection against accidental change of
the monitor.

Monitor dimension
In the combo box it is possible to choose quantity of simultaneously displayed cells on the
current monitor.
2x2 corresponds to 4 cells, 3x3 - to 9 cells, etc.
One image can occupy 1, 4, 9 or 16 side-by-side located cells.
Changing value in the box is possible only in Edit mode 296 of the monitor.

Monitor diagonal
In the combo box it is possible to choose physical size of the screen of the current monitor.
The size is set by diagonal, in inches. Value N/A corresponds to the size which is not set. If the
physical size is set, possibility to change the sizes of Monitor window by the mouse is locked.
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To get precise sizes of the Monitor window you can adjust Monitor size factor 334 in the Options
box.
To change value in the box is possible only in Edit mode 296 of the monitor.

Screen aspect ratio
You can choose in the combo box screen aspect ratio. 4/3 - standard monitor, 16/9 - wide-screen
monitor.

Stretch another aspect ratio images
If the button is pressed then images from cameras with differing aspect ratio will be stretched.

Analog monitor
This tool allows to model analog monitors, the resolution of which is below the computers' one. If
this button is pressed, the resolution of the monitor is limited to value 768x576 pixels.
To change button's state is possible only in Edit mode 296 of the monitor.

Monitor resolution
In this box you can set resolution of the monitor. Resolution in the Monitor window will be limited
by value in this box.
Changing value in the box is possible only in Edit mode 296 of the monitor.
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Main menu

Image
Save as *.bmp 298
Save as *.jpg ,*.gif,
*.tif, *.png 298
Printer setup 298
Print 298

Monitor
Update 298
Edit 298
Clear 299
Rename 299

View
Full screen 299

Help 299

Image > Save as *.bmp
Save the image in the Monitor window in *.bmp format. The image is saved exactly as on the
screen, but the obtained file will be big.

Image > Save as *.jpg, gif, *.tif, *.png
Save the image in the Monitor window in *.jpg, *.gif, *.tif, *.png formats. The image is saved
compressed, at that a small loss of quality appears, but the file size turns to be small.

Image > Printer setup
Choosing this item opens a standard dialog box of current printer setup in Windows.

Image > Print
Print the image in the Monitor window.

Monitor > Update
Update all images on the displayed monitor.
Monitor window itself does not generate 3D images, but uses the ready images which are created
in 3D Video 284 and are stored in the memory that allows to work simultaneously with a big
quantity of 3D images without decreasing program's speed.
As a result of clicking this button, for some time 3D Video will appear, in which the images from
all cameras will be modeled according to saved parameters of the cameras.
To update the image in one cell click it by the right mouse button and choose in the pop-up
menu Update 300 .

Monitor > Edit
If this item is checked, the monitor editing tools become available:
Monitor dimension 296
Monitor diagonal 296
Screen Aspect Ratio 297
Stretch another aspect ratio images 297
Analog monitor 297
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Monitor resolution 297
Monitor>Clear 299
Monitor>Rename 299
Clear cell 300
Opportunity of cameras connection to the monitor 302
Opportunity of moving and copying cells 303
If this item is not checked, monitor's editing is locked for protection against accidental change of
the monitor.

Monitor > Clear
Clear all cells of the displayed monitor, delete images and disconnect cameras.
Item is accessible only in Edit mode 296 of the monitor

Monitor > Rename
Rename the displayed monitor. As a result of clicking this item a dialog box will appear, in which
it is possible to enter the new name of the monitor.
Item is accessible only in Edit mode 296 of the monitor

View > Full screen
Show the image from the displayed monitor at full screen.
In this mode it is possible to switch monitors sequentially using the keys Page Up and Page
Down, to shift cells by cursor moving keys Arrow left and Arrow right, to change monitor's
dimensions by cursor moving keys Arrow up and Arrow down.
To return to the monitor's showing in the window press any other key.

Help
Show Help section with description of Monitor window.
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Pop-up menu
The Pop-up menu appears as a result of click ing the right mouse button on any cell in Monitor w
indow. Operations in the pop-up menu are carried out above the camera, the image from which is
present at the cell. Therefore, in case of an empty cell items of the menu are inaccessible.
Exception is the Clear cell 300 item, which action concerns to the cell. Click ing this item deletes the
image from the cell.
Show in 3D Video 300
Update 300
Activate 300
Find on layouts 300
Clear cell 300

Show in 3D Video
Show the image in this cell in 3D Video 284 . The same result will be obtained, by double click the
cell.
It is convenient in 3D Video check the item of Main menu>View> PTZH frame 287 and visually
adjust cameras' positions. It is also possible to model parameters of the image and conditions of
surveillance. Thus, it is possible to project video surveillance system, working only with images.
All necessary changes on the layout will be automatically carried out.
After changing the camera's parameters click the Update 300 item.

Update
Update the image from the camera connected to this cell.
Monitor window does not generate 3D images itself, and uses ready images which are created in
3D Video 284 and are stored in the memory that allows to work simultaneously with a big quantity
of 3D images without program's speed decreasing.
As a result of clicking this item, for some time 3D Video will appear. In this window the image
from the camera will be modeled. The image will be modeled according to saved parameters of
the cameras.
.
To update the images on the monitor use the Update 295 button on the Tool bar.

Activate
Activate 161 the camera, connected to this cell.

Find on layouts
Find on layouts and select the camera, connected to this cell.

Clear cell
Delete the image from this cell and disconnect the camera from it.
Item is accessible only in Edit mode 296 of the monitor
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Work with Monitors
Opening Monitor window 302
Preliminary monitor's adjustment 302
Connecting cameras 302
Placement of images 303
Updating images 303
Work with monitor 303

Opening Monitor window
For opening the Monitor window click the Monitor window 176
button on Graphics window
tool bar. At first opening in Monitor window the first monitor with the name Monitor 1 and
parameters by default will be shown.
If the monitor is already adjusted and cameras are connected to it, at first opening Monitor
window after starting the program for some time 3D Video 284 will appear, in which images from
these cameras will be modeled.
Generation of 3D images can tak e a lot of time. To interrupt generation press ESC.

Preliminary monitor's adjustment
For monitor's adjustment, first of all switch on edit mode by clicking the Edit 296

button.

For renaming the monitor click the item in the Main menu of Monitor window Monitor >
Rename 299 .
Select quantity of cameras, which will be displayed the Monitor dimension 296 combo box.
If necessary, select physical size of monitor's screen in the Monitor diagonal 296 combo box.
Having set the size it will be impossible to change the size of Monitor Window by the mouse.
If it is an analog monitor, click the Analog monitor 297
pressed.

button. The button should look

In the Monitor resolution 297 box you can specify the resolution of monitor.

Connecting cameras
Connection of cameras is available only in Edit mode (Edit 296

button is pressed).

Select 177 necessary cameras on the layout in Graphics window, and then click a cell on the
monitor, beginning from which these cameras should be displayed on the monitor.
For some time 3D Video 284 will appear, in which images from these cameras will be modeled.
After that the images will appear in cells of the monitor, beginning from a cell selected by click.
Thus it is possible to connect any quantity of the selected cameras simultaneously.
If at the moment of click ing on the monitor Ctrl is pressed, new cameras will fill only free cells on
the monitor. Cells already filled will not change.
The image from each camera is modeled according to saved parameters of the camera.
.
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Placement of images
Images can be changed in positions, copied, deleted, merged in 4,9,16 side-by-side located cells
to get big images from some cameras
For placement of images the Edit 296 mode should be switched on.
To interchange images' positions in two cells, first click the first cell, then the second one.
For copying the image from one cell in another, first click the cell, from which it is necessary to
copy the image, and then on the cell, where it is necessary to copy the image. At the same time
Ctrl should be pressed.
To delete the image from the cell, click it by the right mouse button and choose in pop-up
menu Clear cell 300 .
To delete all images from the monitor choose item in the Main menu>Monitor>Clear 299 .
To increase images' size by merging the cells, place the images from one camera in 4, 9 or 16
side-by-side located cells. These cells are merged automatically.

Updating images
Monitor window does not generate 3D images itself, and uses the ready images which are created
in 3D Video 284 and which are stored in the memory. That allows to work simultaneously with a
big quantity of 3D images without decreasing the program's speed.
That is why after changing the parameters of a camera it is necessary to update camera's image
on the screen. To update the image in a cell click it by the right mouse button and choose in the
pop-up menu Update 300 . Then 3D Video will appear, in which the image will be modeled
according to saved parameters of the camera.
.
To update all images click the Update 295

button on the Tool bar.

Work with monitor
In order not to change monitor's adjustment by accident, switch off Edit mode by clicking the
Edit 296
button. The button should look not pressed.
Application of monitors at designing can be various. For acquaintance with all options of the work
with monitors, see: Tool bar 295 , Menu bar 298 and Pop-up menu 300 .
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Table of camera models
Graphics window
Tool bar
Table of camera models

The table displays parameters of camera models. Rows in the table correspond to models and
columns in the table correspond to model parameters.
To get help for any parameter, select a cell and press F1 or use the Help of parameter (F1) 314
item in the pop-up menu.
Models can be assigned 310 to cameras in the project. As a result of model assignment to a
camera, model parameters 315 would be assigned to the camera.

In VideoCAD Lite there are the most important parameters 315 only, used in modeling. In VideoCAD
Professional this table have much more parameters.
Parameters values can be taken from camera specifications.
Many cameras have different parameters in different modes, for example, at different resolutions,
different combinations of settings. If you need to simulate different modes of these cameras, you
should create several models for single camera.
At adding 310 new model it is not necessary to specify all parameters, it is possible to set only
important for a current task parameters. Unused columns in the table can be hidden 312 . It is
possible to create variety of table views 311 with different sets of columns and switch between them.
Search 309 , filtering 308 , sorting 308 of camera models by parameters are possible. These functions
make the table suitable for optimal choice of camera models for specific tasks.
It is possible to print 311 or export 311 the table or its separate fragments into formats *.txt, *.csv, *.
htm, *.rtf, *.xls.
It is possible to paste 313 fragments from Excel and copy 313 fragments to Excel using standard
copying and pasting.
At that the copying cell number and types of data in the copying cells should coincide.
In the table the sums of some parameters are automatically calculated and displayed in the
bottom row.

The table of camera models has 2 tabs:
All models
On the tab all camera models, which are available in the database of models, are presented. It is
possible to add 310 new models, edit 310 and delete 311 existing ones, as well as to assign 310
models to cameras in the project.
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The assigned model will be copied to the Used models tab automatically.
The database file of models on this tab is located in the VideoCAD installation directory and is not
included in the project. It is possible to save 311 the database of models to file and load 311 from file.

Used models
On the tab there are camera models, which have been already assigned to cameras in the project.
It is possible to edit 310 models and assign 310 models to cameras in the project. Adding and
deleting models from this tab is carried out automatically.
The assigned model from the All models tab is automatically copied to the Used models tab. If
the model is not used in the project any more, it is deleted from this tab.
The database of models on the Used models tab is a part of the project. As a result of opening the
project on other computer on the tab there will be the same models. You can copy 311 model from
this tab to the All models tab.
See more: Table Interface 307 , Tool bar 310 , Pop-up menu 313 , Parameters of camera model 315 .
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Interface
Interface of the Table of camera models includes:
Table Interface 307 ;
Tool bar 310 ;
Pop-up menu 313 .
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Table Interface
Selecting model (row) 307
Selecting column 307
Selecting fragment 307
Selecting and editing cell 307

Changing column width 307
Changing row height 307
Moving columns 308
Visibility of columns 308
Table views 308

Sorting by column data 308
Filtering by parameter value
308

Searching by parameter value
309

Selecting model (row)
To select model (row) bring the cursor to the left end of the row. The cursor should become a
right arrow

. Then click on this place. The selected row will be highlighted and marked by

the sign
.
To select adjacent models use up arrow and down arrow keys.
By pressing the down arrow key on the bottom row, new model will be created.

Selecting column
To select a column bring the cursor to the border between header and data of the column. The
cursor should become down arrow
. Click on this border.
To select several columns hold Ctrl. To select range of columns hold Shift or move the cursor,
holding the left mouse button.

Selecting fragment
Bring the cursor to a corner cell of a fragment, press the left mouse button and then move the
cursor, holding the left mouse button pressed. After selecting the fragment release the left mouse
button.

Selecting and editing cell
To select a cell, click on it. To edit, click on the selected cell once again. In most cells it is
possible to choose parameter value from the list.
It is possible to move around the cells using keys with arrows. For editing press Enter.
Some cells admit choice from the list of values only.

Changing column width
Bring the cursor to border of a column on the header. The cursor will become a double arrow
. Press the left mouse button and move the cursor. After getting the necessary width release
the mouse button.

Changing row height
Bring the cursor to border of a row on the left edge of the table. The cursor will become a double
arrow
. Press the left mouse button and move the cursor. After getting the necessary height
release the mouse button.
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You can change height only for all rows simultaneously.

Moving columns
To move a column, place the cursor on the column header. Press the left mouse button and move
the cursor. After moving column, release mouse button.

Visibility of columns
You can adjust visibility of columns, save and restore table structures as Views.
To show/hide any particular column:

Click on the black triangle on the top-left corner of the table;
In the appeared menu choose Visible columns;
In the appeared list of all columns check or clear name of necessary columns.
See also: Table tool bar>Views 311 .

Table Views
You can adjust visibility of columns, save and restore table structures as Views.
See also: Table tool bar>Views 311 .

Sorting by column data
To sort by the parameter value in the column, just click on the column header. Reclick changes
sort order to the reverse one.
To disable sorting, sort by the Number column.

Filtering by parameter value
Click on the arrow in the combo box at the column top (between parameters values and header)

and choose parameter value from the list.
In this combo box you can specify following filters:
Order by descending;
Order by ascending;
Clear filter;
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Custom; - Combined custom filter with several conditions.
All - all rows;
Not empty - only not empty;
Empty - only empty.
Boxes with possible field value. Just select needed values.

Searching by parameter value
Select any cell in a column (just select by one click, the cell should not be in edit mode). Type
fast a parameter value on the keyboard. During typing search of row (of model) will be carried out
with the typing parameter value in this column

.

See also: Table of camera models 304 , Tool bar 310 , Pop-up menu 313 , Parameters of camera
models 315 .
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Tool bar

Tool bars on All models 304 tab and Used models 305 tab differ a little. Differences are given below, in
tool descriptions.
Camera model 310
Assign 310
New 310
Edit 310
Delete 311
Copy to All models 311

Data 311
Save 311
Load 311
Export 311
Print 311

Views 311
Compress/Expand 311
Hide columns 312
Show all 312
Save view 312
Table view list 312
Delete view 312

Camera model
Assign
Assign model selected in the table to the active 161 camera.
As a result of assignment, model parameters 315 will be assigned to parameters of the active
camera. Changing of some parameters of the active camera will be disabled or restricted
according to model limits.
If model from the All models 304 tab is assigned it will be copied to the Used models 305 tab.
To assign one model to all selected cameras, use pop up menu of the Model of active camera
174 combo box on the Tool bar 164 of the Graphics window.

New
The button is present on the All models 304 tab only.
Create a new camera model. After clicking this button a new line will be added to the table. You
can enter parameters 315 of the new model to the line.
It is possible to specify parameters directly in the table of models. The majority of parameters
can be chosen from lists. For specifying parameter, click the cell of table twice with an interval
not less half of second. To turn the selected cell to edit state press Enter.
It is convenient to move the focus on the cells using the arrow k eys. If you press the "down
arrow" on the bottom line, a new line will be created.
It is possible to copy fragments into the table from Excel table. At that the number of cells and
data types should coincide.
See also. Parameters of camera model 315

Edit
Edit parameters of camera model. After clicking this button, the current line will turn to editing
mode. You can enter parameters 315 of the new model to the line.
It is possible to specify parameters directly in the table of models. The majority of parameters
can be chosen from lists. For specifying parameter, click the cell of table twice with an interval
not less half of second. To turn the selected cell to edit state press Enter.
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It is convenient to move the focus on the cells using the arrow k eys. If you press the "down
arrow" on the bottom line, a new line will be created.
It is possible to copy fragments into the table from Excel table, it is possible to copy cells within
the table of models. At that the number of cells and data types should coincide.
See also. Parameters of camera model 315

Delete
Delete model selected in the table. As a result of deleting model from the Used models 305 tab,
model assignment will be removed from cameras, to which the deleted model had been assigned.

Copy to All models
The button is present on the Used models 305 tab only.
Copy selected model from the Used models 305 tab to the All models 304 tab.

Data
Save
The button is present on the All models 304 tab only.
Save model database to file.

Load
The button is present on the All models 304 tab only.
Load model database from file.

Export
Export table of camera models to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File
format can be chosen in Save as dialog box appeared.
You can export selected fragments using pop-up menu 313 .

Print
Print full table of camera models or a selected fragment of the table. Print dialog box will open in
which it is possible to adjust printing options.

Views
View - is a set, width and order of visible columns.
In real projects there is no necessity to use all parameters. At various times different parameters
sets are necessary. You can hide 312 unnecessary columns, place 308 the rest columns in
required order and save 312 obtained view. After that at any moment you can restore 312 the saved
view (i.e. set and order of visible columns).

Compress/Expand
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Compress columns so that the table is placed completely on the screen or restoring normal width
of columns.

Hide columns
Hide selected 307 columns.

Show all
Show all columns including hidden 312 ones.

Save view
Save current table view 311 . Dialog box will open, in which it is necessary to enter view name. The
name will appear in the Table view list 312 .

Table view list
In the list there are all earlier saved views 311 of the table. To load a view, just choose its name in
the list.

Delete view
Delete the view 311 , the name of which is displayed in the Table view list 312 .

See also: Table of camera models 304 , Table interface 307 , Pop-up menu 313 , Parameters of camera
model 315 .
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Pop-up menu
Pop-up menu appeares at right-clicking on the Table of camera models.
Hide selected columns 313
Freeze columns up to selected one 313
Show all columns 313
Cut selection 313
Copy selection 313
Paste 313
Delete selection 314
Print 314
Export selection 314
Select all 314
Open Internet link 314
Help of parameter (F1) 314
Update cameras of the selected model 314
Update cameras of all models 314

Hide selected columns
Hide selected 307 columns.

Freeze columns up to selected one
Freeze columns, beginning from the left column up to selected 307 one. Frozen columns will not
be moved at horizontal scrolling of the table.

Show all columns
Show all columns including hidden 312 ones.

Cut selection
Cut contents of selected 307 cells to the clipboard.
The cut contents can be pasted 313 to other cells of the table or to Excel table.

Copy selection
Copy contents of selected 307 cells to the clipboard.
The copied contents can be pasted 313 to other cells of the table or to Excel table.

Paste
Paste clipboard contents to the selected 307 cells.
The content can be copied 313 from other sells or from Excel table. The copying cell number and
types of data in the copying cells should coincide.
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Delete selection
Clear selected 307 cells.

Print
Print selected 307 fragment of the table.
Print dialog box will open in which it is possible to adjust printing options.

Export selection
Export selected 307 fragment to any of the following formats: *.txt, *.csv, *.htm, *.rtf, *.xls. File
format can be chosen in Save as dialog box appeared.

Select all
Select all cells.

Open Internet link
Internet link is a camera model parameter 315 too. To each model an Internet link to more detailed
information can be assigned.

Help of parameter (F1)
Open help system topic with description of the parameter in the selected cell.
Effect of the item is similar to F1 pressing.

Update cameras of the selected model
At changing model parameters in the table, the parameters of cameras of this model, do not
change automatically.
Choose this item to bring parameters of all cameras of the selected model in correspondence
with the parameters of this model.
The item is present only in the pop-up menu of Used models 305 tab.

Update cameras of all models
At changing model parameters in the table, the parameters of cameras of this model, do not
change automatically.
Choose this item to bring parameters of all cameras in correspondence with the parameters of
all models.
The item is present only in the pop-up menu of Used models 305 tab.

See also: Table of camera models 304 , Table interface 307 , Tool bar 310 , Parameters of camera
models 315 .
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Parameters of camera model
The bold parameters are used in camera modeling. The rest parameters exist only for information
and comparison of different models.
In VideoCAD Lite there are only most important parameters, used for modeling. In VideoCAD
Professional you can use more than 100 parameters.
Name 316
Producer 316
Key feature 316
Type 316
Fixed, PTZ, Dome, Mini
316

Lens 317
Type 317
Focal length 317
Min. (mm), Max. (mm)
317

Angles of view (deg.) 318

Image sensor 316
Size 316
Number of pixels 317
Aspect ratio 317
See also: Table of camera models 304 .
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Voltage 318
Consumption 318
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Provider 318
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Parameter description
The red highlighted parameters are used in camera modeling. The rest parameters exist only for
information and comparison of different models. The majority of parameters can be chosen from
lists. In VideoCAD Lite there are only most important parameters, used for modeling. In VideoCAD
Professional you can use more than 100 parameters.

Name
Model name.

Producer
Producer of the model.

Key feature
Key feature of the model.

Type
Fixed, PTZ, Dome, Mini
Standard camera, PTZ camera, dome camera, mini-camera, auto-dome camera.
If the Display camera type box (on the tab in the Options box 319 ) is checked:
If PTZ or auto-dome camera is chosen, icons of cameras of this model in the Graphics
window will correspond to PTZ camera
.
If mini-camera (mini or mini-dome) is chosen, icons of cameras of this model in the
Graphics window will correspond to mini-camera
.
If panoramic is chosen, icons of cameras of this model in the Graphics window will
correspond to panoramic camera

or

.

Image sensor
Size
The Size parameter determines size of the image sensor or size of active area of the image
sensor.
See more: Image Sensor and Active area of image sensor
The Image sensor size can be specified by any of the following ways:
By format (type) in inches. For example 1/3";
By diagonal size of the image sensor in millimeters, in the form of dX.Y. For example: d6.0.
By sensor sizes in millimeters horizontally and vertically via hash, in the form of W#H. For
example: 4.8#3.6;
After format or length of diagonal, separated by space, you can specify the aspect ratio of
the image sensor in the form of W:H. For example: 1/3" 16:9 or d6 16:9. If the aspect ratio of

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

317

the image sensor is not specified, it is assumed equal to 4:3.
Active area size of the image sensor can be specified in millimeters horizontally and vertically
via asterisk, in the form of W*H. For example: 4.8*3.6;
See also: Image sensor size 255 , Specifying active area size of the image sensor 415

Number of pixels
Horizontal and vertical numbers of effective pixels of the image sensor.
In VideoCAD Lite the Number of pixels is used for visualization of spatial resolution 277 and to limit
resolution in the 3D Video 287 window.
See more: Number of pixels 277

Aspect ratio
Aspect Ratio of the output image (horizontal side size of the output image to the vertical side
size): 4:3, 16:9 etc.
The Aspect ratio of the output image may be different from the Aspect ratio of the image
sensor (can be specified in the Size 316 field).
See more: Specifying the Aspect ratio on output image 420
You can enter custom values from keyboard in the form of <width> :<height>, for example 11:4.
By specifying formats 3:4 or 9:16, you can set the so-called corridor format in which the height
of the frame is larger than its width.
For correct simulation resolution in the corridor format you must also swap the number of pixels
horizontally and vertically in the camera parameters 317 and image processing settings.
Via space character after the Aspect ratio you can set the crop factor - the ratio of cropping
active area size of the image sensor when the active area does not touch the edges of the image
sensor. Crop factor can be set as a vulgar fraction (separated by slash) or a real number. For
example 4:3 0.67 or 16:9 720/1080. If the crop factor is not specified, it is taken to be unity.

See also: Specifying 420 the crop factor 420 , Aspect ratio 257 , Specifying active area size of the
image sensor 415

Lens
Type
Lens type. If fisheye is chosen then the camera is a panoramic camera (180, 360 deg).
See more: Panoramic 269

Focal length
Min. (mm), Max. (mm)
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Minimal focal length - camera view angles are maximal.
Maximal focal length - camera view angles are minimal.
For a camera of this model, changing lens focal length 175 is possible only within the limits
from minimal to maximal.
For a lens with the fixed focal length minimal and maximal focal length are equal.
See also: Lens focal length 256

Angles of view (deg.)
Calculated angles of view of the lens. Angles of view are determined by VideoCAD, from camera
sensor format 316 and lens focal length 317 .
Real angles of view can differ from the calculated ones becouse of Lens distortion 316

Power supply
Voltage
Supply voltage of camera.

Consumption
Power (watt)
Power consumption of camera.

Current (A)
The consumption current of the camera. The current is calculated by VideoCAD from power
consumption and voltage.
On the Used models 305 tab the total current and power consumption of all cameras of this model
is displayed additionally.

Provider
Provider of the camera model.

Cost
Model cost.

Add. information
Any additional information about this camera model.

Internet link
Internet link to an information about this camera model.
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Options
Graphics window
Main menu
View
Options
The box is intended for adjusting various parameters of the program.
The box can be opened by choosing the item View > Options 218 in the Main menu of the Graphics
window 158 or by double-clicking on the Line type panel 245 or the Font type panel 246 .
The box consists of the following tabs :
Lines 320
Fonts 322
Keyboard 324
Camera icon 327
3D modeling 325
Export 329
Miscellaneous 333
Tool bar 332
All the parameter changes in the tabs become valid immediately and you can see their result.
To save the introduced changes click OK.
To cancel the changes click Cancel.
To assign default values to all parameters on the opened tab click Default.
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9.10.1 Lines
Graphics window
Main menu
View
Options
Lines

Left side of the tab
In the left side of the tab you can see and change parameters of any VideoCAD line type.
Up to 2000 types of lines can be used in VideoCAD project.
Parameters in the left side of the tab :

Number - the number of the displayed line type. Each line type has unique number from 1 to
2000.

Name - the name of the line type. The name can be changed.
Style - the name of line style. It can be chosen from the list (Solid, Dash, Short Dash, DashDot,
DashDotDot, etc).

Shadow - If the box is checked then all constructions made by this line type are considered as
obstacles at calculating shadows 172 .
In addition, to make a construction be considered as obstacle in calculation of shadows, it must
belong to a layer with the shadows option marked
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Choosing the best place for PTZ
(dome) camera 384 , Visualization of the camera control area projections and spatial resolution within
them 381

Cable - If the box is checked then line segments 183 made by this line type are considered as
cables. Their lengths are included in the cable report 240 , their names present in the Cable brand
lists in the Signal cable 341 and Power cable 342 length calculation boxes.

Screen width - line width on the screen (pix).
Print width - line width when printing (mm,inch).
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Screen color - line color on the screen.
Print color - line color when printing.

Parameters, relating to the 3D tools:
Maximum height - maximum height above the ground of 3D objects 181 , made by the line of this
type. Also the height above the ground of 3D models 229 .
Minimum height - minimum height above the ground of 3D objects, made by the line of this
type.
Heights can also tak e on negative values, and at that 3D model plunges under ground.
It is possible to change the heights on the Current construction parameters panel
line type.

247 irrespective

Color - the color of 3D objects, made by the line of this type.

Right side of the tab
In the right side of the tab you can see and change the numbers of line types for displaying the
system objects:
View area edges.
View area projection bounds.
Horizontal bounds.
Signal cable.
Power cable.
Grid.
Ground indication.
Height indication.
Default line type for 3D models.
Don't use the system lines for constructions and change their parameters without necessary.
Sometimes it leads to confusion.
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9.10.2 Fonts
Graphics window
Main menu
View
Options
Fonts

Left side of the tab
In the tab left part you can see and change parameters of any VideoCAD font type.
Up to 100 types of fonts can be used in VideoCAD project.
Parameters in the tab left part:

Number - the number of the displayed font type. Each font type has unique number from 1 to 30.
Name - the name of the font type. The name can be changed.
Style in Windows - the name of font typeface. It can be chosen from the list.
It is necessary to remember that not all the font typefaces are scaled correctly. To use
VideoCAD it is recommended to use only scalable typefaces (True Type or Open Type). Using
bit-mapped fonts (e.g.,MS Sans Serif) is not recommended.

Height - The font height in inches (in the actual drawing sizes). 1 inch = 2.54cm.
If the Scalable box is not check ed, then the height has only relative sense.

Style - Bold, Italic, Underline, Strike out
Screen color - font color on the screen
Print Color - font color at printing.
Scalable If the box is checked, then the font size will change together with changing the drawing scale.
The text typed in such font can be rotated to any angle. The box should be checked for the
majority of fonts.
If the box is not checked, the font size will not change at changing the drawing scale, and at
rotating text typed in such font it will be always horizontal. Such fonts are used for the camera
names and titles. They prove to be convenient for creating labels to be read at any scale.

Right side of the tab
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In the tab right part you can see and change numbers of system fonts:
Font
Font
Font
Font

of the titles displaying;
of the titles displaying in 3D Video 284 ;
of the camera name displaying in the Graphics window 158 .
of the camera name displaying in the 3D Video 284 ..

It is not recommended to use the system fonts and change their parameters without necessary.
Sometimes it leads to confusion.
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9.10.3 Keyboard
Graphics window
Main menu
View
Options
Keyboard

On the tab you can assign Shortcuts keys (keyboard shortcuts) for the items of the Main menu 197
of the Graphics window.
Keyboard shortcuts allow fast activation of various commands from the Main menu, by pressing
shortcuts on the k eyboard.

The order of shortcuts assignment to item of the Main menu:
In the Menu box choose section of the Main menu 197 .
In the Commands box the list of items of the chosen section will appear. Already assigned
shortcuts are indicated in brack ets after the names of menu item.
By the Show all button it is possible to call the full list of all menu items with assigned shortcuts.
This list can be saved to text file.
In the Commands box select the name of the menu item.
If the menu item has already assigned shortcut, the shortcuts will be displayed in the box on the
Current keys panel.
To remove assigned shortcuts click Remove.
To assign new shortcuts:
Set input focus on the Press new shortcut key box on the New shortcut key panel.
Press shortcut key on the keyboard.
The pressed shortcuts will appear in the Press new shortcuts box.
If pressed shortcuts has been already assigned to other menu item, the name of this item will be
displayed in the Currently assigned to box.
To assign typed shortcuts click Assign.
Shortcut assignment will be removed from the item displayed in the Currently assigned to box
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9.10.4 3D modeling
Graphics window
Main menu
View
Options
3D modeling

3D panel
Plate height
- vertical size of the license plate in the 3D Video 284 .

Plate width
- horizontal size of the license plate in the 3D Video.
Specify in these boxes the sizes of license plate, accepted in you country.
Also create *.bmp file with the image of you license plate, name it Number.bmp and replace with it
the file of the same name in the folder \Models\ in the VideoCAD installation directory.
!! The size of file sides, in pixels, must be equal to powers of two:
16,32,64,128,256,512,1024,2048 ....
After that 3D models 229 - cars will be displayed with your license plate.

Ground color
- ground color in the 3D Video.

Licence plate antialiasing
If these boxes are checked- the license plates are displayed more realistic in the 3D Video, but at
that it takes more time for repainting the 3D Video and there can be errors on some outdated graphic
card.

Space limits
At the use of some outdated graphic card the occurrence of distortions on the image in the 3D
Video is possible. For reduction of the distortions it is recommended to reduce Model space.
The increase of the near space limit has the much greater influence on distortions, than reduction of
the far space limit.
The objects which are closer to the camera, than near space limit or farther than far space limit
will not be displayed, but the distortions of the objects which are between space limits will be
reduced or removed completely.
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Background res.
In this box you can set resolution of vector background in the 3D Video 288 .

Redrawing 3D Video
On this panel you can optimize the speed of redrawing 3D Video 284 according to computer's
performance, current design features and designer's habits.

Draw 3D Video in separate thread
Use separate program thread for redrawing image in the 3D Video. When the checkbox is checked,
redrawing the 3D Video doesn't retard work of other windows but is carrying out with delay.
This check box is check ed by default. If errors occur while redrawing the 3D Video, try to clear this
check box.

Redraw 3D image only by clicking
Modeling complex 3D scenes require high computer performance.
If the image in the 3D Video is redrawn too slowly and that hinder operation in the Graphics window,
mark this box. After that the image in the 3D Video 284 will be redrawn automatically only at
activation of cameras. To force redrawing click on the image.
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9.10.5 Camera icon
Graphics window
Main menu
View
Options
Camera icon

On this tab can be changed:

Size and line type for icons of camera
The icon size is specified separately when displaying on the screen and when printing.
You can set any line type 320 for a camera during creating the camera 166 .
The camera will be drawn by default line type, if another line type has not been specified during
creation and placing.
Later on, you can change line type using Change line type 237 tool.

Show camera type
If the box is marked, then cameras of different types 166 will be represented by different icons:
,
,
..
In this case, camera tilt is not represented by the icons.
If the box is not marked, then all cameras will be represented by identical icons, which represent the
camera tilt.

Scalable
If Scalable box is checked, then cameras' icons are scaled with the other constructions. Size of
icons is specified in meters (feet) in the Size box below.
If Scalable box is not checked, then cameras' icons are not scaled. Size of icons is specified
separately: on the screen in pixel - in the Size (pix) box, for printing in millimeters, - in the Size
(mm) box.

Size
Size of scalable icons in meter (foot), when the Scalable box is checked.

Transparence of projections
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This combo box allows to adjust transparence of filling view area projections 169 in the Graphics
window. And transparency of 3D view areas 288 in the 3D Video.
See also: Move active camera name 202
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9.10.6 Export
Graphics window
Main menu
View
Options
Export

On the tab you can adjust parameters of drawing export 202 .
The tab is divided to 2 sub-tabs:
Parameters on the DXF 329 sub-tab are related to the export to AutoCAD DXF format.
Parameters on the BMP,WMF,EMF,GIF,TIFF,PNG,JPG,rPDF,PDF 330 sub-tab are related to the
export to raster BMP,GIF,TIF,PNG,JPG, PDF formats and windows metafile vector formats (WMF,
EMF). The tab includes the Raster PDF 330 panel.
If the Show this box before export is marked, the Export tab will be shown before each export.
See also Drawing>Save as 202

DXF
In VideoCAD 8 Lite export to DXF format is performed in simplified way as well as in versions
VideoCAD4-VideoCAD7. VideoCAD 8 Professional offers more powerful export tools.
All cameras and constructions splits into separate lines, parts of cameras are not combined into
blocks, the structure of the background is broken. Filling of the view areas is not saved, it can be
saved as hatching. When the shadows 213 is enabled, view areas with shadows are not saved.
Simplified export is possible to DXF format only. Resolution is limited by the value in the
Resolution 330 combo box.
While simplified export, the export file will be multi-layers. In obtained *.dxf file there will be the
following layers:
Background;
Constructions;
Cameras;
Additional (grid, titles, horizontal);
Frame for printing (if it is enabled).
Raster objects (projections of 3D models 229 ) are saved in the form of rectangles.

Common scale (unit/m, unit/ft.)
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Common scale of exporting drawing. The scale can be set in AutoCAD unit per meter (or foot)
on the VideoCAD layout.

Resolution (m. or ft.)
Resolution is the accuracy of export. Objects having sizes smaller than the set resolution could
be exported with errors. In most cases the resolution of 0.005m (0.5 cm) is optimal. For big size
drawings (kilometers) the export with such resolution can lead to errors. In this case, it is needed
to increase resolution and repeat export.

Sizes (unit)
As the export is usually executed with resolution, different form the screen resolution, it is
necessary to adjust the size of nonscalable objects. In case of nonscalable objects become too
small or too big in the exporting file.

Sizes (unit)
Camera icon (unit)
In the boxes you can specify sizes of camera nonscalable icons in AutoCAD units.

See also: Scale 327 .

Sizes (unit)
Nonscalable fonts, Hatch and dash lines
In the boxes you can specify scale factors for Nonscalable fonts (unit/point), Hatch and dash
lines. The factor for Hatch and dash lines also applied for arrows.

BMP,WMF,EMF,GIF,TIF,PNG,JPG,PDF
Scale factor
Unlike DXF 329 , the scale is not related to drawing size (in meter or foot), it is related to screen
size only.

Common scale
Common scale of exporting drawing relatively layout size on the screen.

Camera icon, Nonscaleable fonts and hatches.
In the boxes you can specify scale factors of nonscalable Camera icon, Nonscaleable fonts.
See also: Scale 327 .

Raster PDF
On the panel there are tools for export to raster PDF.
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Page Width and Height in centimeters or inches
To change page orientation, invert Width and Height.
Page margins, in centimeters or inches;
Title, Author, Subject, Keywords.
Parameters on the left side of the BMP,WMF,EMF,GIF,TIF,PNG,JPG,PDF 330 sub-tab also
have an influence on raster PDF.
An alternative way to export to *.pdf is to print 199 to a virtual printer, which produces printing result
as a PDF file. In this method, the weight and color of lines 320 , fonts 322 will match the values
specified for printing.
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9.10.7 Tool bar
Graphics window
Main menu
View
Options
Tool bar

On this tab you can control visibility of buttons on the Tool bar 164 of the Graphics window.
In the left window there are Invisible buttons, in the right window there are Visible buttons.
With the help of buttons
them visible or invisible.

and

you can move buttons between these two windows making

To move a button to other window:
select it by clicking;
click on the appropriate button
invisible.

Make the button visible or

Make the button

If after changing buttons' visibility the Tool bar look s incorrectly, - restart VideoCAD.
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9.10.8 Miscellaneous
Graphics window
Main menu
View
Options
Miscellaneous

Scaling factor when turning the mouse wheel
At a large factor the navigation becomes quicker, but less precise. Also use the key Ctrl 249 . Sign
of this factor determines the reaction for direction of rotation the mouse wheel. The factor has an
influence on scaling in the Graphics window 158 .

Exclude blinking
If the box is checked, then the redrawing is carried out in the computer memory and displayed on the
screen only at the end. At that there is no image blinking, but the redrawing speed lowers slightly.
If the box is not checked, the redrawing is carried out directly on the screen.

Snap sensitivity
You can adjust a distance on which the cursor will be snapped to points, lines and grid as a result of
snap 229 effect.
Lesser sensitivity allows to control mouse more precisely.
Higher sensitivity allows to use some imprecise pointer devices or work with high resolution
monitors.

Calculate shadow for active camera
Enable/ disable calculating shadows 172 .
Automatic calculating is performed for the active camera 161 only.
To disable automatic calculating shadows (with keeping already calculated shadows) clear this box.
This box is duplicated in the Main menu 215 of the Graphics window.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Choosing the best place for PTZ
(dome) camera 384 , Visualization of the camera control area projections and spatial resolution within
them 381

Calculate shadow for active camera once
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As a result of clicking this button, shadows for active camera will be calculated once, then the
Calculate shadow for active camera box will be cleared and shadows will not be calculated
anymore. Shadows have been calculated will be saved in project.

Project auto saving
With this panel, you can adjust auto saving VideoCAD's working projects to chain of files in intervals
specified in the Interval (min). The number of files is specified in the Depth box . The more files in
the chain are and the larger the file size of the project, the more hard disk space will require. After full
filling the chain, saving each new file will remove the oldest. You can specify autosave directory by
clicking on the Dir button.
Files in the chain are the usual project files of VideoCAD. The newest file called vcadproject_1.vc7,
previous vcadproject_2.vc7 etc.
Auto saving work s while work ing with the program. When no work , saving stops.

Printing
On the panel you can enable printing via buffer that allows to print without error on printers which do
not support GDI+ drawing commands of transparent fills, gradient and transparent projection of 3D
models. Via the buffer you can print without errors on most virtual printers, such as printing to PDF.
When using the buffer printing on the raster buffer is performed firstly, and then the raster buffer is
passed to the printer.
Without the use of the buffer the image is passed to the printer in vector form, as printing
commands. If the printer does not support all commands, the distortions of the printed image are
possible.
However not all printers can work with the Use buffer mode in all cases. In case of issues clear the
Use buffer checkbox. Try also to decrease printer DPI resolution, hide raster background.
When using the print buffer or if the printer does not scale hatching, to print hatching properly
check the option Scale hatching. If the printer scales hatching on their own and the buffer is not
used, clear the Scale hatching, otherwise the hatching will be printed too rare.

Thin lines of raster background
Mark of this checkbox increases the thickness of the thin dark lines on a light background to one
pixel when displaying raster background in the Graphics window. In most cases it improves
readability of the background when it is scaled.
This mode decreases speed of redrawing back ground.

UNDO depth
VideoCAD keeps several previous states for the possibility to undo operations using the Undo 196
function.
The number of keeping states can be adjusted in this box. The more states are kept and the more
the project size, the more RAM is needed.

Monitor size factor
Correction factor to bring the physical size of the Monitor window 294 on the computer screen to the
value specified in the Monitor diagonal 296 box on the Tool bar of the Monitor window.
To set the factor:
open the Monitor window;
specify in the Monitor diagonal 296 box on the Tool bar of the Monitor window approximately a
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half of the physical diagonal of your computer screen. The Monitor window must be visible on the
screen as a whole;
measure by a ruler the physical diagonal of the Monitor window on the computer screen;
calculate the needed Monitor size factor = (value in the Monitor diagonal box) / (Physical
diagonal of the Monitor window).
The Monitor diagonal is measured in inches. 1 inch = 25.4 mm.
For various physical monitors and screen settings in Windows may require different Monitor size
factors.
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Camera list
Graphics window
Tool bar
Camera list

In the Camera list box list of cameras in the project is displayed. Active camera is highlighted by
red frame. Any camera can be activated, removed, renamed, found on layouts, it is possible to
show 3D image from this camera. It is also possible to sort cameras in the list.
To perform any manipulations with the camera first select its name in the list by clicking.
For the chosen camera, it is possible to change Additional information and Camera type, which
determines camera icon type.
Cameras are displayed by different icons, only if the Display camera type 327 box in the Options box
319 is mark ed.
To activate camera without closing the box, double click the row with camera name in the table.
It is convenient to activate any camera by double click ing on its lens on the layout or by camera's
selection in the Active camera 167 list on the Tool bar of the Graphics window. It is possible to
activate cameras from the Monitor window 300 .
To find a camera on layouts select it in the table by clicking it once and then click Find on layouts.
To show 3D image from a camera select it in the table by clicking it once and then click Show 3D.
Choosing the items of pop-up menu, which appears when clicking the camera selected in the table
with the right mouse button, can perform the same actions.
Using the pop-up menu it is also possible to rename the camera and select camera model 304 .
Choosing the item Copy to clipboard you can copy whole camera list to Windows' clipboard. After
copying you can paste the camera list to MS Word, MS Excel or other software.
You can rename the camera and rename any number of cameras simultaneously using the
Numerate cameras 338 dialog box.
To sort the cameras in the list click the Sort cameras
buttons. Then will appear the buttons, by
using which it is possible to move the cameras selected in the list upwards on one position,
downwards, to the beginning or to the end of the list.
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It is not recommended to change the order of cameras without necessity.
To activate a camera and save the introduced changes click OK.
To cancel the introduced changes and camera activation click Cancel.
To switch promptly between cameras in the graphics window use the shortcut Ctrl+Spacebar.
See also: Active camera combo box 167
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Numerate cameras
Graphics window
Main menu
Camera
Numerate
cameras

This tool allows renaming and serial numeration any quantity of cameras simultaneously.
Order of work:
1.
2.
3.
4.

Adjust Numeration pattern 338 .
Adjust Numeration order 338 .
Adjust additional Setting 339 .
Click Numerate 339 .

Numeration pattern
Numeration pattern can be adjusted by combo boxes and check boxes placed above the combo
boxes.
In order that position of a combo box presents in the pattern, the box above this combo box should
be marked.
It is possible to select variants of using the positions.
In the Example of numeration box the camera name example according to the specified
pattern is displayed.

Numeration order
Camera numeration order on layouts is adjusted on the panel.

Common number - numerate in camera number increasing order all over the project. Camera
numbers are displayed in the Camera list 336 box in the Number column.

Numerate on layouts - numerate in camera number increasing order separately on each layout
242 .
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From top to down - numerate cameras from top to down according to their position on layouts.
From left to right - numerate cameras from left to right according to their position on layouts.
Step - numeration step on layouts when numerating from top to down and from left to right (meters
or foots).

Setting
Selected only - if the box is marked, numerate only selected 161 cameras, otherwise all
cameras.

On all layouts - if the box is marked, numerate cameras on all layouts in the project, otherwise
only on the current layout.

Start numeration on each layout - on each layout the numeration will be started over again.
At that on different layouts in the project, cameras with identical names could be found.

Starting index - index, from which to start numeration.

Numerate
- start numeration.
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Layouts
Graphics window
Main menu
Drawing
Layouts

In this box a list of project layouts is displayed.
The project may contain up to 10 layouts. Originally one layout is created into project.
You can create, delete or rename any project layout. To delete the original layout and any layout
with the cameras present in it is not allowed.
The layouts are separate sections of monitored object (building, room, territory and storey). A layout
contains the horizontal and vertical projections locating backgrounds, cameras, cables 238 and
constructions 181 . Each camera can be displayed in one layout only, though the camera cables
may pass through several layouts.
To choose a layout for displaying it in the graphics window 158 and saving the introduced changes
select it in the table by clicking it once and then click OK.
To delete a layout select it in the table by clicking it once and then click Delete.
To create new layout click Add.
To rename a layout double-click a line with its name in the table.
To cancel the introduced changes and layout loading click Cancel.
It is convenience to switch the layouts, create, delete, rename the layouts using the Layout 242 tabs
in the left bottom corner of the Graphics window and the pop-up menu of the tabs.

To switch promptly between layouts in the graphics window use the shortcut Ctrl+TAB.
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Signal cable length calculation box
Graphics window
Main menu
Cables
Signal cable

VideoCAD summarises the lengths of all the segments, considers the reserves and calculates the
total length of cable.
To change the default parameters and obtain the calculation results double-click on any cable
segment or click Signal cable 193 again.
A dialog box of the same name appears after that.

Cable brand
In this box you can assign a brand to the signal cable of the active camera. Cable brands are
Names of line types 320 , which are considered as cables (the Cable box in the line type parameters
320 is checked).. Thus we assign simultaneously cable brand and correspondent line type by which
the cable will be drawn on layouts.
We can obtain Cable report 240 which contains cable lengths of each brand separately.
The results of the cables' calculation on each individual camera and on the project as a whole are
included into the text file obtained by Text report 200
See also: Power cable electrical parameters and length calculation box 342 , View>Active camera
cables 216 , View>All cameras' cables 216 , Length calculation of line segments 343 , Cable report 240 .
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Power cable electrical parameters and length calculation box
Graphics window
Main menu
Cables
Power cable

VideoCAD summarizes the lengths of all the segments, considers the reserves and calculates the
total length of cable.
To change the default parameters and obtain the calculation results double-click on any cable
segment or click Power cable 193 again.
A dialog box of the same name appears after that enabling to choose a section area of power
cable to fit the requirements of camera voltage supply.
It is assumed that the conductor material is copper and the conductor temperature is + 50° C

Cable brand
In this box you can assign a brand to the power cable of the active camera. Cable brands are
Names of line types 320 , which are considered as cables (the Cable box in the line type parameters
320 is checked).. Thus we assign simultaneously cable brand and correspondent line type by which
the cable will be drawn on layouts.
We can obtain Cable report 240 which contains cable lengths of each brand separately.
The results of the cables' calculation on each individual camera, each individual section area and on
the project as a whole are included into the text file obtained by Text report 200 .
See also: Signal cable length calculation box 341 , View>Active camera cables 216 , View>All
cameras' cables 216 , Length calculation of line segments 343 , Cable report 240 .
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Length calculation of line segments
Graphics window
Main menu
Cables
Length calculation of line segments

With this tool it is possible to calculate total length of line segments 183 of the chosen line type 320 .
Thus, it is possible to use certain line types as cables.
Only line segment 183 lengths are summarized. Lengths of other type constructions 181 are not
summarized.

Line type
In the combo box you can select line type 320 . Line segments made by the line type will be
summarized.

Cables only
When this box is checked, in the Line type combo box only line types which are considered as
cables are shown (the Cable box in the line type parameters 320 is checked).

Selected only
Summarize selected 161 segments only.
After selecting line type, in the On the current layout and On all layouts boxes calculation
results will appear.

Additional buttons:
Refresh - Recalculate.
Close - Close the box.
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Help - open this Help topic.
See also: Cables 238 ,Signal cable length calculation box 341 , Power cable electrical parameters and
length calculation box 342 , Cable report 240 .
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PDF Report
Graphics window
Main menu
Project
PDF Report

The dialog box is used to configure the report in PDF format.
The box consists of the following tabs:
Document 345
Cover 346
Cameras 347
Other 347
To get a report you should adjust the settings on each tab, then click OK.

Document
On the tab the common parameters of a PDF document are specified.
Page Width and Height in centimeters or inches
To change page orientation, invert Width and Height.
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Page Margins, in centimeters or inches;
Title, Author, Subject, Keywords.
In the Font (codepage) combobox a font for the document can be specified. The font must be
TrueType. This can either be the name of the font as shown in the Windows\Fonts folder (for
example "Times New Roman") or it can be the font family name with an optional style specifier in
square brackets (for example "Times New Roman [BoldItalic]").
Possible optional specifiers are: [Bold], [Italic] or [BoldItalic].
A codepage can also be specified (for example "Arial [Bold] {1250}") which allows other encodings
to be used.
If the report is in characters other than the Latin alphabet is not displayed correctly select your codepage.
Possible code pages are:
{0} Direct mapping
{437} OEM_CHARSET
{850} OEM_CHARSET
{852} OEM_CHARSET
{874} THAI_CHARSET
{1250} EASTEUROPE_CHARSET
{1251} RUSSIAN_CHARSET
{1252} ANSI_CHARSET
{1253} GREEK_CHARSET
{1254} TURKISH_CHARSET
{1255} HEBREW_CHARSET
{1256} ARABIC_CHARSET
{1257} BALTIC_CHARSET
{1258} VIETNAMESE_CHARSET
{1361} JOHAB_CHARSET
Below, you can set the Font height in % of the height of the sheet and Line spacing.
If the Page Numbers checkbox is checked, at the bottom of report pages the page
numbers will be printed.
The Headlines checkbox enables drawing horizontal lines on top and on bottom of each
page.
Below you can specify Header and Footer.

Cover
On the tab parameters of the cover sheet can be specified.
If the Cover checkbox is marked, the cover is included in the report.
If the Frame checkbox is marked, the frame is drawn on the cover.
If the Logo checkbox is marked, then any image can be drawn on the cover.
X (%), Y (%) - the position of the image on the sheet in % of the sizes of the sheet.
W (%), H (%) - the size of the image on the sheet, in % of the sizes of the sheet.
In the Path box the path to the image file can be entered. To select a file click on the
button

. Possible file formats: bmp, jpeg, gif, tif, png, wmf, emf.

Below there are 4 identical panels where you can specify blocks of text.
Checkboxes Text 1..Text 4 include corresponded blocks of text on the cover.
X (%), Y (%) - the position of the text on the sheet in % of the sheet size.
Height (%) - the height of the text on the sheet in % of the size of the sheet.
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Interface

347

By clicking
button, you can select color of the text block.
In the Alignment combobox you can select text alignment.
The text itself can be entered in the box at the bottom of each panel.

Cameras
The tab is intended for adjusting information about the cameras that you want to include in the
report.
If the Layouts checkbox checked, the report will include the names of layouts.
If the Drawing checkbox is marked, the report will include drawings of the layouts.
X (%), Height (%) - the position and height of the drawings on the sheet, in % of the size of the
sheet.
If the Cameras checkbox is marked, the report will include parameters of cameras.
If the Images checkbox is marked, the report will include images from the cameras.
X (%), Height (%) - the position and height of the images from the cameras on the sheet, in % of
the size of the sheet.
If the Titles checkbox is marked , the images from the cameras will include titles 287 .
Clicking on the
button starts updating the stored images.
Generation of images from the cameras can be time consuming.
If the Placement checkbox is marked, then the report will include fragments of layouts
with positions of the cameras.
X (%), Height (%) - the position and height of the fragments of the layouts on the
sheet, in % of the size of the sheet.

If cam eras occu py too s m all fragm en ts of plan s , redu ce th e M axim u m dis tan ce of draw in g view
area 265 in th e cam era param eters .
Below there are checkboxes, by which you can select the camera parameters that should
be included in the report.

Other
On the tab additional information in the report can be adjusted.
Cameras summary - the number of cameras, the number of used models of cameras 304 , lens
focal lengths, the camera resolutions in pixels, the total cost of the cameras (if the cost 316 is
assigned to the used camera models).
Cables summary - the sum of the lengths of the cables.
All line segments 183 and cables 193 made by line types with marked Cable 320 box in the
parameters of the line type will be calculated.
These line types are considered as cable brands. These line types can be assigned to the Signal
cable 341 and the Power cable 342 of any camera.
You can simply draw cables as line segments on layouts using these line types. In this case, the
cables are considered as main cables which are not attached to any camera.
The report includes the cables attached to cameras and the main cables as well. Cable lengths
are calculated for each brand (line type) separately.
See also Cable report 240
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Spatial resolution patterns - information about Spatial resolution patterns 272 used in the project.
Date - the date and time of generating the report.
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Image sensor calculator
Camera Geometry
Sensor and Lens
Calculator

The Calculator is intended for convenient calculation :
Aspect Ratio of Image sensor;
Aspect Ratio of active area of Image sensor (=Aspect ratio of the output image);
Crop-factor.
About use of the calculator, see: Specifying active area size of the image sensor/ 415
The calculator can be invoked by the Image sensor calculator
267 box.

button in the Sensor and Lens

The calculator consists from the three lines:

Image sensor
As a result of click on the left button
numbers of pixels of image sensor horizontally
and vertically are copied from the Sensitivity and resolution window to the Hor. and Vert.
boxes. If the numbers are not specified, the left button is not available.
To the Hor. and Vert. boxes you can type any values .

In the Aspect ratio box the calculated ratio of horizontal to vertical numbers of pixels of the Image
sensor will be displayed.
Attention! To calculate the Aspect ratio of Image sensor you must divide maximum number of
horizontal pixels to the maximum number of vertical pixels in all possible modes of the
camera. In general, the maximum number of pixels may be different from those specified in the
Sensitivity and Resolution window..
For example, a camera has the following resolution modes
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90
1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
The maximum horizontal number of pixels - 1920, The maximum vertical number of pixels - 1200.
Probable Aspect ratio of the image sensor 1920/1200=1,6=16:10
Clicking the right button

the calculated aspect ratio of image sensor will be copied to the
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Aspect ratio 267 box in the Sensor and Lens box.

Image sensor's active area
As a result of click on the left button
numbers of pixels of output image horizontally
and vertically are copied from the Processing tab of the Image parameter panel to the
Hor. and Vert. boxes. If the numbers are not specified, the left button is not available.
To the Hor. and Vert. boxes you can type any values .

In the Aspect ratio box the calculated ratio of horizontal to vertical numbers of pixels of the output
image will be displayed.
the calculated aspect ratio of the output image will be copied to
the Aspect ratio 257 box in the Camera Geometry 251 box.
Clicking the right button

Crop
The Crop factor value is calculated from the Aspect ratio of the Image sensor and Aspect ratio
of the output image.
Attention! The calculated value of Crop has sense only if the active area on the image sensor
does not touch the edges of the image sensor. Otherwise Crop = 1 and the result of
calculation does not matter.

See more: Specifying the crop factor 420
To be able to calculate Crop it is necessary that numbers of pixels of image sensor are greater
than or equal to the numbers in pixels of the active area. Otherwise, the Crop box displays Error.
Clicking the right button

the calculated Crop factor will be copied to the Crop 268 box of

the Sensor and Lens box.
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Examples of work with VideoCAD
Example 1 Choice of camera installation height and parameters 355
Example 2 Choice of cameras' quantity and location

357

Example 3 Choice of cameras' quantity and location on the original layout 359
Example 4 Calculation of camera view area parameters 360 (Professional version)
Example 5 Calculation of cameras' parameters and choice of their relative locations 361 (Professional
version)
Example 6 Determining person identification criteria by a real image 362 (Professional version)
Example 7 CCTV design using Monitor window and PTZH frame 363
Example 8 CCTV project 365
Example 9 Choice of camera model according to known scene illumination 366 (Professional version)
Example 10 Measuring camera sensitivity 367 (Professional version)
Example 11 Measuring low illumination 368 (Professional version)
Example 12 Measuring resolution of camera (lens) 369
Example 13 Measuring maximum scene illumination for a camera 371
Example 14 Examples of luminaire calculation 373 (Professional version)
Example 15 Choice of luminaire power and location 374 (Professional version)
Example 16 Determining spectral efficiency of light source 375 (Professional version)
Example 17 Measuring projector parameters 376 (Professional version)
Example 18 Measuring parameters of IR illuminator 377 (Professional version)
Example 19 Modeling megapixel images 378 (Professional version)
Example 20 Selecting frame rate on the basis of known target's positions and velocities 379
(Professional version)
Example 21 Creating animated model of monitor 380 (Professional version)
Example 22 Visualization of cameras' control area projections and spatial resolution inside them 381
Example 23 Choosing install location for PTZ camera 384 (Professional version)
Example 24 Simulating distortions of moving objects arising from Exposure time, Interlace scan and
Rolling shutter 385 (Professional version)
Example 25 Calculating lengths of cables and getting Cable report 388
Example 26 Checking Depth of Field in horizontal projection 390 (Professional version)
Example 27 Measuring exposure time of IP camera 391
Example 28 Measuring rolling shutter row time of IP camera 394
Example 29 Import of 3D models from SketchUp and Autodesk 3dsMax 397
Example 30 Work with layers and multi-level projects 398 (Professional version)
Example 31 Work with 3D models-territories 399 (Professional version)
Example 32 Export 3D view areas to general 3D design software 400 (Professional version)
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Example 33 Using camera rotation around its own axis 402 (Professional version)
Example 34 Modeling lens distortion 403 (Professional version)
Example 35 Measuring real view angles 405
Example 36 Modeling panoramic cameras (Fisheye, 360°/180°) 409
Example 37 Work with background in AutoCAD formats 413 (Professional version)
Example 38 Specifying active area size of the image sensor 415
Example 39 Teaching materials 424
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Example 1 Choice of camera installation height and
parameters
Problem
We have a number of objects spread in a space.
The objects have certain locations and sizes.
It is required to determine the height of installation and lens focal length of the camera to
display all the objects properly.

Solution
1. Place the objects in horizontal and vertical projections according to their actual sizes and
location using the tools on the Tool bar 164 . High-usage tools are:
Line segment 183
Polyline 183
Rectangle 184
Inclined rectangle 184
Wall 186
Aperture in Wall 187
Circle 187
3D model 190
3D image 191
It is necessary for 3D modelling to place objects only in the horizontal projection, color of the
objects preset in the line type 320 , by means of which the object is drawn. Heights of the objects
can be specified on the Current construction parameter panel 247 during drawing constructions.
As the objects prepared 3D models 229
can be used (people, cars). Choose necessary 3D model
from the Tool bar then specify by click ing the place of the model on layout.
2. Open 3D Video 284

. Control image in the 3D Video during next operations.

3. Switch to Select/Edit 177

mode by successive pressing ESC key.

4. To move the camera:
Select the camera by clicking on its lens;
Move the cursor to the lens, then press the left
mouse button;
Keeping mouse button pressed, move the selected
camera to a new place;
Release the left mouse button.
5. For tilting and panning the Active camera 162 on the layout in Select /edit 177 mode:
Move the cursor to the pink grip in the middle of the
view area bound. Thereupon, the point will be
outlined by red square;
Click on it by mouse;
Move the cursor;
To stop tilting or panning click once again on a point
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where the middle of the view area bound is to be
located.
Current focal length value is displayed in the Lens
focal length 175 combo box on the Tool bar 164 .

6. To change lens focal length 256 of the active camera on the layout in Select /edit 177 mode:
Move the cursor to any orange grip on the ends of
view area bound. Thereupon, the point will be
outlined by red square;
Click on it by mouse;
Move the cursor;
To stop changing focal length click Once again on a
point where the end of view area bound is to be
located.

7. You can change Camera installation height by
choosing value from the combo box 257 in the Camera
Geometry 176 box
.
You can also specify the height by click ing in vertical
projection after choosing the Change installation
height 195
tool.

8. According to the image in the 3D Video and view area projections on the layout choose the
optimal camera position and its lens focal length 175 .
External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf) .
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Example 2 Choice of cameras' quantity and location
Problem
It is required to monitor a room of arbitrary form and sizes.
Person detection is required at all the space of a room.
Person identification is requires beside an entrance door, a safe and a manager's table.
The manager's workplace itself must not hit in the view area.
Cameras might be installed anywhere, though not lower than 2.5 m.
It is required to choose the camera quantity, lenses, locations and cables.

Solution
1. Create project 199

and Camera 200

.

2. Using the tools of Constructions group 181 create an actual plan of a room.
All the details are not to be k ept, our task is to observe the sizes carefully.
It is possible to load as a background 204 prepared drawing in any of the following formats:
*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.jpg - the compressed image (e.g., a digital picture of the plan);
*.wmf, *.emf - Windows Metafile (export to *.wmf is supported by the majority of the Windows
graphics applications)
It is necessary for 3D modelling to place objects only in the horizontal projection. Color of the
objects is specified in the line type 320 , by means of which the object is drawn.
Heights of the objects can be specified on the Current construction parameter panel 247 during
drawing constructions.
For example to model a grey wall it is necessary to use lines with the minimum height 0 m and
maximum - 3 m (the height of the wall); to model a door draw a rectangle using a line with the
heights 0-2 m; to model a table surface draw a rectangle in the height range 0,73-0,75 m etc.
Windows and door apertures can be cut through walls made by the Wall 186 tool with the help of the
Aperture in Wall 187 tool. Or model walls by several constructions: under aperture, on each side of
aperture, above aperture.
It is possible to put 3D models 229
of people in some places.
3. Create the essential quantity of cameras, using the copying 180

and paste 180

.

4. By changing camera disposition in the graphics window and lenses' focal lengths 175 we obtain
the best location.
See. Example 1 355 .
5. In the 3D Video 284 we can see 3D models of camera images.
6. Choose Filling

in the drop-down menu of the Fill projection 169 button on the Tool bar.

View area projection will be filled by blend color.
The color of filling is determined by the line type 169 of the camera.
7. Choose Discrete color
the Tool bar.

in the drop-down menu of the

Spatial resolution 176 button on

View area projection will be divided into the regions. The regions will be colored according to values
of the criterion 272 within the regions.
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8. Open the Spatial resolution 176

box.

In the Pattern criterion 275 combo box you can see which criterion is chosen in the pattern assigned
to the active camera.

Specify vertical number of pixel of camera in the Number of pixels 277 combo box.

In the Table of regions 277 you can see what color corresponds to each range of the criterion value.
On the images in the Resolution 278 column, you can see with which resolution people at the far
bound of each region will be visible.
On the images in the Field of view 278 column, you can see which part of the field of view people at
the far bound of each region will cover.

9. Create additional layouts if needed (e.g. several storeys).
External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf), The
principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf).
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Example 3 Choice of cameras' quantity and location on the
original layout
Problem
There is a location plan of site in any of the following formats:
*.bmp - a bitmap (e.g., the layout scanned from a paper copy);
*.dxf - AutoCAD format (created in AutoCAD or other program supporting export to *.dxf);
*.dwg - AutoCAD format (created in AutoCAD or other program supporting export to *.dwg);
*.jpg, *.gif, *.tif, *.png - the compressed image (e.g., a digital picture of the plan);
*.pdf - cross-platform format of electronic documents developed by Adobe Systems;
*.wmf, *.emf, *.emf+ - Windows Metafile (export to *.wmf is supported by the majority of the
Windows graphics applications)
The length of a building frontal wall - 80m. (Or any other size) is known.
It is required to create a project of site surveillance system.

Solution
1. Choose menu item Drawing > Load background > Horizontal projection 204 .
2. In the appeared dialog box choose a layout file and click Open.
3. In the appeared dialog box Adjust Background 205 click Ruler.
4. Click the beginning of the frontal wall in the loaded layout.
5. Then click on the end of the frontal wall.
6. After that enter the known length of the frontal wall - 80m in the Real distance box.
7. Then click OK in the Adjust background dialog box .
If the loaded back ground is in PDF format, the Adjust back ground dialog includes fields for
selecting page in the PDF document and to set resolution of the PDF document. If the loaded
back ground is in DXF or DWG format, the dialog includes tools to select a layout and to control
visibility of layers of the back ground, as well as a check box to hide texts.
8. To obtain 3D model of the site 284 , draw out lines on the background by Constructions 181 in
VideoCAD.
9. Further place cameras and cables on the original layout as well as in previous Examples 353 .
See more: Work with back ground in AutoCAD formats 413
External link : The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
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Example 4 Calculation of camera view area parameters
Problem
It is required to calculate a horizontal projection of view area in a height range of 0.5-2 m and
projections of person detection and identification areas to a camera with 1/4" image sensor and
lens of 12-mm focal length.
The camera is installed at 3,5-m height above the ground. View area far bound is to be 10 m away
from the camera location.
The camera is designed to detect a person. It is required to determine identification capacity.
The lighting is adequate, camera resolution is high, and a digital system of high resolution is used for
displaying and recording. Compression level is minimal.

The solution by calculating
Please see this Example in the VideoCAD 8 Professional Help system.

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Examples of work with VideoCAD

10.5

361

Example 5 Calculation of cameras' parameters and choice of
their relative locations
Problem
It is required to monitor a wall of building at a level of ground floor windows.
Wall length - 60 m.
Height of windowsills - 1 m.
Height of windows - 2 m.
The minimal height to install cameras under the requirements of vandalism guard - 3.5 m.
Person detection by the digital video motion detector for the wall space is required. The video
motion detector can detect an object with no less than 5x5 pixel size.
An entrance is situated within a 20-m distance from the wall edge. It is required to identify all
people coming in and out of the building.
A busy highway is situated within a 10-m distance from the wall. It is required to minimise the
highway hitting in the camera view areas.
The lighting is adequate and at night luminaires are used.
The high-resolution cameras are used, with 1/3" image sensor, 752x582 effective pixels.
A digital system of the high resolution with the full frame input is used for displaying and recording.
Output image size is 768x576 pixels.
The compression level is minimal.
The image is color.
Real horizontal resolution is 350 LPH

Solution
Please see this Example in the VideoCAD 8 Professional Help system.
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Example 6 Determining person identification criteria by a real
image
Please see this Example in the VideoCAD 8 Professional Help system.
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Example 7 CCTV design using Monitor window and PTZH
frame
The Monitor window 294 and the new tool in the 3D Video 284 - PTZH frame 287 allow to project video
surveillance system by a new method, working directly with images from video cameras. This
method can be very convenient.

Order of work:
1. Create 199 the project, load background 204 , by means of constructions 181 create 3D model of
environment and place 3D models 190 of people and cars at control points.
2. Preliminary place cameras in the Graphics window.
3. Choose camera models 304 if necessary.
4. Open 176 the Monitor window,
choose Dimension 296 of monitor. This
dimension must be a little bit greater
than quantity of cameras. Connect 302
all cameras to this monitor. On the
monitor images from preliminary
placed cameras will be visible.

5. Analyze images. If an image is not optimum, do the following:
Double click the image. 3D Video will appear.
In the Main menu of 3D Video choose item View> PTZH frame 287 .
Using the frame, adjust position and
parameters of the camera to get optimum
image. At the same time, changes in the
Graphics window are performed
automatically.

Thus adjust all cameras. If necessary move 180 cameras in the Graphics window, create
additional cameras and delete the cameras, which have become unnecessary.
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If one monitor is not enough to control video surveillance system, connect cameras to other
monitors 295 in the Monitor window.
6. As a result we receive ready project:
Drawing of cameras' placement in the Graphics window;
Images of video surveillance system on monitors;
Description 200 of all cameras for an explanatory note;
External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
.
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Example 8 CCTV project
In the Examples directory you can find an example of a video surveillance system project of an
administration building that was designed in VideoCAD.
In this project locations and parameters 253 of cameras were chosen. Models 304 are assigned
to the cameras.
In the project a prepared background 204 is used in the *.dxf format, walls and objects in the
cameras view areas are outlined by VideoCAD constructions. There are 3D models 190 and 3D
images 191 in the project.
You can look into each camera having activate it and opening 3D Video 284
.
It is convenient to load camera by double click ing on its lens or by choosing in the Active camera
167 combo box.
You can display all cameras on the Monitor, by clicking the Monitor window 176

button.

External link : "The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
.
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Example 9 Choice of camera model according to known scene
illumination
Problem
There is a black/white mini camera with known sensitivity parameters: Minimum scene
illumination 0.04 lx with lens F1.2 at signal/noise ratio=10dB, IRE30.
Mini lens F2.0 is mounted on the camera.
At night the scene is poorly illuminated by the illuminator with a mercury high pressure lamp,
placed far from the scene. Illumination measured by the luxmeter is 0.1 lx.
It is required to obtain and evaluate image model from the camera.

Solution
Please see this Example in the VideoCAD 8 Professional Help system.
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10.10 Example 10 Measuring camera sensitivity
Problem
There is a camera. It is necessary to measure its sensitivity.
The matter of measurement of sensitivity is a measurement of scene illumination with which the
camera image have Signal/Noise ratio = 17dB. To measure illumination a Luxmeter is used, to
measure Signal/Noise ratio the Image analyzer or the Video analyzer from the CCTVCAD Lab
Toolkit pack age can be used.
The Video analyzer reads out the Signal/noise ratio directly from the screen.
The Image analyzer uses the stored frames in *.bmp or *.jpg formats.
In most cases the Video analyzer is more convenient for measuring signal/noise ratio.

Equipment:
Please see this Example in the VideoCAD 8 Professional Help system.
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10.11 Example 11 Measuring low illumination
Not expensive luxmeters which are presented on the market have the lower-range value about
0.1..0.5 lux, but minimum scene illumination for modern cameras reaches 0.04 lux. Therefore when
measuring sensitivity 367 of such cameras it is necessary to attenuate sensitivity in known number of
times (it is convenient to attenuate in 50-200 times).
It is possible to attenuate sensitivity in the following ways:
By limiting exposure time of electronic shutter;
By calibrated manual iris lens;
By calibrated attenuation filter.
Please see this Example in the VideoCAD 8 Professional Help system.
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10.12 Example 12 Measuring resolution of camera (lens)
Problem
There is an image of the test chart EIA 1956, made by equipment under test (camera+lens+DVR). It
is necessary to determine equipment resolution in LPH at contrast loss of 10%.
The test chart EIA1956 in full resolution allows
to measure resolution up to 1600 LPH. To
measure higher resolution you can also use the
test chart EIA1956, but it should not occupy the
entire frame, but a part of the frame. For
example, if the table will occupy by the area of a
quarter of the frame (half the vertical and half of
horizontal sizes), the range of measured values
of resolution will be doubled.
By mak ing measurements with the same
camera, but with different lenses, we can
compare resolution of the lenses. Lens
resolution is very important for megapixel
cameras.
We can measure resolution with a given drop
of contrast as well as drop the contrast at a
given resolution.

To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).

Solution
1. Open the Image analyzer 369 from CCTVCAD Lab Toolkit.
2. Click Load in the upper left corner of Image analyzer and select image file.
3. For conveniences it is recommended to increase image size in 2 times. To do this open the
Processing tab, enter two times larger sizes on the Image size panel and click Apply.
4. Open the TV lines tab.
5. Click vertical wedge area of the test chart with lines corresponding to the minimal resolution (100200 LPH). Record peak-to-peak amplitude of signal in the area of minimal resolution.
The peak -to-peak amplitude of signal can be seen on the oscillogram under the image.
6. Move the cursor with pressed mouse button to the side where the wedge becomes narrow up to the
moment when the peak-to-peak amplitude of signal from the wedge makes 10% from the signal
amplitude at minimal resolution.
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7. Determine resolution according to the place of analyzing line on the test chart.
In case when resolution is close to the maximal possible one at specified image size and camera
aperture corrector work s, determining the point of the contrast loss of 10% could be difficult. Image
pixel beating and chart lines beating as well as image digitization hinder from it. This problem refers
equally to all ways of resolution measurement.
Using CCTVCAD Lab Toolkit we can measure resolution of separate colors.
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10.13 Example 13 Measuring maximum scene illumination for a
camera
Problem
There is a camera. It is required to measure maximum scene illumination, at which this camera
produces image without brightness limitation.

Equipment:
Luxmeter (a device for measuring illumination).
Almost any kind of such a device with
standard CIE spectral response will suit.
Monitor.
Projector with tungsten halogen lamp 220V,
1000W or more.
Such projector can create illumination up to
150000lx, what exceeds illumination in bright
sunny day on mid-latitudes (100000-120000lx).
Work carefully with the projector. There is
danger of overheating and inflammation of
fire hazardous materials next to the projector.
Lens with F1.2 aperture, parameters of which
are reliable, focal length is 4-8mm.
If the camera allows to mount only mini-lenses
(M12), the mini-lens with a k nown aperture (F2.0)
is needed.
A sheet of crumpled white paper.
Stand. It is recommended for convenience and
accuracy.

Order of work
1. Switch off all additional options of image processing. Only AESC and AGC should be switched
on.
2. Mount lens F1.2, on the camera, mount the camera on stand, direct it towards sheet of paper,
connect to computer, display image on the screen.
If the camera allows mounting only mini-lenses (M12), mount a mini-lens with k nown aperture (F2.0).
3. Reduce contrast of the monitor to 50-70% of maximum.
4. Close to the sensor window directly on the sensor, fix a small piece of crumpled white paper.
5. Switch ON the projector.
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6. By changing the distance from the projector to the luxmeter sensor, obtain the image on the
screen with a little bleeding whites on the bends of the rumpled sheet of paper.
You must not change the lamp supply voltage. It should be equal to nominal lamp supply voltage.
Change Illumination only be means of distance variation between the lamp and the sheet of paper.
Be sure, that the luxmeter sensor window and the small piece of paper on the sensor have visually
equal illumination.
7. Record the maximum illumination according to the luxmeter reading.
Maximum illumination for black /white cameras with 1/3" CCD image sensor with exposure range of
the electronic shutter up to 1/100000s and lens with the aperture F1.2 mak e approximately
20000..30000lx. It allows using these cameras indoor with any lenses or outdoor with auto iris lenses
or lenses with maximal aperture no more than F2.5.
Maximum illumination for high-quality color cameras or day/night cameras exceeds 100000lx. For
mini-cameras with image sensor format of 1/4" the maximum illumination can be considerably lower.
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10.14 Example 14 Examples of luminaire calculation
Please see this Example in the VideoCAD 8 Professional Help system.
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10.15 Example 15 Choice of luminaire power and location
Please see this Example in the VideoCAD 8 Professional Help system.
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10.16 Example 16 Determining spectral efficiency of light source
Please see this Example in the VideoCAD 8 Professional Help system.
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10.17 Example 17 Measuring projector parameters
Problem
There is a visible light projector with close to round symmetrical light intensity distribution. It is
necessary to create the model of this projector in VideoCAD.

Equipment:
Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
Measure by the luxmeter and write down the projector illumination on an axis of radiation at
the distance not less than in 20 times more than the geometrical size of the radiant window.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.
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10.18 Example 18 Measuring parameters of IR illuminator
Problem
There is an IR illuminator. It is necessary to measure efficiency of this illuminator for a black/white
camera in relation to the halogen incandescent lamp and create model of this illuminator in
VideoCAD.

Equipment:
To perform the measurements you need the software CCTVCAD Lab Toolkit (visit http://
cctvcad.com ).
Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
Any PC-based video capture system, TV-tuner with video input, etc. The System should allow to
display live video on the computer screen.
Video analyzer utility. It is a part of CCTVCAD Lab Toolkit 377 .
Compact tungsten halogen lamp 12V, 10W.
Stabilized power supply unit for the lamp. 12V DC, without considerable ripples of output voltage.
Manual Iris Lens, focal length is 4-8mm.
Stand. It is recommended for convenience and accuracy.
Measuring should be carried out in a dark room.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.
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10.19 Example 19 Modeling megapixel images
Problem
Because of the Open GL limitation, we can not create three-dimensional image with number of
pixels more than the screen number of pixels in Windows. However, modern megapixel cameras
already have a much higher number of pixels.
Even when the camera number of pixels is less than the screen number of pixels, it is inconvenient
to work with images that occupy a large area on the screen and require a lot of time for regeneration.
In most cases, we need only to see how an object on the scene will look on image from a camera
with the specified number of pixels.
VideoCAD offers 2 ways of solving this problem:
with the help of PiP technology (Picture in Picture);
with the help of pixel multiplication.
Please see this Example in the VideoCAD 8 Professional Help system.
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10.20 Example 20 Selecting frame rate on the basis of known target's
positions and velocities
The frame rate greatly affects the required bandwidth of communication channels, the capacity of
the archives, computing power, and hence the total cost of video surveillance systems.
At the same time, choosing optimal frame rate - not an easy task and criteria for selection are not
always unambiguous. When the frame rate is too low, omission of important events are possible, too
high frame rate leads to an unjustified rise in price of video surveillance systems.
VideoCAD offers a tool for choosing frame rates based on the desired frequency of getting in the
frame objects with the known positions and velocity. Additionally, you can create animated
images with the specified frame rate.

Problem
Place of camera installation, the probable locations and velocity of moving objects are known. We
should choose an optimal frame rate to ensure that any moving object gets into the frame at least
twice.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.
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10.21 Example 21 Creating animated model of monitor
This example shows how to create an animated model of monitor as *.html file. This model may
contain up to 100 animated images from different cameras. Each image has its own settings (frame
rate, resolution, etc.). Obtained html file can be viewed by any Internet browser, edited with any text
editor, etc.

See an example of animated monitor (file size about 4 Mb).
Please see this Example in the VideoCAD 8 Professional Help system.
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10.22 Example 22 Visualization of cameras' control area projections
and spatial resolution inside them
Read before: Shadow 172 ,

Spatial resolution 176

, Spatial resolution box 272

Problem
We have a three-dimensional model of a complex environment.
We need to determine the areas controlled by cameras taking into account shadows arising from
obstacles of the environment (camera control areas). Within the control areas, the spatial
resolution of cameras must be visualized.
We should be able to estimate directly on the 2D site plan how people will look into the camera
image at each point of the camera control area.

Order of work
1. Construct three-dimensional model of the environment using the tools of 3D modeling 181 .
The constructions must be drawn by line types 320 with mark ed Shadow 320 box.
You can import the environment or its fragments in the form of one or several 3D models 190
imported from other graphics formats using Autodesk 3ds Max or Sk etchUp 397 .

2. Place a camera. Activate it.
3. Choose Filling

in the drop-down menu of the Fill projection 169 button on the Tool bar.

View area projection will be filled by blend color.
The color of filling is determined by the line type 169 of the camera.
4. Choose Discrete color in the drop-down menu of the
Tool bar.

Spatial resolution 176 button on the

View area projection will be divided into the regions. The regions will be colored according to values
of the criterion 272 within the regions.
5. Open the Spatial resolution 176

box.

In the Pattern criterion 275 combo box you can see which criterion is chosen in the pattern assigned
to the active camera.

Specify vertical and horizontal resolution (number of pixel) of camera in the Number of pixels 277
combo box.
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In the Table of regions 277 you can see what color corresponds to each range of the criterion value.
On the images in the Resolution 278 column, you can see with which resolution people at the far
bound of each region will be visible.
On the images in the Field of view 278 column, you can see which part of the field of view people at
the far bound of each region will cover.

See details: Spatial resolution box 272 .
Don't close the Spatial resolution box.
6. Choose Within projection
bar.

in the drop-down menu of the Shadow 172

button on the Tool

After a while VideoCAD calculates the control
area projection, taking into account shadowing
from obstacles in environment.

7. Keep the Spatial resolution box opened.
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It is convenient to keep the Spatial resolution
box opened during the analysis of spatial
resolution in the Graphics window. Comparing
color of regions on the layout with colors in the
Table of regions 277 in the Spatial resolution
box, on the images in the Resolution 278 and
Field of view 278 columns you can immediately
see the expected resolution and field of view
size at every point of view area of each camera.

See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Options box>Miscellaneous>Shadow 333
, Choosing the best place for PTZ (dome) camera 384 , Visualization of the camera control area
projections and spatial resolution within them 381
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10.23 Example 23 Choosing install location for PTZ camera
Problem
We have a three-dimensional model of a complex environment. We should choose the best install
location for PTZ (dome) camera so that the areas you want to monitor, should be not shaded by
objects of the environment.

Order of work
1. Construct three-dimensional model of the environment using the tools of 3D modeling 181 .
The constructions must be drawn by line types 320 with mark ed Shadow 320 box.
2. Place the PTZ camera preliminary. Activate it.
3. Choose Dome

in the drop-down menu of the Shadow 172

button on the Tool bar.

After a while VideoCAD calculates the control
area projection, taking into account shadowing
from all obstacles in environment.
In the Dome mode all shaded areas from the
specified camera position become visible.
The Dome mode is also useful for choosing the
best installation place for fixed cameras to
mak e required areas reachable for the cameras.

4. By moving the camera between the possible installation locations, choose the best location in
terms of control required areas.
You can add several cameras and instead of moving, to hide 236 and show different cameras.
See also:Shadows 172 ,Main menu>View>Calculate shadows for active camera 215 , Main
Menu>View>Recalculate shadows 215 ,Line type>Shadow 320 , Options box>Miscellaneous>Shadow
333 , Choosing the best place for PTZ (dome) camera 384 , Visualization of the camera control area
projections and spatial resolution within them 381
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10.24 Example 24 Simulating distortions of moving objects arising
from Exposure time, Interlace scan and Rolling shutter
Problem
There are three cameras:
Three-megapixel (3MP) (2048x1536) IP camera with CMOS sensor and Rolling shutter;
1.3 megapixel (1280x960) IP camera with CCD sensor and Global shutter;
0.4MP (768x576) analog camera with interlace scan.
We know camera exposure time at the scene light conditions.
3MP IP Camera - 100ms;
1.2MP IP camera - 50ms;
analog camera - 20ms (PAL).
3MP camera employs Rolling shutter, the period between start reading successive rows = 50
microseconds.
All cameras have the same sensor size 1 / 3 "and a lens with a focal length = 4mm.
We know camera position, location and speed of moving objects on the scene.
We need to get the model images of moving objects from each camera at the same position and
compare them.
See also: Measuring exposure time of IP camera 391 , Measuring rolling shutter row time of IP camera
394

Please see this Example in the VideoCAD 8 Professional Help system.
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See also: Measuring exposure time of IP camera 391 , Measuring rolling shutter row time of IP camera
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394

External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf)
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10.25 Example 25 Calculating lengths of cables and getting Cable
report
Problem
There is a layout with the placed cameras. We need to determine the required cable length
separately for each brand of cable.

Order of work
1. Configure a separate line type for each brand of cables used in the project
1.1 Open the Options box 319 , switch to Lines 320 tab.
1.2 In the Number box, select any unused number of line type.
Do not select line types, used as system lines 321 .
1.3 In the Name box, type a name of a cable brand, which will correspond to the selected line
type.
1.4 Check the Cable 320 box. Clear the Shadow 320 box.
1.5 When necessary, adjust the line Style, Color and Width on the screen and at printing.
1.6 To make lines of this type invisible on the 3D Video, set equal the maximum and minimum
heights on the 3D panel.
1.7 Repeat steps 1.2 .. 1.6 for all brands of cables used.
1.8 Click OK in the Options box.

2. Assign brands to cables of cameras
2.1 Activate any of cameras.
2.2 Assign brand to the signal cable
2.2.1 Click the menu item Main menu>Cables>Signal cable>Calculate.
2.2.2 In the appeared Signal cable length calculation box 341 choose Cable brand 341 from the
adjusted at p.1 388 line types.
2.2.3 When necessary, adjust reserve for cable laying and connection.
2.2.4 Click OK in the Signal cable length calculation box.
2.3 Assign brand to the power cable
2.3.1 Click the menu item Main menu>Cables>Power cable>Calculate.
2.3.2 In the appeared Power cable electrical parameters and length calculation box 341 choose
Cable brand 341 from the adjusted at p.1 388 line types.
2.3.3 When necessary, adjust reserve for cable laying and connection. Specify electrical
parameters.
2.3.4 Click OK in the Power cable electrical parameters and length calculation box.
2.4 Repeat steps 2.1 .. 2.3 for all cameras, cables of which must be taken into account.

3. Draw cables of cameras in horizontal and vertical projection
3.1 Activate any of cameras.
3.2 Choose Main menu>Signal cable 238 and draw the signal cable of this camera.
3.3 Choose Main menu>Power cable 239 and draw the power cable of this camera. .
When this item chosen, you can draw the signal cable of the active camera by successive click s
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in the graphics area. The end of each segment is the start of the next one. To stop drawing cable,
press ESC.
The status bar 243 displays the segment length and its projection to distance and height.
Both click s are to be made in the same projection. If the projections are different the measured
values are incorrect, therefore when constructing a segment with its ends in different projections
the values are not displayed in the status bar. In this case when changing the drawing the segment
is attached to the projection with its initial point.
A cable consists of segments, allowing to draw it in different projections and layouts, representing
an actual scheme of laying accurately.
When copying 180 the cable segments between cameras and layouts a process of cable drawing
is accelerated considerably even in complex CCTV systems.
When drawing a cable the menu item Cable laying 239 might be used. When choosing it a float
panel of the same name appears enabling to choose a shift of segment ends for a level parallel
cable drawing along the walls, columns etc.
If the Main menu>View>All cameras' cables 216 item is check ed, cables of all cameras will be
visible, but only cables of the active camera can be edited. If this item is not check ed, cables of
the active camera will be visible only.

4. Draw the Main cables (which is not associated with cameras)
4.1 Draw the Main cables with the help of tools Line segment 183
the adjusted at p.1 388 line types.

and

Polyline 183

, using

Line type can be assigned before drawing lines or during editing lines on the Line type panel
245 . To change Line type of several selected 177 lines at once, use the Change line type 237 tool.

5. Get the Cable report
Choose Main menu>Cables>Cable report 240 . The Cable report includes lengths of the cables
attached to cameras and the main cables as well. Cable lengths is calculated for each brand (line
type) separately.
See also: Active camera's cables 216 , All cameras' cables 216 , Line segment 220 , Polyline 221 , Signal
cable 238 , Power cable 239 , Cable laying 239 , Length calculation of line segments 239 , Cable report 240
, PDF Report 200 .
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10.26 Example 26 Checking Depth of Field in horizontal projection
Problem
We need to check that a camera has enough Depth of Field.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.
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10.27 Example 27 Measuring exposure time of IP camera
The sensitivity of cameras depends on the exposure time. Within the validity of the Reciprocity
principle, the camera sensitivity is directly proportional to the exposure time.
However, increasing exposure time leads to
blurring of moving objects that is often
unexpected. Usually, when measuring sensitivity
of cameras and while accepting built CCTV
system a customer looks only at static images,
but moving targets are of interest.
The greater the exposure time and the greater
the velocity of an object on the screen, the more
the blur.

Automation of camera (AESC) constantly adjusts the exposure time (shutter speed) depending on
the illumination on the image sensor. The more light is, the less exposure time is set. But from a
certain threshold light AESC sets the maximum exposure time and further reducing light doesn't
increase the exposure time. Knowing the maximum exposure time and the threshold illumination is
very useful in designing CCTV systems.
VideoCAD offers a tool for modeling blur of moving objects in dependence of the exposure time. But
to use this tool, you need to know the exposure time.
Knowing the maximum exposure time is also needed correct interpretation of results of measuring
sensitivity and sensitivity values in the camera specification. With a minimum illumination the
camera sets the maximum exposure time. Unless otherwise indicated, the sensitivity value in the
camera specification can be achieved at the maximum exposure time.
The maximum exposure time of standard analog cameras without light accumulation is 20ms for
PAL and 16,5 ms for NTSC. IP cameras and analog cameras with accumulation of light can use
exposure time up to 200ms and more. With latent increasing the maximum exposure time, many
manufacturers increase the certified sensitivity of their cameras.
Many cameras allow to modify the maximum exposure time, switching the "night", "supersensitive"
modes, etc. But these settings don't report the real value of the exposure time. If the camera has
several "night" modes, for their proper use it is necessary to know the maximum exposure time for
each of them.

Problem
There is a camera. It is necessary to measure its maximum exposure time and the threshold
illumination at which the camera switches to the maximum exposure time.

Equipment:
Oscilloscope. Any analog oscilloscope will suit.
Luxmeter (a device for measuring illumination). Almost any kind of such a device with standard CIE
spectral response will suit.
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In case of testing analog cameras, we need any PC-based video capture system, TV-tuner with
video input, etc. The System should allow to display live video on the computer screen and
separate frames. For testing IP cameras it is enough to have possibility to display video on the
screen and separate frames.
Compact tungsten halogen lamp 12V, 10W.
Stabilized power supply unit for the lamp. 12V DC, without considerable ripples of output voltage.
Lens with F1.2 aperture, parameters of which are reliable, focal length is 4-8mm. If the camera
allows to mount only mini-lenses (M12), the mini-lens with a k nown aperture (F2.0) is needed.
Stand. It is recommended for convenience and accuracy.
If you want to measure only the maximum exposure time, and measuring the threshold
illumination is not required, then luxmeter, incandescent lamp and power supply are not needed.
Instead, it is required a manual iris lens.

Order of work
1. Set the lens on the camera, install the camera on the stand, point the camera at the screen of the
oscilloscope, connect camera to computer, display image from the camera on the computer screen.
2. Place the luxmeter sensor near to the oscilloscope screen.
3. Enable a "night" mode in the camera setting.

4. Set the oscilloscope sweep time - 50ms/div. Scan - automatic (If your oscilloscope has such
settings).
On the oscilloscope screen a flying spot must be visible. On the computer screen instead of the
spot, flickering segments will be seen.
5. Turn on the incandescent lamp. Turn off the ambient light.
If you need only to measure the maximum exposure time, then instead of changing light simple close
iris on the lens.
6. Set the minimum brightness of the oscilloscope spot, to make the segments on the computer
screen barely visible. Light of the spot should not affect operation of camera's automatics.
7. By moving the lamp away, reducing the illumination of the oscilloscope screen, detect a moment

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Examples of work with VideoCAD

393

when the length of the segments on the computer screen becomes the maximum and no longer
increases with further decreasing light until the appearance of strong noise on the screen.
At the moment when the length of the segments becomes maximum, luxmeter shows the
threshold illumination.
As a result of our measurements, the threshold illumination was about 50lux. That is, when light is
less than 50lux, the testing IP camera with 2 megapixel 1/3" CMOS sensor began to use the
maximum exposure time.
8. Save and view a frame in which a segment of the maximum length gets wholly. If you can not get
such frame, increase the oscilloscope sweep to 100ms/div.
The length of the segment in the frame in the scale of oscilloscope screen equals to the
camera's exposure time.

9. If necessary, by the method described above you can take a function of the exposure time in
dependance of the light.
See also: Image parameter panel>Camera>Exposure
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf)
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10.28 Example 28 Measuring rolling shutter row time of IP camera
As a result of Rolling Shutter work , exposure of
different rows of the image sensor begins and
ends sequentially at different times, which
causes a horizontal shift of moving objects.
This effect occurs with many IP cameras with
CMOS image sensor and usually doesn't occur
with cameras with CCD image sensor.

An important parameter of the rolling shutter is the Row time - the difference in time between the
beginning exposure of neighboring rows. The less the row time is, the smaller the camera distorts
moving objects. Unfortunately this parameter is not given in the camera specification. But it is not
difficult to measure the row time in practice.
The row time may vary with different settings of the same camera.
VideoCAD offers a tool for modeling distortions of moving objects depending on the row time. But to
use this tool, you need to know the row time.

Problem
There is a IP camera with Rolling shutter. It is necessary to measure its row time - the difference in
time between the beginning exposure of neighboring rows.

Equipment:
Oscilloscope. Any analog oscilloscope will suit.
Low-frequency oscillator. Use any sine wave signal generator of any frequency in the range from
200 Hz to the upper limit of the oscilloscope bandwidth. You can use any homemade generator,
software generator for a computer, etc.
For testing IP cameras it is enough to have possibility to display video on the screen and separate
frames.
A Lens, focal length is 4-8mm.
Stand. It is recommended for convenience and accuracy.

Order of work
1. Set the maximum image size in pixels in the camera setting.
2. Set the lens on the camera, install the camera on the stand, point the camera at the screen of the
oscilloscope, connect camera to computer, display image from the camera on the computer screen.
The oscilloscope screen must completely cover the field of view in vertical. But it is not necessarily
that the oscilloscope screen placed in the frame entirely. It is important that between the
oscilloscope screen and the field of view of the camera must not be sk ew. On the computer screen,
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lines of the oscilloscope scale should be strictly parallel to the sides of the frame.

3. Set the oscilloscope sweep time - 50ms/div. Scan - automatic (If your oscilloscope has such
settings). Connect the Low-frequency oscillator to the oscilloscope.
On the oscilloscope screen a flying thin vertical line must be visible. On the computer screen instead
of the thin vertical line, thick inclined line will be seen. The thickness of the line in the scale of
oscilloscope screen equals to the camera's exposure time. The inclination of the line is
determined by the row time of camera's rolling shutter.
4. Save and view a frame in which the inclined line gets wholly. If you can not get such frame,
increase the oscilloscope sweep to 100ms/div. If inclination is not enough, decrease the oscilloscope
sweep to 20ms/div.
5. To calculate the row time, first read a difference between the edge of the line on the top and on
the bottom of the frame in the scale of the oscilloscope screen - frame reading time = 70ms. And
then divide the resulting time by the number of rows in the image (1200) and get the row time = 58
microseconds.

6. Repeat measurements for other frame sizes of the same camera.
In the tested by us IP camera the frame reading time wasn't changed when changing the frame size
from 640*480 to 1600*1200, and was about 70ms. Thus, the row time was from 58 to 146
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microseconds depending on the number of rows in the frame.
Perhaps the opposite situation, when the row time is stable, but the frame reading time depends on
the number of rows in the frame.
See also: Image parameter panel>Camera>Rolling shutter
External link : "The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving
objects"(*.pdf)
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10.29 Example 29 Import of 3D models from SketchUp and Autodesk
3dsMax
VideoCAD has an opportunity of 3D modeling video surveillance scenes using constructions and 3D
models 190 distributed with the program.
The distribution kit of VideoCAD includes several most relevant 3D models for CCTV design. Though
the standard package tends to be enough for accomplishing most of tasks, there may appear a need
for library supplement.
Any 3D models and scenes which can be opened in SketchUp or Autodesk 3ds Max can be added
to the VideoCAD library.
For exporting 3D models to VideoCAD the Free SketchUp version is suitable. http://sketchup.com/
Lots of 3D models can be downloaded from Internet for free https://3dwarehouse.sketchup.com/
You can also create models and scenes in Google SketchUp or Autodesk 3ds Max independently.
Import 3D models is supported by VideoCAD Starter II 45 , VideoCAD Lite 31 and VideoCAD
Professional 3 versions. It is not supported by VideoCAD Starter 49 version.
We offer two special packages for importing 3D models into VideoCAD.
These packages contain:
Plugin file;
User Manual with step-by-step description how to insert a new 3D model into the VideoCAD
library;
Example of ready 3D model files.
The first package for importing 3D models and scenes from Autodesk 3ds Max is free. You can
download it here: Import of 3D models and scenes from 3ds max to VideoCAD
The second package for importing 3D models and scenes from SketchUp is paid. Here is the User
manual. Click here to order the package.
* This pack age is included in the VideoCAD Starter II Kit 45 .
* * Plugin for Sk etchUP has several advanced features: export textures, transparent textures, semitransparent polygons and scale adjusting.
See also: 3D model 190 , Drawing>Import DXF/DWG back ground 199 , Work with 3D models-territories
399 , Work with layers and multi-levels projects 398 , Export 3D view areas to general 3D design
software 400
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10.30 Example 30 Work with layers and multi-level projects
It is convenient when the project can be divided
into horizontal layers, unrelated, such as the
floors of building.
But there are problems with complex
organization on vertical when one camera should
work on several levels. In these cases, the levels
are interconnected and 2D planning is not
enough. In such cases, 3D modeling can be
indispensable.

Problem
There is a project, divided into floor plans. We need to make CCTV project in which some cameras
are located between floors.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.

See also: Drawing>Import DXF/DWG back ground 199 , Import of 3D models from Sk etchUp and
Autodesk 3dsMax 397 , Work with 3D models-territories 399 , Layers
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10.31 Example 31 Work with 3D models-territories
VideoCAD can use not only 3D models of individual objects (people, cars, etc.), but also 3D modelsterritories (buildings, stadiums, airports, towns, etc.).
Within the 3D models-territories cameras and other 3D models can be placed.

Problem
There is a 3D model of the stadium. You need to place a camera in the room under the stands.

Please see this Example in the VideoCAD 8 Professional Help system.
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10.32 Example 32 Export 3D view areas to general 3D design
software
In many enterprises, projects of all building
systems are executed in a single software
environment of 3D design.
However, despite the enormous number of tools
of modern 3D design software, a lot of CCTV
design problems are outside of their
opportunities.
For example, creation of image models from
cameras with known parameters in certain
conditions , modeling camera view areas with
the spatial resolution , lens distortion and
shadowing from obstacles etc.
These and other useful in CCTV design
opportunities are available in VideoCAD.
Furthermore , VideoCAD has means of import
and export , which allows to use VideoCAD as
addition to other 2D/3D design software.
Means of import and export in 2D are described in the Example 413 . Saving images of individual
cameras is easy 286 . Saving monitors is discussed here 380 . In this example we consider import of
3D project from SketchUP and export of 3D models of the view areas to DXF format and import them
into SketchUP.
Free version of Sk etchUP does not support importing DXF format. To import DXF you need
Sk etchUP paid version or you can search an appropriate plugin for importing DXF format for the free
version of Sk etchUP.

Problem
There is a project of a building in 3D. The project must be supplemented by view areas of CCTV
cameras, made with visualization of spatial resolution, taking into account lens distortion and
shadowing from obstacles.

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.
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See also:Drawing>Save as 202 , Drawing>Import DXF/DWG back ground 199 , Options box>Export 329 ,
Work with back ground in AutoCAD format 413 , Work with 3D models-territories 399 , Import of 3D
models from Sk etchUp and Autodesk 3dsMax 397
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10.33 Example 33 Using camera rotation around its own axis
Rotation of camera around its
own axis allows the change
the shape of the view area
projection. This feature can be
useful in CCTV design.
By turning a camera you can
exclude from the view area
unnecessary objects or vice
versa expand the view area in
the needed direction, without
replacing the lens to a shortfocus one, so without
sacrificing the spatial
resolution.
At this a little rotation doesn't
worsen readability of camera
image for an operator.

Problem
Study the effect of camera rotation around its axis on the form of the view area projection.
Please see this Example in the VideoCAD 8 Professional Help system.
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10.34 Example 34 Modeling lens distortion
There is a difference between the actual
values of view angles given in the
specification of cameras(lenses) and
angle values obtained by calculation.
The reason for the difference is the lens
distortion. Distortion can lead to a
significant deviation of the view area form
from a regular pyramid and warping of the
spatial resolution distribution.
See more: About lens distortion 429
Accounting distortion when designing
CCTV provides models of the view areas
and images more close to reality, and
thus more fully use cameras in the
project.

Problem
There is a camera AXIS M1004–W/M1014/M1034-W. It is required to obtain a model of the view
area, the distribution of the spatial resolution and image from this camera with taking into account
lens distortion.
Camera parameters according to manufacturer's specification:
Sensor format - 1/4";
Lens focal length - 2,8mm;
Real horizontal view angle - 80 degrees.
Number of pixels 1280x800 (max)
It is recommended to measure real view angles practically 405 .

Order of work
Please see this Example in the VideoCAD 8 Professional Help system.

Without sim ulating distortion
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Without sim ulating distortion

With sim ulating distortion
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10.35 Example 35 Measuring real view angles
Starting from the eighth version of VideoCAD, the
simulation accuracy of view areas of cameras in
VideoCAD is greatly improved because of the
possibility of simulating lens distortion 429 .
Three view angles (horizontal, vertical, diagonal) are
computed inside VideoCAD from the lens focal length
256 and image sensor size 255 without accounting
distortion. For most long-focus lenses distortion can
be ignored, but in case of short-focus lenses the
distortion introduces significant error in the calculation.
To simulate distortion we need to know the lens focal
length, image sensor size and at least one of the real
angles.
The value of the real angle can be taken from the manufacturer's specifications, as in the Example
403 . But not all manufacturers measure the real view angles of their cameras.
Lets consider a simple technique of practical measurement of camera view angles. Many variants of
the technique are possible depending on the conditions.

Problem
There is a camera with a lens. It is necessary to measure the real angles: horizontal, vertical and
diagonal. To accurately modeling the view area, taking into account lens distortion.

The front nodal point of a lens and measurement inaccuracy
If the camera view area is in the form of a pyramid, the top of the pyramid will be in the front nodal
point of the lens. The front nodal point of the lens is located on the front principal plane within the
length of the lens on the main optical axis, but its exact position is unknown to us.
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If we assume that the front nodal point of the lens is in the middle, the possible error of measuring
the dimensions of the view area will be the ratio of half of the length of the lens by the distance from
the middle of the lens to the screen.
For example, if the physical length of the lens = 40mm, and the distance from the middle of the
lens to the screen = 1 meter, then the inaccuracy of measuring the size of the field of view =
40/2/1000 = 0.02, ie + -2%.
The inaccuracy of measurement of an angle will be less depending on the angle. For example, if
the angle is 90 degrees, the inaccuracy will be+ -1.3%.
If this accuracy is not sufficient, you should use more distance from the camera to the screen, but
it will require a larger screen, that is not always convenient.
Another way of reducing the inaccuracy is locating the front nodal point of the lens within the
length.
To do this, perform 2 measurements at different distances between the front edge of the lens and
the screen, for example 0.5 and 0.25 meters. Then, assuming that the view angles are constant,
solve the system of equations, where the unknown is the distance from the front edge of the lens to
the front nodal point.
Omitting the course of the solution, we present the resulting formula for the calculation.
dL=(S2 * L1 - S1 * L2) / (S1 - S2);
where:
dL - unknown distance from the front edge of the lens to the front nodal point;
L1 - distances between the front edge of the lens and the screen at the first measurement;
L2 - distances between the front edge of the lens and the screen at the second measurement;
S1 - width (at measuring horizontal angle) of the field of view at the first measurement;
S2 - width (at measuring horizontal angle) of the field of view at the second measurement.

Order of work
1. Fully open the lens aperture, if possible.
2. Focus the lens on the camera working distance.
You should focus not on the distance to the screen but on a distance that will work the camera on.
In most cases, this distance is the hyperfocal distance at maximum aperture. Focusing on the
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work ing distance is performed for a case, if the angles of view or the position of the front nodal point
will depend on the focus distance.
3. Secure the camera in front of a flat screen.
4. Close the aperture as possible to obtain a sharp image from the camera.
5. Adjust the camera position so that the main optical axis of the camera will be strictly
perpendicular to the screen. Mark the center of the image on the screen.
6. Watching the image, mark the extreme points on the screen width, height, and diagonal field of
view.
7. Measure the distances on the screen between the points on the boundaries and the marked
center of the image. Boundary points must be strictly symmetrical relative the center. If it is not the
case, then adjust the position of the camera and go back to step 5
8. Measure the distances between the points (field of view size in width, height and diagonal).
9. Measure the distance from the front nodal point of the lens 405 to the screen.

10. Calculate the view angles using the formulas:
Ah=2 * ARCTAN(h / (2 * L));
Aw=2 * ARCTAN(w / (2 * L));
Ad=2 * ARCTAN(d / (2 * L));
where (see image):
ARCTAN - arc tangent, inverse tangent function;
Ah,Aw,Ad - obtained real view angles in height, width and diagonal respectively;
h - distance between extreme points on height of the field of view;
w - distance between extreme points on width of the field of view;
d - distance between extreme points on diagonal of the field of view;
L - distance between lens front nodal point and the screen.
You can use the obtained angles in the Sensor and Lens 267 box for precise modeling view area of
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this camera.
It is possible to mak e very simplified test on a camera already installed.
1. Firstly measure sized and distances of real objects in cameras view area.
2. Then construct 3D model in VideoCAD, place a camera.
3. Then choose angles of view to obtain image model equal to real image from the camera.
See also: Sensor and Lens>Lens distortion 267 , About lens distortion 429 ,, Modeling lens distortion
403
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10.36 Example 36 Modeling panoramic cameras (Fisheye, 360°/180°)
Panoramic cameras are useful for monitoring
small spaces.
The view area of such cameras is a hemisphere.
Field of view is projected on the image sensor in
the form of a circle.
Therefore, the original image produced by the
image sensor is a circle in which the image of
the scene subjected to a strong barrel distortion.
Then, in the original image a target area is cut
out, distortion is corrected in this area and in
result an usual frame is obtained.
Users are interested in the output frame. The
original image in the form of a circle is used as
an intermediate.
VideoCAD allows to:
Simulate the output frames without distortion
with calculated pixel density;
Simulate camera field of view and distribution
of the spatial resolution in the Graphics
window and the 3D Video 284 .
See more Panoramic 269

Problem
There is a camera AXIS M3007-PV. The camera is mounted on a bracket at 3m height at a distance
of 10 meters from a wall of 10 meters height. Camera is pointed down.
It is required to obtain a model of the control area, the distribution of the spatial resolution 272 and
image 284 from this camera.
Camera parameters according to manufacturer's specification, crucial for modeling:
Number of pixels 2592x1944 (5 MP)

Order of work
1. Create a camera by clicking the New camera 166
button. In the New camera box, in the
Camera icon combobox choose an icon for the new camera with panoramic, for example indoor/
panoramic

.

A special icon is not obligatory. In the future it will be possible to change the icon in the
list 167 box.

Camera

2. Place the camera on the layout. At a distance of 10 meters from the camera create a wall of 10 m
height using the
Rectangle 184 tool.
3. Open the Sensitivity and resolution 166
box and specify number of pixels on Horizontal - 2592
and on Vertical - 1944. Close the box and save changes.
The most important parameter that determines the image resolution of panoramic cameras, is
the number of pixels of the image sensor.
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Since the image sensor is rectangular in shape and view area of the camera is projected into a
circle, not all pixels are involved in image formation.
In VideoCAD the number of physical pixels on the sensor horizontally and vertically are
required. The number of pixels involved in the formation of the image (active pixels) will be
calculated by VideoCAD.
High precision of specifying the number of pixels is not required. So for a 2-megapixel camera,
you can enter 1200 * 900, for 3MP -1600 * 1200, for 5MP -2500 * 2000. Standard aspect ratio
should be supported.
Lens focal length 256 and Image size at image processing have no affect on the image resolution
of a panoramic camera.
4. Open the Camera geometry 251

box and specify camera installation height 257 of 3 meters.

5. Click on the
button to open the Sensor and Lens 267 box.
On the Panoramic panel mark the checkbox and specify angles of installation of the panoramic
camera. To point the camera down, choose:
Pan angle = 0; (this value is not important when the camera is pointed down);
Tilt angle=90.

The lens focal length boxes in the Graphics window and the Camera Geometry box will be

colored by aqua-green.
To limit too big size of the view area projection use the Maximum distance of drawing view area
265 box in the Camera geometry 251
box .
6. Assign to the camera a Spatial resolution pattern 274 to visualize the spatial resolution (pixel
density distribution). For this purpose open the
Spatial resolution box 176 . Clear the Active
camera 274 checkbox, then choose the pattern "Home Office Scientific Development Branch 2009
(arbitrary resolutions)" in the Pattern 274 list. Then click Assign 277 to assign the chosen pattern to
the active camera.
Pattern criterion of spatial resolution 275 for panoramic cameras must be based on the spatial
resolution (Pixel per meter (Pixel per foot), Pixel for object), but not on the field of view size.
Criterion Field-of-view height, % of Field-of-view for object are not suitable to panoramic
cameras, because of panoramic cameras have not a stable field of view.
7. Enable and adjust the spatial resolution visualization in the Graphics window.
In the popup menu of the
Shadow 172 button on the Toolbar 164 of the Graphics window
choose Within projection.
In the popup menu of the
Fill projection 169 button choose Filling
In the popup menu of the
Spatial resolution 176 button choose Discrete color.
As a result we will see in the Graphics windows the spatial resolution distribution of the camera
AXIS M3007-PV on the height 275 specified in the Spatial resolution pattern 274 assigned to the
camera.
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Considering the projection can be said, for example, that at a distance of 28 meters from the camera
at a height of (2 + 0.5) / 2 = 1.25m the yellow region ends, and hence the pixel density, according to
the selected pattern, equals 39 pixels per object of 1,64m height or 39 / 1.64 = 24 pixels/meter.
9. Open the
3D Video 176 window. In VideoCAD Lite mark the main menu item Processing>
287
Resolution
.By directing the camera on regions of interest on the scene, we can see with what
resolution these regions will be displayed by our camera.
10. Place
3D model 190 of a man on the far border of yellow region, that is, where the pixel
density is 24 pixels / meter. And direct the camera on the 3D model.
Let's try to change the lens focal length 256 and make sure that only the size of the field of view is
changed. Resolution of the image will remain constant.
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Pan, tilt, made in the usual way does not affect the position of the panoramic camera. By rotation the
camera in the usual way, you can view images from the panoramic camera in different directions in
the 3D Video 284 . In this case, the view area will be limited at 180 degrees from the main optical axis
of the lens. Beyond this limit the image is cut
You can change the Lens focal length, thereby changing the field of view size, but the image
resolution in the 3D Video will always be limited by the calculated resolution of the panoramic
camera.
If the calculated resolution is worse, the resolution of the 3D Video will be artificially reduced.
The Image line in the Titles 287 displays a virtual number of pixels for correct simulation of the
resolution.
The simulated resolution is exact only at the center of the frame. Towards the edges of the frame the
actual resolution is slightly worse than simulated, but this error is negligible. The smaller the view
angle, the more accuracy of simulating resolution on the edges of the frame.
For a more realistic model of the image, turn on modeling compression 286 .
See also: Panoramic 269
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10.37 Example 37 Work with background in AutoCAD formats
Normal sequence of actions at work in VideoCAD is:
1. Loading a background
2. Placing cameras, constructions, 3D models on the baclground.
3. Printing or exporting result of the work.
See more: Choice of cameras' quantity and location on the original layout 359
When the background is in AutoCAD format (DXF or DWG), the additional possibilities are offered:
Adjusting visibility of layers of the background, chosing layout, hiding texts .
Import constructions 199 from a 2D background in AutoCAD formats to 3D VideoCAD
constructions automatically. Use of this tool allows to reduce efforts of outlining background to
convert it to 3D constructions.
Adding cameras and constructions of VideoCAD to the background in AutoCAD format on
additional layers and then save the background to a file to work with it in AutoCAD.

Problem
There is a floor plan in DXF format. We need to place cameras on it and save the file with the
cameras and their view area projections in the same format - DXF.
Please see this Example in the VideoCAD 8 Professional Help system.
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See also: Drawing>Load back ground 204 , Drawing>Adjust back ground 205 , Drawing>Save as 202 ,
Drawing>Import DXF/DWG back ground 199 , Options box>Export 329 , Export 3D view areas to
general 3D design software 400
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10.38 Example 38 Specifying active area size of the image sensor
The Image sensor size in VideoCAD implies the size of the entire light sensitive area of the image
sensor, which can form an image with the maximum number of pixels horizontally and vertically.
Active area of the image sensor in VideoCAD implies an area of the image sensor on which the
image is formed in a given mode of the camera. The sizes of the active area may be less than or
equal to the image sensor size. Active area can differ in different modes of operation of the same
camera.

Exactly the active area size and lens focal length determines the angles of view, and through
them influences on the results of camera modeling. Accuracy of specifying the active area size
greatly affects the accuracy of modeling the camera.

The traditional method of specifying the active area size of the image sensor
In the past, specifying the active area size was a simple task. Each camera specification
includes the image sensor format (type) in "vidicon" inches from the standard series (1/4 ",
1/3", 1/2 "..) which determines the size of image sensor. Although the translation of the format to
the size is not accurate, the accuracy was acceptable for most practical purposes.
Native Aspect ratio of image sensors used in CCTV cameras was 4:3. When camera's output
image had the same aspect ratio of 4:3, the active area occupied the entire image sensor. To get
image with the Aspect ratio of 16:9 only central area across the width of the image sensor was
used, and areas on the top and bottom of the image sensor was not used. Reducing the number
of pixels of the output image had no affect on the active area size.

In such circumstances, to uniquely specify the active area of the image sensor it was enough to
choose in the Image sensor size 255 box the Image sensor format from a list of standard formats
(1/4 ", 1/3", 1/2 "..) and choose the Aspect ratio of the output image in the Aspect ratio box 257 (
4:3, 16:9 ...).
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Now this way might be used for specifying active area size of the image sensor of cameras of
previous generations, or in cases when accuracy of the simulation is not important.
For modern cameras, this method is not sufficiently accurate. An error may exceed 20-30%.
Image sensors with non-standard sizes have appeared, with fractional inch formats that do not
fall into the list of the standard formats (eg, 1/2.8", 1/2.9", 1/3.2", 1/1.9" ..).
Image sensors with aspect ratio different from 4:3 have appeared.
In specifications of some cameras the sensor size is indicated more accurately in the form of
diagonal length or side lengths, in millimeters.
Cameras can form images with different numbers of pixels and aspect ratios.
Some cameras in some modes use active area of the image sensor which does not touch the
edges of the image sensor.

Examples of errors during specifying size of the active area of image sensor
by the traditional way
Example 1: A camera has an image sensor
of 1/3" with aspect ratio of 16:9, but the output
image has aspect ratio of 4:3.
The Image sensor format (1/3") determines the
length of diagonal (6mm). Aspect ratio of any
image sensor in the traditional way is always
assumed to be 4:3. Therefore, in camera
simulation the active area with diagonal of 6
mm and aspect ratio of 4:3 will be used, ie 4,8
* 3,6mm.
However, the real aspect ratio of the image
sensor is 16:9, so the actual size of the image
sensor with diagonal of 6mm will be 2,94mm to
5,23mm.
At the same time, the aspect ratio of the
output image (=aspect ratio of the active area)
is 4:3, so that the active area is formed by
''cutting' side areas from the Image sensor of
16:9 laterally. Therefore, the actual size of the
active area is 3.92 * 2,94mm.
Thus, the actual size of the active area image
sensor, and hence the field of view will be 20%
less than the calculated values.
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Example 2: Some cameras can produce
images with reduced number of pixels using
the active area in the central part of the image
sensor. The active area does not touch the
edges of the image sensor. The size of the
active area may depend on the number of
pixels of the output image.
For example, the same image sensor SONY
Exmor R IMX291LQR has format
1/2.8"(diagonal 6.46 mm) in the full HD1080
mode and 1/4.2" (diagonal 4.31 mm) in the
HD720 mode. In the HD720 mode the image
sensor uses only the central part of pixels.
If you use format 1/2.8" in the HD720 mode,
the actual size of the field of view will be 33%
less than calculated one.

Problem
For accurate camera modeling we must specify the sizes of the active area of the image sensor in a
given mode of the camera.

Order of work
1. If side sizes of the active area of the image sensor in a given camera mode are known, then
enter them directly.

Direct specifying side sizes of active area of the image sensor
If you know the side sizes of active area of the image sensor in a given mode of the camera, simply
enter them in the Image sensor size 255 box separated by asterisk in the form W*H. Where W and
H - width and height of the active area of the image sensor in millimeters.
For example: 4.8*3.6
Thus the size of the active area image sensor was specified and the problem is solved.

However, in most cases, camera specifications don't give the side sizes of the active area for each
camera mode separately, so the program will have to calculate them. For the calculation it is
necessary to set the following parameters, are known in the most cases:
Image sensor size (it is better to set side sizes in millimeres 418 , but possible via the length of
diagonal 418 (format, type) and aspect ratio of the image sensor).
Aspect ratio of the output image 420 .
Crop 420 - a factor of decreasing active area size. The Crop is provided for cases when the active
area does not touch the edges of the image sensor. In other cases Crop=1.
On the basis of this information, VideoCAD will calculate size of the active area of the image sensor,
which will be used in camera modeling.
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You can specify the required parameters in the Image sensor size 255 and the Aspect ratio 257 boxes
in the Camera Geometry 251 box, but it is more convenient to do it in the special Sensor and Lens 267
box .
Open the Camera Geometry 251 box, and then clicking on the Sensor and Lens button

, open the Sensor and Lens 267 box.
2.1.1 If the image sensor side sizes in millimeters are known, then enter them directly.

Direct specifying the image sensor side sizes
If the camera specification contains the sensor side sizes (that is the maximum size of the active
area), then enter them to the Image sensor size 255 box separated by hash, in the form W#H.
Where W and H - width and height in millimeters of the image sensor.
For example: For the camera WV-SFV631L the sensor sizes can be found in the string: Scanning
area 5.346 mm (H) x 3.336 mm (V)
Enter to the Image sensor size box 5.346#3.336

2.1.2 When the image sensor side sizes are unknown, specify them via the length of diagonal
(format, type) and aspect ratio of the image sensor.

Specifying image sensor size via the length of diagonal and the aspect ratio
The length of diagonal in "vidicon" inches as a format (type) almost always exists in camera
specification. For example, 1/2", 1/2.9". Enter the format to the Image sensor size 255 box. In the box you can
choose format from the list or type any value, for example, 1/3.15", 1/2.75". If you enter a value
which not found in the standard list, the Image sensor size box turns yellow and VideoCAD will
calculate diagonal from the format.
If a specifications give diagonal length in millimeters, it is preferable to use it. The value in
millimeters is usually more accurate.The diagonal length in millimeters must be typed with the
letter d, for example d6.0 - the length of diagonal is 6mm.
For example: For the camera WV-SFV631L the image sensor format can be found in the line:
Image Sensor Approx. 1/3 type;
In the specification of the image sensor SONY Exmor R IMX291LQR the length of diagonal line
can be obtained from the line: Diagonal 6.46 mm (Type 1/2.8)
To set the size of image sensor through the format or length of diagonal you must also specify the
aspect ratio of the image sensor, since Image sensors with the same diagonal, but different
aspect ratios will have different sizes.
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One should distinguish between the aspect ratio of the image sensor and the aspect ratio of the
output image 257 .
Aspect ratio of the output image is the ratio of sides of the image produced by the camera in the
given mode. It equals to the ratio of sides of the active area of image sensor in the given mode.
The aspect ratio of the output image can be different from the aspect ratio of image sensor. A
camera with the same image sensor in different modes can produce images with different aspect
ratios.

You can learn the aspect ratio of image sensor by several ways:
1. From the camera specification.
For example: In the specification of the camera WV-SFV631L sensor sizes can be found from the
string: Scanning area 5.346 mm (H) x 3.336 mm (V)
Aspect ratio of the image sensor: 5.346 / 3.336 = 1.60 = 16:10
2. You can learn the aspect ratio of the image sensor visually, if you remove the camera lens. To
determine the aspect ratio of the image sensor, photograph it and calculate the ratio of the number
of pixels in the image of the image sensor vertically and horizontally.

3. It is possible to calculate a ratio of the maximum number of horizontal pixels to the maximum
number of vertical pixels in all possible modes of the camera.
For example, a camera can produce images with the following number of pixels:
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90
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1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
The maximum number of horizontal pixels - 1920, the maximum number of vertical pixels - 1200.
Expected aspect ratio of the image sensor 1920/1200=1,6=16:10
Enter the obtained values of the diagonal (format) and the aspect ratio of the image sensor to
the Image sensor size 255 box in the Camera Geometry 251 separated by space character. If the
aspect ratio of the image sensor is 4:3, it can be omitted.
For example:
1/3"
1/3" 16:9
d6.0 16:9

Or enter the diagonal (format) and the aspect ratio of the image sensor separately to the
Image sensor>Size and Image sensor>Aspect ratio in the Sensor and Lens 267 box.

2.2 Then you need to specify the aspect ratio of the output image.

Specifying aspect ratio of the output image
The Aspect ratio of the output image equals to the aspect ratio of the active area of the image
sensor. It equals to the ratio of number of pixels of the output image horizontally and vertically in
the given camera mode. The aspect ratio of the output image can be different from the aspect
ratio of image sensor 419 . A camera with the same image sensor in different modes can produce
images with different aspect ratios.
For examples for the following number of pixels:
1920 / 1080=1.78=16:9. In the mode 1920 x 1080 the aspect ratio of the output image = 16:9
1600 / 1200=1.33=4:3. In the mode 1600 x 1200 the aspect ratio of the output image = 4:3
Enter the Aspect ratio of the output image to the Aspect ratio 257 box in the Camera
Geometry.

It is convenient to use the Image sensor calculator 349 , which can be invoked by the Calculator
button
in the Sensor and Lens box.

2.3 If it is possible that the active area does not touch the edges of the image sensor, you must set
the crop factor.

Specifying the Crop factor
Crop is a factor of decreasing active area size provided for case when the active area does not
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touch the edges of the image sensor. In other cases Crop=1.
For example, the same image sensor has format 1/2.8"(diagonal 6.46 mm) in the full HD1080
mode and 1/4.2" (diagonal 4.31 mm) in the HD720 mode. In the HD720 mode the image sensor
uses only the central part of pixels.

When setting the crop factor one should be guided by the rules:
1. If, in a given mode, the camera uses the maximum number of pixels of at least one dimension
(horizontal and (or) vertical), it is used the whole width or height of the image sensor, then the Crop
factor equals one.
For example, a camera can produce images with the following number of pixels:
1920 x 1080, 1280 x 720, 640 x 360, 320 x 180, 160 x 90
1600 x 1200, 1280 x 960, 800 x 600, 640 x 480, 400 x 300, 320 x 240, 160 x120
The maximum number of horizontal pixels - 1920, the maximum number of vertical pixels - 1200.
The modes with maximum numbers of pixels: 1920 x 1080 and 1600 x 1200.
2. If in the given camera mode not the maximum number of pixels is used, it is necessary to
get know how the camera produces images with less than the maximum number of pixels. The 3
ways are possible:
1. By resizing the image with the maximum number of pixels of at least one of the direction.
2. Using only the central part of the image sensor, do not touch sides of image sensor.
3. Simultaneous use of 1 and 2 ways. The intermediate image is produced using the center
area of the image sensor, and then the resulting image is resized.
In the first case, the size of the active area of the image sensor is not dependent on the number of
pixels of the output image, therefore the Crop = 1.
In the second and third cases, the size of the active area of the image sensor decreases with the
number of pixels of the output image.
First of all it is necessary to search the specification information whether the image sensor size
(format) or angles of view depend on the number of pixels of the output image. If such information is
not available, it is likely that the Crop = 1. But if there is a suspicion that the camera reduces the
size of the active area, you can check the camera practically:
1. Display the image from the camera in the mode with the maximum number of pixels of the
output image.
2. Switch to the mode with reduced number of pixels and note whether the size of the field of
view is reduced.
If the size of the field of view is not reduced or it is reduced only in one direction, then the Crop = 1.
If the size of the field of view is reduced in both directions in proportion of reduction in the number
of pixels of the output image, it is necessary to separately calculate the horizontal and vertical
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ratio of the number of pixels in the given camera mode to the maximum number of pixels in
appropriate direction. Crop equals to the minimum of these ratios.
For example, if the camera has modes of 1920 x 1080 and 1280 x 720, and the image in 1280 x
720 mode is formed by a central area of the image sensor, then the Crop = 720/1080 =
1920/1280, or 0.67.
If the size of the field of view is reduced in both directions less than the reduction of the number of
pixels of the output image, it is necessary to separately calculate the horizontal and vertical ratios
of the field of view size in the given mode of the camera to the size the field of view in the mode
with the maximum number of pixels. Crop equals to the minimum of these relations.
As you can see, in the most cases the Crop = 1. But on those rare occasions when the Crop <> 1
ignoring this fact can result to significant error. To calculate the crop factor it is convenient to use
the Image sensor calculator 349 that can be invok ed by click ing on the Calculator button
in
the Sensor and Lens 267 box.
Enter the Crop to the Image sensor's active area> Crop 268 box in the Sensor and Lens 267 box.
You can enter a number with decimal point or ratio separated by slash /.
For example:
0.67
720/1080

You can enter the Crop to the Aspect ratio 257 box in the Camera Geometry 251 separated by
space after the aspect ratio of the output image.
For example: 16:9 0.67

As a result of specifying all parameters, on the image in the Sensor and lens box 268 the aspect ratios,
relative position and size of the active area on the image sensor will be schematically displayed.
Examples of image sensor images of real cameras:
Aspect ratio of
Image sensor
Aspect ratio of
Active area of
Image sensor

4:3

16:9

4:3

16:9

16:10

16:10

4:3

16:9

16:9

4:3

16:9

4:3

16:9
(1920*1
080)
16:9
(1280*7

© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Examples of work with VideoCAD

1

1

1

1

1

Crop

1

423

20)
720/10
80=0.6
7

Image

In the Image sensor's active area 268 > Hor. Vertical Diag. boxes the calculated sizes of the active
area of the image sensor will be displayed.
In the Lens 269 > Calculated angles> Hor. Vertical. Diag. the calculated view angles will be
displayed.
The sizes of the active area may be adjusted or typed new values.
After setting all parameters for recording the result to the active camera, click Save.
3. After specifying all parameters it is recommended to verify correctness of the set active area size
using the obtained angles of view.

Verifying correctness of the set active area size using camera view angles
Sometimes camera specifications include view angles with a lens with known focal length.
Considering these angles as a result of practical measurements, it is possible to verify correctness
of the set active area size by comparing the angles from specification with the angles calculated by
VideoCAD in the Sensor and Lens box>Lens> Calculated angles> Hor. Vertical. Diag 269 . The
comparison may confirm the correctness of the obtained size of the active area of the image sensor
or show an error. If an error will be detected, please carefully check all parameters you specified.
When verifying it is necessary to bear in mind the following:
You need to know which angle is given in the specification of the camera (horizontal, vertical or
diagonal) and compare it with the same calculated angle.
You need to know in what mode of the camera the angle is obtained and simulate this particular
mode.
When the lens focal length is less than 6mm possible discrepancy between the calculated angles
and angles from the specification because of lens distortion 429 .
The difference between the calculated and specification's values of angles within 5% is normal,
due to measurement error, error of specifying the size of image sensor and lens focal length.
You can measure the view angles practically 405 .
See also: About Lens distortion 429 .
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10.39 Example 39 Teaching materials
When studying VideoCAD the educational article series The principles of CCTV design in
VideoCAD is very useful.
The principles of CCTV design in VideoCAD. Part I. Camera view area (*.pdf)
The principles of CCTV design in VideoCAD. Part 2. Person detection area, person identification
area, license plate reading area. Spatial resolution."(*.pdf)
The principles of CCTV design in VideoCAD. Part 3. 3D modeling in VideoCAD"(*.pdf)
The principles of CCTV design in VideoCAD. Part 4. Illumination and camera sensitivity in CCTV"(*.
pdf)
The principles of CCTV design in VideoCAD. Part 5. Video surveillance of moving objects."(*.pdf)
The principles of CCTV design in VideoCAD. Part 6. Lens distortion in CCTV design."(*.pdf)
... to be continued...
These articles contain a short theoretical material and illustrated step by step instructions on how to
use VideoCAD.
You can download the articles here http://www.cctvcad.com/CCTVCAD-Download.html
There you can also find:
VideoCAD User's Guide in *. pdf format
Package to import 3D models.
Other useful programs for CCTV design.
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Recommendations on the program use
Precision in calculations
VideoCAD calculates results on the base of laws of geometrical optics, video sensor's
characteristics, lighting engineering and radiometry. Mathematical precision in VideoCAD
calculations is not less than ±1 %.
At the same time, parameters of real cameras and lenses are not so precise.
The difference with reality depends on the accuracy of the input data.
A big influence on the accuracy of camera modeling has accuracy of specifying image sensor
sizes 415 . For wide-angle lens consideration of lens distortion 429 is very important.
Nobody can guarantee that just your camera and lens have no significant inequality of focal length
value with the one declared in the specification. It is advisable to test a camera with a lens
practically 405 in especially crucial cases.
If not performing such a test, it is recommended to leave a reserve about 10-15 % in the results.

Program speed and system requirements
Recommended system requirements:
IBM compatible computer with 2 Core processor;
1 Gb of RAM;
40 Mb of free hard disk space;
SVGA video adapter with Open GL 3D Hardware support;
Windows 2000, Windows XP, Windows Vista, Windows 7, Windows 8, Windows 10 operating
system;
Wheel Mouse;
As with other CAD software, real system requirements greatly depend on complication of your
working materials.
If you use a lot of 3D models, background file of tens of megabytes, you need more productive
hardware.
But you can simplify your materials and make the same work on outdated computer. Thus there
can't be clear system requirements which are correct in all cases.
Program speed depends on several factors.
Redraw speed of the image depends on number and complexity of displayed 3D models
and the size of opened 3D Video. VideoCAD offers powerful but resource-intensive operations
for image processing, which can be enabled or disabled.
The 3D Video 284 and 3D World windows opened simultaneously decelerate program speed.
It is recommended to enable the resource-intensive operations only when needed and disable
them during normal operation.
VideoCAD Lite 31 and VideoCAD Starter 45 may seem less demanding of computer resources
because of absence of resource-intensive tools. However, these tools when they are not needed,
can be disabled in version Professional too.
See details: Errors in rendering 3D images 290

Mastering VideoCAD
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To master the program it will be very useful to get acquaintance with The principles of CCTV
design in VideoCAD articles. See also Examples of work with VideoCAD 353 .
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About lens distortion
Studying the manufacturers specifications of lenses and cameras we can see that in many cases
the actual view angles obtained by measurement and listed in the specification do not coincide with
the calculated view angles for an ideal lens, based on the lens focal length 256 and the size of the
image sensor 255 .
For example, the specification of the lens T2314FICS-3 (Computar) contains the following values:

With lens focal length of 2.3 mm and the size of the image sensor 1/3" real horizontal view angle is
113.30 deg., and the vertical view angle is 86.30 deg. But calculation gives lower values - 92.40 deg
. and 76.10 deg.
The form of the camera view area with this lens differs from the standard pyramid and therefore can
not be accurately calculated by lens calculators or modeled by CCTV design programs of previous
generation.
The cause of warping the view area is the Lens distortion. The Lens distortion arises from the fact
that the optical magnification of a real lens is not constant over the entire field of view. Optical
magnification varies depending on the distance from the center to the edges of the field of view.
Depending on whether the optical magnification of a lens is decreased or increased with distance
from the center of the field of view, the barrel distortion and the pincushion distortion is
distinguished.
The titles barrel and pincushion are associated with the distortion of the image. But the shape of
the field of view varies oppositely the title. Thus, with the barrel distortion the image resembles a
barrel, and the shape of the field of view resembles a pillow. With the pincushion distortion, the
image resembles a pillow, and the shape of the field of view - a barrel.
Lens distortion leads to warping:
shape of view area and field of view;
image from the camera;
distribution of the spatial resolution 272 .
The Lens distortion should not be confused with the Perspective distortion (Fig. 7 431 ), which is
natural on all images obtained with wide-angle lenses. Perspective distortion does not change
pyramidal shape of the view area, rectangular shape of field of view and distribution of the spatial
resolution 272 .

Barrel distortion
If by moving away from the center of the field of view the optical magnification decreases, then
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objects at the edges of the field of view seem compressed, and the spatial resolution decreases
from the center to the edges, and the field of view is stretched to the edges. Real angles in this
case are more than the calculated angles. This is called Barrel distortion. The Barrel distortion
is most common and usual for wide angle lenses.
In particular, the lens T2314FICS-3 has just the Barrel distortion. Let's consider a model of image
from this lens, the model of field of view, view area projections built with and without simulating
distortion. Position of the camera in both cases is constant.
Note the warping of distribution of the spatial resolution (Fig. 4 430 ). Barrel distortion increases
the field of view, but reduces the spatial resolution, the farther from the center of the field of view,
the stronger.

Without lens distortion
simulation

With simulation of barrel
distortion

Fig. 1,2. View of a cross-hatch. With barrel distortion the cross-hatch resembles a barrel.

Fig. 3,4. Field of view. With barrel distortion the cross-hatch resembles a pillow. The spatial
resolution decreases from the center to the edges.
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Fig. 5,6. View are and scene model.

Fig. 7,8. Camera image model. The slope of the men in the upper corners (Fig. 7) is caused not
by the lens distortion but by the perspective distortion, which is natural for any wide-angle
lens.

Fig. 9,10. View area projection. View area projection bounds 168 in the Projection mode.

Pincushion distortion
If by moving away from the center of the field of view the optical magnification increases, then
objects at the edges of the field of view seem stretched, and the spatial resolution increases from
the center to the edges, and the field of view is compressed to the edges. Real angles in this
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case are less than the calculated angles. This is called Pincushion distortion. The Pincushion
distortion occurs seldom with teleobjective lenses.
Let's consider models built with and without simulating distortion. The models are given to illustrate
the pincushion distortion, they are not associated with a certain model of lens. Position of the
camera in both cases is constant.
Note the warping of distribution of the spatial resolution (Fig.14 432 ). Pincushion distortion
decreases the field of view, but increases the spatial resolution, the farther from the center of the
field of view, the stronger.

Without lens distortion
simulation

With simulation of pincushion
distortion

Fig. 11,12. View of a cross-hatch. With Pincushion distortion the cross-hatch resembles a pillow
.

Fig. 13,14. Field of view. With Pincushion distortion the cross-hatch resembles a barrel. The
spatial resolution increases from the center to the edges.
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Fig. 15,16. View are and scene model.

Fig. 17,18. Camera image model. As the lens is teleobjective (narrow angles), the perspective
distortion is not unnoticeable (compare with Fig. 7 431 ).

Fig. 19,20. View area projection. View area projection bounds 168 in the 2 levels mode.

Modeling lens distortion in VideoCAD
Lens distortion is modeled in VideoCAD Professional only.
Despite the complexity of internal calculations, simulation of lens distortion in VideoCAD is very
easy. The lens distortion in VideoCAD is defined by a combination of calculated view angle and
real view angle. The calculated view angles are calculated in the program from the lens focal
length 256 and format 255 or the actual size 267 of the image sensor.
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The real angles are usually given in the specifications of cameras and lenses. If the angles are
unknown, it is possible to get them by practical measuring 405 .
To determine the lens distortion it is enough to set one of three real angles: horizontal, vertical or
diagonal. It is preferable to set the horizontal angle. Missed real angles will be calculated by
VideoCAD. For maximum accuracy, you can specify 2 or all 3 the real angles.

See more: Lens distortion 267 , Modeling lens distortion 403 , Measuring real view angles 405
See also: Specifying active area size of the image sensor 415
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Contacting CCTVCAD Software
For the latest versions of our programs, please check our web site at
http://www.cctvcad.com
Any questions can be e-mailed to us at info@cctvcad.com
Technical questions can be e-mailed to us at support@cctvcad.com
We try to answer e-mail as quickly as possible.
You may also use our on-line form on our website http://www.cctvcad.com/CCTVCAD-Support.html.
Telephone support is available only by request. If you need telephone support, or just want to talk to
a live person, please contact us at one of the above addresses for the current hours of availability, as
they change often.
If you have ideas, suggestions, comments, criticisms, or questions, we would love to hear from you
about our programs!
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Order and registration
For the latest order options, visit the CCTVCAD Software web site at:
http://www.cctvcad.com/CCTVCAD-Order.html
For details of the registration please see VideoCAD registration procedure
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1/2'
255
1/2"
255
1/2.7"
255
1/3'
255
1/3"
255
1/3.2"
255
1/3.6"
255
1/4'
255
1/4"
255
10 layouts
199, 340
100 cameras
199
16:9
255, 316, 415

-22 levels
166, 199
2 stage
325
2 stage+2 priority
325
2/3'
255
2/3"
255

-33D constructions
284
3D H max
361
3D H min
361
3D image
164, 166, 197, 199
3D images
361, 365
3D model
164, 166, 197, 199, 366, 399
3D model height
166
3D model height above the ground
166, 248
3D model sizes
248
3D modeling
319, 325
3D modeling in VideoCAD
424
3D modeling layout
3
3D modelling
355

441

442

VideoCAD Lite

3D models
89, 157, 197, 199, 284, 291, 320, 355,
357, 365
3D MODELS AND 3D Video
89
3D models of terrain
199
3D Models window
197, 199, 291
3D models-territories
399
3D object
361
3D objects
320
3D panel
325
3D translucent view area
199
3D Video
157, 164, 166, 197, 199, 284, 355, 362,
363, 366
3D Video in separate thread
325
3D Video Main menu
286
3D VIDEO WINDOW
89
3D view area
164, 166, 197, 199
3D view areas
400
3D visualization
3, 89
3D Window
89
3D World
157, 164, 166, 197, 199
3D WORLD WINDOW
89
3DS file (*.3ds)
397

-44/3"
4:3

255
255, 316, 415

-77 illuminators
374
768x576 pixels
295

-Aa less capacity of detection
427
About camera sensitivity
367
About VideoCAD
197, 199
According to camera parameters
286
According to camera parameters box
362
Active area of image sensor
147, 415
Active area of the image sensor
415
Active camera
164, 274
active camera coverage
3, 89
actual projection
251
Actual projections
361
Actual resolution
255

Actual view area projections
164, 166, 197, 199
Add
292
Add 3D model
197, 199
Add to DXF/DWG background
329
Add. cost 1..3
315, 316
Add. information
315, 316
Adding new 3D models
166, 199
Adding new 3D models to the library
199
Additional costs
316
Additional features
315, 316
Additional illumination
374
Additional information
166, 197, 199, 255, 336
Adjust background
199, 359, 413
adjust parameters of drawing export
329
Advanced
290
AES
316
AESC
315, 316, 366, 367
After payment is confirmed
439
AGC
315, 316, 366, 367, 375, 377
AGC (dB
Max)
315, 316
Align
197, 199
Alignment
345
All cameras' cables
197, 199
All models
166, 304, 310
Already assigned shortcuts
324
Alt is pressed
159, 249
Alternating current
316
analog camera
385
Analog cameras
316
Analog monitor
295, 302
analog recording
255
angle
164, 166, 197, 199, 247
angle between a direction on the camera and
horizontal
362
Angle of radiation
166, 199, 373, 376, 377
angle of radiation (degree
373
angle values
255
Angles of view (deg.)
315, 316
Angular
199
angular parameters
251
animated *.gif 284, 286, 298
animated image
379
animated images
284, 294, 379
animated model of monitor
380
Animation
295, 298, 380
Any questions can be e-mailed
438
aperture
361
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Aperture (F)
315, 316
aperture changing
316
aperture corrector
316, 369
Aperture in Wall
164, 166, 197, 199, 245, 357, 361
Aperture limits
366
aperure
366
Apply
369
Apply res.
274
Approximate calculation of IR illuminator
373
Approximate calculation of visible light luminaire
373
Arc
164, 166, 197, 199
arrow keys
249
articles
427
AS4806
89, 199, 272
aspect ratio
89, 253, 267, 315, 316, 349, 415
Aspect Ratio of active area of Image sensor
349
Aspect Ratio of Image sensor
89, 349
aspect ratio of output image
89
aspect ratio of the active area of the image sensor
267
Aspect ratio of the output image
255, 267, 349
Assign
274, 310, 324
Assign model
310
assign new shortcuts
324
Assign to selected cameras
166, 251
assigned shortcuts
324
Assigning the pattern to cameras
281
At grid
199
attenuate sensitivity
368
attenuation filters
368
Author
345
AUTO
255, 274, 281
Auto Iris DC
315, 316
auto saving
333
AutoCAD
89, 147, 199, 357
AutoCAD blocks
89, 199
AutoCAD DWG
3, 89, 397
AutoCAD DWG/DXF
199
AutoCAD DXF
329, 397
AutoCAD format
359
AutoCAD unit per meter
329
auto-dome camera
316
AutoDome cameras
316
Autofocus
315, 316
Automatic flip
316
Automatic focusing
316
automatic gain control
366
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166
Automatic white balance
316
Autosaving
89
auxiliary constructions
251
Average brightness
368, 375, 377
AWB
315, 316
axial light intencity (candel)
373
Axial radiant intensity (watt/steradian)
Axial rotation angle
253, 255
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-BB/W
316
Back light compensation
316
background
147, 199, 284, 286, 357, 362
Background illumination (lx)
366
background in AutoCAD
199, 413
Background light source
366
Background only
197, 199
Background res.
325
background resolution
286
Backgrounds
159
barrel distortion
89
Base height
89, 253, 255
base heights
159
base point for the copying
361
base points
159
big size drawings
329
bitmap
357
bit-mapped fonts
322
black line
159
black&white
316
Black-and-white
197, 199
BLC
315, 316
Blend/Hatch
274
BMP,WMF,EMF,GIF,TIF,PNG,JPG
329
BMP,WMF,EMF,GIF,TIFF,PNG,JPG,rPDF
Bold
322
bold parameters
315, 316
bottom of the graphics window
243
bottom-left corner
242
boundary resolution
361
brand of cables
388
brightness
286, 325, 362
brightness drops
255
brightness limitation
371
Bring to front
197, 199
buttons of Constructions group
361

89
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By calibrated attenuation filter
368
By calibrated manual iris lens
368
By limiting exposure time of electronic shutter

368

-CCable
320, 388
Cable box
388
Cable brand
341, 342
Cable laying
197, 199
Cable report
89, 197, 199, 388
cable segment
342
Cables
159, 197, 199
cables of loaded camera
166
Cables only
343
Cables summary
345
Calculate shadow for active camera
333
Calculate shadow for active camera once
333
Calculate shadow from 3D models
333
Calculate shadows for active camera
197, 199
calculated parameters
251, 255
Calculating lengths of cables
388
Calculating lengths of cables and getting Cable report
353
CALCULATING SHADOWS IN THE VIEW AREA
89
calculation method
361
Calculation of camera view area parameters
353,
360
Calculation of cameras' parameters and choice of their
relative locations
353, 361
Calculation of horizontal projections of person
detection
identification and license plate reading areas
427
calculation of IR illuminator
373
calculation of shadows from 3D models
381
Calculation of variants of cameras placing
361
calculation of visible light luminaire
373
calculation with incorrect values
251
Calculator
267, 349
calibrated lens
368
Calibrated manual iris lens
368
Call Help information
249
Camera
197, 199, 286, 327
Camera and Illuminator
319
Camera contol area
147
camera degradation
325

Camera field of view
147
Camera Geometry
164, 166, 197, 199, 355
Camera Geometry box
251, 360, 361, 362
Camera icon
329, 409
Camera installation height
355
Camera installation parameters
253, 255
Camera list
157, 164, 166, 197, 199, 336
camera manual
255
Camera model
310
camera name
159
camera names
197, 199, 322
camera number
166
Camera panel
366
Camera parameters
253, 255, 360, 362
Camera resolution
255
camera rotation
89, 402
camera sensitivity
367
Camera tilt angle
147, 251, 253, 255
camera type
336, 377
camera view angles
316
Camera view area
147, 424
camera voltage supply
342
Camera with attenuated sensitivity
368
camera with the minimal number
249
CAMERA, LENS AND DVR PARAMETERS
89
Cameras
89, 159, 284, 345
cameras of extended quality
255
Cameras over constructions
197, 199
Cameras summary
345
Cameras view area
284
cars with license plates
166, 199
Case
315, 316
CCD sensor
385
CCIR/PAL
316
CCTV design using Monitor window and PTZH frame
353, 363
CCTV project
365
CCTV projectExample 9 Choice of camera model
according to known scene illumination
353
CCTVCAD Lab Toolkit
367, 368, 369, 375, 377
CEA 639
316
CGM
199, 329
change 3D model height
199
Change installation height
164, 166, 197, 199, 355
change lens focal
255
change lens focal length
355
Change line type
197, 199, 327
Change view area lower bound
164, 166, 197, 199
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Change view area upper bound
164, 166, 197, 199,
361
CHANGES
89
changes radically
251
Changes the selection logic
249
changing aperture
316
Changing column width
307
changing lens focal length
316
Changing row height
307
changing the scale
159, 249
chart lines beating
369
Checking Depth of Field in horizontal projection
353
Choice of camera installation height and parameters
353, 355
Choice of camera model according to known scene
illumination
353, 366
Choice of cameras' quantity and location
353, 357
Choice of cameras' quantity and location on the
original layout
353, 359
Choice of luminaire power and location
353, 374
choose a layout
340
Choosing install location for PTZ camera
353
chrominance
362
CIE 97
325
CIE spectral response
367, 371
Circle
164, 166, 197, 199
clean environment
325
Clear
298
Clear cell
300
Clear filter
307
CMOS sensor
385
codepage.
345
color
315, 316, 320, 362
color of 3D objects
320
color temperature
316
Colors of regions
274
Colors of regions button
274
COLORS, FILLING AND HATCHING OF VIEW AREA
PROJECTIONS
89
Combine to block
197, 199
Commands box
324
Common number
338
Common scale
329
Common scale (unit/m
unit/ft.)
329
Compatiability with AutoCAD versions
147
Compatible equipment 1..3
315, 316
Compatible software 1..3
315, 316
Compress columns
310
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Compress/Expand
310
compression
286, 290, 315, 316, 325, 362
Compression rate
255
computer buzzes
290
Concentration
373, 376, 377
conductor material
342
conductor temperature
342
Connect all cameras to this monitor
363
Connection of cameras
302
Connectors
315, 316
Considerable discounts
439
Constant coordinate system
159
Constructions
159, 197, 199
consumed electric power
377
Consumed electrical power
373
Consumption
315, 316
Contact us
197
Contacting CCTVCAD Software
438
context-sensitive help system
153
contrast
286, 325, 362
Contrast %
315, 316
contrast loss of 10%
369
Control
315, 316
Control area horizontal projection
147
control area projections
381
control mouse more precisely
333
convenient at navigation
159
Coordinate system fixed to the loaded camera
159
coordinate systems
159
copper
342
Copy
159, 164, 166, 197, 199, 361
Copy selection
313
Copy to All models
310
Copy to clipboard
197, 199, 286, 336
Copy with base point
197
copying the image
302
Cost
315, 316
counting of the cursor current coordinates
159
Cover
345
cracking software protection
439
create
and rename layouts
242
Create a new camera model
310
Create camera
366
Create new camera
166, 199
create new layout
340
Create new project
199
Creating animated model of monitor
353
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CREATION OF ANIMATED IMAGES
89
Creation of animated monitor
302
criteria
197, 199, 272
Criteria editing box of license plate reading area
157
Criteria editing box of person detection area
157
Criteria editing box of person identification area
157,
362
criteria of the person detection
255
Crop
267, 349, 415
Crop factor
89, 267, 316, 415
Crop, calculation
349
Crop-factor
349
Ctrl
159, 199, 249
Ctrl is pressed
166, 249
Ctrl+A
199, 249
Ctrl+Spacebar
249
Ctrl+TAB
249, 340, 361
Current (A)
315, 316
Current construction parameter panel
244, 355,
361, 373, 374
Current construction parameters panel
158
Current construstion parameters panel
247
current coordinate of the cursor
243
current font type
246
Current image sizes
286
current layout
159
current line type
245
current scale factor
243
Currently assigned to box
324
cursor
243
Customizable shortcuts
249
Cut
164, 166, 197, 199
Cut selection
313
Cut with base point
197
Cycle
368, 375, 377

-Ddark blue lines
251
Dash
320
DashDot
320
DashDotDot
320
Data
310
Database of camera models
3
Date
345
Day and Night
345
Day/Night
286, 295, 298, 316, 365
Default
319

Default line type for 3D models
320
Default line type for cameras
166
default parameters
342
degrees
251
DEL
249
Delete
159, 292, 310
delete a layout
340
delete all images
302
Delete background
197, 199
Delete model
310
Delete selected objects
249
Delete selection
313
delete the image
302
Delete view
310
demo-version
365
Depth of Field
164, 166, 197, 199, 290, 390
Depth of Field box
390
Depth of field calculation box
157, 361
Depth of Field in horizontal projection
390
DEPTH OF FIELD IN THE HORIZONTAL
PROJECTION
89
depth-of-field
286, 361
depth-of-field modeling
286
Description of all cameras
363
Design operator interface
3
Destroy
197, 199
Destroy block
197, 199
detailed analysis of view area
159
Determining person identification criteria by a real
image
353, 362
Determining spectral efficiency of light source
353,
375
Determining the Person identification criteria by the
image model
362
Determining the quality parameters of the image model
362
Differences between versions of VideoCAD
53
Differences between VideoCAD 7 Starter II and
VideoCAD 7 Starter
53
Differences between VideoCAD 8 Lite and VideoCAD
Starter II 53
Differences between VideoCAD 8 Professional and
VideoCAD 8 Lite
53
different icons
327
different type hatchings
166, 199
Digital cameras
316
Digital image processing
316
digital recording
255
Dimension
363
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dimension lines
251
Direct current
316
direct light
166
direction of the camera lens
159
Directories panel
292
dirty environment
325
Disable image processing
286, 290, 325
Discrete color
381
Display camera type
336
Display Properties
290
Display resolution
255
displayed information
159
Distance
199, 376
distance to the camera location
243
distortion
315, 316, 333, 403
distortions of moving objects
385
Document
345
Dome
199, 384
dome camera
316
DOME-cameras
255
dongle driver setup
439
Double line
164, 166, 197, 199
double-clicking the camera lens
166, 199
drag
159
Draw 3D Video in separated thread
290
Drawing
197, 199, 345
drawing export
329
Drawing of cameras' placement
363
DSP
315, 316
Dupl
292
DWG
199, 397
dX.Y
255, 267
DXF
199, 397
DXF,DWG,PLT,CGM,SWF,vPDF
89

-Eeasy day/night
316
Edit
197, 199, 298, 310, 373
Edit button
247
edit any parameters of construction
247
Edit font type
246
Edit line type
245
Edit loaded camera
159, 164, 166, 197, 199
Edit parameters of camera model
310
edit texts
159
Edit/Save
274
editing a rectangle or a mask
249
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editing rectangle
249
editing state
159, 199
editing text
246
Editing the Spatial resolution pattern
281
effective pixels
316
Efficiency factor
373
EIA 1956
369
EIA/NTSC
316
EIA1956
89, 284, 286
electrical parameters
342
electronic shutter
366, 368
EMF
329
Empty
307
EN 50132-7
199, 272
EN50132-7
89
Environment
315, 316
Environment temperature range
316
equivalent illumination
377
Erase
164, 166, 197, 199
Erase all
197, 199
errors are visible on the image
290
Errors in 3D Video
290
Errors in rendering 3D images
290
ES
315, 316
ESC
166, 249
especially crucial cases
427
Example 1
355
Example 2
357
Example 5
361
example of a video surveillance system project
365
Example of numeration
338
Examples directory
365
Examples of luminaire calculation
353, 373, 374
Examples of work with VideoCAD
353
Excel
304, 310
Exclude blinking
333
exemplary images
362
Exit
197, 199
Export
3, 197, 199, 304, 310, 319, 329
Export 3D view areas
400
Export selection
313
Export tab
329
Export table of camera models
310
Export to *.html
298, 380
Export to AutoCAD
89
Export to BMP
EMF
329
Export to DXF
329
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Export to Text
197
Export to VideoCAD3..6
197, 199
Exposure
286
exposure (ms
366
Exposure (ms)
315, 316, 385
exposure time
284, 286, 385, 391
Extension
199
ExView HAD ™ CCD
316
eye contrast sensitivity
286

-FF1
153, 157, 249
F1.2
366
familiar or unfamiliar people
427
far space limit
325
feet
251
Field of view
274
field of view size
272
Field-of-view height
274
Field-of-view size
197, 199
Field-of-view size in point
164, 166
Fill projections
164, 197, 199
Fill Title-Block
199
Filling
164, 166, 197, 199, 381
Filter transmission coefficient
368
filtering
304
Filtering by parameter value
307
Find on layouts
300, 336
Find text
197, 199
First registration
439
First registration key
439
fisheye
267, 317, 409
fix some parameters of construction
247
Fixed
Mini
315, 316
Fixed iris
366
Flip
315, 316
Focal length
267, 315, 316
Focal plane
164, 166, 197, 199
Focus
315, 316
focus plane
320, 390
Font (codepage)
345
font color at printing
322
font color on the screen
322
Font height
345
font height in inches
322
Font type name box
246

Font type number box
246
Font type panel
158, 244, 246, 319
font typeface
322
font types
246, 319
Fonts
322
Form
315, 316
Format
267, 315, 316
format of measurements
199, 274
formatting your hard disk
439
Frame
345
frame rate
248, 284, 379
Frame rate (fps)
286
frame reading time
394
Freeze columns up to selected one
313
From left to right
338
From top to down
338
front nodal point
405
full frame or one field
362
Full screen
298
full version
365
full version of VideoCAD
439

-GGamma
315, 316, 325, 366
gamma correction
366
General information on VideoCAD
3, 31, 45, 49
genlock
316
geometrical distortions
427
Getting started
153
GIF
329
Global shutter
385
Global snaps
164, 166, 197, 199
Google SketchUp
397
Graphical calculation of depth of field
361
graphical depth of field calculation
243
graphical editing state
159, 166
graphics area
158, 159
graphics card driver
290
graphics card features
290
graphics methods
361
Graphics window
158, 159
graphics window menu
249
graphics window size
243
green dash lines
251
green grass
377
grey
251
Grid
197, 199, 284, 320
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Grid selected step box
164, 166
grid step
199, 286
ground
159
Ground color
325
Ground indication
320
Ground surface
284, 286

-HH (%)
345
half frames
286
halogen incandescent lamp
316, 375, 377
hardware acceleration
290
Hatch and dash lines
329
Hatch style
166
hatching
199
hatchings
166
headgear
427
Height
247, 274, 322, 345
height above the ground
243
Height indication
320
height of camera installation
286
height of depth of field measurement
390
height of illuminator
374
height of installation
253, 255, 355
height of the 3D model
199
Height of view area lower bound
253, 255
height of view area upper bound
253, 255, 362
Help
197, 199
Help Contents
197, 199
Help of parameter (F1)
304, 313
HID
439
HID identifies basis
439
HID is lost
439
HID might be lost
439
hidden objects
199
hidden state
159, 199
Hide
159, 197, 199
hide any projection
159
Hide background
197, 199
Hide columns
310
Hide horizontal projection
159, 164, 166, 197, 199
Hide panel
245, 246
Hide selected columns
310, 313
Hide vertical projection
159, 164, 166, 197, 199
High AGC
316
high resolution *.emf 199
high resolution monitors
333
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High resolution on top
89, 199
high-resolution cameras
361
hight resolution images
284
Hight resolution on top
197
hints
243
Home Office Guidelines for identification
272
Home Office Scientific Development Branch
199,
272
Homepage
197
Horiz. only
316
horizontal black line
251
Horizontal bounds
320
Horizontal line
164, 166, 197, 199
Horizontal only
315
horizontal projection
243, 249
horizontal projection of view area
360
horizontal red line
159, 274
horizontal resolution
361, 362
Horizontal resolution (TV-lines)
315, 316
Horizontal size
362
HTML file
380
human body
377
hyperfocal distance
361, 390

-II/O
316
icons of cameras
316
identification
362, 427
illumination
290
Illumination and camera sensitivity in CCTV
424
IllUMINATION AND LUMINARIES
89
illumination from the tested lamp
375
illumination from tungsten halogen lamp
375
illumination is insufficient
374
illumination modeling
374
Illumination modeling panel
325
illumination with filter
368
Illuminator
164, 166, 197, 199, 373, 374
Illuminator calculation
373, 374, 376
Illuminator calculation box
157, 377
Illuminator calculation button
373
Illuminator height above the ground
199
Illuminator icon
329
Illuminator icon (unit)
329
Illuminators
286, 365
Image
286
Image analyzer
157, 197, 199, 367, 369
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Image analyzer utility
377
Image generation time
286
image in the 3D Video
286
image model
366
image of camera view area
251
Image paramerer panel
362
Image parameter panel
361, 362, 366, 374
Image pixel beating
369
Image processing parameters
362
image quality in the 3D Video
290
Image sensor
267, 315, 316, 349
Image sensor calculator
89, 157, 267, 349
Image sensor format
253, 362, 365
image sensor format (type)
415
Image sensor model
316
Image sensor size
147, 253, 255, 267, 316, 360,
361, 362, 365, 415
Image sensor sizes
89, 267
Image sensor's active area
267, 349
Image size
361
Image size in the 3D Video
284
Image size panel
369
Images
345
Images of video surveillance system
363
Imperial
199
Import
3
IMPORT AND EXPORT 89
Import DXF/DWG background
197, 199
Import from VideoCAD3..6
197, 199
Import of 3D models
397
Import of 3D models and scenes from 3ds max to
VideoCAD
166
Import of 3D models from Google SketchUp
353
imprecise pointer devices
333
In construction mode
247
In Edit mode
247
inclination angle
199, 374
Inclined rectangle
164, 166, 197, 199
incorrect value
251
individual case
427
infra-red LED illuminators
316
INHERITED ELEMENTS
89
input-output
316
Insert model
292
Insert rastrer images
329
Install driver
439
install location for PTZ camera
384
installation height
360, 361, 362

Installation parameters
360
IntelliMouse
159
interchange images' positions
302
Interface
89, 157, 319, 333
INTERFACE IMPROVEMENTS
89
Interface of the Table of camera models
interlace distortions
284
Interlace scan
286, 385
Interlaced
316
interlaced fields
362
internal
316
Internet link
313, 315, 316
Invisible buttons
332
IP camera
385, 391, 394
IP cameras
316
IP cameras sensitivity
367
IR corrected lenses
316
IR correction
315, 316
IR illuminator
377
IR LED
315, 316
IRE
315, 316, 366
IRE at the minimum illumination
367
IRE of the image
286
IRE of video signal
316
Iris
315, 316
Iris control type
316
irradiance
377
ISO/IEC 19794
89, 199, 272
Italic
322
iterative algorithms
427

306

-JJPG

329

-KKey feature
315, 316
Keyboard
319, 324
keyboard shortcuts
158, 249, 324
Keywords
345

-Llack of image
290
lamp aging
325
Lamp position
286
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

Index

Lamp power
376, 377
Lamp power (watt)
373
Lamp quantity
373, 376
Lamp spectrum analyzer
157, 197, 199
lamp supply voltage
371, 375
Lamp type
376, 377
Lamp type combo box
373
Language
197, 199
latest versions of our programs
438
laws of geometrical optics
427
layers
89, 157, 158, 164, 166, 199, 398
layout
159, 242
Layout tabs
158, 242
Layouts
157, 197, 199, 340, 345
LED
373
LED quantity
373, 377
length
247
Length calculation of line segments
157, 197, 199,
343
length of the velocity vector
248, 380
Lens
267, 315, 316
lens aperture
316, 365
Lens calibration
368
lens distortion
3, 89, 267, 403
lens focal length
164, 166, 253, 255, 286, 355, 360,
361, 362, 365
lens focal plane
199
Lens format
255, 316
Lens infra-red correction
316
lens manual
255
Lens mount type
316
Lens panel
366
Lens type
316
Licence plate and test chart antialiasing
325
license plate in the 3D Video
325
License plate of cars
199
license plate reading
362
License plate reading area
164, 166, 197, 199, 360
License plate reading area projections
320
License plate reading area size box
157
license plate reading areas
365
LIDC
166
Light flux emitted by lamp (lm)
373
Light intensity curve
373
Light intensity curve with lamp with full light flux of
1000 lumen
373
light intensity curves
376, 377
Light intensity distribution curve
166, 199, 373
© 2003-2016 CCTVCAD Software, http://www.cctvcad.com

451

light reflected from the environment
376
light sensitivity
365
light source
316
lighting
427
Lighting intensity level
255
line color at printing
320
line color on the screen
320
line design
320
line pair per millimeter
89
line pair per mm
315
line pairs per millimeter
316
Line segment
164, 166, 197, 199, 388
Line spacing
345
line type
320, 343, 355, 388
Line type name box
245
Line type number box
245
Line type panel
158, 244, 245, 319
line types
159, 245, 319
line types as cables
343
line types for displaying the system objects
320
Line weight unit/pixel
329
line width at printing
320
line width on the screen
320
linear parameters
251
linelock
316
Lines
199, 320
lines of double thickness
159
lines per picture height
89, 315
List of directories
292
live image
255
live monitoring
255
Live Video Analyzer
157, 197, 199, 368, 375, 377
llumination without filter
368
LO AGC
316
Load
292, 300, 310, 369
Load background
197, 199, 359
Load model database
310
Loaded camera
164, 166, 243, 336
Loaded camera cables
197, 199
Loaded camera group
159
Loaded camera name
286
loaded state of camera
159
Local snap
361
location plan of site
359
Lock constractions
197, 199
Logo
345
long-focus lenses
361
Look around
89
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looking upwards
427
losing the dongle
439
lower limit of illumination
367
lower-range value
368
Low-frequency oscillator
394
lp/mm
315, 316
LPH
89, 286, 315, 316
LPH - lines per picture height
147
luminaire dirt depreciation
325
luminance
362
Luxmeter
367, 371, 375, 376, 377
luxmeter sensor
368, 375
luxmeters
368

-MM.O.D.
315, 316
M12
367
Main cables
388
Main menu
158, 324
main optical axis
159, 199, 255
maintenance cycle
325
maintenance factor
374
Maintenance factor of cameras
325
Maintenance factor of illuminators
325, 373
maintenance factors
366
Make the button invisible
332
Make the button visible
332
Manual Iris Lens
375, 377
Margins
329
Mask
164, 166, 197, 199
Mastering VideoCAD
427
material carrier of the VideoCAD license
439
Mathematical precision in VideoCAD
427
Max. frame rate (fps)
315
Max. humidity (%)
315, 316
maximal distance of surveillance
255
maximal distances of the person detection
255
maximal F number
316
Maximal focal length
316
Maximum AGC gain
316
Maximum aperture
316
Maximum distance
89
Maximum distance of drawing view area
253, 255
Maximum height
320
maximum height of 3D construction
361
Maximum horizontal resolution
286
Maximum humidity
316

Maximum level of brightness
367
maximum realistic quality
290
maximum scene illumination
371
Maximum signal/noise ratio
371
measurement results
243
measurement system
251
Measuring camera resolution
353, 369
Measuring camera sensitivity
353, 367
Measuring exposure
391
Measuring filter transmission coefficient
368
measuring illumination
367
Measuring low illumination
353, 367, 368
Measuring maximum scene illumination for a camera
353, 371
Measuring parameters of IR illuminator
353, 377
Measuring projector parameters
353, 376
Measuring real view angles
405
Measuring rolling shutter
394
measuring sensitivity
368
Medium fog
strong snowfall
286
Medium snowfall
weak fog
286
megapixel images
286, 378
Menu box
324
mercury high pressure lamp
366
Merge contour
197, 199
merging the cells
302
Meteorological visibility
286
meters
251
Metric
199
Microphone
315, 316
middle mouse button
249
Min. (F)
Max. (F)
315, 316
Min. (mm)
Max. (mm)
315, 316
Min. scene illumination (lx)
315, 316
mini-camera
316
mini-lens (M12)
368
mini-lenses
367
Minimal and maximal height
166
minimal F number
316
Minimal focal length
316
minimal resolution
369
Minimum aperture
316
Minimum distance
316
Minimum height
320
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minimum height of 3D construction
361
minimum scene illumination
366, 367, 368
Minimum scene illumination (lx)
366
Minimum vertical resolution
361
minus on the digital keypad
249
Mirror
164, 166, 197, 199
Miscellaneous
89, 319, 333
Model
286, 291, 292, 315, 316
Model color
316
Model cost
316
Model illumination
286
Model illumination box
366
model monitors
294
Model name
316
Model of loaded camera
164, 166
Model panel
292
Model perm.
385
Model permanently
286
Model sizes
316
Model space
290, 325
model video quality
284
Model weight
316
Modeling camera sensitivity
366
Modeling megapixel images
286, 353
MODELING MOVEMENT 89
MODELING RESOLUTION
89
MODELING RESOLUTION OF MEGAPIXEL
CAMERAS
89
Modeling scene illumination
366
modern operating systems
427
Monitor
380
Monitor correction factors
333
Monitor diagonal
295, 302, 333
Monitor dimension
295, 302
Monitor list
295
Monitor resolution
295
Monitor size factor
333
Monitor window
157, 164, 166, 197, 199, 294, 298,
300, 302, 363, 365, 380
Monitor window Main menu
298
Monitor window Pop-up menu
300
Monitor window Tool bar
295
More precise calculation of IR illuminator
373
More precise calculation of visible light luminaire
373
Motion blur
385
Mount
315, 316
Mouse
157
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mouse wheel
159
Move
89, 164, 166, 197, 199, 361
Move background
197, 199
Move drawing
164, 166, 197, 199, 249
move drawing in the Graphics window
249
Move loaded camera
164, 166, 197, 199, 361
Move loaded camera name
197, 199
move the camera
355
Move to active layer
164, 166, 197, 199
Moving 3D models
199
Moving columns
307
MS Excel
336
MS Word
336
MTF
89
multi-layer
199
multi-level projects
398

-NName
315, 316, 320, 322
name of the font type
322
name of the line type
320
names of project
199
narrow angle illuminator
377
Navi (navigation)
291
near space limit
325
neutral density optical filters
368
New
164, 166, 197, 199, 310
new camera
166
NEW FORMATS OF IMPORT AND EXPORT 89
NEW IN TABLE OF CAMERAS AND TABLE OF
CAMERA MODELS
89
NEW IN THE MONITOR WINDOW
89
NEW OBJECTS AND TOOLS
89
NEW PROJECT FORMAT 89
new project name
199
New shortcut key
324
Next cell
295
next layout in turn
249
Next screen
295
Night tab
366
nodal point
405
noise
325
nonscalable
329
Nonscalable fonts
329
nonscalable icons
329
Nonscaleable fonts
329
non-standard
255
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nonstandard image sensors
316
Normal
325
normal environment pollution load
325
normal state
159
Not empty
307
notch (not comb) filters
362
NTSC system
316
Number
320, 322
number of effective pixels of image sensor
362
number of external factors
427
number of lamps in the luminaire
373
number of LEDs in the illuminator
373
number of physical pixels
409
Number of pixels
315, 316, 362
Number of pixels of the image sensor
361
number of rows in the frame
394
number of the displayed font type
322
Number.bmp
166, 325
numbers of pixels
385
Numerate
338
Numerate cameras
197, 199, 336, 338
Numerate cameras tool
199
Numeration order
338
Numeration pattern
338
numerical values
427
Numerical values criteria of person identification and
license plate reading.
427

-Oobject
159
Object height
274
Object height (width)
274
objects
159
Omnidirectional light source
373
On all layouts
338
ON/OFF grid displaying
164, 166
ON/OFF mode of automatic grid step selection
166
One field
286, 362
on-line form
438
Open
197, 199
Open earlier saved project
199
Open GL
290
Open Internet link
313
Open Type
322
OpenGL hardware support
290
Opening Monitor window
302

164,

operating system
427
operator's workplace
294
Optical axis
164, 166, 197, 199
optical center
405
Options
197, 199, 319, 324, 325, 327, 329, 333
Options box
157, 245, 246, 319, 320, 322
Orbit
89
Order
197, 439
Order and registration
439
Order by ascending
307
Order by descending
307
orientation of the second line
249
Origin
197, 199
origin coinciding with the loaded camera
243
origin of coordinates
159, 243
Oscilloscope
394
Other
315, 316, 345
outdated graphic card
325
outdoor
316
Output
315, 316

-PP 78.36.008-99
272
Page margins
345
Page Numbers
345
Page orientation
329
PAL system
316
Pan angle
267
Panoramic
267, 409
parameter boxes
251
parameter variation
325
parameters of actual cameras
427
Parameters of camera model
315, 316
parameters of camera models
304
parameters of constructions
247
parameters of the camera
286
parameters of the scene
286
Paste
164, 166, 197, 199, 304, 313, 361
Path
345
Pattern
274
Pattern criterion
274, 281
PC-based video capture system
367, 375, 377
PDF
199, 329
PDF document
199, 345
PDF files
89
PDF format
199
PDF Report
199, 345
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peak-to-peak amplitude
369
percentage
251
Performance Testing of CCTV Perimeter Surveillance
Systems (Using the Rotakin Standard Test Target)
199
permanent IR filter
316
person detection
357, 361, 362
Person detection area
164, 166, 197, 199, 360
Person detection area projections
320
Person detection area size box
157
Person detection area, person identification area,
license plate reading area
424
person detection areas
365
Person identification
357
Person identification area
164, 166, 197, 199, 360
Person identification area projections
320
Person identification area size box
157
person identification areas
365
Physical diagonal of the Monitor window
333
Picture in Picture
378
PIN-HOLE lens
427
pink circle
159
pink color
159
pink grips
159
PiP
378, 385
Pixel for object
274
Pixel per meter
274
Placement
345
Placement of images
302
Plane at the hyperfocal distance
320
Plate height
325
Plate width
325
PLT 199, 329
plus and minus keys
249
plus on the digital keypad
249
PNG
247, 329
PoE
316
Point
164, 166, 197, 199
point of origin
159
Points
199
Polyline
164, 166, 197, 199, 388
pop-up hint
157
pop-up list
251
Pop-up menu
306, 313
Pop-up panels
244
Positions
199
Power (watt)
315, 316
power cable
164, 166, 197, 199, 320, 342, 388
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Power cable electrical parameters and length
calculation box
157
power consumption
316, 373
Power over Ethernet
316
Power supply
315, 316
power supply unit
367
precise drawing positioning
159
Precision in calculations
427
Predefined shortcuts
249
Preliminary monitor's adjustment
302
Press new shortcut key
324
Previous cell
295
Previous screen
295
previous VideoCAD versions
439
Print
197, 199, 286, 298, 304, 310, 313, 360
Print Color
320, 322
Print full table of camera models
310
Print width
320
Printer setup
197, 199
Printing
3
Priority
325
Processing
286, 315, 316
Processing tab
361, 362, 369
Producer
315, 316
Producer of the model
316
Program registration in the case of the HID basis
protection
439
Program registration in the case of USB dongle basis
protection
439
Program speed problem
427
progressive
316
Project
197, 199
project export
341, 342
Project>New
360
Projection
253, 255
Projection panel
292
projections
159
projections of license plate reading area
147, 166
projections of person detection
360
projections of person detection area
147, 166
projections of person identification area
147, 166
projections of view area
251
Projector
376, 377
projector illumination on an axis of radiation
376
Projector with halogen incandescent lamp
368
Protection
315, 316
Provider
315, 316
PTZ camera
316, 384
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286, 363

-QQuality level
360, 361
quality level criteria
166
Quality level parameters box
Quality levels
197, 199

157

-RRadiant intensity curve
373
Rain
smoke
286
Raster PDF
329
ratio parameters
251
reading
427
Real angles
267, 315, 316
Real distance
199, 359
Real frame size
286
Real size
345
real view angles
405
Recalculate shadows
197, 199
Reciprocity
316
Recommendations on the program use
427
Rectangle
164, 166, 197, 199, 355, 361
red
251
red color
159
red frame
336
red highlighted parameters
310, 316
red line
274
red lines
251
Redo
164, 166, 197, 199
Redraw 3D image only by clicking
286, 290, 325
Redrawing 3D Video
325
redrawn too slowly
325
Reflected light
166
Refresh
343
regions
272
registration
439
Registration box
439
registration key
439
Regulations of upgrading previous VideoCAD versions
to VideoCAD 6.0
439
reinstalling operation system
439
relative spectral efficiency factor
377
reliability requirements
255

Remote control
315, 316
Remove
324
remove assigned shortcuts
324
removeble IR filter
316
Rename
298
rename a layout
340
RENAMINGS
89
REPORTS AS A TABLE
89
Required view area limitations
360
reserve
427
Reserve registration
439
reserve registrations
439
reserves
341, 342
resize 3D models
248
Resolution
89, 274, 315, 316, 325, 362
Resolution (m. or ft.)
329
resolution in TV lines
369
restoring normal width of columns
310
results of calculation
251
right part
243
road down-grade
427
Rolling shutter
284, 315, 316
Rolling Shutter effect
316
Rotakin
164, 166, 197, 199
Rotakin speed (rpm)
325
Rotate
159, 164, 166, 197, 199, 361
row time
315, 316, 385, 394
Ruler
199, 359
RULES OF UPGRADE
89

-SS/N (dB)
366
sacrifice some values
427
S-AGC
316
Sampling
333
Save
197, 199, 310
Save as
197, 199, 360
Save as *.bmp
286, 298, 361
Save as *.jpg
286, 361
Save as animated *.gif 286
Save as background
197, 199
Save as dialog box
310, 313
Save current table view
310
Save model database
310
Save project
164, 199
save the drawing
199
Save the loaded camera
249
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Save to project
164, 166, 197, 199
Save view
310
Scalable
327
scalable typefaces
322
Scale
159, 164, 166, 197, 199
Scale background
197
Scale factor
329
Scale Hatching
89
Scaleable
322
scaling
243
Scaling factor when turning the mouse wheel
333
Scan
315, 316
Scan direction
315, 316
Scene
286, 374
scene illumination
366
scene reflection factor
316
Scene tab
366
Screen
286
Screen Acpect Ratio
295, 298
Screen color
320, 322
screen plane
159
screen resolution
284
screen resolution in Windows
378
Screen width
320
scroll bars
158
Search
304
Searching by parameter value
307
section area of power cable
342
segments
341, 342
Select all
197, 199, 249, 313
Select all cells
313
select all objects
166, 199
Select all the objects
249
select objects
199
select objects by one
166
Select/Edit
159, 164, 166, 197, 199, 355, 361
Selected only
338, 343
selected state
159
Selecting and editing cell
307
Selecting column
307
Selecting fragment
307
Selecting frame rate
379
Selecting frame rate on the basis of known target's
positions and velocities
353
Selecting model (row)
307
selection logic
249
selection window
166, 199
Send to back
197, 199
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Sensitivity
315, 316
Sensitivity and resolution
157, 164, 166, 286, 361,
362, 366
Sensitivity ans Resolution
197, 199
Sensor and Lens
89, 157, 253, 255, 267
sensor format
89
Sensor size panel
267
sensor sizes
267
separation of the luminance and chrominance
362
serial numeration
199
Serial numeration of cameras
157
Set origin
159, 197, 199
Setting
290
Setting limit of electronic shutter
368
settings of the current printer
199
Setup.exe
439
Shadow
164, 197, 199, 320, 384
Shadow box
248, 388
shadows
166, 255
sharp+1
316
sharp+2
316
sharp+3
316
sharpness
325, 362
Sharpness area
320
sharpness area bounds
390
sharpness area limits
361
shift focus
316
shift from the projection of the main optical axis
243
Short Dash
320
Shortcuts keys
324
short-focus PIN-HOLE lens
427
Show 3D
336
Show all
197, 199, 310, 324
Show all columns
310, 313
show any layout
242
Show camera type
327
Show in 3D Video
300
Show loaded camera
164, 166, 197, 199
Show panel
286
Show this box before export
329
shutter
316
shutter control
316
signal cable
164, 166, 197, 199, 320, 341, 388
Signal cable length
341
Signal cable length calculation box
157
Signal/noise (dB)
315, 316
Signal/noise (max
weighted)
315, 316
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signal/noise ratio
316, 366, 367
Simplified export
329
Simulate distortion
333
Simulating distortions
385
Simulating distortions of moving objects arising from
Exposure time, Interlace scan and Rolling shutter
353
Size and line type for icons of camera
327
size of active area
255
size of active area of the image sensor
89, 316
size of output image
362
size of the image sensor
255, 316
Sizes
251, 315, 316
Sizes (unit)
329
SketchUP
3, 397, 400
Smoothing
286
Snap panel
158
Snap sensitivity
333
sockets
316
Solid
320
Sort cameras
336
sorting
304
Sorting by column data
307
Space limits
325
Spacebar
199, 249
spatial resolution
89, 157, 164, 166, 197, 199, 272,
381
Spatial resolution and rotation
333
Spatial resolution box
199, 272, 381
Spatial resolution criterion
272
Spatial resolution pattern
272, 281
Spatial resolution patterns
345
Special sensor size
89
Specify the focus plane
390
Specifying active area size of the image sensor
353, 415
specifying sensor size
267
spectral efficiency
375
Spectral efficiency factor
375
Speed
286
Speed <> Accuracy
290, 325
Speed box
248
speed of moving 3D model
248
SPEED OPTIMIZATION
89
square grips
159
Stabilized power supply unit
377
Stairs
89, 164, 166, 199
Stand
367, 375
Standard camera
316

Start
368, 375, 377
Start numeration on each layout
338
Starting index
338
status bar
158, 243
Step and direction of scaling
159
steradian
373
Stop operation
164, 166, 361
Stop the current operation
249
Stretch another aspect ratio images
295, 298
strictly according to the criteria
427
Strike out
322
Style
320, 322
Style in Windows
322
Subject
345
Super AGC
316
Supply voltage
316
supply voltage and lamp parameters variation
325
SWF
199, 329
switch of time in the project
286
Switch OFF illuminators
197, 199
Switch ON illuminators
197, 199
Switches and adjusments
315, 316
Synchro
315, 316
Synchronization type
316
system fonts
322

-Ttab left part
320, 322
Table Interface
306, 307
Table of camera models
157, 164, 166, 197, 199,
286, 304, 307, 310, 313, 315, 316
Table of cameras
157, 164, 166, 197, 199, 360
Table of regions
274, 381
Table view list
310
Table views
307
table with all camera parameters
363
teaching articles
153
Teaching materials
353, 424
Technical questions can be e-mailed
438
Television system
316
Temperature (C)
315, 316
test chart
286, 369
test chart EIA1956
284
Test object
159, 164, 166, 197, 199, 284
Test object box
157
test object displaying
199
Test object location
164, 166, 197, 199
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Text
159, 164, 166, 197, 199
Text 1
345
text boxes
251
Text report
199
Texts
159
textures
89
the default lower bound
255
the part of the frame height covered by an object of the
specified height
272
The principles of CCTV design in VideoCAD
153,
424, 427
The rest shortcuts
249
Thick fog
286
Thin lines of raster background
333
Three-megapixel IP camera
385
TIF
329
Tilt angle
267
tilting and panning the loaded camera
355
Times New Roman
345
Title
286, 345
Title-Block
199
Titles
159, 197, 199, 322, 345
To selected cameras
274
Tool bar
158, 159, 306, 310, 332
TOOLS
89
Total cost
315, 316
total length of cable
341, 342
total light flux of one lamp
373
Transparence box
166
Transparence of 3D images
247
transparence of Inclined rectangle
247
Transparency of PNG
89
transparent by 70 %
166
transparent pixels
199
Troubleshoot
290
True Type
322
TrueType
345
tungsten halogen lamp
367, 371, 375, 377
TV lines
89
TV lines tab
369
TV system
315, 316
TVL
89
TV-lines
316
TV-tuner
367, 375, 377
Type
315, 316
Type of current
315, 316
Type of hatching
274
Type of hatching combo box
274
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166

-UUnassigned
166
Underline
322
Undo
89, 164, 166, 197, 199
UNDO depth
333
Uninstall driver
439
Unique model number
316
unweighted signal/noise ratio
286
Unweighted value
316
Update
295, 298, 300
Update cameras of all models
313
Update cameras of the selected model
Updating images
302
Upgrading to VideoCAD 6.0
439
USB Dongle
439
USB dongle basis
439
USB port
439
Used models
166, 304, 310
User forum
197
usual color
159
Utilities
89, 197, 199

313

-Vvandalproof 316
variants of camera placing
361
Variants of protection from unauthorized copying
439
varifocal lenses
255
vcm
399
Vector PDF
329
velocities
379
velocity vector
159, 248, 379
velocity vectors
197, 199, 380, 385
Vert.(Horiz.) number of pixel
274
Vert./Hor.
274
vertical (upper) projection
159
vertical field of view size
272
Vertical line
164, 166, 197, 199
vertical number of pixels
274
vertical number of pixels covered by an object of the
specified height
272
vertical projection
243
Vertical size
362
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vertical spatial resolution (pixels/meters, pixels/foot
272
very clean environment
325
very subjective
427
video motion detector
316, 361
VideoCAD 3.0
89
VideoCAD 3.02
439
VideoCAD 4.0
89
VideoCAD 4.01
439
VideoCAD 5.0
89
VideoCAD 5.02
439
VideoCAD 6.0
89, 439
VideoCAD 6.1
89
VideoCAD 7.0
89
VideoCAD 8.1
89
VideoCAD font type
322
VideoCAD interface
157
VideoCAD Lite
31, 45, 49
VideoCAD Professional
3, 31, 45, 49
VideoCAD Starter
45
VideoCAD Starter II 49
VideoCAD Starter II Kit
45, 49
VideoCAD User's Guide
424
VideoCAD_Lite
439
Videotape recorder
255
View
197, 199, 286, 291
view angles of lens
255
view area
251
view area as two sections
89
View area bounds
320
View area edges
164, 166, 197, 199, 320
View area horizontal projection lower bound
360
view area is narrowing downwards
255
view area is narrowing upwards
255
View area length
253, 255
View area limitations
253, 255
View area lower bound
360, 361
View area lower bound distance
253, 255
view area lower bound height
281
View area lower bound width
360
View area projection bounds
164, 166, 320
View area projections
147
View area projections bounds
197, 199
View area upper bound
360, 361
View area upper bound distance
253, 255, 286,
360, 361
view area upper bound height
281, 286
view areas semi-transparent
400

Views
310
virtual post
284
virtual printer
199
visibility of buttons on the Tool bar
332
Visibility of columns
307
Visible buttons
332
visible light projector
376
visible pixelization
290
Visualization of cameras' control area
381
Visualization of cameras' control area projections and
spatial resolution inside them
353
VISUALIZATION OF SPATIAL RESOLUTION AND
FIELD OF VIEW SIZE
89
VMD
315, 316
Voltage
315, 316
voltage slump
325
vPDF
329

-WW (%)
345
W#H
255, 267
W*H
255, 267, 316
W:H
255, 267
Walk
89
Wall
164, 166, 197, 199, 245, 357, 361
warming up
377
waterproof 316
watt/m2
377
wavelength of radiation maximum
373
weather conditions
427
Weight
315, 316
What's new in VideoCAD 3.0
89
What's new in VideoCAD 4.0
89
What's new in VideoCAD 5.0
89
What's new in VideoCAD 6.0
89
What's new in VideoCAD 6.1
89
What's new in VideoCAD 7.0
89
What's new in VideoCAD 8.0
89
What's new in VideoCAD 8.1
89
What's this?
153, 157
Wheel Mouse
157
white
251
white paper
377
wide angle illuminator
377
wide-screen image
316
Width
247, 345
Width of view area lower bound
253, 255
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Width of view area upper bound
WINDOWS
89
Windows 2000
427
Windows 9x
427
Windows clipboard
199
Windows' clipboard
336
Windows Me
427
Windows Metafile
357, 359
Windows XP
427
Within projection
199
WMF
329
Work with Monitors
302
Working in 2D
3

253, 255

-XX(%)
X/Y"

345
267

-YY (%)
345
your individual criteria

255

-ZZero ground
147
ZOOM
89
Zoom frame
89
Zoom in
197, 199
Zoom in/zoom out
164, 166
Zoom out
197, 199
zooming
159
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